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Kata Pengantar

Buku Manual Pemakaian Aplikasi ini merupakan salah satu panduan dalam
menjalankan dan menggunakan aplikasi Software Akuntansi Accpro Trada
dan Accpro Strada. Selain buku manual ini masih ada lagi panduan yang
dapat anda gunakan dalam memahami Accpro Trada atau Accpro Strada di
antaranya Tutorial Accpro yang berupa buku digital (ebook), di samping itu
masih ada lagi panduan berupa Accpro Trada Help atau Accpro Strada Help
yang dapat anda temukan ketika menjalankan aplikasi Accpro Trada atau
Strada dengan menekan tombol F1 atau memilih menu Help > Manual
Pemakaian Aplikasi. Ketiganya saling melengkapi, kalau buku manual ini
beserta Accpro Help lebih berupa penjelasan mengenai fasilitas dan modul
yang ada pada Accpro Trada atau Strada, maka tutorial adalah contoh

penerapannya pada suatu perusahaan.

Buku ini didahului dengan pemahaman tentang konsep Software Akuntansi
Terpadu pada umumnya sebagaimana konsep yang berlaku juga untuk
Accpro sebagai Software Akuntansi Terpadu.

Pemahaman ini diperlukan agar software dapat digunakan secara optimal
dan menghindari kekeliruan yang diakibatkan paradigma yang masih
mengacu kepada konsep pembukuan manual atau software yang hanya

berupa program G/L semata.

Selanjutnya dijelaskan istilah dan konvensi yang digunakan dalam manual ini
maupun Software Accpro itu sendiri, navigasi standar yang berlaku dalam
lingkungan Accpro, proses instalasi Accpro dan persiapan awal dalam

menggunakan Accpro.

Selebihnya buku ini berisi panduan dalam mengoperasikan Software
Akuntansi Accpro Trada dan Strada, modul demi modul mulai dari Setup
Awal dan input Master Data, input transaksi sampai dengan laporan-laporan

yang dihasilkan.

Jakarta, Februari 2018

Stefanus Djanarita
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BAB 1
Pendahuluan

1.1 Konsep Software Akuntansi Terpadu pada umumnya

Pemahaman tentang konsepsi Software Akuntansi Terpadu diperlukan agar
software bisa digunakan secara optimal dan menghindari kekeliruan-
kekeliruan pada saat input data yang disebabkan paradigma yang masih
mengacu kepada konsepsi software akuntansi yang hanya berupa program

G/L semata-mata atau pembukuan yang masih manual.

Berbeda dengan software yang hanya berupa program G/L, Software
Akuntansi Terpadu terdiri dari modul Pembelian, Penjualan, A/P, A/R, Kas /
Bank, Inventory disamping modul G/L. Keterkaitan antar modul

digambarkan pada bagan berikut :

AP 4 PEMBELIAN — [INVENTORY
& : : ‘ &
BUKU BESAR
KAS/BANK ——» (GIL)

b4 =
AR +—— PENJUALAN

Seperti tergambar pada bagan di atas, pada saat user melakukan input

penjualan, maka program akan secara otomatis mengupdate A/R (Piutang)
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Customer yang bersangkutan, demikian juga program akan mengupdate
persediaan barang (Inventory) serta membentuk jurnal pada Buku Besar
(G/L). Sebagai gambaran, jurnal yang terbentuk adalah kurang lebih sebagai
berikut :

Piutang Dagang XXXXXXXX (Db)
Penjualan XXXXXXXX (Cr)
PPN Keluaran XXXXXXXX (Cr) (optional)
Harga Pokok Penjualan XXXXXXXX (Db)
Persediaan Barang Dagang XXXXXXXX (Cr)

Apabila anda menggunakan program yang hanya berupa G/L semata-mata,
maka anda harus membuat jurnal penjualan secara manual, perhitungan
Harga Pokok Penjualan dan Nilai Persediaan pun biasanya dilakukan secara
sekaligus pada akhir periode. Karena hanya ada modul G/L semata-mata,
maka anda bebas melakukan penjurnalan terkait akun manapun karena Buku
Besar (G/L) menjadi satu-satunya sumber informasi. Tidak demikian halnya
dengan Software Akuntansi Terpadu, sebagaimana digambarkan di atas,
pada saat input penjualan, maka selain membentuk jurnal, program juga
mengupdate buku pembantu Piutang Dagang demikian juga Kartu
Persediaan. Oleh sebab itu maka anda tidak diperkenankan membuat jurnal
yang terkait dengan akun Piutang Dagang atau Persediaan Barang Dagang
secara langsung melalui modul G/L karena jurnal yang dibuat melalui modul
G/L tidak mengupdate buku pembantu Piutang (Kartu Piutang), demikian
juga Kartu Persediaan. Akibatnya akan timbul ketidaksesuaian antara saldo
akun terkait pada Buku Besar (G/L) dengan buku pembantunya. Ini berlaku
juga untuk Hutang Dagang, dimana Hutang Dagang diupdate oleh program
melalui modul Pembelian dan Pengeluaran Kas / Bank pada saat

pelunasannya.

Hal lain yang membedakan software yang hanya terdiri dari G/L semata
dengan Software Akuntansi Terpadu adalah karena sebagai satu-satunya
sumber informasi, maka agar bisa mengetahui saldo Piutang masing-masing
Customer atau Hutang masing-masing Supplier, maka anda harus
membedakan akun Piutang Dagang untuk masing-masing Customer dan

Hutang Dagang untuk masing-masing Supplier. Ini tidak diperlukan pada
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Software Akuntasi Terpadu (walaupun anda bisa melakukannya - Accpro
mengakomodasi hal ini - tidak semua Software Akuntasi Terpadu
mengakomodasi hal ini) karena saldo Piutang atau Hutang masing-masing
Customer atau Supplier akan dapat diketahui melalui buku pembantunya,
artinya anda cukup mempunyai satu akun Piutang atau Hutang pada Buku
Besar, kalaupun ingin dibreakdown adalah berdasarkan kriteria lain misalnya

jenis valutanya atau pengelompokkan customernya dan sebagainya.

1.2 Konsep Software Akuntansi Terpadu Accpro

Sebagai Software Akuntansi Terpadu, konsepsi sebagaimana dikemukakan di
atas juga berlaku untuk Accpro. Secara lebih detail, konsep yang berlaku
pada Accpro adalah sebagi berikut :

e Agar program bisa melakukan penjurnalan secara otomatis, maka
program perlu diberitahukan manakah akun Piutang Dagang, Penjualan
dan PPN Keluaran misalnya, inilah yang dimaksud dengan Account
Default. Dengan demikian pada saat user melakukan input penjualan,
program otomatis dapat membuat jurnalnya berdasarkan akun default ini.

e Akun yang telah ditetapkan sebagai akun default untuk Piutang Dagang
tidak bisa digunakan pada jurnal yang dibuat secara manual. Akun ini
akan dipakai oleh program pada saat melakukan penjurnalan melalui
modul Sales Invoice, selanjutnya apabila ada pelunasan atas Invoice
bersangkutan maka harus diinput melalui modul Penerimaan Kas / Bank.
Penerimaan Kas / Bank sendiri dibedakan atas 2 jenis transaksi yaitu yang
berkaitan dengan Piutang Dagang dan yang tidak terkait dengan Piutang
Dagang yaitu Penerimaan Kas / Bank lain-lain. Pelunasan Piutang Dagang
atas suatu Invoice hanya dapat dilakukan melalui jenis transaksi yang
pertama. Program hanya akan mengupdate buku pembantu Piutang
Dagang pada jenis transaksi yang pertama, demikian juga penentuan
Invoice yang akan dilunasi hanya difasilitasi pada jenis transaksi ini.
Inilah alasan lain mengapa anda tidak bisa melakukan penjurnalan terkait
akun Piutang Dagang secara manual. Pada Software Akuntansi Terpadu,

timbulnya Piutang Dagang selalu terkait penerbitan Invoice (atau Debit
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Note), demikian juga pelunasannya harus dikaitkan dengan Invoice
tertentu, sehingga akan ada dasar untuk melakukan analisa umur piutang
yaitu berdasarkan Jatuh Tempo Invoice bersangkutan. Tidak demikian
halnya pada software yang hanya berupa program G/L semata, karena
tidak ada dasar untuk hal ini maka Laporan Umur Piutang tidak akan
anda dapatkan, padahal laporan ini sangat penting sebagai sumber
informasi dalam melakukan penagihan.

Modul lain yang bisa digunakan untuk melakukan transaksi yang
berkaitan dengan Piutang Dagang adalah modul Credit Note / Debit Note.
Melalui modul ini misalnya anda bisa melakukan penghapusan Piutang
Dagang, lagi-lagi ini selalu harus dikaitkan dengan Invoice tertentu,
demikian juga jika ada pengkreditan terhadap Piutang Dagang yang tidak
berupa Penerimaan Kas / Bank.

Apabila anda tetap memerlukan untuk melakukan penjurnalan terkait
akun Piutang secara manual, maka itu hanya bisa dilakukan apabila akun
Piutang itu dibedakan dari akun Piutang Dagang yang telah anda
beritahukan kepada program sebagai Account Default Piutang Dagang,
misalnya anda membuat akun Piutang Non Usaha atau Piutang Lain-lain
untuk piutang yang timbul hanya berdasarkan penjurnalan, sebagai
konsekwensinya anda tidak memiliki kartu piutang dan laporan piutang
untuk piutang yang demikian, tetapi semata-mata informasinya didapat
hanya melalui Buku Besar (Ledger).

Apa yang telah dikemukakan menyangkut Piutang Dagang berlaku juga
untuk akun Hutang Dagang. Akun default Hutang Dagang akan
digunakan oleh program pada saat penjurnalan melalui modul Purchase
Invoice dan Pengeluaran Kas / Bank terkait pelunasan Hutang Dagang.
Seperti halnya pada Penerimaan Kas / Bank, Pengeluaran Kas / Bank
dibedakan atas 2 jenis transaksi yaitu yang terkalit pelunasan Hutang
Dagang dan Pengeluaran Kas / Bank lain-lain. Apabila ada pendebitan
terhadap Hutang Dagang yang tidak terkait Pengeluaran Kas / Bank,
maka bisa dilakukan melalui modul Credit Note / Debit Note, seperti
halnya Piutang Dagang, untuk Hutang Dagang juga harus dikaitkan
terhadap Purchase Invoice tertentu.

Apabila anda tetap memerlukan untuk melakukan penjurnalan terkait

akun Hutang secara manual, maka itu hanya bisa dilakukan apabila akun



Hutang itu dibedakan dari akun Hutang Dagang yang telah anda
beritahukan kepada program sebagai Account Default Hutang Dagang,
misalnya anda membuat akun Hutang Non Usaha atau Hutang Lain-lain
untuk hutang yang timbul hanya berdasarkan penjurnalan, sebagai
konsekwensinya anda tidak memiliki kartu hutang dan laporan hutang
untuk hutang yang demikian, tetapi semata-mata informasinya didapat
hanya melalui Buku Besar (Ledger).

Accpro menyediakan dua metode yang dapat dipilih salah satunya dalam
menentukan Harga Pokok Penjualan, yaitu FIFO (First In Fisrt Out) dan
Average (Weighted Average). Idealnya, anda melakukan input transaksi
yang ada kaitannya dengan persediaan seperti pembelian, penerbitan
Surat Jalan (DO), penyesuaian persediaan, assembling, pemindahan
barang (pindah gudang), purchase return, sales return sesuai kronologis
terjadinya transaksi. Ini sangat penting khususnya jika anda memilih
metode FIFO sebagai metode penilaian persediaan sehingga banyak orang
ragu-ragu untuk memilih metode FIFO. Namun anda tidak perlu
mengkhawatirkan hal ini, karena Accpro selalu akan melakukan hitung
ulang HPP jika ada transaksi yang tidak diinput sesuai dengan
kronologisnya dan itu berlaku baik apakah anda menggunakan metode
FIFO atau Average. Perlu diketahui, tidak semua Software Akuntansi bisa
mengantisipasi dan mengakomodasi hal ini. Jadi paradigma bahwa
metode FIFO lebih merepotkan tidak berlaku jika anda menggunakan
Accpro.

Sinkronisasi antar data merupakan hal yang essensial pada Software

Akuntansi Terpadu. Oleh karena itu jurnal yang dihasilkan secara otomatis

oleh program terkait modul tertentu tidak bisa diedit ataupun dihapus

kecuali melalui pengeditan atau penghapusan transaksi yang merupakan asal

(sumber) dari jurnal tersebut. Prinsip ini juga berlaku untuk data atau

transaksi yang terkait data atau transaksi lainnya, contohnya Sales Invoice

yang telah diterima pelunasannya, tidak bisa diedit atau dihapus kecuali

dengan menghapus lebih dulu transaksi Penerimaan Kas / Bank yang

merupakan pelunasan atas Sales Invoice dimaksud.

1-5



1-6



BAB 2
Pengenalan Accpro

2.1 Gambaran Umum

Accpro merupakan software akuntasi terpadu untuk pengelolaan data
akuntansi yang didesain dengan mengutamakan kemudahan dalam
pengoperasiannya tanpa meninggalkan kelengkapan fitur sehingga dapat
digunakan oleh user tanpa memerlukan pengetahuan akuntasi mendalam.

Accpro dikembangkan dalam beberapa varian atau versi yang disesuaikan
dengan kebutuhan user. Contohnya, user yang bergerak di bidang
perdagangan dan tidak memerlukan fasilitas multi currency, multi
departemen, multi gudang dan tidak membutuhkan modul Assembling
cukup menggunakan Accpro varian Trada, sedangkan user yang bergerak di
bidang jasa murni yang tidak membutuhkan modul Inventory, tidak
membutuhkan fasilitas multi currency dan proyek bisa menggunakan Accpro
Servitia. Sedangkan user baik yang bergerak di bidang perdagangan atau jasa
yang membutuhkan modul dan fasilitas yang lebih lengkap seperti fasilitas
multi currency, multi gudang, multi departemen, proyek, modul Fixed Asset,
Assembling dan lainnya bisa menggunakan Accpro Spectra. Satu varian lagi
adalah kombinasi dari varian Accpro Trada dan Accpro Servitia yaitu Accpro
Strada yaitu untuk user yang memerlukan modul Inventory dan Jasa tetapi
tidak membutuhkan fasilitas multi currency dan fasilitas lainnya seperti multi

gudang, departemen, proyek seperti yang ada pada Accpro Spectra.

2.2 Fitur dan Fasilitas Accpro

e Multi user, multi company, multi satuan, multi diskon (diskon
bertingkat). Fasilitas yang hanya ada di varian Accpro tertentu (Accpro
Spectra, Accpro Prima) : multi departemen, multi currency, multi gudang,

multi tax.
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Multi DO. Satu Invoice (Penjualan) bisa lebih dari satu DO (Surat Jalan).
(Fasilitas ini tidak tersedia pada Accpro Servitia, karena modul Delivery Order
(DO) tidak tersedia untuk varian ini)

Multi Payment. Penerimaan dan Pengeluaran Kas / Bank untuk Piutang
Usaha / Hutang Usaha bisa lebih dari satu kali untuk setiap Invoice
(mengakomodasi pembayaran dengan sistem mencicil). Multi Payment
juga berarti dalam satu transaksi pelunasan bisa atas lebih dari satu
Invoice.

Terintegrasi penuh. User hanya perlu memasukkan transaksi tertentu,
penjurnalan otomatis dilakukan oleh program.

Autoposting. Posting pada jurnal otomatis dilakukan oleh program
sehingga dapat langsung menghasilkan laporan keuangan secara real-
time.

Mendukung pengeditan dan penghapusan data sekaligus pembatalan
posting oleh user yang diberi hak akses untuk itu.

Mudah dalam pengoperasiannya, disediakan fasilitas (jendela) bantuan /
pencarian sehingga tidak harus menghapal kode.

Input transaksi untuk periode berikutnya tidak harus menunggu tutup
buku periode bulan berjalan, bahkan dapat dibuka untuk berapapun
periode yang diinginkan. Disediakan fasilitas untuk mengaktifkan dan
menonaktifkan periode tertentu.

Laporan-laporan keuangan maupun laporan lainnya untuk periode-
periode sebelumnya tetap dapat dilihat /dicetak setiap saat.
Laporan-laporan dapat dilihat di layar maupun dicetak ke printer.
Tampilan menarik dan user friendly.

Disediakan 3 (tiga) level User dengan pembatasan hak akses untuk setiap

user dengan level tertentu.

2.3 Istilah dan Konvensi

Seb

elum membahas lebih lanjut, akan diuraikan lebih dulu istilah dan

konvensi yang digunakan baik pada Manual Pemakaian Aplikasi Accpro ini

maupun pada Aplikasi Accpro itu sendiri.
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Untuk dicatat bahwa definisi yang dikemukakan disini adalah definisi yang
berlaku khusus (standar) Accpro untuk memudahkan user memahami istilah

yang digunakan. Di luar aplikasi ini mungkin saja definisinya berbeda.

backup

Adalah proses menyimpan data sebagai cadangan. Cadangan data ini
dibutuhkan apabila terjadi kerusakan pada data yang asli, maka data
cadangan ini akan dapat dipakai sebagai data untuk transaksi

menggantikan data yang rusak tadi melalui proses restore.

e contact

Contact atau Kontak adalah semua yang mempunyai hubungan transaksi
dengan perusahaan. Contact bisa berupa perusahaan, institusi atau
perorangan dan dikategorikan atas Customer, Supplier dan Other
Contact. Other Contact digunakan untuk Contact yang bukan Supplier
atau Customer, bisa karyawan, perusahaan pengangkutan dan lain
sebagainya yang transaksinya tidak menghasilkan Hutang Dagang atau
Piutang Dagang.

e database
Database adalah suatu file yang berisi satu atau lebih tabel. Untuk lebih
jelasnya lihat pengertian tabel.

o default
Kondisi awal yang telah ditetapkan apabila tidak diubah.

(] field
Yang dimaksud field adalah bidang biasanya berupa baris yang dibatasi
kotak dimana ditampilkan data tertentu atau digunakan oleh user untuk
memasukkan data tertentu. Umumnya nama field ada disamping kiri
bidang isian tersebut walaupun tidak selalu. Field bisa juga berupa combo-
box yang menampilkan daftar yang bisa dipilih, option button atau check
box.
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filter
Filter adalah kegiatan menyeleksi data tertentu menurut batasan atau
kondisi tertentu. Untuk melakukan filter, klik tombol Filter pada form

yang menyediakannya

form

Form adalah jendela (window) baik dengan atau tanpa bingkai dimana
ditampilkan data untuk modul tertentu maupun digunakan untuk
meminta input dari user untuk modul tersebut. Pada field di dalam form

inilah user memasukkan atau mengedit data tertentu.

icon
Icon berupa gambar berbentuk kecil yang ditampilkan pada form atau
window atau tombol. Tidak semua icon bisa diklik, adakalanya hanya

untuk melengkapi teks yang ditampilkan.

konvensi

Kaidah atau ketentuan yang telah disepakati.

log in
Log In atau seringkali digabung (login) adalah proses untuk masuk ke
dalam aplikasi melalui form Login dimana user harus mengisi User Id dan

Password.

log out

Log Out atau logout atau Log Off adalah keluar dari aplikasi, khusus
untuk Accpro logout adalah keluar dari aplikasi tanpa menutup aplikasi,
untuk masuk lagi ke dalam aplikasi cukup dengan mengklik tombol Log

In.

lookup
Look up berarti mencari. Jadi form lookup dimaksudkan sebagai form

yang menampilkan tabel untuk keperluan pencarian data.
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modul

Walaupun pengertian modul sebenarnya lebih luas, tetapi di dalam
Accpro kita akan menggunakan istilah modul untuk menyatakan satu
kesatuan dari satu atau lebih kegiatan pemasukan atau pengeditan data
maupun menampilkan data.

Pada umumnya, modul ditampilkan dalam suatu form tertentu.

navigasi
Cara penggunaan tombol keyboard atau mouse di dalam lingkungan

aplikasi, dalam hal ini Accpro.

obyek
Setiap bagian dari suatu form yang bisa berupa tombol, field, icon, tabel,

scroll-bar dan lain-lain, termasuk form itu sendiri.

optional

Optional berarti bersifat pilihan. Bisa dipilih bisa tidak.

preferensi

Pengaturan yang diinginkan / disukai.

preview
Menampilkan laporan pada layar komputer. Umumnya di dalam form
untuk preview ini ada tombol untuk mencetak ke printer. Dengan preview

anda bisa melihat dulu data yang akan anda cetak.

refresh

Tetap menggunakan istilah dalam bahasa aslinya karena lebih singkat,
refresh berarti kegiatan menampilkan kembali data dalam kondisi terkini
setelah ada pengeditan atau penambahan baik oleh user sendiri tetapi
umumnya untuk memperbaharui tampilan data oleh kemungkinan

penambahan atau pengeditan data oleh user lain.
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restore
Proses menjadikan data yang disimpan sebagai cadangan (backup) menjadi

data untuk keperluan transaksi.

search
Kegiatan pencarian data tertentu menggunakan batasan atau kondisi
tertentu yang telah ditetapkan oleh program. Untuk melakukan search klik

tombol search pada form yang menyediakannya.

sel
Sel atau dalam bahasa Inggris cell adalah bagian terkecil dari suatu tabel
dimana tabel disini dalam pengertian tabel yang terdiri dari baris dan

kolom. Lihat pengertian tabel.

tab
Tab (akronim dari tabulasi) adalah bagian dari suatu bidang yang berisi
field-field yang dikelompokkan menurut tugas atau kategori tertentu. Tab

dalam kehidupan sehari-hari analog dengan index pada arsip.

tabel

Pengertian tabel ada dua. Yang pertama adalah tabel dalam bentuk
susunan satu atau lebih baris yang tediri dari kolom-kolom dimana
ditampilkan data atau sebagai bidang untuk user memasukkan atau
mengedit data. Yang kedua tabel digunakan untuk menyatakan suatu file

sebagai bagian dari database untuk menyimpan data tertentu.

toggle
Tombol hidup mati. Apabila klik pertama mengaktifkan sesuatu, maka

klik berikutnya akan menonaktifkannya.

transaksional

Istilah ini digunakan untuk membedakan antara form yang digunakan
untuk menambah atau mengedit data dengan form yang hanya
menampilkan data saja. Jenis yang pertama diistilahkan form

transaksional.
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e update
Merupakan proses menambah atau mengedit data untuk kemudian
dilakukan penyimpanan ke dalam tabel. Dengan kata lain update adalah

kegiatan memperbaharui data.

2.4 Navigasi Standar Accpro

Untuk memudahkan user dalam menggunakan aplikasi, pada bagian ini akan

diuraikan navigasi standar yang berlaku dalam lingkungan aplikasi Accpro.

e Pada form yang bersifat transaksional umumnya terdapat tombol navigasi

seperti berikut.

44| > M

L} digunakan untuk berpindah ke record (data) yang pertama.
14 digunakan untuk berpindah ke record (data) sebelumnya.
iLd digunakan untuk berpindah ke record (data) berikutnya.

L digunakan untuk berpindah ke record (data) terakhir

Tombol navigasi hanya aktif dalam modus pengeditan data, apabila anda
berada dalam modus penambahan data, maka klik tombol Cancel untuk
membatalkan modus penambahan data tersebut, maka anda akan berada

pada modus pengeditan data

e Pada saat anda membuka form transaksional melalui menu atau icon
pada toolbar, apabila modul tersebut sudah ada datanya, maka program
akan menampilkan data terakhir dan anda akan langsung berada pada
modus pengeditan data. Untuk menambah data klik tombol New, maka
anda akan masuk ke dalam modus penambahan data. Seperti telah
dikemukakan di atas pada modus pengeditan data, anda dapat berpindah
ke data yang lain menggunakan tombol navigasi.

Namun bila modul yang anda buka belum ada datanya maka anda akan

langsung berada pada modus penambahan data.

2-7



ABA

2-8

Untuk berpindah dari satu field ke field lain dalam suatu form klik pada
field yang bersangkutan atau menggunakan tombol Tab atau Enter pada

keyboard.

Standar pengaksesan combobox

DI Jisya, SENTOSA| wv-——= tombel drop-down Satuanlnventory  |Unit v

Untuk menampilkan pilihan pada combobox, klik pada field tersebut atau
klik pada tombol drop-down disamping kanan field tersebut.

Pada combobox yang jumlah pilihannya tetap (mis: Sub Kategori pada
form Chart of Account) maupun jumlah pilihannya bisa bertambah tetapi
tidak terlalu banyak (mis: Satuan Inventory pada form Barang & Jasa),
klik pada pilihan yang ditampilkan untuk memilih atau klik pada field
lain atau diluar field tersebut untuk membatalkan pilihan. Anda bisa juga
menggunakan tombol keyboard panah atas dan panah bawah untuk
berpindah pilihan. Tombol Enter bisa digunakan untuk menetapkan
pilihan dan berpindah ke field berikutnya. Pada field yang harus diisi
anda tidak dapat mengosongkan field tersebut.

Sedangkan pada combobox yang jumlah pilihannya bisa bertambah
menjadi cukup banyak (mis: supplier, customer, perkiraan), selain cara
tersebut diatas anda bisa mengetikkan potongan awal data yang dicari
pada field tersebut, maka kursor pada daftar pilihan akan berpindah pada
data yang memenuhi kriteria tersebut, selanjutnya anda dapat
menggunakan mouse untuk memilih data yang dimaksud, apabila pilihan
cukup banyak manfaatkan scroll-bar yang ada. Hal ini berlaku juga pada
tombol drop-down yang ada pada tabel. Pada beberapa combobox,
apabila potongan data yang dicari tidak ada maka kursor pada daftar
pilihan akan disembunyikan, gunakan tombol keyboard Backspace atau
Del untuk mengedit teks yang dicari.

Apabila data yang dicari belum ada, anda bisa menambah data dengan

cara memilih pilihan < New > pada combobox yang menyediakannya.



Option button
Tipe Perkiraan () General () Detail

Field yang ditampilkan dalam bentuk option button hanya dapat anda
pilih salah satunya. Klik pada option button pilihan anda. Untuk
berpindah ke field berikutnya klik pada field tersebut atau tekan Tab atau
Enter pada keyboard. Apabila anda menggunakan keyboard maka untuk
berpindah di antara option button gunakan tombol panah kanan atau
panah bawah untuk maju ke pilihan berikutnya atau tombol panah kiri

atau panah atas untuk mundur ke pilihan sebelumnya.

Checkbox

Tampilkat yang berzalda Mal
Tampilkah Persentase

Berbeda dengan option button, field yang ditampilkan dalam bentuk
checkbox umumnya bisa dipilih lebih dari satu pilihan kalau pilihan yang
ditampilkan lebih dari satu. Namun dalam kasus tertentu, ada juga
checkbox yang dibuat hanya bisa dipilih salah satunya. Apabila
menggunakan keyboard anda bisa berpindah pilihan dengan
menggunakan tombol Tab, panah kanan, panah bawah untuk maju ke
pilihan berikutnya atau Shift+Tab, panah kiri, panah atas untuk mundur
ke pilihan sebelumnya. Menggunakan mouse untuk memilih/tidak
memilih tinggal di klik pada pilihan tersebut sedangkan menggunakan

keyboard anda harus menekan tombol Spacebar.

Spinner
Tahun  [2008 =

Untuk merubah data yang ditampilkan dalam field berupa spinner klik

tombol spinner panah atas atau panah bawah pada spinner tersebut.
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Tanggal

Tal. Invoice

30404408 “

Untuk mengisi field berupa tanggal, klik pada tombol drop-down untuk

memunculkan kalender dan pilih tanggalnya atau dapat mengisi langsung

dengan format dd/mm/yy dimana dd adalah 2 digit tanggal, mm adalah 2

digit bulan dan yy adalah 2 digit tahun tanpa perlu mengetikkan tanda "/".

Tombol-tombol lain selain tombol navigasi dapat dilihat pada tabel

berikut.
Tombol Shortcut Kegunaan
Alt+N Menambah data baru
Alt+S Menyimpan perubahan yang dilakukan
Membatalkan perubahan yang telah dilakukan
dan mengembalikan tampilan di layar seperti
Alt+C sebelum diedit atau pada form yang meminta
konfirmasi berarti tidak jadi melakukan suatu
tugas tertentu.
¢ Delete Alt+D Menghapus data tertentu
IﬁSeardj Alt+H Mencari data menurut field tertentu.
& Edit Alt+E Menampilkan form untuk mengedit data
=Y Preview Alt-+V Menampilkan laporan ke layar untuk kemudian

bisa dicetak ke printer.

Tombol Lookup. Untuk menampilkan form
pencarian data. Pada form ini umumnya
ditampilkan tabel untuk pencarian data,
tergantung contextnya adakalanya berupa
daftar file atau folder

B =

Filker

Menyeleksi data yang ditampilkan. Dengan
mengklik tombol ini program akan
memunculkan form untuk mengisi/memilih
kondisi penyeleksian

[aiy

0




Memperbaharui data yang ditampilkan

@ khususnya terhadap kemungkinan
Refresh penambahan atau pengeditan data oleh user
_ lain
- Mencari data tertentu
Search
m Menutup form. Untuk form yang tidak
menyediakan tombol close, untuk menutup
Close form klik [x] pada pojok kanan atas form

Apabila pada form ditampilkan tombol Periode
maka itu gunanya untuk menentukan periode
data atau transaksi yang ingin ditampilkan.
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BAB 3
Memulai Accpro

3.1 Instalasi Accpro

Langkah awal untuk menggunakan aplikasi Accpro dimulai dengan
menjalankan file instalasi Setup Accpro Trada.exe atau Setup Accpro
Strada.exe (tergantung varian yang anda gunakan). Setelah anda melakukan
double klik file tersebut ikuti langkah-langkah yang ditampilkan. Untuk versi
Full Version (bukan Demo Version), pastikan dongle telah terpasang lebih
dulu pada port USB komputer yang akan diinstall.

5! Setup - Accpro Strada (= o |

Select Destination Location
Where should Accpro Strada be installed?

i Setup will install Accpro Strada into the following folder.

To continue, dick Next. If you would like to select a different folder, dlick Browse.

Browse...

At least 99.9 ME of free disk space is reguired.

Next = N [ Cancel
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Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Accpro
Strada, then dick Mext.

Additional shortcuts: |
Create a desktop shortout

[ <Back | Next)D;[ Cancel | |

—— ]

Ready to Install
Setup is now ready to begin instaling Accpro Strada on your computer,

Click Install to continue with the installation, or dick Back if vou want to review or
change any settings.

Destination location: i,
C:'Program Files (x86)\Accpro\strada V3

Additional tasks:
Additional shortouts:
Create a desktop shortout

<Back | mmn!}yj[ Cancel |




Installing
Please wait while Setup installs Accpro Strada on your computer.

Extracting files...
| C:V¥Program Files (x86)\Accpro\Strada Y3\Accpro Strada.exe

Cancel

Completing the Accpro Strada
Setup Wizard

Setup has finished installing Accpro Strada on your computer.
The application may be launched by selecting the installed
shorteuts.

Click Finish to exit Setup.
Wiew Tutorial Accpro Strada V3.pdf

Wiew Accpro Strada.chm
Launich Accpro Strada V3
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Selanjutnya program akan menampilkan form konfirmasi sebagai berikut

Accpro memerlukan informasi Default Database, kalau ini adalah
pertama kali anda menjalankan Accpro di komputer ini dan anda
sudah mempunyai database di komputer lain maka pilih Set Default
Database, tetapi kalau database belum dibuat pilih Buat Data Baru

(@ Set Default Database

E:[guat Data Baru

| g OK | |!3§ancel|

Apabila anda sudah mempunyai database Accpro baik di komputer tempat
anda menjalankan setup Accpro maupun database ada di komputer lain
dalam jaringan, maka pilih Set Default Database, tetapi kalau ini adalah
pertama kalinya anda menginstall Accpro dan anda belum mempunyai
database yang akan dijadikan default database maka anda harus memilih
pilihan Buat Data Baru.

Apabila anda memilih pilihan Set Default Database maka tentukan database
yang dimaksud. Apabila database berada di komputer lain maka folder
tempat database tersebut berada harus dishare lebih dulu, selanjutmya cari
lokasi folder database tersebut. Kalau database berada di komputer lain anda
harus mencarinya di My Network Places (Windows XP) atau Network

(Windows 7 ke atas), bisa juga folder tersebut dimapping lebih dulu.

Dalam gambar di bawah, database berada di komputer lain, dimana nama
komputernya adalah ACCOUNTING sedangkan foldernya telah dishare
dengan nama Data Accpro, jika kita kesulitan menemukan folder atau
komputernya maka ketikkan \ \ ACCOUNTING\ kemudian pilih foldernya.

3-4



A € \\ACCOUNTING!, ~| 3 | search Network
| ACCOUNTING\Data Accpro

WACCOUNTING\Downloads

WACCOUNTING\Sample Demo

4 Libraries WACCOUNTING\SharedDocs atch your search.
@ Docum
&) Music
[&] Pictures —
B videos

Organize *

18 Computer
&L Local Disk (C3)
—a Data (D:)
&% DVD RW Drive (E:
& TOURO Mobile (1

m

f' Metwork

File name: - [Flie data Accpre (*.dac) ']

I Open |vl I Cancel I.::

Selanjutnya tentukanlah database dimaksud. Database Accpro mempunyai
ekstensi dac.

|
Search Data Accpro el
Organize + Mew folder > 0 @
* Name ‘ Date modified Type
4 Libraries =
&) PT. SIGMA GPS.dac I 06/02/2018 16:03 DAL File
@ Documents
J Music
[&] Pictures —
B videos
18 Computer
&, Local Disk (C)
—a Data (D3] =
4% DVD RW Drive (£
a TOURO Mobile (|
ci Network
- 4 n | 3
File name: PT. SIGMA GPS.dac ~ [File date Accpro (dac) -
[ open |+ [ conesl |
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Tahap terakhir program akan meminta konfirmasi dari anda mengenai

keberadaan database tersebut.

Set Default Data )
Ny

Default Database
VWACCOUNTING\Data Accpro'PT. SIGMA GPS.dac

Pastikan lokasi database apakah di komputer ini atau di komputer lain
) Lokal (@ Remote [ Server

["|Buka database ini begitu form ini ditutup

ey

Namun kalau anda memilih pilihan Buat Data Baru maka akan ditampilkan

form untuk mengisi data perusahaan sebagai berikut.

Informasi Perusahaan

MNama PT. SIGMA GPS

Alamat Rukeo Melrose Residence Blok AB No. 23
. Kembang Mekar Mo, 1

Kota Jakarta Barat Kode Pos

Megara Indonesia

B erevious | | EYNext % 1 ganoal_

Kalau komputer anda menggunakan sistem operasi Windows 7 ke atas
disarankan anda tidak meletakkan database Accpro pada folder Program
Files atau Program Files (x86), karena database akan selalu dipindahkan oleh
Windows ke Virtual Store (ini akan membingungkan anda nantinya) kecuali
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anda mematikan fitur UAC atau menonaktifkan Virtualization dengan

melakukan pengeditan pada registry windows.

Periode Awal Akuntansi

Izilah dengan Bulan dan Tahun Anda akan mulai menggunakan
program Accpro ini

Bulan Januari -

Tahun 2015 E

Igilah Nama File Database tanpa disertai extension. Extension
akan otomatis diberikan oleh program.

Nama File  PT, SIGMA GPS

Lokasi File  D:\Data Accpro

Jadikan File ini sebagai Default Database

Final !

Sebelum melanjutkan ke tahap berikutnya vaitu Proses pembuatan
Database baru, pastikan lebih dulu data yang anda masukkan
sudah benar.

MNama * PT. SIGMA GPS

Alamat @ Ruko Melrose Residence Blok AB No. 28
Jl. Kembang Mekar No. 1
Jakarta Barat
Indonesia

Periode @ Januari 2015

Mama File : D:\Data Accpro'PT. SIGMA GPS

Buka File ini setelah proses Buat Data selesai

e
@ Proses Buat Data Baru sukses...
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Selanjutnya apabila proses Buat Data Baru berhasil, maka anda akan diminta
membuat user yang berhak menggunakan aplikasi Accpro. Minimal anda
harus memasukkan 1 (satu) user dengan level Administrator. User dengan
level Administrator tidak perlu dan tidak bisa anda batasi hak aksesnya
karena otomatis akan berhak atas semua akses atas aplikasi ini. Klik Save
untuk menyimpan data yang anda buat dan tutup form ini (klik [x] pada

bagian kanan atas form) maka program akan menampilkan form Login

Untuk kepentingan 'security’ pada modus edit anda tidak bisa merubah Level User, apabila ingin merubah

level user maka user yang bersangkutan harus dihapus lebih dulu dan kemudian dinput kembali, demikian
juga apabila user lupa terhadap passwordnya.

User Id :.ﬂdmin I AR AL Non Aktif  [7]

MNama .Administahor [ Password :“‘** Retype ::t:t:

Level | i : I

User
File | Master :n}tor . | Laporan | utiitas

- Buat Data Baru

*| Buka Data Perusahaan

*| Set Default Database

- Setup User

*| Setup Informasi Perusahaan
*| Setup Preferensi

| Setup Printout Transaksi
Log In

Edit | Delete | Print

Opf O

m

mOO0O0000
oooooooof
oooooooo
oooooooo
oooooooo

[7] Tampilkan Reminder pada saat Login [ Tampilkan Finandial Highlight pada saat Login

[l User ini diberikan akses untuk menggunakan akun Default Hutang, Piutang sebagai baris jurnal manual pada modul

Jurnal Transaksi
d Mome

Apabila anda memilih pilihan pertama (Set Default Database) maka program

akan langsung memunculkan form Login. Isi User Id dan passwordnya.
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| Masukkan User Id dan Password Anda

l User ID admin

Password | ==

e (Bew

3.2 Persiapan Awal Penggunaan Accpro

Setelah anda melakukan instalasi Accpro, maka dimulai tahap persiapan awal
penggunaan aplikasi Accpro. Persiapan ini terutama adalah memasukkan
data yang digunakan sebagai Master Data untuk keperluan transaksi
nantinya. Setelah anda memasukkan Master Data dan melakukan beberapa

Setup Awal, baru pemasukan transaksi bisa dimulai.

Master Data dan Setup Awal yang harus anda lakukan berturut-turut adalah

sebagai berikut.

Deskripsi
Sty . Melengkapi Informasi Y F|Ie_>Setup
1. | Informasi Informasi Perusahaan
Perusahaan
Perusahaan
Menetapkan parameter Menu File>Setup
Setup sistem yang akan Preferensi
2. . .
Preferensi diterapkan dan pengaturan
lainnya
Menu Master
>
Chart of Memasukkan semua DECEECITEDD Bl .
3. Account erkiraan Account atau klik Icon
p Chart of Account pada
toolbar
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10.

11.

3-10

Account
Default

Salesman

Kelompok

(Grup)
Customer

Customer

Supplier

Other
Contact

Tabel Satuan

Kelompok

(Grup)
Barang

Setup Account default
untuk keperluan
penjurnalan dan
autoposting oleh program

Memasukkan semua
Salesman yang ada

Apabila pada point 2, anda
memilih Penjualan
dibreakdown menurut Grup
Customer, maka tentukan
Kelompok (Grup)
Customernya, bila tidak
tahap ini bisa dilewati
apabila anda tidak merasa
perlu mengelompokkan
Customer.

Memasukkan semua data
customer yang ada

Memasukkan semua data
supplier yang ada

Memasukkan semua data
kontak lain

Memasukkan semua satuan
yang akan dipakai pada
transaksi

Menentukan
pengelompokan barang
menurut Grup tertentu

Menu Master
Data>Account Default

Menu Master
Data>Salesman

Menu Master
Data>Kelompok
(Grup) Customer

Menu Master
Data>Customer atau
klik icon Daftar
Kontak pada toolbar

Menu Master
Data>Supplier atau
klik icon Daftar
Kontak pada toolbar

Menu Master

Data>Other Contact
atau klik icon Daftar
Kontak pada toolbar

Menu Master
Data>Tabel Satuan

Menu Master
Data>Kelompok
(Grup) Barang



12.

13.

14.

15.

16.

17.

18.

19.

Barang dan
Jasa

Saldo Awal
Inventory

Saldo Awal
Hutang /
Piutang

Saldo Awal
G/L

Terms of
Payment

Tabel Nama
Bank

Tabel Biaya

Proses Awal
Bulan

Memasukkan data semua
barang yang dimiliki

Memasukkan semua saldo
awal barang yang ada

Memasukkan saldo awal
Hutang/Piutang

Memasukkan semua saldo
Awal perkiraan dan
melakukan Set Saldo Awal

Melengkapi data Terms of
Payment

Memasukkan Nama Bank
kepada/dari mana Giro
yang dikeluarkan/didapat

Memasukkan semua biaya
tambahan yang terjadi
pada pembelian/penjualan
(mis: freight, dll) berikut
perkiraannya

Membuka periode awal
untuk mulai memasukkan
transaksi

Menu Master
Data>Barang dan
Jasa atau klik icon
Daftar Barang pada
toolbar

Menu Master
Data>Saldo Awal
Inventory

Menu Master
Data>Menu Master
Data>Saldo Awal
Hutang / Piutang

Menu Master
Data>Setup Saldo
Awal G/L

Menu Master
Data>Terms of
Payment

Menu Master
Data>Tabel Lain-
lain>Tabel Nama
Bank

Menu Master
Data>Tabel lain-
lain>Tabel Biaya

Menu Utilitas>Proses
Awal Bulan
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BAB 4
Setup Awal & Input Master Data

Setelah Accpro terinstall pada komputer anda, maka tahap selanjutnya adalah
melakukan Setup Awal dan menginput berbagai macam data dasar yang

akan menjadi Master Data bagi keperluan transaksi nantinya.

4.1 Menjalankan Accpro

Untuk menjalankan Accpro, double klik ikon Accpro yang ada di tampilan
dekstop komputer anda sesuai varian yang anda gunakan.

Cara lain untuk menjalankan Accpro adalah dari Start Menu. Pada gambar di

bawah ini diberikan contoh untuk sistem operasi Windows XP dan Windows
7.

Accpro Servitia ¥3

All Programs » WinRAR

Hewlett-Packard B Accprostradavs v | B8 AccoroStrada v3 k
Accpro Trada %3 ¢ ﬁ' Uninskall Accpra Strada W3

Mozilla FireFox T Mobc
Care FTP v Cla.
Windows XP
\. Realsoft
1 Accpro Servitia V3 Default Programs
. Accpro Spectra V3
.. Accpro Strada V3 Y Help and Support

. Accpro Trada V3 by

Windows 7

Untuk sistem operasi Windows 7 ke atas, anda juga dapat menempatkan
shortcut Accpro pada taskbar, caranya klik kanan pada icon Accpro di
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desktop kemudian pilih Pin to Taskbar sehingga shortcut Accpro akan selalu
muncul di taskbar.

Selanjutnya akan ditampilkan splash screen Accpro sebagai berikut :

Version 3.6.0
Build 8
Copyright @ 2008 - 2017 Realsoft
www.accprosoftware.com

4.2 Menu File

Menu File berisi sub menu terutama untuk keperluan pengaturan sistem.
Untuk tahap awal pada saat mulai menjalankan Accpro, maka yang perlu
dilakukan adalah menyangkut Setup Informasi Perusahaan, Setup Preferensi,
Setup Printout Transaksi dan juga mungkin diperlukan Setup User apabila
ingin menambah user lain diluar yang sudah dibuat pada saat menginstall
Accpro.

4.2.1 Setup Informasi Perusahaan

Informasi menyangkut perusahaan bisa dilengkapi, yaitu menyangkut
informasi Fiskal dan Authorized Person. Sedangkan Nama dan Alamat
Perusahaan seyogyanya sudah dilakukan sebelumnya pada saat menginstall
aplikasi dan membuat data baru.

4-2



2 senp o e =

Peruzahaan |f|5ka|| Authorized Person |

Mama Perusahaan
PT. SIGMA GPS
Alamat Perusahaan [ Generate dari Alamat dan Kota di tab Perusahaan
NP WP 01.777.777.2-039.000
Pengusaha Kena Pajak (PKP)
Tanggal Pengukuhan PKP

[ Clsave | | ¥ concel |

Lengkapi NPWP dan Tanggal Pengukuhan PKP

8 s s e =
Perusahaan - Authorized Person !

Nama Jabatan
DO (Surat Jalan)
Sales Invoice
Faktur Pajak ERICK SETIAWAN Direktur

Authorized Person adalah personal yang berwenang menandatangani Dokumen tertentu
dan Mamanya akan tercetak pada dokumen tersebut pada saat diprint, jabatan jika
diperiukan bisa diisi.

| Esney

Authorized Person adalah personal yang berwenang menandatangani
printout transaksi khususnya dalam konteks ini adalah DO (Surat Jalan),
Sales Invoice dan Faktur Pajak. Hanya jika diinginkan tercetak pada
dokumen terkait maka Nama perlu diisi, sedangkan untuk Jabatan

bersifat optional artinya bisa diisi jika diinginkan..
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4.2.2 Setup Preferensi

Yang diatur melalui Setup Preferensi adalah menyangkut pilihan terhadap
sistem yang diinginkan yang diatur melalui tab Sistem, aktif tidaknya fitur
tertentu yang diatur melalui tab Fitur, default pengaturan lainnya melalui tab

Profil serta catatan default pada Surat Jalan dan Invoice melalui tab Lain-lain.
% Tab Sistem

Menyangkut pengaturan terhadap sistem ada beberapa hal yang perlu
diatur, yaitu apakah akun hutang usaha/ piutang usaha pada buku besar
(G/L, Chart of Account) ingin dibreak-down menurut masing-masing
Supplier / Customer atau tidak; metode harga pokok penjualan apakah
FIFO atau Average; posting HPP pada Surat Jalan (DO) apakah langsung

Sisteml Format I Fitur I Profil I Laindain |

Pengaturan yang ada pada bagian ini harus anda tetapkan pada saat transaksi belum berjalan, bahkan
untuk Metode Harga Pokok Penjualan sebelum anda memasukkan Saldo Awal Inventory, sebab apabila
sudah ada transaksi yang terkait dengan pengaturan tersebut maka pengaturan itu tidak bisa diubah
lagi

|| Breakdown Account Hutang Usaha Fiutang Usaha menurut Supplier (Customer
Metode Harga Pokok Penjualan

@ FIFO () Average

Posting HPP pada DO (Surat Jalan)

(@) Harga Pokok Penjualan () Persediaan dalam Perjalanan

Breakdown Account Penjualan pada Buku Besar

(@) Menurut Barang / Grup Barang (2 Menurut Grup Customer

Apabila anda ingin menggunakan Kode Referensi Jurnal yang
berbeda dengan default Accpro, Kik Set Kode Jurnal

| E_'Jgave | | ‘Sganoel |

ke Harga Pokok Penjualan atau masih berupa Persediaan dalam
Perjalanan; apakah akun Penjualan akan dibreakdown berdasarkan barang

/ grup barangnya atau menurut kelompok (grup) customernya; yang
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terakhir adalah apabila ingin menggunakan Kode Referensi Jurnal (Kode

Voucher, Kode Jurnal) yang berbeda dengan default yang diberikan oleh

Accpro. Pengaturan pada tab Sistem ini harus dilakukan pada tahap

awal, umumnya sebelum transaksi berjalan artinya belum ada input yang

menyangkut transaksi seperti jurnal, pembelian atau penjualan dsbnya.

Bahkan untuk Metode Harga Pokok Penjualan harus ditetapkan sebelum

melakukan input Saldo Awal Inventory. Karena setelah itu, maka

program tidak mengijinkan untuk dilakukan perubahan. Indikasi bahwa

pengaturan tertentu tidak bisa diubah lagi adalah adanya garis bawah

pada field tersebut.

Breakdown Account Hutang Usaha/Piutang Usaha menurut

Supplier / Customer

Kalau checkbox ini dicheck maka artinya untuk setiap penambahan
Supplier / Customer, anda harus membuatkan satu akun Hutang
Usaha / Piutang Usaha untuknya pada Chart of Account dan
mengaitkan akun tersebut kepada Supplier / Customer
bersangkutan. Penting untuk diketahui bahwa akun yang anda
kaitkan kepada Supplier / Customer akan digunakan oleh program
untuk melakukan penjurnalan secara otomatis, oleh karena itu akun
ini tidak dapat digunakan pada saat anda membuat jurnal secara
manual melalui penjurnalan langsung baik melalui Jurnal Transaksi,
Pengeluaran Kas / Bank bukan Hutang Usaha, Penerimaan Kas /
Bank bukan Piutang Usaha. Karena kalau itu dilakukan maka akan
terjadi ketidaksesuaian antara Saldo Hutang Usaha / Piutang Usaha
pada G/L (buku besar) dengan saldo pada kartu Hutang / Piutang
karena pada saat penjurnalan secara otomatis dari modul Pembelian
dan Pembayaran Hutang Usaha melalui modul Pengeluaran Kas /
Bank dan juga Credit Note / Debit Note, program juga akan
mengupdate Kartu Hutang dan Saldonya, demikian juga pada saat
transaksi Penjualan dan Penerimaan Piutang Usaha melalui modul
Penerimaan Kas / Bank dan juga Credit Note / Debit Note , program
juga akan mengupdate Kartu Piutang dan saldonya. Sedangkan

apabila anda membuat jurnal secara manual baik melalui modul
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Jurnal Transaksi ataupun Pengeluaran Kas / Bank bukan Hutang
Usaha atau Penerimaan Kas / Bank bukan Piutang Usaha maka
hanya G/L (buku besar) yang akan terupdate sedangkan Kartu
Hutang, Kartu Piutang tidak.

Menilik penjelasan di atas maka pertimbangkanlah urgensinya
untuk membreakdown akun Hutang Usaha dan Piutang Usaha
menurut Supplier / Customer. Tanpa melakukan hal ini, anda tetap
dapat mengetahui Saldo Hutang Usaha / Piutang Usaha untuk
masing-masing Supplier / Customer karena telah disediakan fasilitas
Laporan Kartu Hutang, Laporan Umur Hutang serta Laporan Kartu
Piutang dan Laporan Umur Piutang. Membreakdown akun Hutang
dan Piutang menurut Supplier / Customer hanya diperlukan kalau
anda menggunakan software akuntansi yang tidak terintegrasi yaitu
sebatas program G/L saja. Namun semua kembali kepada preferensi
anda, apabila tetap ingin membreakdown maka Accpro mendukung
hal ini tentunya anda sudah memahami bahwa kalau akun itu
dikaitkan kepada Supplier / Customer maka akun bersangkutan
hanya dapat diupdate secara otomatis oleh program melalui modul-
modul yang telah dikemukakan di atas, namun jika tidak dikaitkan
kepada Supplier / Customer tertentu maka akun tersebut tidak
mempunyai buku pembantu Hutang / Piutang berupa Kartu Hutang

atau Kartu Piutang.

Accpro merekomendasikan untuk tidak perlu membreakdown akun
Hutang Usaha / Piutang Usaha menurut Supplier / Customer, tetapi
sekali lagi semuanya kembali kepada pertimbangan anda, kalau
anda ingin ada perincian Hutang / Piutang masing-masing Supplier /
Customer tampil pada buku besar dan Chart of Account maka

tandai checkbox ini dengan mengkliknya.

Tetapkan pilihan anda apakah akan dibreakdown atau tidak
sebelum anda mulai input Saldo Awal Hutang dan Saldo Awal

Piutang.



Metode Harga Pokok Penjualan

Ada 2 pilihan metode harga pokok penjualan yaitu Average
(Weighted Average) dan FIFO (First In Fist Out). Pilih salah satunya.

Lakukan ini sebelum anda mulai menginput Saldo Awal Inventory.
Posting HPP pada DO (Surat Jalan)

Ini maksudnya adalah posting akun lawan (kontra) persediaan pada
saat membuat Surat Jalan. Umumnya akun lawan persediaannya
adalah HPP (Harga Pokok Penjualan). Namun pertimbangkanlah
kemungkinan untuk memilih pilihan kedua yaitu Persediaan dalam
Perjalanan. Terutama kalau ada transaksi yang DO (Surat Jalan)nya
berbeda bulannya antara Tanggal DO dan Tanggal Invoicenya.
Karena kalau ini terjadi, maka kalau pada saat membuat DO
postingnya adalah ke HPP yang adalah biaya sedangkan
penjualannya yang adalah pendapatan baru timbul pada bulan
berikutnya (pada saat Invoice dibuat), maka pada bulan
diterbitkannya DO akan terkesan rugi sedangkan pada bulan
berikutnya akan terkesan laba khususnya kalau nilai transaksinya
cukup besar.

Dengan memilih pilihan kedua (Persediaan Dalam Perjalanan), maka
pada saat membuat DO belum timbul biaya tetapi baru berupa
persediaan dalam perjalanan, sedangkan pada saat Invoice dibuat
baru timbul HPP dengan mengkredit kembali Persediaan dalam
Perjalanan. Dengan memilih pilihan ini maka anda harus
menyediakan akun Persediaan dalam Perjalanan selain akun

Persediaan.
Breakdown Account Penjualan pada Buku Besar

Defaultnya adalah Menurut Barang / Grup Barang. Pada kondisi ini
maka akun Penjualan pada buku besar (G/L) bisa dibreakdown
berdasarkan kelompok barang atau bahkan menurut barangnya.

Namun kalau tidak ingin dibreakdown artinya hanya ada satu akun
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Penjualan, pilihan ini jugalah yang harus anda lakukan.
Pertimbangan apakah mau dibreakdown atau tidak adalah
tergantung apakah ada urgensinya, kalau tidak ada disarankan tidak
usah dibreakdown, karena pada Laporan Penjualan pun anda bisa
mengetahui laporan penjualan per Barang atau Kelompok Barang.
Pilihan kedua adalah Menurut Grup Customer, yaitu jika pada buku
besar ingin ditampilkan akun penjualan menurut karakteristik
customernya, misalnya dibreakdown atas Penjualan Lokal dan
Penjualan Ekspor artinya ada 2 grup customer yaitu Lokal dan
Ekspor atau Penjualan Retail dan Grosir, mungkin juga Penjualan
Konsinyasi dan Non Konsinyasi. Apabila pilihan ini yang dilakukan,
pada saat membuat data Customer anda perlu menentukan grup
customernya, oleh karena itu tetapkan pilihan ini sebelum anda
mulai menginput data customer.

Baik pilihan pertama atau kedua maka tetapkanlah sebelum anda
mulai menginput data barang.

Alternatif lain adalah anda tidak perlu membreakdown akun
Penjualan pada Buku Besar, jadi anda memilih pilihan pertama dan
hanya mempunyai satu akun Penjualan pada Buku Besar, tetapi
anda mengelompokkan customer dengan membuatkan grup
customernya. Informasi penjualan masing-masing grup customer
dapat anda lihat bukan melalui Buku Besar tetapi melalui Laporan

Penjualan.
Set Kode Jurnal.

Kode Jurnal (kode referensi jurnal, kode voucher) adalah kode yang
terdiri dari 2 atau 3 karakter untuk mengindetifikasikan jenis
transaksi, sehingga dengan melihat Kode Jurnal dapat diketahui dari
modul manakah sumber transaksi berasal, dengan demikian kode ini

adalah unik untuk setiap jenis transaksi.

Accpro merekomendasikan agar anda menggunakan Kode Jurnal
yang telah ditentukan secara default oleh Accpro, tetapi kalau anda

ingin merubahnya maka klik tombol Set Kode Jurnal.



Ei Kode Refrensi Jurmnal Q

1.|e3} General Journal, Jurnal Umum Gl
2 Purchase Invoice, Faktur Pembelian PI
S} Delivery Order, Surat Jalan Do save
405 | Sales Invoice, Faktur Penjualan SI B
LU RV Receipt Voucher, Penerimaan Piutang Usaha RV - | QLCEI |
[3 Payment Voucher, Pembayaran Hutang Usaha PV | Set to Default |
7 Bank In, Penerimaan Bank bukan Piutang Usaha BI R
8 Bank Cut, Pengeluaran Bank bukan Hutang Usaha BO
=L GM Giro Masuk GM M

I GK Giro Keluar GK

1 ssp Surat Setor Pajak dari Bendaharawan 58P

5 PR Purchase Return PR

BN SR Sales Return SR i

Anda hanya bisa merubah Kode Referensi Jurnal apabila transaksi belum berjalan, sedangkan apabila

transaksi sudah dimulai yaitu apabila telah dilakukan Proses Awal Bulan untuk pertama kalinya maka

tombal Save akan dinonaktifkan oleh program

Ubahlah Kode Jurnalnya pada kolom Kode dengan mengetikkan 2
sampai 3 karakter, hanya harus diketahui tidak boleh ada Kode
Jurnal yang sama. Apabila ingin mengembalikan keseluruhan Kode
Jurnal sesuai default Accpro maka klik tombol Set to Default. Setelah
dilakukan perubahan jangan lupa mengklik tombol Save untuk
menyimpannya. Perubahan harus dilakukan sebelum transaksi
berjalan, sedangkan kalau anda telah melakukan Proses Awal Bulan
untuk pertama kalinya maka tidak bisa diubah lagi (tombol Save
akan dinonaktifkan oleh program).

K3

< Tab Format

¢ Pemisah digit No. Perkiraan.
Menyangkut pemisah digit Nomor Perkiraan anda diberikan pilihan
apakah lebih suka menggunakan default Accpro yaitu berupa tanda

hubung “-“ atau titik “.”

e Format Nomor Dokumen.
Pada setiap transaksi umumnya pasti ada No. Referensinya
contohnya adalah No. Invoice, No. DO, No. PO, No. SO atau nomor
bukti transaksi. Kecuali No. Invoice pada Purchase Invoice yang
berasal dari pihak Supplier, maka untuk transaksi lainnya anda bisa
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menentukan No. Referensinya sesuai dengan format yang anda
inginkan. Dan kalau anda ingin No. Referensi ini otomatis berlanjut
nomornya (digenerate secara otomatis oleh program), maka anda
bisa mengaturnya dengan mengklik tombol Format Nomor
Dokumen, tetapi kalau karena alasan tertentu tidak memungkinkan
anda untuk menggunakan Nomor Refensi otomatis, anda bisa
melewatkannya. Klik tombol Format Nomor Dokumen, maka akan
ditampilkan daftar dokumen yang bisa diatur penomoran

otomatisnya.

sistem | Format | Fitur [ Profil [ Laindain |

Pemisah digit No. Perkiraan - - Sample 01-03-01-A01
Format Nomor Dokumen

Setting Regional

Demi keseragaman dan untuk menghindari kerancuan, direkomendasikan agar Setting Regional
pada setiap komputer yang anda gunakan untuk menjalankan aplikasi Accpro mengacu pada
format angka dan tanggal yang berlaku di Indonesia sebagai berikut

Pemisah Ribuan [ Tanggal Pendek .ddﬂ“'lM.l"WW atau dd/MMjyy |
Pemisah Desimal [, Tanggal Panjang :dd MMMM yyyy [

Untuk melakukan Setting Regional, kik tombol Setting Regional,

pastikan pada bagian [Standard and formats] mengacu ke Indonesian Setting Regional

| E_'Jgave | | ggancel |

Dimungkinkan sampai dengan 9 bagian untuk penomoran dokumen
tetapi anda tidak perlu menggunakan sampai semua bagian
tersebut. Tiap-tiap bagian mempunyai pilihan yang sama. Anda bisa
mengklik tombol drop-down pada kolom bersangkutan untuk
memilih pilihan yang ada. Pilihannya adalah sebagai berikut :

= [N/A] : gunanya adalah kalau misalnya anda sudah mengatur

penomoran dokumen misalnya sebagai berikut :



Partl : [Tahun (YY)]

Part2: [.]

Part3: [Bulan(MM)]

Part4: [.]

Part5: [Auto 5 digit]

Kemudian anda ingin menghilangkan Part2 : [.], daripada

O O O 0O O O

mendefiniskan ulang tiap bagian, lebih baik anda cukup
mendefinisikan ulang Part2 sebagai [N/A].
[Tahun (YYYY)] : menampilkan bagian tertentu dalam angka
tahun 4 digit, Bagian ini nantinya akan tergantung pada tanggal
transaksinya, kalau tanggal transaksinya 28/01/2015, maka part
tersebut akan ditampilkan sebagai 2015.
[Tahun (YY)] : menampilkan bagian tertentu dalam angka tahun
2 digit, Bagian ini nantinya akan tergantung pada tanggal
transaksinya, kalau tanggal transaksinya 28/01/2015, maka part
tersebut akan ditampilkan sebagai 15.

Format Nomor Dokumen

Dokumen
Purchase Order (PC)
Sales Order (SC)
Delivery Order (DO}
Sales Invoice
Purchase Return
Sales Return
Stock Adjustment
N atas Putang
DN atas Hutang
CN atas Hutang
DN atas Putang

Part 1 3 5 arts Part 10 Hasil Penomaran
TH | [Tahun (17)] [1 [Buian (MM)] 8] [Auto 4 digit] PO-18.02.0001
S0 [Tahun (V)] [l [Auto 6 digit] 50-18.000001
DO- [Tahun (11)] o] [Auto & digit] DO-18.000001
- [Tahun ()] o] [Auto & digit] INV-18.000001
PR-  [Tahun (V)] [l [Auto 6 digit] PR-18.000001
SR~ [Tahun (V)] . [Buian (V)] [l [Auto 4 digit] SR-18.02.0001
[Tahun (1)] [l [Bulan (MM)] L1 [Auto 4 digit] 18.02.0001
MR- [Auto 6 digit] (CNR-000001
DNP-  [Auto 6 digit] DNP-000001

Purchase Order (PO)

Nomor dokumen otomatis ;
Tidak bisa edit nomor
[¥]Reset nomor setiap ganti bulan [l dolasmen pada saat Al getoar
[ ] Reset nomor setiap ganti tahun transaksi
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* [Bulan (MM)] : menampilkan bagian tertentu dalam angka
bulan 2 digit, Bagian ini nantinya akan tergantung pada tanggal
transaksinya, kalau tanggal transaksinya 28/01/2015, maka part
tersebut akan ditampilkan sebagai 01

* [Bulan (Rom)] : menampilkan bagian tertentu dalam angka
bulan Romawi, Bagian ini nantinya akan tergantung pada
tanggal transaksinya, kalau tanggal transaksinya 28/10/2015,
maka part tersebut akan ditampilkan sebagai X.

= [Tanggal (DD)] : menampilkan bagian tertentu dalam angka
tanggal 2 digit, Bagian ini nantinya akan tergantung pada
tanggal transaksinya, kalau tanggal transaksinya 28/01/2015,
maka part tersebut akan ditampilkan sebagai 28

= [Auto 4 digit] s/d [Auto 8 digit] : menampilkan bagian tertentu
sebagai bagian yang akan digenerate oleh computer dalam
format 4 digit, 5 digit, 6 digit, 7 digit atau 8 digit.

* [Text] : menampilkan teks tertentu pada bagian tertentu dari
nomor dokumen, anda akan diminta memasukkan teksnya oleh
program, misalnya INV, DO, dsbnya.

= [Spasil : kalau anda perlu memasukkan spasi sebagai bagian
dari nomor dokumen, gunakan pilihan ini.

= []: menampilkan titik sebagai bagian dari nomor dokumen.

*  [-]: menampilkan tanda penghubung sebagai bagian dari nomor
dokumen

= [/1 : menampilkan garis miring sebagai bagian dari nomor
dokumen.

Setiap kali anda selesai menentukan pilihan untuk bagian tertentu,

contoh hasil penomorannya akan ditampilkan oleh program pada

kolom Hasil Penomoran. Kalau anda memasukkan [Tahun (YY)]
atau [Tahun (YYYY)] sebagai bagian dari penomoran dokumen,
maka pada bagian bawah form ini apabila checkbox Nomor
dokumen otomatis dicentang, maka anda bisa mencentang checkbox

Reset nomor setiap ganti tahun agar penomoran dokumen untuk

bagian yang didefinisikan sebagai [Auto 4 digit] s/d [Auto 8 digit]

dimulai lagi dari nomor 1 apabila tahunnya berganti. Sedangkan



kalau anda memasukkan [Bulan (MM)] atau [Bulan (Rom)] sebagai
bagian dari penomoran dokumen, bahkan anda bisa mencentang
checkbox Reset nomor setiap ganti bulan agar penomoran dokumen
untuk bagian yang didefinisikan sebagai Auto, dimulai lagi dari
nomor 1 setiap ganti bulan. Kalau suatu saat anda ingin
menonaktifkan penomoran otomatis untuk dokumen tertentu,
pastikan kursor berada pada baris bersangkutan, kemudian uncheck
checkbox Nomor dokumen otomatis.

Agar penomoran otomatis tidak bisa diedit nomornya pada saat
transaksi, centang checkbox ‘Tidak bisa edit nomor dokumen pada
saat transaksi’. Jangan lupa untuk menyimpan pengaturan yang
telah anda lakukan dengan mengklik tombol Save. Anda tidak harus
setiap kali mengklik tombol Save setiap kali pengaturan untuk
dokumen tertentu telah selesai dilakukan, karena penyimpanan yang
anda lakukan berlaku untuk semua pengaturan yang anda lakukan,
bukan baris per baris. Kalau anda ingin membatalkan pengeditan
yang belum tersimpan, klik tombol Cancel. Sebagai saran, agar tidak
membingungkan, mungkin ada baiknya anda membedakan
penomoran dokumen tidak sama semua formatnya, mungkin perlu
ada tambah teks misalnya : INV 14.00001, SR 14.00001, dsbnya.

Setting Regional.

Pengaturan selanjutnya yang mungkin perlu dilakukan pada tab ini
adalah menyangkut pengaturan Regional Option yang akan
menentukan format digit pemisah ribuan dan desimal serta format
tanggal. Accpro merekomendasikan anda untuk menggunakan
format angka dan tanggal yang berlaku di Indonesia yaitu titik
sebagai pemisah digit ribuan, koma sebagai pemisah desimal
sedangkan untuk tanggalnya, format pendeknya adalah
dd/MM/yyyy atau dd/MM/yy (tanggal/bulan/tahun) dan untuk
format panjangnya adalah dd MMMM yyyy (tanggal Nama Bulan
tahun). Pada tab ini, program akan menampilkan peringatan dengan
teks berwarna merah apabila pengaturan regional pada komputer

yang anda gunakan untuk menjalankan Accpro tidak sesuai dengan
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format yang direkomendasikan, klik tombol Setting Regional untuk

menyesuaikannya, pastikan Standard and formats pada tab Regional

Options mengacu ke Indonesian. Walaupun demikian, boleh saja

anda menggunakan format lain yaitu koma sebagai pemisah digit

ribuan dan titik sebagai pemisah desimal, namun tidak disarankan.

Paling tidak pastikan semua komputer yang anda gunakan untuk

menjalankan Accpro menggunakan format yang sama, ini untuk

menghindari kerancuan dan kebingungan.
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Tab Fitur

Pengaturan yang dilakukan pada tab ini adalah apakah suatu fitur
diperlukan atau tidak. Apabila fitur tertentu diperlukan, pastikan

checkbox bersangkutan dalam keadaan tercentang, demikian sebaliknya.

Sistem I Farmat |Fitur| Profil I Lain-ain |

|| Bisa mengisi keterangan untuk setiap baris (ayat) jurnal transaksi

[ Ada fasilitas untuk menggunakan Nama Lain (Alias) pada Nama Perkiraan

[ Modul Penjualan tidak memerlukan (menggunakan) Salesman

Akumulasikan PPM Masukan Bukan Kredit Pajak ke akun pembeliannya

|| Discount Total pada pembelian barang non inventory tidak dipotongkan ke akun pembeliannya

| E]ga\re | | ‘Sganoel |

e Bisa mengisi keterangan untuk setiap baris (ayat) jurnal transaksi :

apabila anda menginginkan adanya keterangan tambahan untuk
setiap baris jurnal transaksi, tidak hanya keterangan tunggal
menyangkut keseluruhan transaksi, centanglah checkbox ini. Maka
kolom keterangan akan ditampilkan pada modul Jurnal Transaksi,
Penerimaan Kas / Bank, Pengeluaran Kas / Bank serta Credit Note /
Debit Note sehingga jika diperlukan anda bisa mengisi keterangan

untuk masing-masing baris jurnal transaksi pada modul dimaksud.

e Ada fasilitas untuk menggunakan Nama Lain (Alias) pada Nama

Perkiraan : fasilitas ini berguna apabila anda menginginkan Chart of

Account maupun Laporan Keuangan bisa ditampilkan dalam bahasa
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kedua misalnya bahasa Inggris maka anda bisa mencentang
checkbox ini sehingga anda bisa memasukkan Nama Lain (Alias)
untuk masing-masing Nama Perkiraan.

Modul Penjualan tidak memerlukan (menggunakan) Salesman :
pada saat anda menginput transaksi Penjualan melalui modul Sales
Order maupun Sales Invoice, maka program akan selalu
menanyakan atau meminta anda untuk memasukkan Nama
Salesman untuk transaksi tersebut, apabila di perusahaan anda
tidak menggunakan Salesman (Sales Person) atau karakteristik usaha
anda tidak memerlukan Salesman, maka sebaiknya anda mencetang
checkbox ini sehingga program tidak akan menanyakan hal ini setiap
kali anda melakukan transaksi yang dikemukakan di atas.
Akumulasikan PPN Masukan Bukan Kredit Pajak ke akun
pembeliannya : centang checkbox ini apabila anda menginginkan
PPN yang timbul pada saat pembelian yang tidak bisa dijadikan
Kredit Pajak tidak ditampung pada akun tersendiri tetapi langsung
diakumulasikan pada akun pembeliannya. Akun pembelian di sini
bisa berupa Persediaan, akun aktiva lainnya atau akun Biaya
tergantung barang atau item pembeliannya. Kalau anda mencentang
checkbox ini maka pada saat anda melakukan transaksi pembelian
yang PPNnya tidak bisa dikreditkan maka anda tidak perlu setiap
kali mencentang checkbox “Akumulasikan ke akun pembelian”
tetapi program otomatis melakukannya untuk anda.

Diskon Total pada pembelian barang non inventory tidak
dipotongkan ke akun pembeliannya : untuk pembelian barang-
barang inventory yaitu barang-barang yang perlu dikontrol stocknya
dalam hal ini adalah barang dagang atau barang persediaan, apabila
ada diskon pembelian yang berupa Diskon Total (Diskon Faktur),
Accpro akan langsung memperhitungkannya ke akun pembeliannya
dalam hal ini adalah akun persediaannya. Terkait pembelian barang
non inventory yaitu barang yang tidak bisa atau tidak diperlukan
pengontrolan terhadap stocknya, ada opsi agar Discount Total pada
transaksi pembeliannya tidak dipotongkan ke akun pembeliannya

tetapi masuk ke akun Potongan Pembelian. Untuk itu centang



0,

*

checkbox ini, itu juga berarti anda harus menyediakan akun
Potongan (Discount) Pembelian.

e  Fitur-fitur lainnya yang hanya ada varian Accpro Spectra atau Prima
adalah :
0  Multi Tax. Mengakomodasi Pajak Lain diluar PPN

Multi Departemen
0 Mengakomodasi Proyek (Project Costing)
0 Multi Gudang
0 Mengakomodasi Penerimaan Barang Konsinyasi Masuk

(Consigment In) dari Supplier
0 Mengakomodasi Penjualan Konsinyasi dan Inventory Control
Barang Konsinyasi di Customer

Tab Profil

Pengaturan pada tab ini adalah menyangkut pengaturan lain misalnya
menyangkut tampilan atau pilihan yang disukai atau default pengaturan
tertentu.

B S—————C—PPLLSS_S—_———_————— LLEE—SSBBBRBBBR———

sistem | Format [ Fitur | Profil | Laindain_|

Mama Kontak menggunakan huruf CAPTTAL
Kode Barang menggunakan huruf CAPITAL
[~ Kuantitas Barang pada transaksi bisa dalam bentuk pecahan 2 ::II digit desimal
Selalu tampilkan kuantitas barang dalam format 2 digit decmal
Selalu tampilkan kuantitas barang pada printout transaksi dalam format 2 digit decimal
[~ pefault Penjualan adalah Penjualan Langsung (Tanpa Surat Jalan / DO)
[~ pefault Penjualan adalah Penjualan Laindain (Jzsa dsbnya)

Aging Hutang / Piutang

Hari
Periode Aging Hutang 30 &0 90 120 150
Periode Aging Piutang 30 &0 90 120 150
Persentase DPP Penjualan default 100,00 | o
Persentase Pajak Pertambahan Nilai (PPN} 10,00 | % Dibulatkan ke bawah
Potongan PPh Pasal 22 oleh Bendaharawan 1,50 | % untuk penjualan = 1]
| m Save | | n Cancel |
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Nama Kontak menggunakan huruf CAPITAL : ini hanya untuk
mempermudah pada saat input data kontak (supplier, customer atau
kontak lain), dimana diinginkan Nama Pengenal kontak selalu
diinput dengan menggunakan huruf CAPITAL (huruf besar).
Dengan mencentang checkbox ini, maka tanpa mengaktifkan caps
lock pun apa yang diketikkan pada field Nama Pengenal pada form
Customer, Supplier, Other Contact akan langsung dalam huruf
CAPITAL, tetapi ini hanya berlaku untuk field Nama Pengenal, tidak
untuk Nama Resmi dan field yang lain.
Kode Barang menggunakan huruf CAPITAL : ini juga hanya
dimaksudkan untuk mempermudah pada saat input Kode Barang
pada Master Barang & Jasa, apabila diinginkan Kode Barang selalu
dalam huruf CAPITAL, centanglah checkbox ini, maka apa yang
diketikkan pada field Kode Barang akan langsung dalam huruf
CAPITAL sekalipun caps lock tidak diaktifkan.
Kuantitas Barang pada transaksi bisa dalam bentuk desimal
(pecahan) : apabila anda menginginkan transaksi yang menyangkut
kuantitas barang bisa dalam bentuk pecahan, maka centang
checkbox ini. Kalau tidak dicentang, maka kuantitas barang hanya
bisa dalam bentuk angka bulat. Ini untuk menghindari kesalahan
penginputan untuk perusahaan yang tidak membutuhkan transaksi
menyangkut kuantitas barang dalam bentuk pecahan. Apabila anda
mencentang checkbox ini, maka anda bisa mengatur apakah
maksimal 1 digit, 2 digit atau 3 digit di belakang desimal dengan
mengklik spinner yang ada. Defaultnya adalah 2 digit desimal.

#t  Selalu tampilkan kuantitas barang dalam format x digit
desimal. Centang checkbox ini kalau anda menginginkan
tampilan kuantitas barang pada form dan laporan-laporan
selalu ditampilkan x digit desimal biarpun angkanya bulat.
Kalau tidak dicentang, maka angka akan ditampilkan apa
adanya, artinya kalau bulat ditampilkan tanpa desimal, kalau 1
digit desimal akan ditampilkan demikian, demikian pula 2 digit
atau 3 digit desimal.



% Selalu tampilkan kuantitas barang pada printout transaksi
dalam format x digit desimal. Apabila anda menginginkan
bukan hanya pada form dan laporan-laporan tetapi juga pada
printout transaksi (DO, Invoice, Bukti Pembelian, dsbnya),
tampilan kuantitas barang selalu dalam format x desimal,
dimana x adalah jumlah digit yang anda tentukan di atas, maka
centang checkbox ini.

Default Penjualan adalah Penjualan Langsung (Tanpa Surat Jalan /
DO) : apabila perusahaan anda hanya mengenal penjualan langsung
tanpa melalui penerbitan Surat Jalan, maka aktifkan pilihan ini
dengan mencentangnya. Maka setiap kali anda melakukan input
penjualan melalui modul Sales Invoice, anda tidak perlu mencentang
pilihan penjualan langsung karena otomatis program akan
menentukannya sebagai penjualan langsung.

Default Penjualan adalah Penjualan Lain-lain (Jasa,dsbnya) :

fasilitas ini hanya ada pada varian Accpro Strada, Accpro Spectra

dan Accpro Prima. Maksudnya adalah apabila anda menggunakan
varian-varian dimaksud tetapi anda hanya membutuhkan penjualan
langsung (tanpa Surat Jalan) atas item-item non inventory, termasuk
jasa (yang anda tidak ingin buatkan Kode Barangnya pada Master

Barang & Jasa), maka anda bisa mencentang checkbox ini sehingga

anda tidak perlu setiap kali mencentang checkbox Penjualan Lain-

lain pada saat input transaksi penjualannya melalui modul Sales

Invoice. Untuk varian Accpro Trada, opsi Penjualan Lain-lain tidak

disediakan, maka fitur ini tidak tersedia.

Aging Hutang / Piutang : Accpro telah menentukan default periode

aging hutang / piutang yaitu 30, 60, 90, 120 dan 150 hari, artinya

pada laporan umur hutang / piutang selain ditampilkan saldo
hutang / piutang yang sedang berjalan (belum jatuh tempo), juga
akan ditampilkan hutang / piutang yang telah lewat jatuh tempo

dalam rentang 1-30 hari, 31-60 hari, 61-90 hari, 91-120 hari, 121-150

hari dan > 150 hari, apabila anda menginginkan lain maka anda bisa

menyesuaikannya dengan catatan harus berkesinambungan dan

tidak ada yang dikosongkan.
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Persentase DPP Penjualan default : apabila dominan atau semua
penjualan yang dilakukan perusahaan menggunakan Dasar
Pengenaan Pajak Nilai Lain yang bukan 100% maka sebaiknya anda
menyesuaikan persentasenya di sini, sehingga nantinya anda tidak
perlu harus selalu menyesuaikan persentase DPPnya tiap kali
membuat transaksi penjualan melalui modul Sales Order dan Sales
Invoice.
Persentase Pajak Pertambahan Nilai (PPN) : disini ditentukan
persentase Pajak Pertambahan Nilai. Sesuaikan dengan peraturan
yang sedang berlaku. Checkbox disampingnya hanya perlu
dicentang kalau anda menginginkan perhitungan nilai PPN selalu
dibulatkan ke bawah, sedangkan kalau tidak dicentang maka
pembulatannya adalah  proporsional. = Sehubungan dengan
penerapan eFaktur, disarankan anda mencentang checkbox
“Dibulatkan ke bawah” sesuai perhitungan pada eFaktur.
Potongan PPh Pasal 22 oleh Bendaharawan : hanya untuk
perusahaan yang mempunyai customer yang adalah Bendarawan.
Ubahlah kalau nilainya sudah tidak sesuai seiring dengan
perkembangan waktu.
Pengaturan lain pada tab Profil ini yang hanya pada varian Accpro
Spectra atau Prima adalah :
0 Dimungkinkan Pembelian dengan No. PO tanpa input data PO
lebih dulu.
o Tidak bisa input SO (Sales Order) baru apabila Customer

melampaui Credit Limit

«+» Tab Lokasi File Gambar

Tab ini hanya ada pada varian Accpro Spectra dan Prima. Yaitu gunanya

untuk mengatur atau menetapkan lokasi file gambar untuk data Barang.

Jadi untuk setiap barang bisa dimasukkan gambarnya yang akan

ditampilkan pada transaksi atau inquiry yang menyangkut barang

bersangkutan. Tab ini digunakan untuk menentukan folder dimana

gambar-gambar barang diletakkan.
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Tab Lain-lain

Untuk printout transaksi DO (Surat Jalan) dan Invoice sebenarnya telah
ada fasilitas untuk memasukkan catatan default untuk kedua printout ini
melalui menu Setup Printout Transaksi (File > Setup Printout Transaksi).
Setelah memilih varian yang diinginkan baik untuk DO maupun Sales
Invoice, maka gunakan tombol Modifikasi yang ada pada form Setup
Printout Transaksi. Pada form yang ditampilkan setelah anda mengklik
tombol Modifikasi, pada tab Footer field Catatan, anda bisa memasukkan

catatan defaultnya.

Sistem I Format I Fitur I Profil |Lain-lain|

Catatan pada DO (max. 2 baris, 95 karakter per baris )

] b

Catatan pada Invoice (max. 2 baris, 93 karakter per baris) [] Apply otomatis tiap kali buat Invoice

Pembayaran dengan Cheque/Giro, kami anggap lunas setelah Cheque/Giro tersebut dapat kami ua

4 1 | +

Logo Peruzahaan : tempatk.an file gambar logo dengan format jpg. bp atau gif
pada folder : D:\Data Accpra

\ | Tanpa Logo

—— Ji Tampilkan Logo pada printout tranzaksi dan laporan-laporan

| E]ga\re | | ‘Sganoel |

Tetapi catatan yang anda tentukan melalui cara di atas sifatnya adalah
bersifat fix artinya akan selalu ditampilkan pada printout transaksinya,
kalau anda menginginkan catatan yang tidak selalu sama untuk setiap
transaksi DO atau Invoice, maka cara di atas tidak dapat dipakai.

Apabila catatannya tidak selalu sama tetapi setidaknya ada satu catatan

yang menjadi default, maka pada tab ini anda bisa menentukan catatan
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default untuk DO (Surat Jalan) dan Invoice (Sales Invoice). Catatan
default ini nantinya bisa digunakan pada saat membuat DO atau Invoice
dengan mengklik tombol Use Default disamping field Catatan pada
modul dimaksud, sehingga tidak perlu mengetiknya lagi kalau
catatannya pada umumnya seringkali sama antara satu dengan transaksi
lain. Catatan ini juga akan tercetak pada printout transaksinya yang
berupa dokumen DO (Surat Jalan) dan Invoice. Oleh karena itu dibatasi
jumlah baris dan karakternya mempertimbangkan layout dokumen
dimaksud.

Checkbox Apply otomatis tiap kali buat Invoice apabila dicentang
gunanya agar setiap kali buat Invoice baru, maka field Catatan pada form
Sales Invoice tersebut akan langsung terisi dengan catatan default yang

anda tentukan ini tanpa perlu lagi mengklik tombol Use Default.

Apabila anda ingin menggunakan logo untuk laporan-laporan maupun
printout transaksi yang pada Setup Printout Transaksi tidak disediakan
fasilitas untuk memasukkan logonya (di Setup Printout Transaksi hanya
ada fasilitas untuk memasukkan logo untuk printout PO, SO, DO dan
Invoice), disinilah logonya ditentukan.

Klik tombol Ambil Logo dan pilih file gambar logo dengan format bmp,
jpg atau gif. Atur lebar logo dengan menggeser slider yang ada di bawah
logo. Jangan lupa centang checkbox di sampingnya agar logo
ditampilkan pada laporan-laporan dan printout transaksi. Suatu saat
anda tidak ingin menampilkan logo pada laporan-laporan dan printout
transaksi (tidak termasuk PO, SO, DO dan Sales Invoice yang pengaturan
logonya dilakukan melalui menu Setup Printout Transaksi), maka

uncheck checkbox ini.

e Tombol Save : menyimpan keseluruhan pengaturan atau perubahan
yang telah anda lakukan.

e Tombol Cancel : menutup form tanpa menyimpan pengaturan atau
perubahan yang telah dilakukan.

e Tombol :menutup form ini.
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4.2.3 Setup Printout Transaksi

Yang terutama perlu diatur melalui modul ini adalah menyangkut ukuran
kertas yang akan dipakai pada saat pencetakan printout transaksi. Khususnya
untuk Surat Jalan dan Sales Invoice anda dapat memilih varian layout
printout yang paling sesuai dengan keinginan anda dari varian yang telah
disediakan oleh Accpro. Sedangkan untuk layout printout transaksi yang lain

adalah sesuai default yang diberikan Accpro.

Modul Jurnal Transaksi _

Jurnal Transaksi Template | 2] sample Preview |
Penerimaan Kas / Bank v

Pengeluaran Kas / Bank v

Sales Order

Delivery Order (Surat Jalan _
i ( ) Ukuran kertas @ ,5in x 5,5 in (Continuous Form 9,5 % 11/2 = 1/2 Kwarto)

718,5in x 6,5 in (Continuous Form 9,5 x 13/2 = 1,2 Folia)
() Letter atau Continuous Form 9,5 x 11

Sales Invoice (Faktur Penjualan) v

Sales Return

Purchase Order () A4 (210 mm x 297 mm)
Purchase Invoice (©) 1/2 kertas A%

Purchase Return Rekomendasi Printer : Dot Matrix

Stock Adjusment Preview lebih dulu sebelum dicetak ke printer
Credit Note / Debit Note v Menggunakan preprinted form

[ Mo text decoration. Jangan menggunakan cetak tebal

Laporan

Laporan-laporan

‘ E]Save | | :Sganoel‘

e Modul : pilih modul transaksi yang ingin dilakukan pengaturannya
dengan mengklik pada pilihan modul dimaksud. Apabila ada sub
menunya (baris dengan tanda ¥) maka akan ditampilkan popup pilihan
sub menunya, pilih sub menu yang dikehendaki. Panel di sebelah kanan
akan merefleksikan pilihan yang telah anda lakukan. Dengan
memperhatikan caption (judul) panel, bisa diketahui menu (modul)
manakah yang sedang aktif.

e Template : apabila tidak ada pilihan varian layout printout transaksi

untuk modul bersangkutan maka pilihannya hanya satu yaitu Default,
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tetapi kalau ada variannya khususnya untuk Surat Jalan dan Sales
Invoice, maka anda bisa memilih varian yang paling sesuai dengan
keinginan anda. Untuk mengetahui seperti apakah tampilan varian yang
anda pilih klik tombol Sample Preview.

e Sample Preview : untuk melihat seperti apakah printout transaksi
setelah diatur (terutama menyangkut ukuran kertas) maka klik tombol
ini. Apabila memang ada samplenya untuk modul dan template
dimaksud maka akan ditampilkan previewnya, kalau tidak ada maka
tombol ini tidak berfungsi.

e Modifikasi : tombol ini hanya muncul untuk modul yang ada pilihan
variannya (pada field template). Gunanya untuk memodifikasi lebih
lanjut tampilan atau layout varian dimaksud.

e  Deskripsi : apabila ada deskripsi menyangkut template atau varian
tertentu maka akan ditampilkan disini.

e  Ukuran kertas : pilih ukuran kertasnya. Ada 5 pilihan, tapi tidak selalu
bisa dipilih. Untuk Faktur Pajak misalnya, maka hanya ada pilihan ketiga
: Letter atau Continuous Form 9,5 x 11 atau pilihan keempat : A4 (210
mm X 297 mm). Namun dengan diterapkannya eFaktur maka Faktur
Pajak tentunya tidak perlu lagi dicetak.

Selain Faktur Pajak, maka pilihan kedua yaitu 8,5 in x 6,5 in (Continuous
Form 9,5 x 13/2) sebenarnya adalah yang paling ideal tetapi tidak selalu
mudah mendapatkannya, maka pilihan pertama atau ketiga yang paling
sering digunakan jika memakai continuous form.

Khusus untuk laporan-laporan gunakanlah ukuran A4.

¢ Rekomendasi Printer: tergantung modulnya, maka program akan
merekomendasikan jenis printer yang sebaiknya digunakan. Kecuali
untuk Laporan-laporan maka jenis printer yang direkomendasikan
adalah dot-matrix khususnya lagi kalau kertas yang digunakan lebih dari
satu rangkap maka inilah satu-satunya jenis printer yang bisa digunakan.
Sedangkan untuk Laporan-laporan maka direkomendasikan jenis
printernya adalah deskjet (inkjet) atau laserjet dengan ukuran kertas A4.

e Preview lebih dulu sebelum dicetak ke printer : apabila pada modul

terkait anda menginginkan agar sebelum dicetak ke printer (pada saat
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anda mengklik tombol Print), printout transaksi ditampilkan dulu ke
layar maka biarkan checkbox ini dalam keadaan tercentang.
Menggunakan preprinted form : checkbox ini hanya aktif (bisa diakses)
pada modul tertentu khususnya Surat Jalan (DO), Sales Invoice dan
Faktur Pajak. Klik checkbox ini hingga tercentang apabila anda ingin
menggunakan form yang sudah tercetak (dalam hal ini sebaiknya apabila
rangkap maka harus berupa continuous form, karena menurut
pengalaman sulit sekali bahkan tidak mungkin bagi printer dot matrix
untuk meload kertas rangkap, pun manual printernya juga tidak
merekomendasikannya). Apabila ini yang diinginkan maka anda harus
menyesuaikan cetakannya dengan printout yang berasal dari program
ini.

No text decoration. Jangan menggunakan cetak tebal : artinya kalau
checkbox ini dicentang maka hasil cetakannya tidak menggunakan cetak
tebal, khususnya ini umumnya cocok untuk bukti transaksi yang bersifat
internal perusahaan.

Tombol Save : menyimpan pengaturan yang telah dilakukan. Anda tidak
harus melakukan ini setiap kali melakukan pengaturan suatu modul
tetapi ini berlaku untuk semua pengaturan yang telah anda lakukan.
Misalnya anda ingin melakukan pengaturan ukuran kertas untuk modul
Jurnal Transaksi dan modul Purchase Invoice, maka lakukanlah
keduanya dan setelah selesai baru anda mengklik tombol Save.

Tombol Cancel : menutup form ini dengan mengabaikan semua

pengaturan yang telah anda lakukan.
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Contoh pengaturan printout transaksi Sales Invoice :

Klik pada modul Sales Invoice (Faktur Penjualan), kemudian pilih Sales
Invoice pada popup menu yang ditampilkan, pada field Template pilih
variannya. Apabila ingin melakukan modifikasi maka klik tombol Modifikasi.
Modifikasi bertujuan memilih kolom atau field apa saja yang ingin
ditampilkan, merubah judul (penamaan) label baik pada header, detail

maupun footer transaksi.

Pada tab Lain-lain, anda bisa memasukkan gambar logo yang akan
ditampilkan pada printout transaksi. Klik tombol Ambil Logo, kemudian atur

slider di bawah logo bersangkutan untuk mengatur lebar logo.

m Setup Printout Transal g
o —
Jurnal Transaksi Template Varian 7 ~|| =) sample Preyiew | | Mocifikasi [‘w
Penerimaan Kas / Bank v Deskripsi
pengeluaran Kas / Bank v Wariah ini cocok untuk, anda yang Ltubkan footer yang lengkap .
mencakup Sub Taotal, Discount, ang Muka, DFF, PPM, Biaya-biaya, Total
Sales Order Faktur. Klik. tambol bModifikasi apabila ada item atau kolom tertentu yang ingin- +

Sales Invoice (Faktur Penjualan) u

Purchase Order @

Purchase Invoice

v _
,5in x 5,5in (Continuous Form 9,5 x 11/2 = 1/2 Kwarto)
Sales Invoice ,5in % 6,5in (Continuous Form 9,5 x 13/2 = 12 Falio)

Faktur Pajak Rp etter atau Continuous Form 9,5 x 11
Credit Note / Debit Note Faktur Pajak Valas 4 (210 mm x 257 mm)
T T Y2kertas A4
Rekomendasi Printer: Dot Matrix \

]

Preview lebih dulu sebelum dicetak ke printer @ Pilih ukuran

[ Menggunakan preprinted form
[ Mo text decoration. Jangan menggunakan cetak tebal

kertasnya

Laporan

Laporan-aporan

| E]Save_‘ | ngano;|
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5 Mottt o A T

Ketersediaan (Visibility)

Ubah
penamaannya
Jika diperlukan

Customer Vustomer

ship To Kirim ke

Telp (=] = ip :

Mo. Invoice Invoice Ng- Uncheck item
Tanggal Invoice Tanggal yang tidak ingin

ditampilkan

Mo. PO No. PO
Terms Terms

Jatuh Tempo Jatuh Tempo
Currency Valuta

Inta Penusahaan
[]3angan cetak Info Perusahaaan (Preprinted Header)

Baris1: | PT. SIGMA GPS

Baris2: | Ruko Melrose Residence Blok AB No. 28
Barig 3: | 1. Kembang Mekar MNo. 1

Bariz 4 :Jakarm Barat

Editinfo
perusahaan
jika diperlukan

[FPada Sample Preview akan ditampilkan info peusahaan sample. apabila
ingin melihat tampilan info perusahaan sesungguhnya adalah pada hiansaksi)

Headall Kaolom | Fanter I Laitv-lair |

Klik tab Kolom, kemudian uncheck kolom yang tidak ingin ditampilkan,
tetapi memang ada kolom-kolom yang tidak bisa diuncheck, hanya bisa
diubah penamaannya.

5 Mottt SRR, =

Ketersediaan (Visibility)

Kode Barang Kode Barang

MNama Barang Nama Barang

Quantity Quantity

Satuan Unit

Harga Satuan Harga Satuan ‘
Item Disc Disc % ‘
Harga Total Jumizh

Uncheck kolom
yang fidak ingin

ditampilkan Ubah

penamaannya
jika diperukan

Header |Ko|om| Faoter | Lair-lain |
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Klik tab Footer, uncheck item-item yang tidak ingin ditampilkan pada footer

printout transaksi.

o st SR T
_ :

- .
n (Visibility) Ubah
penamaannya

——— | lika diperlukan

Terbilang Terbilang : 4

Tanda Terima Diterima oleh,

Hormat kami Hormat kami,

Catatan Note :

Sub Total Sub Total

Disc Discount

Uang Muka (PPN diterima) | [~ ng Muka

ol ‘rﬁ;\ Uncheckyang
0 71 fidakingin

PPN PPN ditampilkan

Biaya-biaya ya Lain

Total Total

Catatan

Hanya kalau dinginkan catatan pang fix untul Tentukan ield di

bawah ini harus diisi, tetapi kalau bisa berbedq  catatan default  Btan

yang ditentukan pada saat membuat Invoice § jika diperlukan  fan

B
Header | Kalom | Footer | Lairelair ‘

Klik tab Lain-lain dan masukkan logo perusahaan jika diinginkan.

5 ottt oy R T

diaan (Visibility)

[ Tidak perlu tampilkan / cetak garis vertikal pada kolom

Apabila detall transaksi tidak melebihi 20 ::|l baris, maka batasi
[ pencetakan baris kosang sebatas jumlah baris dimaksud. (Khusus ukuran
kertas Letter atau A4)

Tampilkan nomor halaman

Tulisan yang ditampilkan jika harga sudah termasuk PP
Harga sudah termasuk PPN

‘Centang yang
diinginkan
Edit jika

diperlukan

Logo Perusahaan : tempatkan file gambar logo dengan format jpg, bmp atau
gif pada folder : D:\Data Accpro

Ambil Logo -

—J—

Klik di sinijika ingin
memasukkan logo

Header | Kalom I Footer |Lain—|ain

4-28



£ Modifikasi 1amutwmﬁn7 [
i

Ketersediaan (Visibility)

[ Tidak perlu tampilkan { cetak garis vertikal pada kolom

Apabila detal transaksi tidak melebihi 20 ﬁ baris, maka batasi
[~ pencetakan baris kasong sebatas jumlah baris dimaksud. (Khusus ukuran
kertas Letter atau A4)

|| | [Z] Tampilkan nomer halaman

Tulisan yang ditampilkan jika harga sudah termasuk PPN
Harga sudah termasuk PPN

Brag slider

untuk mengatur,
lebar logo

Logo Perusahaan : tempatkan file gambaf logo dengan format jpg, bmp atau
aif pada folder : D:\Data Accpro

§ Tanpa Logo
— A

Header I Kaolom | Finter |Lain—lain|

| E]iaue ‘ ‘ !j Cancel ‘

Klik di sini jika
ingin menghapus
logo

4.2.4 Setup User

Diluar user yang telah anda buat pada saat membuat data baru, mungkin
anda ingin membuat data user yang lain, untuk itu pilih menu File > Setup
User.

User yang anda buat adalah terkait database yang sedang dibuka saat itu.

e User Id : Isi User Id, walaupun bisa sampai dengan 15 karakter tetapi
sebaiknya singkat saja supaya tidak merepotkan nantinya pada saat
melakukan Login. Anda bebas menggunakan huruf besar, huruf kecil
atau kombinasinya. Yang penting harus unik artinya tidak boleh ada 2
user id yang sama, dalam hal ini tidak case-sensitive contohnya : admin
akan dianggap sama dengan Admin atau ADMIN.

e Nama : isi dengan Nama User secara lebih lengkap, bisa huruf kecil,
huruf besar atau kombinasinya.

e Password : isi passwordnya minimal 6 karakter, maksimal 8 karakter.
Password adalah case-sensitive artinya apabila menggunakan huruf
kecil, huruf besar atau kombinasinya maka demikian juga user harus

mengetikkannya pada saat melakukan Login.
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Untuk kepentingan 'security’ pada modus edit anda tidak bisa merubah Level User, apabil

level user maka user yang bersangkutan harus dihapus lebih dulu dan kemudian diinput kembali, demikian
juga apabila user lupa terhadap passwordnya.

Userd  Eddy | it sl Non Akt [7]
Mama W Password SRR Retype F—— |
Level User -
File | Master Data | Transaksi I Daftar I Laporan I Utilitas ‘
O B B O B
HNo pel Add di -
| Chart of Account O O O B
"1 Account Default O O O E
<1l saldo Awal G/L O | O a
_1 Customer M
3 supplier O O O O O
] Other Contact
'+ Salesman
:1| Saldo Awal Hutang/Piutang/Sub Ledger -
[7] Tampilkan Reminder pada saat Login [T Tampilkan Financial Highlight pada saat Login

0 User ini diberikan akses untuk menggunakan akun Default Hutang, Piutang sebagai baris jurnal manual pada modul
Jurnal Transaksi

+ Mew x Delete | @ Save D;

¢ Retype : untuk memastikan anda tidak salah ketik, maka program akan
meminta anda untuk mengetikkan sekali lagi apa yang anda ketik pada
field Password. Ini dimaksudkan supaya jangan sampai User Id yang
sudah anda input tidak dapat digunakan karena password salah ketik
pada saat pembuatannya dan anda tidak menyadarinya.

o Level : ada 3 pilihan level untuk user yang anda buat, yaitu
Administrator, Supervisor dan User.
Administrator akan bisa mengakses apa saja, dalam hal ini tentunya
membuat user baru dan bahkan menghapus user tertentu. Jadi
pertimbangkanlah dengan seksama user yang diberikan level ini karena
user tipe ini tidak bisa dibatasi hak akses dan wewenangnya. Namun
demikian disarankan setidaknya anda mempunyai 2 user id dengan tipe
ini sebagai backup agar apabila lupa passwordnya masih ada cadangan
user lain dengan level Administrator. Jangan sampai tidak ada user yang

bisa membuka akses untuk user lain atau membuat user id baru.
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Level berikutnya adalah Supervisor, dimana user dengan level ini dapat
dibatasi hak, wewenang maupun modul/menu yang bisa diakses.

Level terendah adalah User, sama seperti Supervisor maka untuk level
ini bisa dibatasi hak,wewenang maupun modul/menu yang bisa diakses.
Bedanya dengan level Supervisor adalah bahwa ada menu-menu tertentu
yang hanya bisa diberikan akses kepada level Supervisor sementara
untuk level User tidak bisa diberikan akses sama sekali contohnya menu
Tutup Buku dan Hitung Ulang Saldo G/L (pada form Setup User ini
ditandai dengan teks berwarna merah).

Untuk level Administrator, anda tidak perlu bahkan tidak bisa
membatasi atau mengatur hak akses dan wewenang melalui tab-tab di
bawah inj, jadi anda bisa melewati bagian ini.

Tab File dan Utilitas : hak akses yang perlu diatur pada kedua tab ini
hanyalah hak untuk mengakses (Open) menu bersangkutan, jadi hanya
kolom Open yang perlu anda atur, dicentang apabila ingin diberikan
akses untuk menu tertentu dan sebaliknya. Apabila anda ingin
memberikan akses untuk kesemua menu yang ada pada salah satu tab
tersebut anda cukup mencentang checkbox yang ada di atas kolom Open,
demikian pula sebaliknya.

Tab Master Data dan Transaksi : pada kedua tab ini hak akses dan
wewenang yang perlu diatur menyangkut 5 hal yaitu Open, Add, Edit,
Delete dan Print. Open hanya berarti bisa membuka modul yang terkait
menu tertentu. Untuk bisa menambah data harus diberikan wewenang
untuk Add. Sedangkan agar bisa mengedit data maka harus ada
wewenang untuk Edit. Begitu juga halnya dengan Delete dan Print.
Khusus Print tentunya hanya akan berpengaruh apabila modul tersebut
memang mempunyai fasilitas untuk dicetak (diprint). Centanglah kolom
yang akses atau wewenangnya ingin anda berikan terkait baris menu
tertentu. Apabila kesemua menu yang ada ingin diberikan akses tertentu,
cukup centang checkbox di atas kolom yang sesuai, demikian pula
sebaliknya.

Tab Daftar dan Laporan : ada 2 hak akses dan wewenang yang perlu
diatur pada kedua tab ini, yaitu Open dan Print. Untuk memberikan

akses atau wewenang, centang kolom dimaksud sesuai baris menu yang
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ingin diberikan akses. Apabila kesemua menu yang ada ingin diberikan
akses tertentu, cukup centang checkbox di atas kolom yang sesuai,
demikian pula sebaliknya.

e Tampilkan Reminder pada saat Login : klik checkbox ini hingga
tercentang apabila untuk user bersangkutan, pada saat login ingin
ditampilkan form Reminder.

e Tampilkan Financial Highlight pada saat Login : klik checkbox ini
hingga tercentang apabila untuk user bersangkutan, setiap kali login
ingin ditampilkan form Financial Highlight. Dalam hal ini anda harus
mempertimbangkan urgensinya terutama untuk user dengan level di
bawah Supervisor.

e Jangan tampilkan (sembunyikan) Harga Pokok Penjualan pada
Laporan / Inquiry tertentu : ini maksudnya adalah apabila anda ingin
menyembunyikan harga pokok penjualan pada modul-modul tertentu
terutama laporan dan daftar (inquiry) yang menampilkan hal itu, khusus
untuk user tertentu.

e User ini diberikan akses untuk menggunakan akun Default Hutang,
Piutang, Persediaan sebagai baris jurnal manual pada modul Jurnal
Transaksi : ini adalah fasilitas khusus untuk user dengan level
Administrator. Berulang kali ditegaskan pada buku manual ini bahwa
akun Default Hutang, Piutang dan Persediaan tidak bisa digunakan
sebagai baris jurnal manual dengan pertimbangan yang telah
dikemukakan yaitu agar jangan sampai terjadi ketidaksesuaian antara
Buku Besar dengan buku pembantunya. Namun ada kalanya justru saldo
akun Piutang, Hutang dan Persediaan pada Buku Besar perlu
disesuaikan dengan saldo menurut perincian pada buku pembantunya
terutama pada saat awal pemakaian Accpro dimana saldo akun Hutang,
Piutang atau Persediaan yang anda dapat dari Laporan Neraca sebelum
pemakaian Accpro ternyata tidak bisa tepat sesuai saldonya menurut
perincian Invoicenya pada Saldo Awal Hutang/Piutang atau nilai
persediaan menurut Saldo Awal Inventorynya, maka berikanlah akses
kepada user tertentu dengan level Administrator dengan mencentang
checkbox ini agar user tersebut bisa menggunakan akun-akun dimaksud

sebagai baris jurnal manual pada modul Jurnal Transaksi guna
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penyesuaian dimaksud. Tetapi karena fasilitas ini bisa menjadi sangat
krusial apabila tidak digunakan dengan hati-hati, maka sebaiknya akses
ini dibatasi kepada user tertentu saja. Gunakanlah dengan hati-hati dan
hanya apabila diperlukan. Jangan sampai jurnal koreksi yang anda
lakukan dengan menggunakan akun default Piutang, Hutang atau
Persediaan atas saldo akunnya pada Buku Besar malah menyebabkan
tidak sinkronnya antara saldo akunnya dengan perinciannya menurut
buku pembantunya.

e Tombol New : menambah user baru.

¢ Tombol Delete : menghapus user tertentu.

e Tombol Save : menyimpan penambahan atau perubahan data yang anda
lakukan.

e Tombol Cancel : membatalkan penambahan atau perubahan data yang
anda lakukan.

e Tombol navigasi : untuk berpindah dari record satu ke record berikut

atau sebelumnya,

e Tombol Close : menutup form ini.

4.3 Menu Master Data

Master Data adalah berbagai macam data dasar yang digunakan sebagai
master pada saat melakukan input transaksi, diantaranya meliputi Valuta,
Chart of Account (daftar Nomor Perkiraan), Customer, Supplier, dan lain-

lain.
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4.3.1 Tabel Valuta

Accpro telah menyediakan satu valuta sebagai valuta default yaitu Rp.
(Rupiah). Hanya apabila ada transaksi yang menggunakan valuta asing anda
perlu mengupdate tabel ini, kalau tidak anda bisa melewatkan tabel ini.

(Untuk varian Accpro Trada dan Accpro Strada karena fitur Multi Currency tidak

tersedia, maka menu dan modul untuk input tabel Valuta tidak disediakan)

4.3.2 Chart of Account

Sebelum kita bisa melakukan input transaksi baik terkait penjurnalan secara
manual melalui modul Jurnal Transaksi maupun untuk transaksi yang
penjurnalannya dilakukan secara otomatis oleh program seperti halnya
pembelian, penjualan dan sebagainya maka kita perlu menentukan dulu
daftar Nomor Perkiraan atau disebut juga Chart of Account. Nomor Perkiraan
atau akun atau account adalah kode yang umumnya adalah berupa deretan
angka atau bisa juga dengan kombinasi huruf untuk mewakili pos tertentu

dalam Buku Besar (General Ledger).

Accpro telah menetapkan standar Nomor Perkiraan yang digunakannya yaitu
menggunakan sistem hirarki dan terdiri dari 9 digit dengan format 99-99-99-
A99. Angka 9 pada notasi tersebut berarti anda bisa memasukkan angka 0 s/d
9, sedangkan huruf A menandakan bahwa anda bisa memasukkan baik angka
0 s/d 9 maupun abjad A s/d Z. Yang terakhir ini sebenarnya dimaksudkan
untuk mengakomodasi user yang tetap menginginkan Hutang Usaha atau
Piutang Usaha dibreak-down untuk masing-masing Supplier / Customer.
Walaupun sebenarnya dengan adanya buku pembantu Hutang / Piutang, hal

tersebut sesungguhnya tidak perlu lagi. Tanda "-" pada Nomor Perkiraan
akan otomatis diberikan oleh program, anda tidak perlu mengetiknya.
Tergantung pengaturan yang telah dilakukan pada menu File > Setup
Preferensi pada tab Format maka pemisah digit Nomor Perkiraan bisa juga

"

berupa titik (“.”) sehingga tampilan formatnya menjadi 99.99.99.A99.

Dua digit pertama dari Nomor Perkiraan digunakan untuk mengelompokkan

perkiraan menurut Kategori Asset, Liability, Capital, Revenue dan Expense.
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Anda bisa mempunyai lebih dari satu kelompok perkiraan yang mempunyai
kategori yang sama. Ada dua tipe perkiraan yaitu General dan Detail.
Perkiraan bertipe General berarti perkiraan tersebut merupakan induk dari
perkiraan dengan hirarki di bawahnya yang bisa saja bertipe General atau
Detail. Hanya perkiraan yang bertipe Detail yang bisa ditransaksikan artinya

bisa digunakan pada jurnal transaksi.

Perkiraan dengan hirarki tertinggi (hirarki ke-1) yaitu 01-00-00-000 s/d 20-00-
00-000, otomatis akan bertipe General. Jadi khusus untuk 2 digit awal nomor
perkiraan dibatasi antara 01 sampai dengan 20 dan ini dirasa sudah sangat
mencukupi. Oleh karena itu jangan membuat nomor perkiraan dengan
struktur seperti ini : 10-00-00-00, 20-00-00-000, 30-00-00-000, dstnya tetapi
hendaknya sebagai berikut : 01-00-00-000, 02-00-00-000, 03-00-00-000 dstnya,
bisa sampai 20-00-00-000. Setelah anda memasukkan perkiraan dengan
hirarki ke-1 dan menentukan Kategorinya, maka otomatis perkiraan dengan
hirarki di bawahnya akan mempunyai kategori yang sama, anda tidak perlu

lagi menentukan Kategori untuk perkiraan di bawahnya.

Anda tidak bisa memasukkan perkiraan yang mempunyai hirarki ke-2, bila
anda belum memasukkan perkiraan dengan hirarki ke-1, demikian juga anda
tidak bisa memasukkan perkiraan dengan hirarki ke-3 apabila anda belum
memasukkan perkiraan dengan hirarki ke-2. Oleh karena itu apabila anda
ingin memasukkan perkiraan dengan hirarki ke-4 maka anda harus

memasukkan induk dari perkiraan tersebut yang mempunyai hirarki ke-3.

Kecuali hirarki ke-1 (otomatis General), pada hirarki ke berapapun perkiraan
bisa bertipe Detail. Penentuan Detail atau General tergantung apakah
perkiraan tersebut mempunyai account anak yang berarti ada perkiraan
dengan hirarki lebih rendah. Apabila perkiraan tersebut mempunyai account
anak maka perkiraan tersebut harus bertipe General. Ini berarti bisa saja anda
membuat Chart of Account yang hanya terdiri dari akun hirarki ke-1 dan 2.

Yang jelas hirarki ke-1 pasti (otomatis) bertipe General.
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Chart of Account

Mo. Perkiraan

Hama Peikilaan alego
071-00-00-000 ARTIVA LANCAR Aszet Genesal

L
o u]
o | 010100000 KAS Bazat Genesal =]
o 01-01-1-000 Faz Kecil Augset Detail =] Kas
a 01-01-02-000 Kas Becar st Detail H Kas
o | 00200000 BANE, Asset Genersl =] | Hew
o 01-02-0n-000 Bark ABC Ap Asgzet Detail =] Bank.
o 01-02-02-000 Bark ABC USD Agset Deail =] Bank.
o | 010203000 Bark BCD Azt Detail H Bank Edt
o | 010300000 FIUTANG Bussel Genetal O
a 010301000 FILTANG DAGANG Aazet Genesal O
o 010200401 Aneka Uzaha Jaya Agset Dietail [m] Piutang Dagang
o 010307402 Andalan Semesta Raya Azeat Dretail [m} Piutang Dagang
a m-030-Bm Buana Ussha fzeat Drestail ] Piutang Dagang
a 01030 -B02 Bersama Kita Bisa Asset Dretail O Putang Dagang z
o 01-0300-Cm Citra Alfa Indah Asgzet Dretail [m] Putang Dagang |E
L hirarki ke 4
hirarki ke 3
hirarki ke 2
hirarki ke 1

Dengan sistem hirarki ini memudahkan anda dalam menyusun No. Perkiraan
karena anda tidak dipusingkan dan tidak diminta oleh program untuk
menentukan level No. Perkiraan, cukup masukkan Nomor Perkiraan menurut

hirarkinya.

Untuk membuat Chart of Account, maka klik menu Master Data > Chart of
Account atau klik icon terkait pada toolbar, maka akan ditampilkan tabel
Chart of Account. Ada 2 pilihan, apakah ingin membuat sendiri Chart of
Account dari nol atau menggunakan Chart of Account dari Sample Chart of
Account dan mengeditnya. Untuk cara yang pertama, maka klik tombol New.

Sedangkan untuk pilihan kedua maka ikuti langkah-langkah berikut :

Klik tombol Open Sample.
Pilih opsi Perdagangan pada field Jenis Usaha.
3. Pilih Perusahaan Dagang pada combobox Nama Sample Chart of
Account
Klik tombol OK.
5. Klik tombol Impor.
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Selanjutnya edit Chart of Account dari hasil impor ini dengan
memposisikan kursor pada Nomor Perkiraan yang ingin diedit
kemudian klik tombol Edit, mungkin juga perlu menghapus akun yang
tidak diperlukan, caranya adalah dengan mengklik tombol Delete.
Mungkin ada akun yang perlu ditambahkan maka klik tombol New.
Yang harus diketahui adalah yang dimaksud mengedit Nomor Perkiraan
adalah mengedit Nama Perkiraan, Tipe atau Sub Kategorinya. Nomor
Perkiraannya sendiri tidak bisa diedit karena merupakan field kunci,
maka apabila ada Nomor Perkiraan yang tidak sesuai maka yang bisa
dilakukan adalah menghapusnya dan kemudian membuat Nomor

Perkiraan baru.
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Apabila anda mengklik tombol New maka akan ditampilkan form berikut.

ﬁ Chart of Account : - . X

[ Form ini digunakan untuk memasukkan Mo. Perkiraan untuk keperluan Jurnal Tran:
.fEE;‘ Format Mo, Perkiraan adalah 99-99-99-A99, angka 9 artinya anda dapat memasukkan

angka 0-9, sedangkan 'A’ artinya boleh angka atau huruf tanpa tanda penghubung '

No. Perkiraan | 01-02-02-000 ans [CIMon Aktif

Mama Perkiraan ~ Bank BCD

Nama Alias Bank BCD

Kategari Asset

Tipe Perkiraan General (@) Detail

Sub Kategori : Bank - Valuta Rp I

Kas /Bank [ uang Muka Pembelian Uang Muka Penjualan l
|

Parent Account

| 01-02-00-000  BAMNK | General
| 01-00-00-000  JAKTIVA LANCAR | General :
| I I
|
|
| iﬂiuew | ’ﬁsaard’l ‘ | xgeiete | | Bgave | 'ganoel |

No. Perkiraan : Ketik Nomor Perkiraannya sesuai aturan yang telah
dikemukakan diatas

Nama Perkiraan : Isi Nama Perkiraannya

Kategori : Otomatis terisi apabila untuk perkiraan hirarki ke-2 dstnya,
sedangkan untuk perkiraan hirarki ke-1 maka tentukan kategorinya
dengan memilih dari pilihan yang ada apakah Asset, Liability, Capital,
Revenue atau Expense

Tipe Perkiraan : Otomatis adalah General untuk perkiraan hirarki ke-1,
sedangkan untuk hirarki ke-2 dstnya, maka tentukan tipe perkiraannya
apakah General atau Detail

Sub Kategori : Hanya perlu dan bisa diisi apabila tipe perkiraannya
adalah Detail. Tentukanlah dengan memilih dari daftar yang ada. Daftar
sub kategori adalah tergantung kategorinya.

Valuta : Pilih valutanya, defaultnya adalah Rp. (Karena fasilitas multi

currency tidak tersedia pada Accpro Trada maupun Accpro Strada, maka pilihan
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valuta yang tersedia pun hanya Rp. Fasilitas multi currency hanya tersedia pada
varian Accpro Spectra)

Kas / Bank : Hanya untuk akun bertipe Detail, maka apabila adalah akun
Kas / Bank centanglah checkbox ini.

Uang Muka Pembelian : Hanya untuk akun bertipe Detail. Centanglah
checkbox ini jika akun bersangkutan adalah merupakan uang muka
pembelian. Fungsi dari checkbox ini adalah untuk memberitahukan
kepada program akun-akun mana sajakah yang merupakan akun uang
muka pembelian, karena ada fasilitas tertentu pada program yang hanya
menampilkan akun-akun yang telah ditetapkan sebagai akun uang muka
pembelian.

Uang Muka Penjualan : Hanya untuk akun bertipe Detail. Centanglah
checkbox ini jika akun bersangkutan adalah merupakan uang muka
penjualan. Fungsi dari checkbox ini adalah untuk memberitahukan
kepada program akun-akun mana sajakah yang merupakan akun uang
muka penjualan, karena ada fasilitas tertentu pada program yang hanya
menampilkan akun-akun yang telah ditetapkan sebagai akun uang muka
penjualan.

Parent Account : menampilkan perkiraan dengan hirarki di atasnya.
Tombol Save : untuk menyimpan perubahan atau penambahan data
Tombol Cancel : apabila tidak jadi merubah atau menambah data, maka
klik tombol ini, apabila sebelumnya anda bermaksud menambah data
maka program akan menampilkan data terakhir apabila sudah ada
datanya yang artinya anda akan berada pada modus Edit (penjelasan
mengenai modus Add dan Edit dikemukakan lebih terinci pada Manual
Pemakaian Aplikasi dalam bentuk Help File yang akan ditampilkan
dengan menekan tombol F1 pada posisi dimana saja di dalam aplikasi
Accpro).

Tombol Search : untuk mencari akun tertentu.

Tombol navigasi : untuk melihat record sebelum atau sesudahnya.

(hanya berfungsi pada modus edit)
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Catatan :

Harap diperhatikan bahwa khusus pada Accpro, anda harus membreak-
down Laba (Rugi) Berjalan atas Account Laba (Rugi) Tahun Berjalan
(yang adalah minus bulan berjalan) dan Laba (Rugi) Bulan Berjalan. Itu
artinya di dalam Chart Account yang anda buat selain Account Laba
(Rugi) Ditahan, anda juga harus menciptakan Account Laba (Rugi)
Tahun Berjalan dan Account Laba (Rugi) Bulan Berjalan. Penjelasan lebih
lengkap mengenai hal ini lihat penjelasan di bawah menyangkut Account
Default.

Tips :

Hanya sekedar saran, Nama Perkiraan dengan tipe General sebaiknya
menggunakan huruf CAPITAL, sedangkan perkiraan dengan tipe Detail
dapat menggunakan kombinasi huruf Capital dan huruf kecil.

4.3.3 Account Default

Yang dimaksud Account Default adalah akun atau Nomor Perkiraan yang
digunakan dan dibutuhkan oleh program dalam melakukan penjurnalan dan
posting secara otomatis pada modul-modul transaksi yang menghasilkan
jurnal. Jurnal transaksi akan dibuatkan secara otomatis oleh program
berdasarkan akun default yang telah anda beritahukan kepada program.
Sebagai contoh, anda cukup menginput transaksi pembelian atau penjualan,

sedangkan penjurnalannya akan dilakukan secara otomatis oleh program.

Khusus Account Default untuk Persediaan, Persediaan Dalam Perjalanan dan
Harga Pokok Penjualan bisa anda kosongkan jika untuk setiap kelompok
barang adalah berbeda akunnya, namun jika tidak dibedakan menurut
kelompok barang (atau bahkan barangnya) maka bisa ditentukan disini.

Demikian juga Account Default untuk Penjualan, Potongan Penjualan dan
Retur Penjualan bisa ditentukan disini jika tidak dibedakan baik menurut
kelompok barangnya maupun menurut kelompok customernya. Namun

apabila dibedakan apakah pembedaannya menurut kelompok barang (atau
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bahkan menurut barangnya) atau menurut kelompok customernya maka bisa
dikosongkan. Apabila dibedakan menurut kelompok barangnya,
penentuannya nanti pada saat input kelompok (grup) barang, sedangkan
apabila pembedaannya menurut kelompok customernya maka penentuannya
pada saat input kelompok (grup) customer. Mengenai apakah dibedakan
menurut kelompok barang atau kelompok customer ditentukan pada Setup

Preferensi tab Sistem yaitu Breakdown Account Penjualan pada Buku Besar.

Account Default u

Sebelum mulai menggunakan program Accpro, anda harus menentukan Account Default untuk item dibawah ini. Pilih dari
Account yang sudah anda input ke tabel Account atau tambahkan lebih dulu ke tabel Account bila belum ada dengan mengklik
tombol New Account

Keterangan
- Laba (Rugi) Ditahan 04-02-00-000 Laba (Fugi) Ditahan
- Laba (Rugi) Tahun Berjalan 04-03-00-000 Laba (Rugi) Tahun Berjalan
* Laba (Rugi) Bulan Berjalan 04-04-00-000  Laba (Rugi) Bulan Berjalan
- Persediaan LI Fersediaan Barang Dagang
- Uang Muka Pembelian Nama Perkiraan

= 01-04-01-000 Persediaan Barang Dagang

§ Vang Muka Penjualan |Asuransi Dibayar Dimuka
~ PPN Masukan 01-05-01-005 |sewa Dibayar Dimuka
" PPN Masukan Bukan Kredit Pajak 01-05-02-001 |Uang Muka PPh 21
01-05-02-002 |Uang Muka PPh 22
-| PPN Keluaran 01-05-02-003 |Uang Muka PPh 23
" Penjualan 01-05-02-004 |Uang Muka PPh 25
|Uang Muka Pembelian
|Invemaris Kantor
| Akumulasi Penyusutan Inventaris Kantor

m

Rp Keterangan

03-01-01-000 _»|Hutang Dagang
01-03-01-001 Fiutang Dagang

| ﬁgave | | agance{ |

| —_',=' Mew Account |

Selain itu, khusus Account Default untuk Penjualan Lain-lain, bisa saja
nantinya pada saat input data item penjualan melalui menu Master Data >
Item Lain-lain > Item Penjualan atau secara langsung pada saat input
Penjualan Lain-lain, akunnya bisa berbeda dengan Account Default yang
telah anda tentukan disini karena ada fasilitas untuk menentukan akun
penjualan untuk masing-masing item penjualan, artinya untuk item penjualan
satu dengan lainnya bisa sama atau berbeda akun penjualannya. Apabila hal

seperti ini yang diinginkan maka untuk saat ini anda bisa tidak menentukan
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account default untuk Penjualan Lain-lain, atau tentukanlah sebagai yang
paling banyak dipakai oleh item penjualan yang anda miliki. Disini perlu
dijelaskan bahwa mungkin saja anda sama sekali tidak perlu menentukan
Account Default Penjualan Lain-lain apabila memang anda tidak memerlukan
atau tidak mengenal penjualan lain-lain. Penjualan Lain-lain disini
dimaksudkan untuk mengakomodasi perusahaan yang selain penjualan
menyangkut persediaan barang dagang, kadangkala ada item penjualan yang
bukan persediaan barang dagang (mungkin jasa atau barang yang tidak
memerlukan pengontrolan terhadap stok), dimana penjualan lain-lain
memungkinkan item penjualan yang demikian tidak perlu ditentukan lebih
dulu Kode Barangnya pada Master Barang & Jasa tetapi cukup mengisikan
deskripsi item penjualannya secara bebas tanpa terikat apakah sebelumnya
sudah ada item penjualan yang demikian pada Master Item Penjualan. (Untuk
varian Accpro Trada kavena tidak ada fasilitas Penjualan Lain-lain, maka Account

Default untuk ini juga tidak ada / tidak diperlukan)

Selengkapnya Account Default yang harus ditentukan beserta penjelasannya
dapat dilihat pada tabel berikut :

o

Akun ini adalah akun yang menampung laba

1| Lalsm (Ruep) Pl (rugi) untuk tahun-tahun yang sudah lalu

Akun ini adalah akun yang menampung laba

Lalze (gl Tl (rugi) untuk tahun berjalan minus laba

el Em (rugi) bulan berjalan
Laba (Rugi) Bulan Akur_l ini adalah gkun yang menampung laba
3 Berialan (rugi) bulan berjalan. Penjelasan lebih
J lengkap lihat catatan di bawah
4 | Persediaan cukup jelas
Akun ini perlu apabila posting pada DO
(Surat Jalan) ditetapkan bukan pada Harga
Persediaan Dalam Pokok Penjualan tetapi masih berupa
5 N . .
Perjalanan Persediaan Dalam Perjalanan. Baru pada

saat diterbitkan Invoicenya timbul Harga
Pokok Penjualan

Apabila ada uang muka yang telah
6 | Uang Muka Pembelian | dibayarkan pada saat membuat transaksi
pembelian, maka akun ini diperlukan
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10

11

12

13
14

15

16

17

18

19

20

Uang Muka Penjualan

PPN Masukan

PPN Masukan Bukan
Kredit Pajak

PPN Keluaran
Penjualan
Potongan Penjualan

Retur Penjualan
Harga Pokok Penjualan

Hutang Giro

Piutang Giro

Hutang / Barang belum

ditagih
PPh Pasal 22
Selisih karena

pembulatan

Akun Kas/Bank untuk
Penj. Tunai

Apabila ada uang muka yang telah diterima
pada saat terjadinya transaksi penjualan,
maka akun ini diperlukan

Akun ini diperlukan untuk PPN pada
transaksi pembelian (Purchase Invoice)

Apabila ada PPN Masukan pada transaksi
pembelian (Purchase Invoice) yang tidak
bisa menjadi kredit pajak, maka akan
ditampung pada akun ini.

Akun ini diperlukan untuk PPN pada
transaksi penjualan (Sales Invoice)

cukup jelas

Akun ini diperlukan apabila ada potongan
(discount) pada transaksi penjualan (Sales
Invoice)

Akun ini diperlukan oleh modul Sales Return
cukup jelas

Akun ini diperlukan apabila ada transaksi
yang menggunakan cek / giro pada
Pengeluaran Kas / Bank

Akun ini diperlukan apabila ada transaksi
yang menggunakan cek / giro pada
Penerimaan Kas / Bank

Akun ini diperlukan apabila ada pembelian
(penerimaan barang) yang belum diterima
tagihan / Invoicenya

Akun ini diperlukan oleh modul Menerima
SSP dari Bendaharawan

Terutama pada transaksi yang ada PPNnya,
kadang-kadang timbul selisih antara debit
dan kredit karena adanya pembulatan. Anda
bisa menentukan akun ini apakah sebagai
akun biaya ataupun pendapatan

Hanya diperlukan apabila ada penjualan
menyangkut Customer Tunai. Jika
menginginkan tidak perlu selalu harus
menentukan akun Kas/Bank untuk
menerima pembayarannya pada saat input
penjualan melalui modul Sales Invoice
khusus untuk Customer Tunai, maka
tentukanlah akun defaultnya disini
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21 | Penjualan Lain-lain Hanya diperlukan apabila ada penjualan

lain-lain
22 Potongan Penjualan Hanya diperlukan apabila ada penjualan
Lain-lain lain-lain

Point No. 21 dan No. 22 diperlukan untuk varian Accpro Strada pada saat
anda menggunakan opsi Penjualan Lain-lain pada modul Sales Invoice. Anda
bisa menentukan default akun Pendapatannya di sini walaupun nantinya
pada saat melakukan transaksi penjualan melalui modul Sales Invoice anda
bisa merubahnya (melalui kolom No. Perk) apabila pada kasus tertentu akun
Pendapatan (Penjualan) nya adalah berbeda (bukan akun default yang anda
tentukan di sini). Sedangkan apabila ada discount atau potongan penjualan
terkait opsi Penjualan Lain-lain ini anda harus menentukannya di sini.

Apabila pada Setup Preferensi tidak ditentukan Breakdown Account Hutang
Usaha / Piutang Usaha menurut Supplier / Customer maka selain account
default yang telah dirinci di atas maka anda juga harus menentukan account
default untuk Hutang Usaha dan Piutang Usaha. Seperti halnya pada saat
menentukan account default lainnya di atas maka tentukan accountnya

melalui kolom No. Perk atau atau Nama Perkiraan.

Catatan :

Sebenarnya apa perlunya ada akun Laba (Rugi) Bulan Berjalan ?
Mungkin ini pertanyaan yang timbul di benak anda. Penjelasannya
adalah sebagai berikut : Akun ini dipertahankan demi kompabilitas
dengan versi Accpro terdahulu dimana ada user yang menginginkannya.
Sebenarnya ada kegunaan atau keuntungannya dengan adanya akun ini,
yaitu dengan adanya akun ini maka untuk mengetahui Laba (Rugi) Bulan
Berjalan dapat terlihat melalui Laporan Neraca ataupun Buku Besar,
tidak hanya melalui Laporan Laba Rugi. Kalaupun merasa hal ini tidak
diperlukan maka pada versi Accpro yang sekarang, pada Laporan Neraca
Standar tidak ditampilkan lagi Laba (Rugi) Bulan Berjalan tetapi hanya
Laba (Rugi) Ditahan dan Laba (Rugi) Berjalan. Tetapi untuk yang
menginginkannya tetap tampil di Laporan Neraca tetap dimungkinkan
dengan menggunakan Laporan Neraca Customize dimana disana bisa
ditampilkan secara lebih rinci yaitu Laba (Rugi) Ditahan, Laba (Rugi)
Tahun Berjalan (minus bulan berjalan) dan Laba (Rugi) Bulan Berjalan.
Oleh karena itu akun ini tetap diperlukan dan dipertahankan.
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4.3.4 Salesman

Apabila untuk penjualan di perusahaan anda tidak ada atau tidak perlu
ditentukan Salesmannya, maka modul ini bisa anda lewati.

e Nama: Isi dengan Nama Salesman

e Keterangan : Keterangan menyangkut Salesman bersangkutan jika
diperlukan.

e Non Aktif : Suatu saat mungkin saja Salesman tertentu sudah tidak aktif,
agar dalam inquiry khususnya Daftar Penjualan Tahunan apabila
Salesman bersangkutan sudah tidak ada penjualannya untuk tahun
bersangkutan maka Salesman tersebut tidak ditampilkan lagi, maka
tandailah kolom Non Aktif.

i o . ==

Wo. — Wama | Keterangan | ion At B
1. Sony Susanto D | —
2. Harry Sutandi O @ Save
3. Budiono O -
4| O 2 5 Cancel
5. O
8. O w Delete
7. O
8. O
9. O
10. O
11. O
1, O
13, O i
Tips Kolom keterangan dapat anda isi sebagai sekedar catatan atau bisa juga

dikosongkan. Untuk Salesman yang sudah terpakai pada tabel Customer, merubah
% nama Salesman pada no. tersebut berarti merubah pula data Saleman pada tabel
Customer.,

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan keseluruhan perubahan atau
penambahan data dan menutup form.

¢ Tombol Delete : menghapus baris tertentu.

e Tombol kI: menutup form ini.
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4.3.5 Kelompok (Grup) Customer

Kelompok (grup) customer harus ditentukan apabila penjualan dibedakan
menurut kelompok customernya, yaitu bila pada Setup Preferensi tab Sistem,
Breakdown Account Penjualan pada Buku Besar ditetapkan sebagai Menurut
Grup Customer. Bila tidak demikian, pengelompokan customer bersifat
optional, artinya apabila anda merasa tidak perlu atau tidak ada urgensinya
membagi customer ke dalam kelompok yang berbeda, anda bisa melewati

bagian ini

Form yang ditampilkan apabila Breakdown Account Penjualan pada Buku

Besar : Menurut Barang / Grup Barang adalah sebagai berikut :

5 Tt o tongo i
Mo.| _ Grup | Keterangan | Terms | HargaJual |

-
1. AGEM Agen Penjualan Met 30 Harga Jual 1 j
2. END USER Net 14 Harga Jual 2 |; |
3| b
&k
5.
6.
7.
8.

ﬁgelet; | Egave_ | | m Qanc; |

Sebagaimana dikemukakan di atas, hanya kalau Breakdown Account
Penjualan pada Buku Besar adalah Menurut Grup Customer, anda perlu
menentukan grup customer, apabila Menurut Barang / Grup Barang maka
anda bisa melewatkan modul ini dan membiarkan Tabel Grup (Kelompok)
Customer kosong jika merasa tidak ada urgensinya dan itu berarti anda
nantinya juga tidak perlu menentukan grup customer untuk masing-masing

customer.
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Form yang ditampilkan apabila Breakdown Account Penjualan pada Buku

Besar : Menurut Grup Customer adalah sebagai berikut :

#{ Tabel Grup (Kelompok) Customer

No.  Grup | Keterangan | Terms | HargaJual [&
1. B Penjualan Grosir
Z. Retail Penjualan Retail
5 3
&
53
[
7
g v
{ Grosir )
Penjualan 05-01-01-000 Penjualan Bruto - Grosir
Potongan Penjualan 05-01-0z-000 Potongan Penjualan - Grosir
Retur Penjualan 05-01-03-000 Retur Penjualan - Grosir
X Delete [ H Save l [ & Cancel ]

Dengan memilih preferensi sistem yang menetapkan akun penjualan pada
Buku Besar atau Chart of Account dibreakdown Menurut Grup Customer
artinya anda harus merinci grup customernya melalui modul ini dan

menentukan akun penjualannya masing-masing.

¢  Grup : Ketikkan nama grup atau kelompoknya.

e Keterangan : apabila perluy, isi deskripsi mengenai kelompok ini.

e Terms : apabila untuk kelompok Customer tertentu mempunyai
kesamaan syarat pembayaran (Terms of Payment), maka pilih Terms
dengan klik tombol drop-down pada kolom ini. Pilih < New Terms > jika
ingin menambah terms of payment baru ke tabel Terms of Payment.

e Harga Jual : apabila untuk kelompok Customer tertentu mempunyai

kesamaan skema Harga Jual, maka pilih skemanya dengan mengklik
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tombol drop-down pada kolom ini. Ada 5 skema harga jual. Penjelasan
mengenai hal ini lihat penjelasan di 4.3.6 Customer
e Account Default :

3z Penjualan : tentukan akun default penjualan untuk kelompok
customer sesuai baris dimana kursor pada tabel diatasnya berada
dengan mengetikkan secara langsung atau klik tombol Lookup
disampingnya untuk memunculkan bantuan Lookup Perkiraan.

3+ Potongan Penjualan : tentukan akun default untuk potongan
penjualan.

7t Retur Penjualan : tentukan akun default untuk retur penjualan.

¢ Tombol Save : menyimpan keseluruhan perubahan atau penambahan
data.

e Tombol Cancel : membatalkan keseluruhan perubahan atau
penambahan data yang belum disimpan dan menutup form.

¢  Tombol Delete : menghapus baris tertentu.

¢ Tombol I: menutup form ini.

4.3.6 Customer

Customer merupakan salah satu bagian dari Kontak (Contact), dimana
kontak (contact) diartikan sebagai semua yang mempunyai hubungan
transaksi dengan perusahaan. Oleh karena itu untuk mengakses modul
Customer bisa melalui Daftar Kontak. Daftar Kontak sendiri bisa dibuka
melalui menu Daftar > Daftar Kontak, Saldo, Kartu Hutang / Piutang atau
dengan mengklik icon Daftar Kontak pada toolbar. Bisa juga langsung

melalui menu Master Data > Customer.

Dengan membuka Daftar Contact, maka akan muncul form seperti di bawah
ini.

e (New) Customer : menambah customer baru.

¢ (New) Supplier : menambah supplier baru.

¢ (New) Others : menambah data kontak lainnya.
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Data Contact r £ ol [
Filter Refresh Search Close
Nama Pengenal Nama Resmi
PT. ABC FINANCE Jakarta Barat rs New
Toko DELTA COMPUTER Jakarta Utara
[
o ERABARU SOLUSINDO PT. ERA BARU SOLUSINDO Palembang Customer
0 GRAHA CELLULAR GRAHA CELLULAR Jakarta Pusat Suppler ;
0 GRAHA PRIMA SEJAHTERA PT. GRAHA PRIMA SEJAHTERA Surabaya Supplier | & suppler ‘
0 IMPERIAL TAXI PT. IMPERIAL RODA PERKASA Jakarta Selatan Customer -
o JAYA ABADI CV. JAYA ABADT Jakarta Barat Supplier | B Others ‘
0 KAS NEGARA KAS NEGARA Jakarta Barat Others
o MITRA FINANCE PT. MITRA FINANCE Jakarta Selatan Others
o PANCAMITRA PT. PANCA MITRA Jakarta Barat Supplier —
o PRIMATRAVEL CV. RODA PRIMA SAKTT Jakarta Timur Customer | e |
0 RAJAWALT PERKASA PT. RAJAWALI PERKASA Makassar Customer
o SEMESTAGPS PT. SEMESTA GPS Bandar Lampung Customer ‘ 3¢ Delete ‘
| Sprevew |
| Kartu AR ‘
| Saldo AR ‘
| Saldo AP ‘

e Edit : merubah data kontak (customer, supplier atau kontak lain) pada
baris dimana kursor berada.

e Delete : menghapus data kontak pada baris dimana kursor berada.

e Preview : menampilkan laporan Data Contact (sesuai yang saat itu
sedang ditampilkan) ke layar untuk selanjutnya bisa dicetak apabila
diinginkan.

e Kartu A/R : menampilkan Kartu Piutang, dengan mengklik tombol ini
maka Data Contact akan disaring (difilter) sehingga hanya kontak berupa
Customer yang ditampilkan. Selanjutnya untuk melihat Kartu Piutang
customer tertentu, posisikan kursor pada baris dimana customer tersebut
berada.

e Kartu A/P : apabila kursor ditempatkan pada baris yang berupa data
supplier, maka tombol Kartu A/R akan berfungsi dan berubah labelnya
menjadi tombol Kartu A/P. Seperti halnya tombol Kartu A/R maka
tombol Kartu A/P berfungsi menampilkan Kartu Hutang.
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e Saldo A/R : menampilkan kolom Saldo Piutang, dengan mengklik
tombol ini maka Data Contact akan disaring (difilter) sehingga hanya
kontak berupa Customer yang ditampilkan.

e Saldo A/P: menampilkan kolom Saldo Hutang, dengan mengklik tombol
ini maka Data Contact akan disaring (difilter) sehingga hanya kontak
berupa Supplier yang ditampilkan.

e Filter : menyaring atau menyeleksi data kontak yang ditampilkan
menurut batasan tertentu yaitu kategori (customer, supplier, others atau
kesemuanya), sembarang potongan nama pengenal, kota tertentu.
Khusus apabila difilter menurut customer, maka bisa difilter lagi
menurut grup customernya.

e Search : mencari data kontak tertentu berdasarkan Nama Pengenal,
Nama Resmi, Kota atau Telepon dengan cukup memasukkan sebagian
teks berupa potongan awal atau sembarang potongan teks yang dicari.
Ini berguna apabila data kontak relatif cukup banyak, maka ketimbang
melakukan scrolling dengan mengklik pada scroll-bar, bisa juga
menggunakan cara ini sebagai alternatif.

e  Refresh : untuk memperbaharui tampilan data apabila ada penambahan
atau perubahan data khususnya yang dilakukan oleh user lain. Mungkin
anda membuka Data Contact ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi penjualan yang
mempengaruhi piutang customer tertentu, atau menambah customer
baru, maka dengan melakukan refresh, data akan ditampilkan sesuai
dengan kondisi terkini.

e  Close : menutup form ini. Form Data Contact adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.
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Apabila tombol Kartu A/R atau Kartu A/P diklik, maka akan tampil seperti

berikut.

FT. USAHA BHAKTI JAYA

o TRIMITRA SEJATI FT. TRIMITRA SEJATI
o TRIJAYA FC. TRIJAYA

Urfilered

Tanggal
01/01/2008
14/01/2008
31/01/2008

Jml Datat 12

Mo, Trs

51 000003
SR 000001

No,

0&.00000003
0&.00000003

USAHA BHAKTI JAYA

Debit

14.575.000

Edo Brokoli
Edo Brokoli
Edo Brokali

kredic

291,500

44,000,000
1,976,000

Met 30
MNet 15
Met 30

Total 4R ¢ Rp, 163,140,500

1 Januari 2008 sfd 31 Januari 2008

Refrensi

72.000.000
86.575.000
86.283.500 SI 000003

&
1.
2.
3.
4
ST XV Y T T W VN G W Y SV PN Y T N Y BT Y S WLV Y

e  Periode : Klik tombol ini untuk menentukan periode tanggal yang ingin
ditampilkan pada Kartu Piutang / Kartu Hutang.

Dengan mengklik tombol Search, maka tampilan akan berubah sebagai
berikut.

ol 2] -

Data Contact

PT. PRIMA E] bk,

Sl o RN a A B AR 8

e  Cari : ketikkan teks, bisa berupa potongan awal untuk Nama Pengenal
atau sembarang potongan teks untuk lainnya.

e di: klik tombol drop-down pada field ini untuk memilih apakah mencari
menurut Nama Pengenal, Nama Resmi, Telepon atau Kota.

e  Go : klik tombol ini untuk mulai melakukan pencarian. Klik lagi apabila
masih ingin mencari apakah ada data lain yang memenubhi kriteria yang
anda ketikkan pada field Cari.

e  (lear : mengosongkan field Cari, agar anda mudah mengetikkan kriteria

pencarian yang baru.
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Mengklik tombol (New) Customer atau Edit (kursor berada pada baris
dengan kategori Customer) pada Daftar Contact atau memilih menu Master

Data > Customer akan memunculkan form seperti di bawah ini.

_ = Pada field Nama Customer, anda harus memasukkan Nama Customer yang dipakai sebagai
- !' pengenal (identitas) tanpa didahului oleh gelar, sebutan (mis. Bp., PT, Dr., dll) sedangkan

— untuk Mama Customer yang lengkap (resmi) dapat dimasukkan pada field Nama Resmi

Kode Customer 00003 EE » @ [ Non Aktif

Nama Customer ~ ERABARU SOLUSINDO

| |
| Mama Resmi FT. ERA BARL SOLUSINDO |
| Alamat 1. Rawa Buaya No. 5 ‘
| |
Kota Palembang + Kode Pos
I N
Propinsi + MNegara Indonesia ‘
| Telepon Fax |
| Contact Person HP i
| Outlet of -
| Website Email
| Umum l Alamat Kirim l MPWP, Terms, d l Lain-ain J |

| (@) ([@a]  (Kow]  (Cee] Bow |

¢ Kode Customer : otomatis digenerate oleh program, kode ini hanya
digunakan oleh program sebagai field kunci dan tidak akan pernah
ditanyakan oleh program pada saat anda menginput transaksi, jadi anda
tidak perlu fokus pada field ini.

e Nama Customer : isi dengan Nama Customer yang digunakan sebagai
identitas atau pembeda dengan customer lain. Nama Customer ini dalam
setiap kesempatan selalu diistilahkan atau disebutkan sebagai Nama
Pengenal. Sebagai Nama Pengenal, maka tidak perlu anda mengawalinya
dengan sebutannya misalnya PT., CV., Bp., Toko, dr. dan sebagainya,
kalaupun tetap ingin dicantumkan tempatkanlah di belakang Nama
Pengenal. Apa maksudnya ? Maksudnya adalah agar nantinya pada

daftar customer akan mudah dalam melakukan pencarian karena urut
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menurut nama customer tanpa didahului oleh sebutannya. Bayangkan
kalau semua nama customer diawali PT., maka urutan yang ditampilkan
menjadi tidak banyak berguna. Nama Pengenal inilah yang selalu akan

digunakan pada saat anda menginput transaksi.
Tab Umum

e Nama Resmi : disinilah tempatnya anda memasukkan nama customer
sesuai dengan format resminya dengan diawali sebutannya. Nama Resmi
ini yang nantinya akan tercetak pada printout transaksi yang berupa
Sales Invoice dan/atau Faktur Pajak.

e Alamat:isi dengan alamat customer kepada mana tagihan ditujukan.

e Kota : ketik kotanya atau pilih dari daftar kota yang sudah pernah anda
masukkan dengan mengklik tombol drop-down.

e Kode Pos : cukup jelas.

e  Propinsi : ketik/pilih propinsinya hanya jika perlu, kalau tidak maka bisa
dibiarkan kosong.

e Negara: cukup jelas.

e Telepon: cukup jelas.

e  Fax: cukup jelas.

e  Contact Person : jika ada, field ini bisa dilengkapi.

e HP:idem.

e Akun Piutang : apabila parameter sistem pada Setup Preferensi yang
menyangkut Breakdown Account Hutang Usaha/Piutang Usaha menurut
Supplier / Customer dicentang yang artinya anda ingin ada perincian
(pembedaaan) akun Hutang / Piutang untuk masing-masing Supplier /
Customer pada Chart of Account dan buku besar, maka akan tampil
pada form ini field Akun Piutang yang harus anda tentukan baik dengan
mengetikkan langsung pada field tersebut atau menggunakan bantuan
tombol Lookup disampingnya.

e Outlet Of : apabila customer ini merupakan outlet dari customer lain
maka pilih customer induknya dengan mengklik tombol drop-down
yang ada. Implementasi dari fasilitas ini diilustrasikan sebagai berikut :
Katakan perusahaan A sebagai perusahaan induk mempunyai outlet atau

cabang B dan C, dimana pengiriman barang dilakukan ke B atau C tetapi
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tagihannya dan Faktur Pajaknya ke A. Maka input A di Master Customer
sesuai nama resmi perusahaan A berikut NPWPnya. Nama dan Alamat
Kirim biarkan saja sesuai nama dan alamat perusahaan A. Kemudian
input juga B dan C di Master Customer tetapi jangan lupa, pada field
Outlet Of pilih A sebagai customer induknya. Pada saat input DO (Surat
Jalan) dan Invoice pilih customernya A tetapi centang checkbox Ship to
Customer’s outlet dan pilih B atau C.
¢  Website : bisa diisi jika ada

e  Email : idem
Tab Alamat Kirim

e Nama : pada saat anda pertama kali menambah customer baru, field ini
otomatis terisi sesuai Nama Resmi pada tab Umum. Anda bisa merubah
nama ini jika nama perusahaan sebagai alamat pengiriman berbeda
dengan nama pada tab Umum. Tetapi kalau perusahaan mempunyai
lebih dari satu nama & alamat pengiriman yang berbeda, maka gunakan
fasilitas Outlet Of seperti yang dijelaskan di atas.

e Alamat, Kota, Kode Pos, Propinsi, Negara, Telepon, Fax, Contact
Person, HP : seperti halnya Nama, pada saat pertama kali customer
dibuat, kesemua field ini akan mengikuti yang diketikkan pada tab

Umum, anda bisa mengeditnya jika diperlukan.
Tab NPWP, Terms, dll

e Valuta : otomatis terisi valuta default (Rp). (Untuk varian Accpro Trada dan
Strada tidak ada pilihan valuta lain).

e Grup : Apabila penjualan dibedakan menurut grup customernya
(Breakdown Account Penjualan pada Buku Besar : Menurut Grup
Customer) maka grup customer harus ditentukan. Bila tidak demikian,
grup customer boleh tidak diisi.

e Salesman : apabila ada Salesmannya maka bisa ditentukan dengan
memilih dari daftar Salesman dengan mengklik tombol drop-down yang
ada pada field ini. Tetapi apabila tidak ada Salesmannya atau Salesman

tidak tentu tergantung transaksinya, maka bisa dikosongkan.
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NPWP : isi dengan NPWP customer apabila ada.

NPPKP : idem.

Jenis Perusahaan : pilih apakah Swasta atau Bendaharawan.

Terms of Payment : centang checkbox Customer Tunai (Non A/R) hanya
kalau customer ini adalah customer dengan pembayaran tunai dan tidak
perlu ada kartu piutangnya.

Untuk sebaliknya, maka isi jumlah hari jatuh tempo, persentase diskon
yang diberikan apabila pelunasan dilakukan tidak melebihi sekian hari
dari tanggal Invoice. Apabila anda menggunakan fasilitas grup Customer
dan anda telah menentukan Terms of Payment untuk grup customer
tertentu, maka apabila customer ini merupakan anggota dari kelompok
customer tersebut, Terms of Payment otomatis akan terisi dengan
sendirinya.

Batas kredit : apabila ada pembatasan limit piutang untuk customer ini,
maka field ini bisa diiisi, kalau tidak maka bisa dilewati. Implementasi
pembatasan limit piutang customer juga tidak difasilitasi pada varian
Accpro Trada dan Strada, oleh karena itu field ini bisa dilewati.

Harga Jual : ada 5 skema Harga Jual yaitu Harga Jual 1, Harga Jual 2
Harga Jual 3, Harga Jual 4 dan Harga Jual 5. Bila diperlukan anda bisa
mengenakan skema harga jual yang berbeda untuk customer yang
berbeda, misalnya ada customer yang dikenakan skema Harga Jual 1, ada
yang Harga Jual 2 atau Harga Jual 3 atau Harga Jual 4 atau Harga Jual 5.
Apabila suatu customer dikenakan Harga Jual 1, maka pada transaksi
penjualannya untuk setiap item barang akan berlaku harga jual yang
ditentukan pada field Harga Jual 1 untuk item barang bersangkutan
(untuk lebih jelasnya lihat juga penjelasan pada 4.3.11 Barang & Jasa).
Namun apabila anda merasa tidak memerlukannya maka field ini bisa
diabaikan atau dilewati. Seperti halnya Terms of Payment, jika suatu
customer merupakan anggota grup customer tertentu dan skema harga
jual untuk grup customer telah anda tentukan sebelumnya, maka

otomatis skema Harga Jual akan tercentang dengan sendirinya.
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Tab Lain-lain

e Nama & Alamat di Faktur Pajak : kalau anda membutuhkan nama &
alamat yang berbeda dengan nama resmi dan alamat di tab Umum, maka
kedua field ini bisa diisi, kalau tidak maka Nama & Alamat di Faktur
Pajak akan disesuaikan dengan nama resmi & alamat di tab Umum.
Mungkin hasil perangkaian alamat yang dilakukan program tidak sesuai
dengan yang diinginkan, di sinilah terutama gunanya kedua field ini
terutama field Alamat. Anda bisa mengisinya sesuai keinginan anda
terutama menyangkut letak pemotongan alamat. Untuk pertama kali
kalau kedua field ini belum anda isi, anda bisa mencentang checkbox
Generate dari Nama & Alamat di tab Umum maka program akan
mengisikannya pada kedua field ini, selanjutnya tinggal diedit jika
diperlukan

e Catatan : bisa diisi dengan catatan atau deskripsi yang lebih lengkap

mengenai customer ini, sekedar untuk keperluan dokumentasi.
Fungsi tombol yang ada adalah sebagai berikut :

¢ Tombol Save : menyimpan perubahan atau penambahan data.

e  Tombol New : untuk menambah data baru.

e Tombol Search : apabila ingin mencari customer tertentu, klik tombol ini
maka form Lookup Customer akan ditampilkan.

¢  Tombol Delete : menghapus customer tertentu

e Tombol Cancel : membatalkan perubahan atau penambahan data.
Tombol ini hanya aktif pada modus Add, sedangkan pada modus Edit
apabila memang ada upaya perubahan atas data yang ditampilkan.
Sekedar mengklik tombol drop-down pada combobox sudah ditafsirkan
sebagai ada upaya untuk merubah data, maka tombol ini akan aktif.

e Tombol navigasi : untuk berpindah dari record satu ke record lainnya.
Tombol ini hanya aktif pada modus Edit.
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4.3.7 Supplier

Seperti halnya Customer, Supplier juga merupakan salah satu bagian dari
Kontak (Contact). Oleh karena itu untuk mengakses modul Supplier bisa
melalui Daftar Kontak. Daftar Kontak sendiri bisa dibuka melalui menu
Daftar > Daftar Kontak, Saldo, Kartu Hutang / Piutang atau dengan
mengklik icon Daftar Kontak pada toolbar. Bisa juga langsung melalui menu

Master Data > Supplier.

Penjelasan tentang Daftar Contact bisa dilihat pada 4.3.6 Customer.

Mengklik tombol (New) Supplier atau Edit (kursor berada pada baris dengan
kategori supplier) pada Daftar Contact atau memilih menu Master Data >

Supplier maka form Supplier akan ditampilkan.

Kode Supplier 00001 A R IE‘ [T Mon Aktif
Nama Supplier GRAHA PRIMA SEJAHTERA
| |
| Mama Resmi PT. GRAHA PRIMA SEJAHTERA i
| Alamat 1l. Pakis Kawat No. 53 A ‘
' |
Kota Surabaya ¥ Kode Pos
I
Propinsi ~ MNegara Indonesia |
| Telepon Fax |
| Contact Person Bp. Agus HP |
| Website Email
| gmuml MPWP, Terms, d l Lain-ain J
| (o [Come | B
I

¢ Kode Supplier : otomatis digenerate oleh program, kode ini hanya
digunakan oleh program sebagai field kunci dan tidak akan pernah
ditanyakan oleh program pada saat anda menginput transaksi, jadi anda
tidak perlu fokus pada field ini.
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e Nama Supplier : isi dengan Nama supplier yang digunakan sebagai
identitas atau pembeda dengan supplier lain. Nama Supplier ini dalam
setiap kesempatan selalu diistilahkan atau disebutkan sebagai Nama
Pengenal. Sebagai Nama Pengenal, maka tidak perlu anda mengawalinya
dengan sebutannya misalnya PT., CV., Bp., Toko, dr. dan sebagainya,
kalaupun tetap ingin dicantumkan tempatkanlah di belakang Nama
Pengenal. Maksudnya adalah agar nantinya pada daftar supplier akan
mudah dalam melakukan pencarian karena urut menurut nama supplier
tanpa didahului oleh sebutannya. Bayangkan kalau semua nama supplier
diawali PT., maka urutan yang ditampilkan menjadi tidak banyak
berguna. Nama Pengenal inilah yang selalu akan digunakan pada saat

anda menginput transaksi.
Tab Umum

e Nama Resmi : disinilah tempatnya anda memasukkan nama supplier
sesuai dengan format resminya dengan diawali sebutannya. Nama Resmi
ini yang nantinya akan tercetak pada printout transaksi yang berupa
Purchase Order.

e Alamat: isi dengan alamat supplier.

e Kota : ketik kotanya atau pilih dari daftar kota yang sudah pernah anda
masukkan dengan mengklik tombol drop-down.

¢ Kode Pos : cukup jelas.

o  Propinsi : ketik/pilih propinsinya hanya jika perlu, kalau tidak maka bisa
dibiarkan kosong.

e Negara: cukup jelas.

e Telepon : cukup jelas.

e Fax: cukup jelas.

e  Contact Person : jika ada field ini bisa dilengkapi.

e HP:idem.

e Akun Hutang : apabila parameter sistem pada Setup Preferensi yang
menyangkut Breakdown Account Hutang Usaha/Piutang Usaha menurut
Supplier / Customer dicentang yang artinya anda ingin ada perincian
(pembedaaan) akun Hutang / Piutang untuk masing-masing Supplier /

Customer pada Chart of Account dan buku besar, maka akan tampil
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pada form ini field Akun Hutang yang harus anda tentukan baik dengan
mengetikkan langsung pada field tersebut atau menggunakan bantuan
tombol Lookup disampingnya.

e  Webiste : bisa diisi jika ada

e  Email : idem
Tab NPWP, Terms, dll

e  Valuta : otomatis terisi valuta default (Rp). (Untuk varian Accpro Trada dan
Strada tidak ada pilihan Valuta lain)

e NPWP :isi dengan NPWP supplier apabila ada.

¢ Jenis Perusahaan : pilih apakah Lokal atau Impor.

e Terms of Payment : centang checkbox Supplier Tunai (Non A/P) hanya
kalau supplier ini adalah supplier dengan pembayaran tunai dan tidak
perlu ada kartu hutangnya.

Untuk sebaliknya, maka isi jumlah hari jatuh tempo, persentase diskon
yang diberikan apabila pelunasan dilakukan tidak melebihi sekian hari
dari tanggal Invoice.

e Batas Kredit : field ini sekedar untuk informasi atau dokumentasi saja

dan tidak ada implementasinya pada program.

Tab Lain-lain

e Catatan : bisa diisi dengan catatan atau deskripsi yang lebih lengkap

mengenai supplier ini, sekedar untuk keperluan dokumentasi.
Fungsi tombol yang ada adalah sebagai berikut :

e Tombol Save : menyimpan perubahan atau penambahan data.

e Tombol New : untuk menambah data baru.

e Tombol Search : apabila ingin mencari supplier tertentu, klik tombol ini
maka form Lookup Supplier akan ditampilkan.

e Tombol Delete : menghapus supplier tertentu

e Tombol Cancel : membatalkan perubahan atau penambahan data.

Tombol ini hanya aktif pada modus Add, sedangkan pada modus Edit
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apabila memang ada upaya perubahan atas data yang ditampilkan.
Sekedar mengklik tombol drop-down pada combobox sudah ditafsirkan
sebagai ada upaya untuk merubah data, maka tombol ini akan aktif.

e Tombol navigasi : untuk berpindah dari record satu ke record lainnya.
Tombol ini hanya aktif pada modus Edit.

4.3.8 Other Contact

Other Contact adalah kontak lain diluar Customer dan Supplier. Kontak yang
tidak bisa dikategorikan dalam kedua jenis kontak ini misalnya karyawan
atau pihak lain yang transaksinya tidak melibatkan modul pembelian atau
penjualan. Karena merupakan bagian dari Kontak (Contact), maka untuk
mengakses modul Other Contact bisa melalui Daftar Kontak. Daftar Kontak
sendiri bisa dibuka melalui menu Daftar > Daftar Kontak, Saldo, Kartu
Hutang / Piutang atau dengan mengklik icon Daftar Kontak pada toolbar.
Atau secara langsung untuk membuka modul Other Contact bisa melalui

menu Master Data > Other Contact.

Penjelasan tentang Daftar Contact bisa dilihat pada 4.3.6 Customer.

Mengklik tombol (New) Others atau Edit (kursor berada pada baris dengan
kategori others) pada Daftar Contact atau memilih menu Master Data > Other

Contact akan memunculkan form berikut.

¢ Kode : otomatis digenerate oleh program, kode ini hanya digunakan oleh
program sebagai field kunci dan tidak akan pernah ditanyakan oleh
program pada saat anda menginput transaksi, jadi anda tidak perlu fokus
pada field ini.

e Nama : isi dengan Nama other contact yang digunakan sebagai identitas
atau pembeda dengan kontak lain. Nama ini yang dalam setiap
kesempatan selalu diistilahkan atau disebutkan sebagai Nama Pengenal.
Sebagai Nama Pengenal, maka tidak perlu anda mengawalinya dengan
sebutannya misalnya PT., CV., Bp., Toko, dr. dan sebagainya, kalaupun

tetap ingin dicantumkan tempatkanlah di belakang Nama Pengenal.
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Maksudnya adalah agar nantinya pada daftar kontak akan mudah dalam
melakukan pencarian karena urut menurut namanya tanpa didahului
oleh sebutannya. Nama Pengenal inilah yang selalu akan digunakan

pada saat anda menginput transaksi.

Bp., PT, Dr.,
n pada field Mama Lengkap

Kode 00001 44 p M| [Elhon Aktif

Mama Lengkap <N/A*, Lain-ain |

Alamat

Kota ~ Kode Pos
Propinsi « Negara
Telepon Fax

HP

Website Email

Record pertama dari tabel ini adalah <M/A> (= Mot Available) dan tidak dapat anda ubah. Ini akan |
digunakan pada modul transaksi tertentu yang transaksinya memerlukan data Nama Contact tetapi pada |
kasus tertentu Nama Contactnya tidak pasti (mis: gabungan beberapa nama) atau tidak ingin disebutkan,
anda dapat menggunakan Mama Contact <N/A> ini yang artinya adalah Nama Contact tidak diperlukan. |

|xgelehe | | ﬁgava | ‘ Cancel !

Tab Umum

¢ Nama Lengkap : disinilah tempatnya anda memasukkan nama lengkap
untuk kontak bersangkutan dengan diawali sebutannya.

e Alamat:isi dengan alamat supplier.

¢ Kota : ketik kotanya atau pilih dari daftar kota yang sudah pernah anda
masukkan dengan mengklik tombol drop-down.

¢ Kode Pos : cukup jelas.

e Negara: cukup jelas.

e Kategori : pilih kategori untuk kontak ini apakah Karyawan, Personal,
Company atau Others

e Telepon : cukup jelas.

e  Fax: cukup jelas.
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Contact Person : jika ada bisa field ini bisa dilengkapi.
HP : idem.
Webiste : bisa diisi jika ada

Email : idem

Tab Catatan

Catatan : bisa diisi dengan catatan atau deskripsi yang lebih lengkap

mengenai supplier ini, sekedar untuk keperluan dokumentasi.

Fungsi tombol yang ada adalah sebagai berikut :

Tombol Save : menyimpan perubahan atau penambahan data.

Tombol New : untuk menambah data baru.

Tombol Search : apabila ingin mencari kontak tertentu, klik tombol ini
maka form Lookup Contact akan ditampilkan.

Tombol Delete : menghapus kontak tertentu

Tombol Cancel : membatalkan perubahan atau penambahan data.
Tombol ini hanya aktif pada modus Add, sedangkan pada modus Edit
apabila memang ada upaya perubahan atas data yang ditampilkan.
Sekedar mengklik tombol drop-down pada combobox sudah ditafsirkan
sebagai ada upaya untuk merubah data, maka tombol ini akan aktif.

Tombol navigasi : untuk berpindah dari record satu ke record lainnya.

Tombol ini hanya aktif pada modus Edit.
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4.3.9 Tabel Satuan

Setiap transaksi atas barang dan jasa yang ada pada Master Barang & Jasa
harus ditentukan satuannya, oleh karena itu satuan transaksi sebaiknya anda

lengkapi lebih dulu melalui modul ini.

Modul ini dibuka melalui menu Master Data > Tabel Satuan.
T T T—
ﬁ Tabel Satuan - Pl u

No.| _ Satuan | Keterangan -

1. Box

2, Pcs

3. Unit 1

:l | E]Ea\re |
|

- LTS
I 8.
| ]E | Rgelete |
I 11.

12,

13 i

Tips Masukkan sampai dengan 5 karakter pada kolom Satuan, apabila lebih

sebaiknya anda gunakan singkatan dari Satuan tsb, sedangkan
% keterangan lengkap mengenai Satuan dapat anda masukkan pada

kolom Keterangan

e  Satuan : ketik satuannya maksimal 5 karakter.

e Keterangan : isi keterangannya jika diperlukan.

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

e Tombol Delete : menghapus data pada baris tertentu.

e Tombol Ld: menutup form ini.
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4.3.10 Kelompok (Grup) Barang

Setiap barang dan jasa yang ada pada Master Barang dan Jasa harus masuk
dalam kelompok (grup) barang tertentu, untuk itu sebaiknya anda
melengkapi dulu Kelompok (Grup) barang melalui modul ini.

4 Tabel Grup Barang - T - X
No.  Grup | Keterangan | _ Kategori __Ji§
L Inventory L
2. GPS MAVIGASI Inventory 5
3. OTHERS Inventory b
4, JASA Jasa
5.
6.
7.
8 -
I |
I ( GPS TRACKER ) |
Sesuaikan dengan pengaturan pada tabel Account Default Set to Default | |
Persediaan 01-04-01-000 R] Persediaan Barang Dagang

Persediaan dalam Perjalanan P

Harga Pokok Penjualan 06-01-00-000 R] Harga Pokok Penjualan
I Penjuslan 05-01-01-000 | ||  Penjualan Bruto
| Potongan Penjualan 05-01-02-000 RI Potongan Penjualan
| Retur Penjualan 05-01-03-000 R] Retur Penjuslan
I Jadikan pengaturan ini sebagai Default | Set As Default |
| T
| R Delete | | Er_] Save | | 5 cancel |

Form atau modul ini dibuka melalui menu Master Data > Kelompok (Grup)
Barang.

e Grup : ketik nama grup atau kelompok barangnya.
e Keterangan : isi keterangannya jika diperlukan.
e Kategori : pilih kategorinya apakah Inventory, Non Inventory atau Jasa.
(penjelasan mengenai masing-masing kategori lihat 4.3.11 Barang & Jasa)
¢ Account Default:
3 Set to Default : apabila sebelumnya anda telah menentukan default
akun Persediaan, Persediaan dalam Perjalanan (apabila posting HPP
pada DO adalah ke Persediaan dalam Perjalanan) dan Harga Pokok
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Penjualan (demikian juga Penjualan, Potongan Penjualan dan Retur
Penjualan apabila Breakdown Account Penjualan adalah menurut
Barang / Grup Barang) melalui modul Account Default dan anda
tidak ingin membedakan akun-akun ini menurut kelompok
barangnya (sama antara kelompok barang satu dengan lainnya),
maka anda bisa mengklik tombol ini sehingga akun-akun default
untuk Grup Barang pada posisi kursor akan terisi sesuai akun-akun
default yang telah ditentukan pada modul Account Default.
Persediaan : sebagai alternatif, anda bisa membedakan masing-
masing Grup Barang atas akun-akun default yang berbeda, untuk itu
ketik nomor perkiraannya atau klik tombol Lookup yang ada untuk
memunculkan Lookup Perkiraan dimana anda bisa mencari
perkiraan yang dikehendaki. Apabila kategorinya adalah Jasa maka
akun ini tidak diperlukan, sedangkan kalau Non Inventory maka
akun ini bisa berupa aktiva atau biaya.

Persediaan dalam Perjalanan : field ini hanya aktif jika posting HPP
pada DO adalah ke Persediaan dalam Perjalanan, bukan ke Harga
Pokok Penjualan, untuk itu lakukan hal yang sama seperti yang
dikemukakan diatas menyangkut akun default untuk Persediaan.
Apabila kategorinya adalah Non Inventory atau Jasa maka akun ini
tidak diperlukan.

Harga Pokok Penjualan : sama halnya dengan akun default untuk
Persediaan, jika masing-masing Grup Barang dibedakan akunnya,
tentukanlah akunnya seperti cara diatas. Apabila kategorinya adalah
Non Inventory atau Jasa maka akun ini tidak diperlukan.

Penjualan : hanya jika Penjualan dibreakdown (dibedakan) menurut
Barang atau Grup Barangnya maka field ini akan ditampilkan oleh
program dan perlu ditentukan dengan cara yang sama sebagaimana
dikemukakan diatas.

Potongan Penjualan : seperti halnya Penjualan.

Retur Penjualan : seperti halnya Penjualan.

Set As Default : kegunaan dari tombol ini adalah untuk menjadikan
akun-akun yang telah anda tetapkan untuk Grup Barang tertentu

sebagai Account Default sehingga akun-akun default pada modul
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Account Default akan terisi dengan akun-akun yang bersesuaian.
Lebih jelasnya adalah sebagai berikut : mungkin sebelumnya anda
belum menentukan akun-akun default Persediaan, Persediaan dalam
Perjalanan, Harga Pokok Penjualan atau juga Penjualan, Potongan
Penjualan, Retur Penjualan pada modul Account Default, sedangkan
anda tidak ingin membedakan akun-akun ini menurut Grup
Barangnya, maka dengan mengklik tombol ini akun-akun default
yang bersesuaian pada modul Account Default akan terisi dengan
akun-akun ini. Selanjutnya untuk Grup Barang berikutnya, anda

tinggal menggunakan tombol Set to Default.

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

¢  Tombol Delete : menghapus data pada baris tertentu.

e Tombol &I : menutup form ini.

4.3.11 Barang & Jasa

Barang dan Jasa yang terkait dengan kegiatan bisnis perusahaan harus
ditentukan Kode Barangnya dan diinventarisir ke dalam Master Barang &

Jasa agar dapat digunakan pada transaksi.

Untuk membuka modul ini pilih menu Master Data > Barang & Jasa atau
membuka daftar barang lebih dulu melalui menu Daftar > Daftar Barang,
Saldo & Kartu Stock atau klik icon [l pada toobar. Apabila membuka daftar
barang lebih dulu maka gunakan tombol New untuk menambah barang baru,
tombol Edit untuk menghapus barang pada posisi kursor, tombol Delete

untuk menghapus barang pada posisi kursor.

¢ Kode Barang : field ini merupakan kunci untuk mengidentifikasi item
barang tertentu, oleh karena itu Kode Barang harus unik, artinya tidak
boleh ada lebih dari satu item barang yang mempunyai kode yang sama.
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Karena merupakan field kunci maka Kode Barang tidak bisa diubah
apabila sudah ada transaksi yang terkait dengannya. Isikan Kode Barang
maksimal 15 karakter. Anda bebas apakah menggunakan huruf
CAPITAL, huruf kecil atau kombinasinya tetapi lazimnya Kode Barang
menggunakan huruf CAPITAL, untuk mempermudah hal ini anda bisa
memanfaatkan bantuan Setup Preferensi yaitu dengan mengaktifkan opsi
“Kode Barang menggunakan huruf CAPITAL”, maka apa yang anda
ketikkan pada filed ini akan dikonversi ke huruf CAPITAL sekalipun
anda tidak mengaktifkan tombol Caps Lock pada keyboard.

8 wasiersareng & oo S ==
Pa 1t me

KodeBarang  GT-90V Edit Kode Barang W p[pl]  [Menskst
Nama Barang \5PS Tracker GT-50V
Kategori Inventory Grup  GPS TRACKER -
Umum I Informasi Tambahan | Akun-Akun | Catatan
| Satuan Inventory dan Saldo
| Satuan Inventory [ Unit 7)) Stock Minimum 0 |
Saldo [ 1 unt Jumlah Recrder 0
Harga Beli Terakhir lm Tal. Beli Terakhir W

|
Satuan Transaksi dan Harga Jual |
|
|

Konversike Sat. |y oo torakhic | W, Jual1 | H.Jusl2 H.Judl4 | Houals
Inventory
Lounit = 1 600.000
2, Box 0 12,000,000

3.

Anda bisa memasukkan sampai 5 jenis (skema) H. Jual, kemudian untuk setiap Customer dapat dikenakan skema H.
Jual tertentu

| e | [feen | Ko Ko |

Edit Kode Barang : checkbox ini hanya aktif pada modus Edit dan hanya
jika Kode Barang yang bersangkutan belum terpakai pada transaksi atau
modul lain. Gunanya adalah apabila dicentang maka artinya anda
memberitahukan kepada program bahwa anda ingin mengedit atau
merubah Kode Barang tersebut. Apabila anda tidak mencentang
checkbox ini apa yang anda input pada field Kode Barang akan dianggap
oleh program sebagai menambah Kode Barang baru apabila Kode Barang
tersebut belum ada atau menampilkan data barang tertentu apabila Kode

Barang tersebut sudah ada.
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e Nama Barang : isi deskripsi atau nama barang maksimal 40 karakter.

e Kategori : pilih kategorinya dengan klik pada field ini atau tombol drop-
down yang ada. Ada 3 macam kategori barang yaitu Inventory, Non
Inventory dan Jasa. Segala macam barang yang anda inginkan ada
pengontrolan terhadap stok atau kuantitasnya harus anda kategorikan
Inventory. Dengan demikian setiap ada transaksi terkait barang jenis ini
program selalu akan memeriksa ketersediaan dan mengupdate stoknya.
Non Inventory adalah segala jenis barang yang tidak diperlukan
pengontrolan terhadap stok atau kuantitasnya, dengan demikian
transaksi terkait barang jenis ini tidak memerlukan ketersediaan ataupun
menambah kuantitasnya, program hanya akan mengupdate saldo akun
terkait barang bersangkutan. Demikian juga dengan Jasa, bedanya adalah
Jasa dikhususkan untuk servis yang diberikan kepada customer sehingga
item barang dengan kategori ini tidak bisa digunakan pada transaksi
pembelian, untuk jasa yang didapatkan dari Supplier anda harus
mengkategorikannya sebagai Non Inventory.

e  Setelah ada transaksi terkait item barang tertentu maka anda tidak bisa
lagi merubah kategorinya, karena field ini akan dinonaktifkan oleh
program, oleh karena itu tentukanlah kategori secara cermat.

e Grup : untuk setiap item barang harus ditentukan kelompok barangnya,
untuk itu pilih grupnya dengan klik pada field ini atau tombol drop-
down yang ada. Bila ingin menambah grup baru pilih < New >, maka
form Kelompok (Grup) Barang akan ditampilkan.

Tab Satuan dan Stock :

e Satuan Inventory : satuan yang digunakan sebagai dasar dalam
menentukan saldo barang. Misalnya suatu barang berkemungkinan
ditransaksikan dalam satuan Pcs dan juga satuan Lsn dimana 1 Lsn = 12
Pcs, maka anda harus menetapkan Pcs sebagai satuan Inventory sehingga
saldo barang akan selalu dikonversikan kedalam satuan Pcs. Seandainya
Lsn yang dijadikan sebagai satuan Inventory dan ada transaksi dalam
Pcs sebesar 5 Pcs maka saldo barang akan bertambah atau berkurang
sebesar 5/12 Lsn. Dari gambaran ini, maka intinya adalah sebagai Satuan
Inventory harus merupakan satuan terkecil diantara satuan yang ada
untuk item barang bersangkutan.
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Pilih Satuan Inventory dari daftar satuan yang telah anda input
sebelumnya ke Tabel Satuan dengan melakukan klik pada field ini atau
tombol drop-down yang ada, pilih < New > jika ingin menambah satuan
baru, maka form Tabel Satuan akan ditampilkan.
Pertimbangkan dengan seksama dalam menentukan satuan Inventory,
jangan sampai di kemudian hari ada transaksi dengan satuan yang lebih
kecil dari Satuan Inventory yang telah anda tetapkan karena apabila item
barang ini sudah terpakai pada transaksi atau modul lain maka Satuan
Inventory tidak bisa diubah lagi karena field ini akan dalam keadaan non
aktif.
Valuta : default valuta adalah Rp. (Karena fitur Multi currency tidak tersedia
pada varian Accpro Trada dan Strada tidak ada pilihan Valuta lain).
Stock Minimum : field ini bersifat optional artinya anda bisa mengisinya
jika diperlukan, isi sebesar jumlah minimum saldo barang dalam Satuan
Inventory sebagai dasar dalam melakukan pemesanan barang atau
penambahan stok.
Saldo : field ini menampilkan saldo barang terkini.
Harga Beli Terakhir : menampilkan harga pembelian terakhir per unit
Satuan Inventory.
Pada Tanggal : menampilkan tanggal beli terakhir.
Satuan Transaksi : dimungkinkan sampai dengan 3 jenis satuan untuk
setiap item barang tertentu, satu diantaranya adalah Satuan Inventory
yang telah anda tetapkan di atas, akan menempati baris pertama dari
tabel ini, oleh karena itu kolom satuan dan konversi pada baris pertama
tidak bisa diedit. Apabila perlu menambahkan satuan baru maka
gunakan baris kedua dan ketiga.

#  Satuan : pilih satuannya dengan klik pada tombol drop-down yang
ada pada kolom ini.

3 Konversi ke Sat. Inventory : isi konversi dari satuan ini ke Satuan
Inventory, contohnya kalau Satuan Inventory = Pcs dan satuan
tambahan ini adalah Lsn dan 1 Lsn = 12 Pcs, maka isi dengan 12,
dengan catatan konversi harus > 1.

z  H. Beli Terakhir : kolom ini bukan untuk diisi oleh user tetapi akan
menampilkan harga beli terakhir setelah dikonversikan (sesuai
satuan pada kolom Satuan).

z+ H.Jual 1, H. Jual 2, H. Jual 3, H, Jual 4, H. Jual 5 : kelima kolom ini
dapat anda gunakan untuk mengisikan sampai dengan 5 jenis harga
satuan yang berbeda dikaitkan satuan pada kolom Satuan.
Implementasinya nanti pada saat anda menentukan skema harga
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jual untuk masing-masing customer. Mungkin ada customer yang
dikenakan skema H. Jual 1, maka untuk cusomer tersebut berlaku
harga jual yang telah anda tentukan pada kolom H. Jual 1 tersebut
untuk keseluruhan item barang yang ada, demikian seterusnya.

Tab Nama Lain :

e Supplier Utama : untuk keperluan dokumentasi, anda bisa memasukkan
nama supplier utama untuk item barang tertentu dengan klik pada
tombol drop-down yang ada untuk memilih suppliernya.

¢ Nama Lain : untuk kepentingan pemesanan ke supplier, bisa jadi Kode
Barang dan juga Nama Barang berbeda maka anda bisa memasukkan
kode dan nama lain itu disini sehingga memudahkan pada saat membuat
PO cukup memilih dari daftar ini. Sedangkan untuk kepentingan
penjualan, bisa jadi Nama Barang berbeda tergantung customernya atau
ada variannya walaupun secara internal item barangnya tidak
dibedakan, maka anda bisa memasukkan Nama Lain untuk keperluan
ini. Namun untuk kepentingan penjualan hanya Nama Barang yang bisa
berbeda.

3 Kode Barang : hanya perlu diisi jika ada kode lain untuk item
barang ini dalam kaitannya dengan pemesanan ke Supplier.

# Nama Barang : hanya perlu diisi jika ada nama lain untuk item
barang ini dalam kaitannya dengan pemesanan ke supplier atau
untuk kepentingan penjualan.

Tab Akun-akun:

Akun-akun untuk kepentingan penjurnalan otomatis oleh program ketika
terjadi transaksi, akan otomatis terisi sesuai dengan yang telah ditetapkan
sebagai akun default untuk Kelompok (Grup) Barang yang telah anda
tentukan pada field Grup diatas. Namun anda masih bisa membedakannya
lagi secara spesifik apabila diperlukan, namun pertimbangkanlah urgensinya
melakukan hal ini.

Tab Assembly :

Tab ini tidak ada pada varian Accpro Trada dan Strada karena fasilitas
Assembling tidak tersedia pada varian ini.
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Tab Gambar:

Tab ini juga tidak ada pada varian Accpro Trada dan Strada, gunanya untuk
menentukan dan memasukkan gambar barang untuk barang tertentu.

Tab Catatan :

Untuk keperluan dokumentasi anda bisa memasukkan catatan atau deskripsi
yang lebih lengkap mengenai item barang tertentu.

¢ Tombol Save : menyimpan perubahan atau penambahan data.

e Tombol New : untuk menambah data baru.

e Tombol Search : apabila ingin mencari item barang tertentu, klik tombol
ini maka form Lookup Barang akan ditampilkan.

¢ Tombol Delete : menghapus item barang tertentu

e Tombol Cancel : membatalkan perubahan atau penambahan data.
Tombol ini hanya aktif pada modus Add, sedangkan pada modus Edit
hanya apabila memang ada wupaya perubahan atas data yang
ditampilkan. Sekedar mengklik tombol drop-down pada combobox
sudah ditafsirkan sebagai ada upaya untuk merubah data, maka tombol
ini akan aktif.

¢ Tombol navigasi : untuk berpindah dari record satu ke record lainnya.
Tombol ini hanya aktif pada modus Edit.

e Tombol kd: menutup form ini.

4.3.12 Item Pembelian

(Untuk varian Accpro Trada karena fasilitas Pembelian Lain-lain tidak tersedia, maka
menu dan modul untuk input Item Pembelian tidak diperlukan oleh karena itu tidak
disediakan. Fasilitas Pembelian Lain-lain tersedia pada varian Accpro Strada dan

Accpro Spectra)

Tabel ini akan terupdate dengan sendirinya tanpa anda harus
menambahkannya secara manual. Setiap kali anda membuat transaksi

pembelian lain-lain melalui modul pembelian dan transaksi disimpan, maka
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item pembelian pada transaksi tersebut yang belum ada pada tabel Item
Pembelian akan otomatis ditambahkan. Jadi pada dasarnya anda tidak perlu
mengupdate tabel ini secara manual, namun tetap saja anda boleh
menambahkan item pembelian yang mungkin akan seringkali anda gunakan
untuk memudahkan sehingga pada saat membuat transaksi pembelian lain-

lain tinggal memilih dari daftar yang ada.

Tabel ini bisa anda abaikan atau lewati jika anda tidak memerlukan transaksi
Pembelian Lain-lain. Transaksi Pembelian Lain-lain sendiri dimaksudkan
sebagai pembelian menyangkut item yang bukan merupakan barang dagang
tetapi karena pembeliannya secara kredit maka timbul Hutang dan anda
menginginkan Hutang ini tidak sekedar bisa dilihat pada Buku Besar
(Ledger) tetapi juga mempunyai Kartu Hutang dan dapat dianalisa umur
hutangnya atau ada Laporan Umur Hutangnya. Alasan lainnya adalah
biarpun bukan pembelian kredit tetapi anda menginginkan item pembelian
bersangkutan dapat diketahui jejak pembeliannya melalui laporan pembelian.
Lazimnya pembelian semacam ini cukup dijurnal melalui Jurnal Umum atau
Pengeluaran Kas/Bank, namun apabila hanya melalui penjurnalan maka
hanya dapat dijejaki melalui Laporan Ledger (Buku Besar), tidak ada laporan
pembelian yang merinci item pembelian tersebut dan apabila timbul hutang
maka tidak ada kartu hutang dan analisa umur hutangnya, tambahan lagi
apabila dijurnal secara manual anda tidak bisa menggunakan akun Hutang
Dagang yang telah dijadikan sebagai akun default Hutang Dagang dimana
digunakan oleh program untuk penjurnalan secara otomatis, artinya anda
harus memiliki akun hutang tersendiri diluar akun hutang yang dijadikan
akun default Hutang Dagang, lazimnya adalah akun Hutang Lain-lain atau
Hutang Dagang Lain-lain. Sedangkan kalau diinput sebagai transaksi
pembelian biasa (bukan Pembelian Lain-lain) maka anda harus membuatkan
Kode Barangnya (dengan kategori Non Inventory) pada Master Barang &
Jasa, tambahan lagi transaksi pembelian jenis ini (bukan Pembelian Lain-lain)
sebenarnya hanya dimaksudkan untuk yang berkenaan dengan barang
dagang, demikian juga Master Barang & Jasa. Bayangkan kalau setiap item

pembelian yang mungkin sifatnya hanya insidentil (sesekali atau mungkin
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hanya sekali) dimasukkan ke dalam Master Barang & Jasa, maka akan sangat
banyak, demikian juga kurang relevan karena bukan barang dagang.

Kegunaan lain dari tabel Item Pembelian adalah apabila anda perlu
menerbitkan PO (Purchase Order) terkait pembelian yang bukan merupakan
barang dagang, dalam hal ini disebut sebagai PO Lain-lain. Jadi PO Lain-lain
dan Pembelian Lain-lain diadakan untuk user yang memerlukannya, anda

bisa mengabaikannya apabila tidak memerlukannya.

Untuk mengakses modul ini pilih menu Master Data > Item Lain-lain > Item

Pembelian.

£ Tabel ltem Pembelian - Non Inventory SRR — o)

Tabel ini digunakan untuk memasukkan Item Pembelian yang bukan berupa barang Inventory, artinya tidak ada (tidak diperlukan) pengontrolan
terhadap Stock atau Saldo, demikian juga tidak diperlukan adanya Kode Barang. Iskan Deskripsi Itemnya, kemudian pilih dari Account yang sudah
anda input ke tabel Account ataukan tambahkan lebih dulu ke tabel Account bila belum ada dengan mengklik tombol New Account

Item Pembelian

L -
'8 Laptop LENOVO G40-30 02-01-01-000 Inventaris Kantor |:‘
A Mesin Fotocopy IR-5600 w | [nventaris Kantor Unit :
Mo Perkiraan Nama Perkiraan
Inventaris Kantor
| 02-01-02-000 Akumulasi Penyusutss Inventaris Kantor |
02-02-01-000 Kendaraan El
| 02-02-02-000 Akumulasi Penyusutan Kendaraan | |
02-03-01-000 Bangunan
| 02-03-02-000 Akumulasi Penyusutan Bangunan |
03-01-01-000 Hutang Dagang
03-01-02-000 Hutang Dagang Belum Ditagih |
03-02-01-000 Hutang PPh 21
03-02-02-000 Hutang PPh 22 |
03-02-03-000 Hutang PPh 23
03-02-04-000 Hutang PPh Final Ps. 4 Ayat 2
03-02-05-000 Hutang PPh 25 = o

=5 New Aoccu; wgeleh; ‘ @ﬁava_ | ‘ L] Qanc; | |

e  Deskripsi : Ketikkan deskripsi item pembelian.

¢ No. Perk : tentukan Nomor Perkiraan terkait item pembelian dimaksud.
Caranya ketikkan secara langsung atau klik tombol drop-downnya,
daftar perkiraan akan ditampilkan oleh program untuk memudahkan
anda dalam memilih Nomor Perkiraan yang dimaksud..

e Nama Perkiraan : otomatis terisi Nama Perkiraannya setelah anda
menentukan Nomor Perkiraannya. Tetapi anda juga bisa menggunakan
kolom ini untuk menentukan perkiraannya, selain melalui kolom No.

Perk. Caranya ketikkan potongan awal Nama Perkiraannya atau klik
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tombol drop-downnya, maka daftar perkiraan akan ditampilkan oleh
program menurut urutan Nama Perkiraannya.

e Satuan : Ketikkan satuannya jika ada. Karena tabel ini adalah
menyangkut item pembelian yang merupakan barang Non Inventory,
anda bebas menentukan satuannya tanpa terikat ataupun memerlukan
adanya tabel Satuan. Pengertian barang Non Inventory sendiri diartikan
sebagai barang yang tidak dikenakan (baik karena tidak bisa atau tidak
diperlukan) pengontrolan terhadap saldo barang dari sisi kuantitas.

¢ Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

¢  Tombol Delete : menghapus data pada baris tertentu.

¢ Tombol New Account : apabila Nomor Perkiraan yang dikehendaki
belum ada, klik tombol ini untuk menambahkan akun baru ke Chart of
Account.

e Tombol :menutup form ini.

4.3.13 Item Penjualan

(Seperti hainya Item Pembelian, untuk varian Accpro Trada karena fasilitas
Penjualan Lain-lain tidak tersedia, maka menu dan modul untuk input Item
Penjualan tidak diperlukan oleh karena itu tidak disediakan. Fasilitas Penjualan Lain-

lain tersedia pada varian Accpro Strada dan Accpro Spectra)

Seperti halnya Item Pembelian, tabel ini akan terupdate dengan sendirinya
tanpa anda harus menambahkannya secara manual. Setiap kali anda
membuat transaksi penjualan lain-lain melalui modul penjualan dan transaksi
disimpan, maka item penjualan pada transaksi tersebut yang belum ada pada
tabel Item Penjualan akan otomatis ditambahkan. Jadi pada dasarnya anda
tidak perlu mengupdate tabel ini secara manual. Namun karena biasanya
item penjualan sudah diketahui secara pasti, ada baiknya anda

menambahkannya lebih dulu ke tabel Item Penjualan ini sehingga
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memudahkan pada saat membuat transaksi penjualan, tidak perlu lagi
mengetikkan keseluruhan deskripsi item, tinggal memilih dari daftar yang

ada.

Seperti halnya Item Pembelian maka tabel Item Penjualan dimaksudkan
untuk mengakomodasi Penjualan Lain-lain artinya penjualan yang tidak
terkait barang dagang yang ada di Master Barang & Jasa. Penjualan jenis ini
tidak memerlukan adanya Kode Barang, dengan demikian juga tidak
mengupdate stok, artinya khusus untuk barang non inventory atau jasa.
Apabila anda tidak memerlukan Penjualan Lain-lain, maka modul ini bisa

diabaikan.

Untuk mengakses modul ini pilih menu Master Data > Item Lain-lain > Item

Penjualan.

Tabel Item Penjualan - Non I - u
L]

Tabel ini digunakan untuk memasukkan Item Pembelian yang bukan berupa barang Inventory, artinya tidak ada (tidak diperlukan) pengontrolan
terhadap Stock atau Saldo, demikian juga tidak diperlukan adanya Kode Barang. Isikan Deskripsi Itemnya, kemudian pilih dari Account yang sudah
anda input ke tabel Account ataukan tambahkan lebih dulu ke tabel Account bila belum ada dengan mengklik tombol New Account

Item Penjualan

L -
"1} Perpanjangan web tracking selama 1 tahun - | Jasa Web Monitoring Unit |:
Z Mo Perkiraan Nama Perkiraan 3
3. 05-02-01-000 Jasa Web Monitoring I
4, 05-02-02-000 Jasa Pemasangan k
| & 05-02-03-000 Jasa Perbaikan |
G 06-01-00-000 Harga Pokok Penjualan
| = 07-01-01-000 Biaya Gaji |
Z 07-01-02-000 THR E
1 07-01-03-000 Bonus = |
9. 07-01-04-000 Honorarium (Jasa Profesional)
| 0. 07-01-05-000 Tunjangan Kesehatan |
11, 07-01-06-000 Tunjangan Transport
1z, 07-01-07-000 Tunjangan Uang Makan I
13, 07-01-08-000 Biaya Transportasi
= 07-01-09-000 Biaya Bahan Bakar - |

“F New Acmu; xgﬂet; | E]gave_ | | 5 Eanc; | |

e Deskripsi : Ketikkan deskripsi item penjualan.

¢ No. Perk : tentukan Nomor Perkiraan terkait item penjualan dimaksud.
Caranya ketikkan secara langsung atau klik tombol drop-downnya,
daftar perkiraan akan ditampilkan oleh program untuk memudahkan

anda dalam memilih Nomor Perkiraan yang dimaksud.
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e Nama Perkiraan : otomatis terisi Nama Perkiraannya setelah anda
menentukan Nomor Perkiraannya. Tetapi anda juga bisa menggunakan
kolom ini untuk menentukan perkiraannya, selain melalui kolom No.
Perk. Caranya ketikkan potongan awal Nama Perkiraannya atau klik
tombol drop-downnya, maka daftar perkiraan akan ditampilkan oleh
program menurut urutan Nama Perkiraannya.

e Satuan : Ketikkan satuannya jika ada. Karena tabel ini adalah
menyangkut item penjualan yang merupakan barang Non Inventory atau
Jasa, anda bebas menentukan satuannya tanpa terikat ataupun
memerlukan adanya tabel Satuan. Pengertian barang Non Inventory
sendiri diartikan sebagai barang yang tidak dikenakan (baik karena tidak
bisa atau tidak diperlukan) pengontrolan terhadap saldo barang dari sisi
kuantitas.

¢ Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

¢ Tombol Delete : menghapus data pada baris tertentu.

¢ Tombol New Account : apabila Nomor Perkiraan yang dikehendaki
belum ada, klik tombol ini untuk menambahkan akun baru ke Chart of
Account.

e Tombol : menutup form ini.

4.3.14 Saldo Awal G/L

Setelah Chart of Account selesai dibuat, barulah Saldo Awal G/L bisa diisi.
Saldo Awal G/L merupakan saldo terakhir akun-akun pada buku besar (G/L)
untuk periode (bulan) transaksi sebelum pemakaian Accpro. Apabila anda
mulai menggunakan Accpro pada bulan Januari, anda bisa tidak mengisi
saldo awal untuk akun-akun biaya dan pendapatan dengan
mengakumulasikan saldonya sebagai Laba (Rugi) Ditahan.
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Untuk membuka modul atau form ini, pilih menu Master Data > Saldo Awal
G/L.

e No. Perkiraan, Nama Perkiraan, Valuta : ditampilkan sesuai dengan
akun-akun detail pada Chart of Account yang anda buat, jadi disini anda
tidak bisa mengedit perkiraan, apabila ingin mengeditnya adalah melalui
modul Chart of Account.

e Saldo Awal (Rp) : karena untuk varian Accpro Trada dan Strada tidak
ada fasilitas multi currency, maka otomatis Saldo Awal adalah dalam Rp.

H
Close
No. Perkiraan Nama Perkiraan Saldo Awal (Rp) .
01-01-01-000  Kas Kedl [500. 000
01-0201-000  Bank ABC 65,750,000 =
01-0202-000  Bank BCD 500.375.000 ‘ Clsave ‘
01-03-01-001  Piutang Dagang 311.963.437
01-03-02-001  Piutang Giro
01-0401-000  Persediaan Barang Dagang 272.500.000 ‘ ¥5 cancel ‘
01-0501-001  Asuransi Dibayar Dimuka A
01-0501-005  Sewa Dibayar Dimuka 50.000.000 |~
01-05-02-001  Uang Muka PPh 21 ‘ = preview ‘

01-0502-002  Uang Muka PPh 22

01-05-02-003  Uang Muka PPh 23 Untuk Hutang Usaha, Piutang Usaha dan Persedizan, pastikan nilai

01-0502-004  Uang Muka PPh 25 yang anda input adalh sesuai dengan masing-masing total nilai yana
01-0503-000  Uang Muka Pembelian anda input melalui Saldo Awal Hutang, Piutang dan Inventary
02-01-01-000  Inventaris Kantor 22.150.000 ||

02-01-02-000  Akumulasi Penyusutan Inventaris Kantor -12.997.917

02-0201-000  Kendaraan 628,000,000

02-0202-000  Akumulasi Penyusutan Kendaraan -182.583.333

02-03-01-000 Bangunan Tips  Anda harus menginput semua saldo akhir Account G/L
02-03-02-000  Akumulasi Penyusutan Bangunan . periode bulan terakhir sebelum pemakaizn software in
03-01-01-000 Hutang Dagang 275.000.000 ‘J sebagai saldo Awal G/L untuk apikasi Accpro.
03-01-02-000  Hutang Dagang Belum Ditagih

03-02-01-000  Hutang PPh 21

03-0202-000  Hutang PPh 22
03-0203-000  Hutang PPh 23
03-0204-000  Hutang PPh Final Ps. 4 Ayat 2 Desember
03-0205-000  Hutang PPh 25 :
03-0206-000  Hutang PPh 29 .
03-03-01-000 PPN Masukan 25.000.000 ‘ £} 5et saldo ‘
03-03-02-000 PPN Keluaran 28.360.312
03-0401-000  Uang Muka Penjualan

Saldo Awal G/L ini merupakan saldo akhir periode bulan

C 1=
Tahun 014 =i

030501000 Hutang Giro

030502000 Hutang Gaji Set Saldo

030503000 Hutang Bark apabila znda teizh
03-0504-000  Hutang Angsuran Kendaraan 236,724.940 aldo Awal LGl anda baru bisa mulai
03-05-10-000  Hutang Biaya Laindain L 2 e
040100000 Setoran Modal 500.000.000

040200000 Laba (Rugi) Ditshan 371.732.747

Pastikan anda menginput semua akun-akun yang sampai dengan bulan

terakhir sebelum pemakaian Accpro masih mempunyai saldo. Apabila

neraca belum balance, maka pada baris terakhir (footer) dari tabel ini

akan ditampilkan Total Aktiva, Total Passiva dan selisihnya, sedangkan
P g F e Pl G A A AP T V) W Tl
03-02-03-000  Hutang PPh 23

03-02-04-000  Hutang PPh Final Ps. 4 Ayat 2
03-02-05-000 Hutang FPh 25

Total Pa 8 sib  Rp -3.000,000



apabila sudah balance maka tidak ditampilkan. Anda bisa saja
melanjutkan ke tahap berikutnya, yaitu mulai membuka periode awal
agar bisa mulai melakukan input transaksi walaupun neraca belum
balance, artinya saldo awal G/L bisa dilengkapi sambil jalan dengan
konsekwensi neraca belum balance. Sedangkan apabila anda mulai
menggunakan Accpro tidak dari bulan Januari, maka selain akun-akun
Neraca, anda juga harus input saldo akun-akun Laba Rugi, yaitu
PN G TV E T AETEA AT ATl w
03-02-04-000  Hutang PPh Final Ps. 4 Ayat 2

03-02-05-000 Hutang PPh 25
03-02-06-000

L/R Berjalan : Rp 603,458,000 Selisih @ Rp 46,929,000

Pendapatan dan Biaya. Selisih akumulasi saldo akun-akun pendapatan
dan biaya harus sama dengan saldo laba Rugi Berjalan yaitu saldo akun
Laba Rugi Tahun Berjalan ditambah saldo akun Laba Rugi Bulan
Berjalan, bila tidak, maka pada baris terakhir (footer) akan ditampilkan
informasi adanya selisih ini. Akumulasi saldo akun-akun Pendapatan
dan Biaya akan ditampilkan pada baris footer sebagai Rev. — Exp,
sedangkan sedangkan Laba Rugi Berjalan akan ditampilkan sebagai L/R
Berjalan.

e Saldo Awal G/L ini merupakan saldo akhir periode bulan : field bulan
dan tahun yang menunjukkan periode sebelum pemakaian Accpro.
Selama anda belum melakukan proses awal bulan untuk pertama
kalinya, field ini masih bisa diubah, namun apabila anda sudah
melakukan itu maka kedua field ini akan dinonaktifkan oleh program.
Bila pada saat anda membuat database baik pada saat melakukan Setup
Accpro Trada atau Strada maupun jika anda membuat database baru
melalui menu File > Buat Data Baru, anda diminta untuk menentukan
periode awal (bulan dan tahun) anda akan mulai menggunakan
Accpro, maka pada field ini akan ditampilkan sebagai periode akhir
sebelum pemakaian Accpro, jadi satu periode sebelumnya. Jika anda
ingin menggunakan Accpro mulai bulan Januari 2015 maka field ini akan

berisi Desember 2014, jadi jangan sampai keliru menafsirkannya, anda
harus cermat dan berhati-hati menyangkut field ini karena jika proses
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awal bulan telah dilakukan untuk pertama kalinya melalui menu Utilitas
> Proses Awal Bulan maka field ini tidak bisa lagi diedit.

Tombol Save : untuk menyimpan keseluruhan perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan perubahan yang belum disimpan.
Tombol Preview : menampilkan Laporan Saldo Awal G/L ke layar untuk
selanjutnya bisa dicetak.

Tombol Set Saldo : hanya mengklik tombol Save saja belum berarti anda
telah melakukan Set Saldo awal. Proses ini hanya perlu dan harus
dilakukan sebelum anda melakukan Proses Awal Bulan untuk pertama
kalinya, artinya anda juga tidak perlu (walaupun boleh) melakukan

proses ini tiap kali anda menyimpan perubahan yang anda lakukan.
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4.3.15 Saldo Awal Inventory

Barang dengan kategori Inventory yang memiliki saldo pada saat awal
pemakaian Accpro harus diinput sebagai Saldo Awal Inventory melalui

modul ini.

Untuk membuka modul ini, pilih menu Master Data > Saldo Awal Inventory.

GPS Navigasi GN-333 Inventory GPS MAVIGAST
GPS Navigasi GN-333X Inventory GPS MAVIGAST unit
GPS Tracker GT-30V Inventory GPS TRACKER
T = = S
Free langganan web tracking Jasa
Free Jasa Pemasangan Jasa
o KP-01 Kartu Perdana Inventory OTHERS Pcs
o VCH-250 Pulsa 250 ribu Inventory OTHERS Unit
o VN-50E GPS Navigasi VN-50E Inventory GPS MAVIGAST unit

Unfiltered Total Saldo A

Saldo Awal
GT-90X - GPS Tracker GT-90X

wal :272.500.000

Kode Barang :

200,000,000

Daftar Barang akan ditampilkan, posisikan kursor pada barang Inventory
yang ingin diinput saldo awalnya, kemudian klik tombol Saldo Awal.
Selanjutnya anda tinggal mengisi saldo Awal wuntuk item barang
bersangkutan, hanya item barang dengan kategori Inventory yang bisa
diinput saldo awalnya. Agar memudahkan, anda bisa melakukan filter lebih
dulu agar hanya barang dengan kategori Inventory yang ditampilkan, untuk
itu klik tombol Filter. Apabila fitur Multi Gudang pada Setup Preferensi
diaktifkan, maka sebelum anda mengklik tombol Saldo Awal, anda harus
memilih gudangnya lebih dulu melalui field Gudang. Jadi saldo awal harus
diinput berdasarkan saldo pada masing-masing gudang. Fitur Multi Gudang

tidak tersedia pada varian Accpro Trada dan Strada, maka anda langsung
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bisa input saldo awalnya tanpa harus memilih gudangnya lebih dulu. Setelah
anda mengisi saldo awal dan menyimpannya, anda tinggal mengarahkan
atau memindahkan kursor pada baris lainnya pada daftar barang untuk diisi
saldo awalnya, jadi tidak perlu lagi mengklik tombol Saldo Awal, mengklik
Saldo Awal kembeali justru diartikan sebagai menutup panel atau tabel Saldo
Awal.

¢ Quantity : isi kuantitas atau saldo barangnya.

e Satuan : setelah anda mengisi kuantitasnya maka apabila satuan untuk
barang bersangkutan hanya ada satu jenis satuan, maka kolom ini akan
terisi dengan sendirinya, tetapi kalau satuannya ada lebih dari satu,
maka anda harus memilih satuannya dengan klik tombol drop-down
yang ada pada kolom ini.

e Harga Satuan : isi harga satuannya sesuai satuan pada kolom Satuan,
artinya kalau pada kolom Satuan adalah Pcs maka isilah dengan harga 1
Pcs. Apabila dengan alasan tertentu harga satuan tidak ada maka anda
harus memberitahukannya secara eksplisit kepada program dengan
mengisinya dengan angka 0 (nol).

e Nilai : kolom ini terisi dengan sendirinya sesuai hasil perkalian kolom
quantity dan harga satuan

¢ Tombol Insert Row : setiap item barang bisa jadi mempunyai lebih dari
satu baris data saldo awal khususnya kalau metode harga pokok
penjualan yang digunakan adalah FIFO, maka bisa ada variasi harga
satuannya. Sejalan dengan hal ini, apabila anda perlu menyelipkan baris
baru diantara baris data yang sudah ada, klik tombol ini.

¢ Tombol Delete Row : menghapus baris data tertentu.

e Tombol Save : untuk menyimpan penambahan data atau perubahan
yang telah dilakukan.

e Tombol Cancel : membatalkan perubahan atau penambahan data.

Setiap kali anda selesai melakukan penambahan atau perubahan saldo awal,
maka program akan menampilkan total saldo awal untuk keseluruhan barang
(inventory) yang ditampilkan pada baris footer dari tabel Daftar Barang
diatasnya. Mestinya pada akhirnya setelah semua barang telah diinput saldo

awalnya maka nilai ini akan sama dengan saldo akun persediaan barang
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dagang yang anda input melalui modul Saldo Awal G/L. Demi alasan
fleksibilitas, untuk data saldo awal, Accpro tidak secara otomatis mengupdate
saldo awal akun Persediaan pada buku besar (G/L), tetapi apabila ada
perbedaan antara saldo akun Persediaan yang mungkin telah anda input atau
mungkin belum anda input melalui modul Saldo Awal G/L, program akan
menampilkan tombol Update Saldo Awal G/L. Apabila anda ingin
menyamakan saldo awal akun Persediaan pada buku besar dengan nilai
persediaan menurut perincian saldo awal barangnya, maka anda bisa
mengklik tombol ini. Apabila anda memerlukan laporan saldo awal barang
yang telah anda input, anda bisa melihatnya melalui menu Laporan >
Laporan Saldo Barang & Kartu Stock > Laporan Saldo Barang, isi tanggalnya
dengan tanggal akhir periode sebelum pemakaian Accpro, apabila anda ingin
mengetahui saldo awal per kelompok barang maka aktifkan opsi

Kelompokkan menurut Grupnya.

Catatan :

Apabila program mendeteksi ada upaya untuk menambah data saldo
awal atau melakukan pengeditan maka obyek lain diluar area saldo awal
akan dikunci oleh program, oleh karena itu anda harus menyimpan
peng-update-an yang anda lakukan atau membatalkannya lebih dulu
dengan mengklik tombol Save atau Cancel untuk membebaskan
penguncian sehingga area tersebut bisa diakses kembali.

4.3.16 Saldo Awal Hutang/ Piutang/Sub Ledger

Invoice-invoice yang masih outstanding (belum lunas) pada saat awal
pemakaian Accpro, baik pembelian maupun penjualan harus diinput sebagai
Saldo Awal Hutang / Piutang melalui modul ini. Demikian juga apabila ada
akun tertentu pada Chart of Account yang penting (ada urgensinya) bagi
anda untuk mengetahui sub ledgernya terkait Supplier, Customer atau Other
Contact tertentu dan ada saldo awalnya pada periode sebelum pemakaian
Accpro harus diinput sebagai Saldo Awal Sub Ledger untuk contact tersebut,
misalnya Uang Muka Pembelian atau Uang Muka Penjualan, Piutang

Karyawan, Hutang Direksi, dll.
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Untuk membuka modul ini, pilih menu Master Data > Saldo Awal
Hutang/Piutang/Sub Ledger. Selanjutnya posisikan kursor pada baris dimana

supplier atau customer yang ingin diinput saldo awalnya, kemudian klik
tombol Saldo Awal.

DAL Gon EaGE
Hama Pengenal

Jakarta Utara
Pekanbaru
Jakarta Pusat
Surabaya

SEJAHTERA
PT. IMPERIAL RODA PERKASA Jkarta Selatan

o JAYA ABADI CV. JAYA ABADL Jakarta Barat Net 7 Supplier
o KAS NEGARA KAS NEGARA Jekarta Barat Others

@ MITRA FINANCE PT. MITRA FINANCE Jskarta Selatan Others.

@ PANCA MITRA PT. PANCA MITRA Jakarta Barat Supplier
o PRIMA TRAVEL CV. RODA PRIMA SAKTT Jakarta Timur Net 14 Customer
o RAJAWALT PERKASA PT. RAJAWALI PERKASA Makassar Net 30 Customer
o SEMESTA GPS PT. SEMESTA GPS Bandar Lampung Net 30 Customer

Unfiltered JmlData : 14

Saldo Awal
Customer : ERA BARU SOLUSINDO

Piutang

No. Invoice Tgl. Invoice OF Fiutang Tersisa

1. INV-14,000302 09 Desember 2014 Net 30 Rp 1,00 27.063.437 |

2. INV-14.000304 15 Desember 2014 Net 30
3
4
5.

g

1,00 61.600.000

« i ] v

Delete Row Total Salda Awal AR : Rp 311.963.437 Total: Rp. 88.663.437
Total Saldo Awal G : Rp 311563437

Tab Hutang atau Tab Piutang

¢ No. Invoice : isi kolom ini dengan nomor Invoice yang belum lunas.

e Tgl. Invoice : isi tanggal Invoicenya dengan format dd/mm/yy (tgl-bln-
thn) masing-masing 2 digit atau klik tombol drop-down pada kolom ini
untuk memunculkan kalender sehingga tinggal dipilih tanggalnya.
Tanggal Invoice harus di bawah tanggal awal pemakaian Accpro, artinya
hanya invoice yang timbul sebelum itu yang perlu diinput sebagai saldo
awal sedangkan invoice yang timbul setelah itu harus diinput sebagai
transaksi pembelian atau penjualan melalui modul terkait.

e No. PO : apabila ada No. POnya maka bisa diisi.
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o  Terms : tentukan Terms of Paymentnya dengan mengklik tombol drop-
down pada kolom ini untuk memilih dari daftar yang muncul.

e Curr : untuk varian Accpro Trada dan Strada otomatis valutanya adalah
Rp dan tidak ada pilihan valuta lain.

e  Kurs: untuk varian Accpro Trada dan Strada otomatis kursnya adalah 1.

e DPiutang Tersisa atau Hutang Tersisa : isi nominal piutang atau hutang
tersisa, jadi belum tentu sama dengan nilai Invoice apabila Invoice telah
dilunasi sebagian.

e Total Saldo Awal A/P atau Total Saldo Awal A/R : menunjukkan jumlah
total saldo awal Hutang / Piutang yang telah anda input untuk kesemua
supplier / customer yang ada. Seperti telah dikemukakan di atas,
penginputan saldo awal Hutang / Piutang tidak akan otomatis
mengupdate saldo awal G/L untuk Hutang / Piutang, tetapi akan ada
tombol Update Saldo Awal G/L apabila ada perbedaan nilainya dengan
saldo awal akunnya yang ditampilkan disini sebagai Total Saldo Awal
G/L. Apabila anda ingin menyamakan saldo awal pada buku besar
dengan nilai saldo awalnya menurut perincian Invoicenya, anda bisa
mengklik tombol ini. Apabila anda memerlukan laporan saldo awal
Hutang/Piutang yang telah anda input, anda bisa melihatnya melalui
Laporan Saldo Piutang (menu Laporan > Laporan Piutang > Laporan
Saldo Piutang) atau Laporan Saldo Hutang (menu Laporan > Laporan
Hutang > Laporan Saldo Hutang), isi tanggalnya dengan tanggal akhir
periode sebelum pemakaian Accpro, maka nilai yang ditampilkan pada
laporan tersebut adalah merefleksikan saldo awal piutang atau hutang
yang telah anda input. Pada laporan dimaksud, khusus untuk piutang,
kalau ingin mengetahui saldo awal per kelompok customer maka
aktifkan opsi Kelompokkan menurut Grupnya. Apabila anda ingin
laporan yang lebih rinci mencakup detail Invoicenya, anda bisa
menggunakan Laporan Piutang per Invoice (menu Laporan > Laporan
Piutang > Laporan Piutang per Invoice) atau Laporan Hutang per
Invoice (menu Laporan > Laporan Hutang > Laporan Hutang per
Invoice), isi tanggalnya dengan tanggal akhir periode sebelum

pemakaian Accpro.
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e Salesman : kolom ini hanya ada pada saat input saldo awal piutang. Pilih

Salesmannya kalau ada salesmannya untuk invoice dimaksud.
Tab Sub Ledger

Accpro menyediakan fasilitas Laporan Sub Ledger khususnya untuk
mengakomodasi akun-akun lain di luar Hutang, Piutang dan Persediaan yang
kemungkinan dibutuhkan untuk mengetahui mutasi atau saldonya tidak
hanya secara keseluruhan tetapi juga menyangkut kontak tertentu baik
Customer, Supplier atau Other Contact tertentu. Contohnya jika perlu
mengetahui Uang Muka Pembelian supplier tertentu atau Uang Muka
Penjualan customer tertentu atau pos biaya tertentu yang telah dikeluarkan

untuk kontak tertentu. Sepanjang ada urgensi atau relevansinya hal ini

DALCONEAGE

Nama Pengenal
E

Nama Resmi
PT. ABC FINANCE

o ABC FINANC

o GRAHA CELLULAR GRAHA CELLULAR Jakarta Pusat

© GRAHA PRIMA SEJAHTERA PT. GRAHA PRIMA SEJAHTERA Surabaya Net 30 Supplier
o IMPERIAL TAXI PT. IMPERIAL RODA PERKASA Jakarta Selatan Net 14 Customer
o JAYA ABADI CV. JAYA ABADI Jakarta Barat et 7 Supplier
o KAS NEGARA KAS NEGARA Jakarta Barat Others

o MITRA FINANCE PT. MITRA FINANCE Jakarta Selatan Others.

o PANCA MITRA PT. PANCA MITRA Jakarta Barat Supplier
o PRIMA TRAVEL CV. RODA PRIMA SAKTI Jakarta Timur Net 14 Customer
o RAJAWALT PERKASA PT. RAJAWALI PERKASA Makassar Net 30 Customer
o SEMESTA GPS PT. SEMESTA GPS Bandar Lampung Net 30 Customer

Unfiltered Jml Data : 14

Saldo Awal
Other Contact : ABC FINANCE
Sub Ledger
No| Mo, Perkiraan Nama Perkiraan

1. 03-05-04-000 - |Hutang Angsuran Kendarazn
2

dimungkinkan karena untuk setiap transaksi yang ada jurnalnya, Accpro

selalu meminta anda memasukkan nama kontak untuk transaksi tersebut.
Terkecuali kalau nama kontak tidak anda sebutkan secara spesifik khususnya

untuk transaksi yang menyangkut kontak lain dimana nama kontak hanya
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diisikan sebagai < N/A >, maka laporan sub ledgernya menjadi tidak relevan.
Agar informasi yang ditampilkan pada laporan sub ledger akurat, maka tentu
saja apabila akun dimaksud mempunyai saldo awal untuk kontak tertentu

pada periode sebelum pemakaian Accpro, maka harus anda input di sini.

e No. Perkiraan : ketik No. Perkiraannya atau klik tombol drop-down
untuk memilih No. Perkiraannya

e Nama Perkiraan : bila lebih mudah buat anda mengingat Nama
Perkiraannya, maka anda bisa menggunakan kolom ini sebagai alternatif
dari kolom No. Perkiraan untuk menginput perkiraannya. Ketikkan
potongan awal nama perkiraan maka daftar perkiraan akan ditampilkan
menurut nama perkiraannya. Tinggal anda mencari dan memilih
perkiraan dimaksud. Begitupun jika anda mengklik tombol drop-down
pada kolom ini, maka daftar perkiraan juga akan ditampilkan.

e Saldo : input saldo awalnya pada kolom ini. Untuk akun debit dan
saldonya debit atau akun kredit dan saldonya kredit maka isi dengan
nilai positif. Sebaliknya isi dengan dengan nilai negatif.

e  Tombol Insert Row : untuk menyelipkan baris baru diantara baris data
yang sudah ada.

e Tombol Delete Row : menghapus baris data tertentu.

e Tombol Save : untuk menyimpan penambahan data atau perubahan
yang telah dilakukan.

e Tombol Cancel : membatalkan perubahan atau penambahan data.

Catatan :

Apabila program mendeteksi ada upaya untuk menambah data saldo
awal atau melakukan pengeditan maka obyek lain diluar area saldo awal
akan dikunci oleh program, oleh karena itu anda harus menyimpan
peng-update-an yang anda lakukan atau membatalkannya lebih dulu
dengan mengklik tombol Save atau Cancel untuk membebaskan
penguncian sehingga area tersebut bisa diakses kembali.
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4.3.17 Set Harga Jual

Selain secara individual melalui modul Master Barang & Jasa, maka anda bisa
melakukan set harga jual secara massal melalui modul ini. Penentuan harga
jual adalah bersifat optional, artinya hanya kalau anda merasa perlu
memanfaatkan fasilitas ini. Apabila harga jual ditentukan, akan memudahkan
user pada saat input penjualan, karena program akan otomatis
mengisikannya pada kolom harga satuan. Namun harus diketahui bahwa
menentukan harga jual saja tidak ada gunanya tanpa anda
mengaplikasikannya pada masing-masing customer, artinya anda harus
menentukan skema harga jual untuk masing-masing customer apakah
dikenakan H. Jual 1, H. Jual 2, H. Jual 3, H. Jual 4 atau H. Jual 5.

Untuk membuka modul ini pilih menu Master Data > Set Harga Jual.
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e Tombol Satuan 1,2,3 : Telah dipahami bahwa untuk setiap item barang
dimungkinkan hingga 3 macam satuan, satu diantaranya akan menjadi
Satuan Inventory. Tombol ini berguna untuk menyeleksi satuan yang
akan ditampilkan atau ditentukan harga jualnya apakah kesemua satuan
yang ada atau hanya satuan tertentu apakah satuan ke 1, satuan ke 2,
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satuan ke 3 atau kombinasinya. Pada saat ditampilkan pertama kali maka
semua satuan yang ada untuk masing-masing item barang akan
ditampilkan.

Tombol Filter : apabila ingin menyeleksi data yang ditampilkan secara
lebih spesifik maka gunakan tombol ini.

Kode Barang : menampilkan Kode Barang, bisa jadi untuk item barang
tertentu ditampilkan lebih dari satu baris Kode Barang yang sama
tergantung apakah item barang tersebut mempunyai lebih dari satu
macam satuan dengan memperhatikan penyeleksian satuan yang telah
anda lakukan menggunakan tombol Satuan 1,2,3 di atas.

Nama Barang : menampilkan Nama Barang.

Satuan : satuan yang ditampilkan tergantung satuan yang ada pada item
barang bersangkutan dan penyeleksian yang telah anda lakukan baik
melalui tombol Satuan 1,2,3 atau tombol Filter.

Curr : menampilkan valuta item barang bersangkutan.

H. Beli Akhir : menampilkan harga beli terakhir per satuan pada kolom
Satuan.

H. Beli Max : menampilkan harga beli tertinggi per satuan pada kolom
Satuan.

H. Beli Avg : menampilkan harga beli rata-rata per satuan pada kolom
Satuan.

Set : apabila anda ingin melakukan penentuan harga jual menggunakan
fasilitas Set Harga Jual Massal (Otomatis) maka centang checkbox pada
kolom ini untuk baris-baris yang ingin anda set harga jualnya.

H. Jual 1 : anda bisa mengisikannya secara manual atau menggunakan
fasilitas Set Harga Jual Massal (Otomatis)

H. Jual 2 : anda bisa mengisikannya secara manual atau menggunakan
fasilitas Set Harga Jual Massal (Otomatis)

H. Jual 3 : anda bisa mengisikannya secara manual atau menggunakan
fasilitas Set Harga Jual Massal (Otomatis)

H. Jual 4 : anda bisa mengisikannya secara manual atau menggunakan
fasilitas Set Harga Jual Massal (Otomatis)

H. Jual 5 : anda bisa mengisikannya secara manual atau menggunakan

fasilitas Set Harga Jual Massal (Otomatis)
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Set Harga Jual Massal (Otomatis) : ada 3 pilihan formulasi untuk

melakukan set harga jual secara otomatis, pilih salah satunya, kemudian

isi persentase atau nilainya pada field disampingnya sesuai dengan harga

jual yang ingin dilakukan perubahan.

Lt

Prosentase Profit Margin : apabila ingin menentukan harga jual
dengan persentase tertentu terhadap harga beli. Isi persentase pada
kelima field disampingnya tergantung harga jual manakah yang
ingin diset. Kemudian pilih apakah terhadap Harga Beli Akhir atau
Harga Beli Tertinggi atau Harga Beli Rata-rata. Pilihan ini hanya
berhasil apabila baris barang bersangkutan sudah pernah ada harga
belinya.

Prosentase Markup Harga Jual : pilihan ini hanya bisa dilakukan
kalau baris barang yang ingin diset, sebelumnya sudah ada harga
jualnya. Isi persentase kenaikan atau penurunan harga jual terhadap
harga jual semula pada kelima field disampingnya tergantung harga
jual manakah yang ingin diset.

Nominal Markup Harga Jual : pilihan ini dilakukan apabila ingin
menyesuaikan harga jual sebesar nilai tertentu terhadap harga jual
semula. Isi nominal kenaikan atau penurunan terhadap harga jual
semula pada kelima field disampingnya tergantung harga jual
manakah yang ingin diset.

Tanpa Desimal : biarkan checkbox ini dalam keadaan tercentang
apabila hasil proses set harga jual ingin tanpa desimal.

Dibulatkan ke atas : dalam kaitannya dengan checkbox Tanpa
Desimal, apabila ingin dibulatkan ke atas maka biarkan checkbox ini
dalam keadaan tercentang.

Dibulatkan ke bawah : sebagai alternatif dari dibulatkan ke atas
maka apabila ingin dibulatkan ke bawah, klik checkbox ini hingga
tercentang.

Pecahan terkecil : apabila pembulatannya ingin ke pecahan tertentu
maka centang checkbox ini kemudian pilih apakah dibulatkan ke
puluhan, lima puluhan, ratusan, lima ratusan atau ribuan. Sebagai

alternatif dari pembulatan ke atas dan pembulatan ke bawah,
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centang checkbox Terdekat apabila pembulatannya ingin ke pecahan
terdekat sesuai pecahan yang telah anda pilih.

3t Aplikasikan pada yang terpilih saja : tanpa mencentang checkbox
ini maka proses set harga jual otomatis akan dilakukan pada
keseluruhan baris yang ditampilkan, tetapi kalau hanya ingin
berefek pada baris tertentu yang telah ditandai pada kolom Set,

maka centang checkbox ini.

Tombol Select All : klik tombol ini apabila ingin menandai kolom Set
pada keseluruhan baris yang ditampilkan. Apabila kolom Set telah
ditandai semua maka tombol ini akan berfungsi sebagai tombol Deselect
All yaitu berfungsi kebalikannya.

Tombol Process : klik tombol ini apabila ingin melakukan proses Set
Harga Jual Otomatis sesuai dengan kondisi yang telah anda tentukan.
Tombol Undo : tombol ini akan aktif apabila anda telah mengklik tombol
Proses, yaitu berfungsi membatalkan proses terakhir yang telah anda
lakukan.

Tombol Save : menyimpan hasil proses Set Harga Jual baik yang
dilakukan secara manual ataupun otomatis.

Tombol Cancel : membatalkan proses Set Harga Jual dan
mengembalikan tampilan form seperti sebelum dilakukan perubahan
harga jual.

Tombol Preview : menampilkan laporan Data Harga Barang ke layar
untuk selanjutnya bisa dicetak ke printer.

Tombol Search : apabila perlu mencari data tertentu berdasarkan Kode
Barang atau Nama Barangnya, maka klik tombol ini kemudian masukkan
potongan teks yang dicari pada field Cari, pilih apakah ingin mencari
Kode Barang atau Nama Barang, selanjutnya klik tombol Go. Tombol
Clear berguna mengosongkan kembali field Cari.

Tombol Close : menutup form ini.
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4.3.

18 Terms of Payment

Walaupun tabel ini akan terupdate dengan sendirinya sejalan dengan adanya

tambahan terms of payment baru pada saat anda menentukan terms of

payment ketika membuat data supplier atau customer, anda bisa

menambahkan terms of payment secara langsung lewat modul ini.

Untuk membuka form atau modul ini, pilih menu Master Data > Terms of

Payment.

Jatuh Tempo (Hari) : ketikkan jumlah hari sampai dengan jatuh tempo.
Discount (%) : apabila ada diskon bila pembayaran tidak melewati
jumlah hari tertentu dari tanggal Tagihan (Invoice), maka isikan
persentase diskonnya.

Hari Discount (Hari) : terkait dengan kolom Discount (%), tentukan
jumlah harinya.

Keterangan : akan otomatis terisi sesuai dengan apa yang diisikan pada

ketiga kolom lainnya.

4 Tabel Terms of Payment = — l ]

ﬂ ™| © m
0

O ‘ | @Sava |
o a0 i Net 14 l L
0 0,00 0 Cash | ¥ Cancel | |
30 Net 30 ==
[ K peete | |
|

IEIEIEIEIEIEIEIEIEIEI

BES 0o wmmaeswpe

Tips ‘fang dimaksud dengan Hari Discount adalah Discount diberikan jika
pembayaran tidak melebihi jumlah hari yang tercantum pada kelom Hari

% Discount. Kolom Keterangan akan otomatis diisi oleh program sesuai
input yang anda masukkan pada kolom yang lain
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e  Default : anda boleh menandai salah satu dari terms of payment yang
ada sebagai Terms of Payment default dengan mencentang kolom ini.
Implementasinya nanti pada saat transaksi Sales Order atau Sales Invoice
untuk customer tertentu, maka apabila terms of payment untuk customer
tersebut tidak anda tentukan pada saat input data customer
bersangkutan melalui Master Customer, maka terms of payment ini yang
akan otomatis terisi dengan sendirinya pada transaksi tersebut.

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

¢ Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

¢  Tombol Delete : menghapus data pada baris tertentu.

e Tombol :menutup form ini.

4.3.19 Tabel Departemen 7/ Divisi

(Untuk varian Accpro Trada dan Accpro Strada, fitur Multi Departemen tidak
disediakan, oleh karena itu menu dan modul untuk input Tabel Departemen tidak
tersedia)

Modul ini hanya akan ditampilkan apabila opsi Multi Department pada Setup
Preferensi telah ditandai (dicentang). Implementasi multi departemen adalah
apabila ingin ada breakdown pendapatan dan biaya menurut departemen

tertentu.

4.3.20 Proyek

(Untuk varian Accpro Trada dan Accpro Strada, fasilitas Proyek tidak tersedia, oleh
karena itu menu dan modul untuk input data Master Proyek tidak disediakan)

Modul ini hanya akan ditampilkan apabila fitur Mengakomodasi Proyek
(Project Costing) pada modul Setup Preferensi telah ditandai (dicentang).

Dengan mengaktifkan fitur ini maka ada menu untuk menginput data proyek
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melalui menu Master Data > Proyek. Demikian juga untuk setiap transaksi
yang melibatkan akun biaya atau pendapatan dapat ditentukan apakah akan
dibebankan atau dialokasikan pada proyek tertentu, karena kolom untuk ini
akan dimunculkan pada setiap transaksi yang berkemungkinan melibatkan

akun biaya atau pendapatan.

4.3.21 Tabel Gudang

(Untuk wvarian Accpro Trada dan Accpro Strada, fasilitas Multi Gudang tidak
disediakan, oleh karena itu menu dan modul untuk input Tabel Gudang tidak

tersedia. Fasilitas Multi Gudang tersedia pada varian Accpro Spectra)

Apabila fitur Multi Gudang pada Setup Preferensi diaktifkan maka akan ada
menu Master Data > Tabel Gudang sehingga anda bisa melakukan input
data gudang. Baris pertama dari tabel Gudang merupakan gudang default,
anda bisa merubah namanya dan keterangannya. Gudang default artinya
pada transaksi nantinya, apabila tidak ditentukan lain oleh user maka

transaksi adalah atas gudang ini.

4.3.22 Tabel Biaya

Hanya kalau ada biaya-biaya lain yang mungkin timbul pada transaksi
pembelian atau penjualan, tabel ini perlu diupdate, kalau tidak maka modul

ini bisa dilewati.

Untuk membuka modul atau form ini, pilih menu Master Data > Tabel Lain-

lain > Tabel Biaya.

¢ Nama Biaya : isi nama biayanya.

e No. Perk : tentukan Nomor Perkiraannya (umumnya adalah perkiraan
biaya). Caranya ketikkan langsung pada kolom ini atau klik tombol drop-
down yang ada maka akan tampil daftar perkiraan untuk memudahkan

anda memilih nomor perkiraannya.
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Tabel Biaya ini digunakan untuk memasukkan biaya- biaya yang timbul baik pada saat pembelian Barang maupun pada saat Penjualan . Isikan Nama
Biayanya, kemudian pilih dari Account yang sudah anda input ke tabel Account ataukan tambahkan lebih dulu ke tabel Account bila belum ada dengan
mengklik tombol New Account

Biaya Pembelian/Penjualan

I Biaya Angkut 07-01-10-000 Biaya Ankut
-

Angl =
Biaya Asuransi 1
Biaya ATK & Keperluan Kantor 07-01-16-000 E
Biaya Bahan Bakar 07-01-09-000
Biaya Bunga Pinjaman 09-06-00-000
Biaya Cetakan 07-01-17-000
Biaya Fotocopy 07-01-19-000
Biaya Gaji 07-01-01-000
Biaya Iklan 07-01-32-000
Biaya Internet 07-01-31-000
Biaya Jasa Perbaikan 07-01-35-004
Biaya Keamanan & Kebersihan 07-01-30-000
Biaya Laindain 09-20-00-000 -

[m] [m] -

- ew Account 3 peete [ Blsae | [ B cance |

e Nama Perkiraan : bila lebih mudah bagi anda mengingat Nama
Perkiraannya ketimbang No. Perkiraannya, kolom ini bisa digunakan
sebagai alternatif untuk menentukan perkiraannya. Caranya ketikkan
potongan awal Nama Perkiraannya atau klik tombol drop-down yang
ada maka akan tampil daftar perkiraan dalam urutan Nama
Perkiraannya, sehingga anda tinggal memilih perkiraannya.

e Purchase : tandai kolom ini bila biaya ini akan dipakai pada modul
pembelian.

e Sales : tandai kolom ini bila biaya ini akan dipakai pada modul
penjualan.

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

¢ Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

e Tombol Delete : menghapus data pada baris tertentu.

e Tombol New Account : apabila Nomor Perkiraan yang dikehendaki
belum ada, klik tombol ini untuk menambahkan akun baru ke Chart of
Account.

e Tombol :menutup form ini.
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4.3.23 Tabel Nama Bank

Tabel ini hanya sekedar untuk mendaftar Nama Bank dari mana cheque atau
giro dikeluarkan atau didapat.

Untuk membuka modul atau form ini, pilih menu Master Data > Tabel Lain-
lain > Tabel Nama Bank.

54 Nama Bank -_— (o)
S— — |
[ No. | Hama Bank -
1. Bank ABC I [ —
2, Bank BCD —
3. Bank Artha |
i 4 = [Clsave [y
'E .
i x Delete
| 7.
I s
| o
: 10,
| i1,
| 12.
I 13, i
|
| .
| Tips Mama Bank digunakan untuk keperluan memasukkan informasi
| Mama Bank pada modul Penerimaan atau Pengeluaran
| Kas/Bank yang transaksinya menggunakan Cek atau Giro

¢ Nama Bank : isi nama Banknya.

e Tombol Save : untuk menyimpan keseluruhan perubahan atau
penambahan data.

e Tombol Cancel : membatalkan perubahan atau penambahan data yang
belum tersimpan dan menutup form.

¢ Tombol Delete : menghapus data pada baris tertentu.

e Tombol Lid: menutup form ini.
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4.3.24 Tabel Kode Pajak

(Untuk varian Accpro Trada dan Strada, fasilitas Multi Tax tidak tersedia, oleh
karena itu menu dan modul untuk input Tabel Kode Pajak tidak disediakan)

Hanya kalau pada transaksi pembelian atau penjualan berkemungkinan
adanya pengenaan atau pemotongan pajak lain diluar PPN, anda perlu

mengupdate tabel ini, kalau tidak maka modul ini bisa dilewati.

4.3.25 Fixed Asset (Aktiva Tetap)

Harta Tetap (Fixed Asset) yang perlu dilakukan proses perhitungan
penyusutan (depresiasi) pada akhir tiap preriode perlu diinput ke dalam
Master Fixed Asset. (Untuk varian Accpro Trada dan Strada, modul Fixed Asset
tidak disediakan, oleh karena itu menu dan modul untuk input Fixed Asset tidak
tersedia)

4.3.26 Proses Awal Bulan

Transaksi untuk periode bulan tertentu hanya bisa diinput apabila anda telah
melakukan Proses Awal Bulan untuk periode tersebut. Proses ini pulalah
yang harus anda lakukan untuk membuka periode awal untuk pertama
kalinya setelah anda selesai menyiapkan data awal yang dibutuhkan
sebagaimana yang telah dibahas satu persatu di atas. Sebelumnya kalau anda
belum melakukan Set Saldo Awal G/L, maka lakukan proses ini dengan
memilih menu Master Data > Saldo Awal G/L kemudian klik tombol Set
Saldo. Proses Awal Bulan dilakukan dengan memilih menu Utilitas > Proses

Awal Bulan. Program akan meminta konfirmasi lebih dulu sebagai berikut.
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Sebelum anda mulai melakukan Proses Awal Bulan

untuk pertama kalinya, pastikan anda telah

mengeksplorasi dan memastikan pengaturan pada
Setup Preferensi pada menu File sudah sesuai
dengan yang dikehendaki karena ada pengaturan
yang tidak bisa diubah lagi setelah proses ini !

Lanjutkan Proses Awal Bulan ?
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BAB 5
Input Transaksi

51 Purchase Order

Transaksi pembelian bisa diawali dengan menerbitkan PO (Purchase Order)
kepada pihak Supplier. Namun seringkali juga pembelian dilakukan tanpa

menggunakan PO, dalam hal ini anda bisa melewatkan modul ini.

Dalam implementasinya pada Accpro, PO pada umumnya adalah terkait
dengan barang dagang yaitu barang yang akan dijual kembali kepada
customer baik melalui proses pengolahan lebih dulu atau tidak, dengan kata
lain barang yang terkait dengan kegiatan bisnis inti perusahaan, untuk itu
masing-masing barang yang diinput melalui PO seperti ini harus sudah
memiliki Kode Barang pada Master Barang & Jasa, sedangkan PO Lain-lain
dimaksudkan untuk item pembelian diluar yang dikemukakan di atas
dimana tidak diperlukan pencatatan menyangkut stock item barang
bersangkutan baik karena memang tidak ada urgensinya karena bukan
barang dagang, demikian juga akan sulit dan merepotkan dalam pengukuran
atau pemantauan stocknya. Jadi PO Lain-lain adalah untuk mengakomodasi
barang yang tidak ada kaitannya dengan kegiatan bisnis inti perusahaan
namun tetap perlu diinput ke dalam sistem khususnya lagi karena perlu
dicetak POnya.

Catatan : Untuk Varian Accpro Trada, opsi atau fitur PO Lain-lain tidak tersedia.

Modul ini dibuka melalui menu Transaksi > Purchase Order. Pada transaksi
ini tidak terjadi penjurnalan, penjurnalan baru dilakukan apabila telah

dilakukan penerimaan barangnya melalui modul Purchase Invoice.

e No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya.
e PO Lain-lain : checkbox ini defaultnya adalah dalam keadaan tidak

tercentang. Apabila berupa PO Lain-lain sesuai pengertian yang telah
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dikemukakan di atas maka centang checkbox ini. (Untuk varian Accpro
Trada checkbox ini tidak tersedia)

Hanya untuk cetak PO : opsi ini terkait dengan checkbox PO Lain-lain,
yaitu apabila PO Lain-lain dimaksud hanya semata-mata untuk
keperluan mencetak PO dan tidak berlanjut nantinya untuk dilakukan
penerimaan Barang melalui modul Purchase Invoice, maka anda bisa
mencentang checkbox ini. Khususnya apabila pembelian terkait PO Lain-
lain ini tidak timbul hutang dan tidak ada PPNnya sehingga tidak ada
kepentingannya untuk dilakukan penerimaan itemnya melalui modul
Purchase Invoice sebagaimana yang akan dijelaskan pada 5.2 Purchase
Invoice, demikian juga tidak ada kepentingan untuk menjejaki pembelian
terkait item-item bersangkutan. Lebih jelasnya adalah sebagai berikut :
apabila pembelian menimbulkan Hutang Dagang atau Hutang Usaha,
maka pada software yang terintegrasi, dalam konteks ini adalah Accpro,
boleh dikatakan satu-satunya cara agar pembelian tersebut mengupdate
buku pembantu Hutang (Kartu Hutang dan Laporan Umur Hutang)
adalah dengan melalui modul Purchase Invoice, tetapi kalau pembelian
menyangkut item non inventory ini tidak timbul Hutang, maka anda bisa
langsung input transaksi pembelian tersebut melalui modul Pengeluaran
Kas/Bank, karena PO Lain-lain adalah menyangkut item non inventory
sehingga tidak perlu (lagipula tidak akan) diupdate stocknya dengan
melakukan penerimaan itemnya melalui modul Purchase Invoice.
Apabila anda tidak mencentang checkbox ini, maka anda perlu
melakukan penerimaan item atau input tagihan pembeliannya melalui
modul Purchase Invoice, kalau tidak maka PO ini akan tetap muncul
dalam daftar PO yang belum diterima barangnya. Inilah gunanya
checkbox ini. (Untuk varian Accpro Trada checkbox ini tidak tersedia)
Supplier : pilih Suppliernya. Caranya klik pada field ini atau tombol
drop-downnya, kemudian ketikkan initial atau potongan awal Nama
Pengenal supplier bersangkutan atau gunakan bantuan scroll-bar untuk
mencarinya. Setelah anda memilih supplier, Nama Resmi dan alamat
supplier akan ditampilkan pada textbox di bawahnya. Apabila supplier
belum ada dalam daftar supplier, pililh < New > untuk

menambahkannya, maka form Supplier akan ditampilkan.



No. PO :isi No. POnya.

Tgl. PO : sesuaikan tanggal PO apabila diperlukan, bisa dengan
mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn) masing-
masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

Valuta : otomatis terisi sesuai valuta supplier bersangkutan pada Master
Supplier. Apabila anda memilih “Breakdown Account Hutang
Usaha/Piutang Usaha menurut Supplier/Customer” (pada saat Setup
Preferensi pada tab Sistem) dan anda menentukan akun Hutang Usaha
untuk supplier dimaksud pada Master Supplier adalah akun dengan
valuta asing (bukan Rp), maka valuta untuk transaksi juga disesuaikan
dengan itu dan tidak bisa diubah, tetapi apabila dalam Rp maka valuta
transaksi bisa Rp atau valuta lainnya. Klik tombol drop-down apabila
ingin memilih valutanya. (Untuk varian Accpro Trada dan Accpro Strada
pilihan valuta tidak tersedia)

Kurs : jika valuta dalam Rp, maka Kurs otomatis terisi dengan 1 dan
tidak bisa diedit, sedangkan untuk valuta lainnya, anda harus
mengisinya. Apabila histori kurs untuk valuta bersangkutan pernah
diupdate melalui modul Tabel Valuta, maka akan otomatis terisi kurs
sesuai tgl terakhir yang pernah anda update dibandingkan dengan
tanggal PO.

Terms : apabila supplier bersangkutan telah ditentukan terms of
paymentnya pada Master Supplier, maka akan otomatis terisi, namun
masih dimungkinkan untuk diubah. Klik tombol drop-down untuk
memilih termsnya.

Required : diisi dengan Tanggal Diperlukan, bisa dengan mengetikkan
langsung dengan format dd/mm/yy (tgl/bln/thn) masing-masing 2 digit
atau klik tombol drop-down untuk memunculkan kalender.

ETA : Estimation Time of Arrival, sesuaikan tanggal perkiraan
kedatangan barang bisa dengan mengetikkan langsung dengan format
dd/mm/yy (tgl/bln/thn) masing-masing 2 digit atau klik tombol drop-

down untuk memunculkan kalender.
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e Close this PO : checkbox ini hanya aktif pada modus Edit, gunanya
adalah untuk menutup PO yang belum lengkap diterima tetapi POnya
ingin ditutup.

e *Harga sudah termasuk PPN : tandai (centang) checkbox ini apabila

harga barang dikenakan PPN dan harga sudah termasuk PPN.

Khusus PO pada Umumnya (checkbox PO Lain-lain dalam keadaan tidak
dicentang) (Untuk varian Accpro Trada hanya PO jenis ini yang tersedia)

GRAHA PRIMA SEJAHTERA

PT. GRAHA PRIMA SEJAHTERA
3. Pakis Kawat No. 53 A

Net 30
Ship To
PT. SIGMA GPS

ﬁ Purchase Order (o]
@[ ]PO Laindain
Ne. 000001 i ElE Purchase Order @) [ Hanya untuk cetak PO 50-15.01.0001

Ruko Melrose Residence Blok A8 No. 28
11, Kembang Mekar No. 1
Jakarta Barat

Surabaya

@ [ Close this PO

Barang | 5uppuer s Ttem No.

[] *Harga sudah termasuk PPN

_--EE-
1. GT-50v _IGPS Tracker GT/QUV 24.000.000 120.000. 00( .
2. GN-333X GPS Mavigasi GN-333X 50 50 Ur\lt 1.500.000 75.000.000
3. u]

4, [m]
5 [u]
2 u]
7 u]
8. o=

P—— P —— SubTotal 195.000.000

Disc 50 % 97.500.000

o niE @) Uang Muka (1) [

DPP 100 % 97.500.000

D PPN 10 % 9.750.000

Pajak Lain 0

Jumlah Biaya 0

Grand Total 107.250.000

@) Uzng Muka (2) 0

e Tab Barang:

3t Kode Barang : isi Kode Barangnya, atau klik tombol drop-down
pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Kode Barangnya, anda tinggal memilih item barang yang dimaksud.
Pilih < New > apabila perlu menambah barang baru.

3 Nama Barang : setelah anda mengisi kolom Kode Barang, maka

kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
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apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Nama Barangnya. Tetapi harus diketahui bahwa apabila kolom
Kode Barang telah terisi, maka mengedit kolom ini hanya dianggap
oleh program sebagai mengedit Nama Barang, sedangkan
barangnya tetap mengacu pada Kode Barangnya, oleh karena itu
kalau anda ingin menentukan barangnya melalui kolom ini, pastikan
kolom Kode Barang belum terisi atau dikosongkan lebih dulu.

Qty : isikan kuantitasnya.

Diterima : kolom ini hanya tampil pada modus Edit, menampilkan
kuantitas diterima berdasarkan data penerimaan barang yang
diinput melalui modul Purchase Invoice, oleh karena itu kolom ini
tidak bisa diedit.

Satuan : apabila satuan untuk item barang yang anda isikan pada
kolom Kode Barang hanya satu (sesuai yang ada pada Master
Barang & Jasa), maka kolom ini akan terisi dengan sendirinya.
Namun apabila lebih dari satu, maka anda harus memilih satuannya
dengan mengklik tombol drop-down pada kolom ini

Harga Satuan : isi harga satuannya.

Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.
Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom
lainnya.

Cls : kolom ini hanya muncul pada modus Edit. Gunanya untuk
menandai baris transaksi tertentu yang belum diterima lengkap
tetapi ingin ditutup (mungkin pesanan tidak ada atau telah
dibuatkan PO baru).

Tab Supplier’s Item No : tab ini berguna apabila ada Kode dan/atau

Nama Barang yang dikenal oleh Supplier yang berbeda dengan

pengkodean dan/atau penamaan menurut perusahaan. Apabila tab ini
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diisi, maka yang akan tercetak pada printout transaksi adalah sesuai
kolom Supp’s Item No. dan Nama Lain (Supp’s Product Name). Hanya
baris transaksi yang Kode atau Nama Barangnya berbeda dengan Kode
atau Nama Barang menurut Supplier yang perlu diisi.

3+ Kode Barang : akan terisi sesuai Kode Barang pada tab Barang.

¥  Nama Barang : akan terisi sesuai Nama Barang pada tab Barang.

#  Supp’s Item No. : anda bebas mengetikkan Kode Barangnya sesuai
yang dikenal Supplier atau pilih dari Kode Lain yang telah anda
input sebelumnya pada Master Barang & Jasa dengan mengklik
tombol drop-down pada kolom ini.

2t

Nama Lain (Supp’s Product Name) : demikian juga anda bebas
mengetikkan Nama Barang menurut Supplier atau pilih dari Nama
Lain yang telah anda input sebelumnya pada Master Barang & Jasa
dengan mengklik tombol drop-down pada kolom ini.

Khusus PO Lain-lain (checkbox PO Lain-lain dalam keadaan dicentang)
(Untuk varian Accpro Trada, PO jenis ini tidak tersedia)

o S ==

w. moz  [4[«]» Purchase Order gDP"LE‘"ﬁi“

[] Hanya untuk cetak PO 50-15.01.0002
JAYA ABADI ~ Rp 1

Ship To
CV. JAYA ABADL

N PT. SIGMA GPS

d R eTE i 0 Rukco Melrose Residence Biok AB No. 28
Jakarta Barat . Kembang Mekar No. 1

Jakarta Barat

Detail Transaksi | Supplier's It=m No.

o perc orge Setan [oiec ()| i ]ci]
1. Mesin Fotocopy IR-5600 ;IOZﬂlﬂl«OOﬂ 1 1 Unit 25.000.000 25.000.000

[ =Harga sudah termasuk PPN

2 [u]
& [m]
i [m]
5 [m]
5 [m]
2 [m]
8. [m]
InsertRow | | Delete Row SubTotal 25.000.000

Disc % 0

Catnton) @) Uang Muka (1) o

0P % 0
] e % 0
Pajak Lain 0
Jumlah Biaya 0
Grand Total 25,000,000
@) Uang Muka (2) 0
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Tab Detail Transaksi :

Deskripsi : isi deskripsi itemnya, anda bebas mengetikkan apa saja
baik item yang sudah ada pada tabel item pembelian ataupun tidak.
Semua item pada transaksi jenis ini adalah item non inventory, oleh
karena itu tidak memerlukan Kode Barang. Apabila tabel item
pembelian sudah ada datanya, maka akan ada bantuan berupa
daftar item yang dimunculkan begitu anda mengetikkan sesuatu,
pun bila anda mengklik tombol drop-down yang ada pada kolom
ini.

No. Perk : guna keperluan penjurnalan pada saat penerimaan
barang melalui modul Purchase Invoice, maka anda bisa
menentukan akun yang akan dikenakan pendebitan terkait item
pembelian ini, biasanya adalah akun biaya tetapi bisa juga akun
aktiva, tetapi jangan sampai salah paham, yang dimaksudkan
bukanlah akun Hutang Usahanya, karena akun Hutang Usaha ada
di sisi kredit dan program telah mengetahuinya berdasarkan akun
default Hutang Usaha yang telah anda beritahukan kepada program.
Ketikkan Nomor Perkiraannya, daftar perkiraan akan dimunculkan
oleh program sebagai bantuan dalam mencari akun yang dimaksud.
Pilih < New > apabila ingin menambahkan akun baru ke Chart of
Account. Cara lain adalah dengan mengklik tombol drop-down pada
kolom ini, maka form Lookup Perkiraan akan ditampilkan sehingga
anda dapat mencari perkiraan tertentu berdasarkan Nomor
Perkiraan atau Nama Perkiraannya. Klik tombol New apabila ingin
menambah akun baru. Apabila anda tidak menentukan akunnya
pada saat ini, maka anda bisa menentukannya pada saat penerimaan
barang melalui modul Purchase Invoice. Sedangkan apabila hanya
untuk keperluan cetak PO (checkbox Hanya untuk cetak PO
dicentang) maka anda tidak perlu menentukan akunnya, oleh karena
itu kolom ini bisa dikosongkan.

Qty : isikan kuantitasnya.

Diterima : kolom ini hanya tampil pada modus Edit. Apabila
checkbox “Hanya untuk cetak PO” tidak dicentang, maka kolom ini
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menampilkan kuantitas diterima berdasarkan data penerimaan
barang yang diinput melalui modul Purchase Invoice, oleh karena
itu kolom ini tidak bisa diedit. Sedangkan apabila kolom “Hanya
untuk cetak PO” dicentang maka kolom ini bisa diedit, agar setelah
barang diterima anda bisa mengisinya sesuai yang telah diterima.
Apabila kemua item barang yang ada telah diterima seluruhnya
maka anda cukup mengklik pada judul kolom ini, maka kolom ini
akan terisi sesuai kolom Qty.

Satuan : ketikkan satuannya, karena item non inventory maka anda
bebas mengetikkan apa saja bahkan bisa tidak diisi.

Harga Satuan : isi harga satuannya.

Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.
Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.

Tips :

Untuk mengisi kolom No. Perk secara global khususnya bila Nomor
Perkiraannya sama untuk kesemua atau beberapa item pada detail
transaksi, maka gunakan cara dengan mengklik pada judul kolom No.
Perk, maka form Lookup Perkiraan akan ditampilkan. Setelah anda
memilih perkiraannya, maka akan diminta konfirmasi apakah perkiraan ini
akan diaplikasikan pada kesemua detail transaksi yang ada atau hanya
baris yang belum ditentukan Nomor Perkiraannya.
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Tab Supplier’s Item No. : tab ini berguna apabila anda perlu mengisi
Kode Barang atau Nama Barang sesuai dengan yang dikenal oleh
Supplier. Apabila tab ini diisi, maka yang akan tercetak pada printout
transaksi adalah sesuai kolom Supp’s Item No. dan Nama Lain (Supp’s
Product Name).

#  Kode Barang : kolom ini tidak ada isinya karena PO Lain-lain tidak

memerlukan Kode Barang.




#+ Nama Barang : akan terisi sesuai Deskripsi pada tab Detail
Transaksi.

3t Supp’s Item No. : anda bebas mengetikkan Kode Barangnya sesuai
yang dikenal Supplier.

3 Nama Lain (Supp’s Product Name) : demikian juga anda bebas

mengetikkan Nama Barang menurut Supplier.

Disc : apabila ada diskon terhadap total nilai transaksi, isikan
persentasenya, mendukung multi diskon, contohnya 5+2,5. Nominal
jumlah diskon akan otomatis terisi pada field disebelahnya. Jika diskon
tidak berupa persentase terhadap nilai transaksi, maka isi field ini
dengan nominal jumlah diskonnya.

Uang Muka (1) : apabila ada Uang Muka terkait pesanan ini yang telah
atau akan dibayarkan kepada Supplier, dimana Supplier juga meminta
PPN atas Uang Muka tersebut, anda bisa mengisinya di sini. Isi field ini
hanya sebesar nominal tanpa PPNnya.

Jangan lupa untuk menginput transaksi pelunasan atau tagihan Uang
Muka ini (lihat penjelasan mengenai hal ini pada 5.2 Purchase Invoice).
DPP : defaultnya, DPP (Dasar Pengenaan Pajak) adalah 100 % yang akan
diisikan oleh program apabila anda mencentang checkbox PPN di
bawahnya, tetapi bisa saja ada transaksi dengan DPP Nilai Lain, dalam
hal ini anda bisa mengisikan persentasenya sendiri. Jadi, DPP hanya
perlu ditentukan jika transaksi dikenakan PPN.

PPN : Tandai (centang) checkbox ini jika ada PPNnya, maka persentase
PPN akan terisi sesuai default persentase PPN yang telah ditentukan
pada Setup Preferensi, demikian juga nominal PPN akan dihitung oleh
program. Jika checkbox *Harga sudah termasuk PPN ditandai, maka
checkbox PPN juga akan ikut tercentang dengan sendirinya.

Jumlah Biaya : apabila ada biaya lain, isi jumlah biayanya.

Uang Muka (2) : bedanya dengan Uang Muka (1) adalah field ini untuk
Uang Muka yang tidak dimintakan PPNnya atau memang transaksinya
tidak ada PPNnya. Seperti Uang Muka (1), seyogyanya transaksi
Pengeluaran Kas / Bank untuk pembayaran Uang Muka harus dilakukan,
kecuali kalau ada sisa Uang Muka Pembelian untuk Supplier ini yang
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mencukupi. Jurnalnya sama seperti Pengeluaran Kas / Bank untuk Uang
Muka (1) tetapi tanpa PPN Masukan.

e Catatan : bisa untuk memberikan catatan untuk diketahui pihak
Supplier.

e Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

¢ Tombol Delete Row : untuk menghapus baris tertentu.

¢ Tombol New : menambah transaksi baru.

e Tombol Search : mencari transaksi berdasarkan No. Trs, No. PO.

e Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

e Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

¢  Tombol Delete : menghapus transaksi tertentu.

e  Tombol Print : mencetak printout transaksi. Apabila checkbox Preview
tercentang maka akan ditampilkan dulu ke layar. Pengaturan default
untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Purchase Order. Pilih ukuran kertas dan lakukan

pengaturan lain yang dikehendaki.

52 Purchase Invoice

Pada umumnya modul Purchase Invoice digunakan untuk input penerimaan
barang dan tagihan pembelian yang berkaitan dengan barang dagang
khususnya yang dikategorikan sebagai Inventory (lihat pengertian Inventory

yang telah dijelaskan sebelumnya). Agar suatu item barang dagang bisa
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diinput melalui modul Purchase Invoice maka item barang bersangkutan
harus lebih dulu ditentukan Kode Barangnya dan diinput lebih dulu pada
Master Barang & Jasa. Tergantung kategorinya, apabila Inventory maka akan
mengupdate saldo barang bersangkutan sedangkan bila Non Inventory maka
hanya akan mengupdate saldo akun (Aktiva atau Beban) yang terkait item

barang bersangkutan.

Mengakomodasi pembelian yang tidak terkait barang dagang, khususnya jika
pembelian tersebut berupa pembelian kredit sehingga timbul Hutang kepada
Supplier, maka Accpro menyediakan opsi Pembelian Lain-lain dimana untuk
tipe pembelian jenis ini tidak memerlukan Kode Barang, demikian juga tidak
mengupdate saldo item barang bersangkutan, tetapi hanya saldo akun aktiva
atau biaya terkait item barang bersangkutan. Dengan diinput melalui modul
Purchase Invoice maka akan ada buku pembantu Hutangnya yaitu Kartu
Hutang dan Laporan Umur Hutang. Demikian juga kalau ada PPNnya,
dengan diinput melalui modul Purchase Invoice, maka akan muncul di Daftar
PPN Masukan yang selanjutnya bisa diekspor ke file CSV untuk keperluan
impor PPN Masukan melalui program eFaktur. Apabila pembelian secara
cash (tidak timbul Hutang) dan tidak ada PPNnya, anda bisa menginputnya
melalui modul Pengeluaran Kas / Bank (dengan jenis transaksi bukan Hutang
Usaha), kecuali kalau anda ingin menjejaki item pembelian yang anda
lakukan agar bisa muncul dalam Laporan Pembelian, maka bisa juga diinput
melalui modul Purchase Invoice ini menggunakan opsi Pembelian Lain-lain.

(Untuk varian Accpro Trada opsi ini tidak tersedia)

Modul ini dibuka dengan memilih menu Transaksi > Purchase Invoice atau

mengklik iconnya pada toolbar.

e No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher) akan menjadi referensi untuk transaksi ini. Default Kode Jurnal
yang diberikan Accpro untuk modul ini adalah PIL

¢ Pembelian Lain-lain : checkbox ini defaultnya adalah dalam keadaan
tidak tercentang, hanya apabila pembelian yang tidak terkait barang

dagang apalagi kalau hanya bersifat insidentil sehingga akan merepotkan
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apabila harus dibuatkan Kode Barangnya maka checkbox ini perlu
dicentang. (Untuk varian Accpro Trada checkbox ini tidak tersedia)

e Invoice Diterima : biarkan checkbox ini dalam keadaan tercentang,
apabila Invoice sudah diterima. Apabila Invoice belum diterima maka
belum timbul Hutang sehingga belum mengupdate Kartu Hutang dan
belum muncul pada Laporan Umur Hutang, tetapi hanya mengupdate
akun Hutang Dagang belum ditagih pada Buku Besar (G/L) (anda bisa
menamakan akun ini sesuai keinginan anda : Barang belum ditagih,
Penerimaan Barang belum ditagih atau lainnya, intinya adalah
memisahkan akun ini dengan akun Hutang Dagang sehingga tidak
terjadi perbedaan saldo akun Hutang Dagang pada buku besar dengan
buku pembantu Hutang)

e  Supplier : pilih Suppliernya. Caranya klik pada field ini atau tombol
drop-down disampingnya, kemudian ketikkan initial atau potongan
awal Nama Pengenal supplier bersangkutan atau gunakan bantuan
scroll-bar untuk mencarinya. Setelah anda memilih supplier, Nama
Resmi dan alamat supplier akan ditampilkan pada textbox di bawahnya.
Apabila supplier belum ada dalam daftar supplier, pilih < New > untuk
menambahkannya, maka form Supplier akan ditampilkan.

¢ No. PO : apabila pembelian menggunakan PO, pilih POnya dengan klik
pada icon ¥. Form Lookup PO akan ditampilkan sehingga anda dapat
memilih PO yang sudah anda input sebelumnya. Untuk pembelian tanpa
PO maka field ini bisa dikosongkan. Hanya kalau opsi “Dimungkinkan
Pembelian dengan No. PO tanpa input data PO lebih dulu” pada Setup
Preferensi diaktifkan, anda bisa mengisi No. PO walaupun PO
bersangkutan tidak diinput sebelumnya melalui modul PO. Opsi ini
untuk mengakomodasi user yang tidak menggunakan modul PO
(dengan alasan tertentu) tetapi ingin bisa mengisikan informasi No.
POnya pada transaksi pembelian.

e Tgl Terima : sesuaikan tanggal penerimaan barang apabila diperlukan,
bisa dengan mengetikkan langsung dengan format dd/mm/yy
(tgl/bln/thn) masing-masing 2 digit atau klik tombol drop-down untuk
memunculkan kalender.

e No. Invoice : isi Nomor Invoicenya.
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Tgl. Invoice : sesuaikan tanggal Invoice apabila perlu, caranya
sebagaimana Tgl. Terima.

No. Faktur Pajak : No. Faktur Pajak bisa diisi, jika ada (optional).
Sebaiknya anda mengisi No. Faktur Pajaknya jika transaksi ada PPNnya,
karena nantinya data ini diperlukan untuk ekspor PPN Masukan ke CSV
melalui menu Daftar > Daftar PPN Masukan.

Tgl. Faktur Pajak : apabila No. Faktur Pajak diisi, maka field ini juga
harus diisi. Setelah No. Faktur Pajak diisi, Tgl. Faktur Pajak akan terisi
sesuai Tgl. Invoice, anda bisa mengeditnya apabila perlu.

Valuta : untuk pembelian dengan PO, maka otomatis terisi sesuai valuta
pada POnya, selain daripada itu akan otomatis terisi sesuai valuta
supplier bersangkutan pada Master Supplier. Apabila anda memilih
“Breakdown Account Hutang Usaha/Piutang Usaha menurut
Supplier/Customer” (pada saat Setup Preferensi pada tab Sistem) dan
anda menentukan akun Hutang Usaha untuk supplier dimaksud pada
Master Supplier adalah akun dengan valuta asing (bukan Rp), maka
valuta untuk transaksi juga disesuaikan dengan itu dan tidak bisa
diubah, tetapi apabila dalam Rp maka valuta transaksi bisa Rp atau
valuta lainnya. Klik tombol drop-down apabila ingin memilih valutanya.
(Untuk varian Accpro Trada dan Accpro Strada pilihan valuta tidak tersedia)
Kurs : untuk pembelian dengan PO akan terisi sesuai data pada POnya,
selain daripada itu, apabila histori kurs untuk valuta bersangkutan
pernah diupdate melalui modul Tabel Valuta, maka akan otomatis terisi
kurs sesuai tgl terakhir yang pernah anda update dibandingkan dengan
tanggal Invoice. Jika valuta dalam Rp, maka Kurs otomatis terisi dengan
1 dan tidak bisa diedit. Sedangkan untuk valuta lainnya, bisa dientry
ataupun diedit.

Terms : untuk pembelian dengan PO akan terisi sesuai data pada POnya,
selain daripada itu, apabila supplier bersangkutan telah ditentukan terms
of paymentnya pada Master Supplier, maka akan otomatis terisi, namun
bisa diubah. Klik tombol drop-down untuk memilih termsnya.

Jatuh Tempo : otomatis terisi sesuai dengan Tanggal Invoice ditambah

jumlah hari jatuh tempo sesuai termsnya.
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e  Supplier Tunai (Non A/P) : checkbox ini hanya tampil apabila supplier
merupakan supplier tunai yaitu supplier yang pembayarannya tunai
sehingga tidak mempunyai kartu hutang. Penentuan mengenai hal ini
adalah melalui Master Supplier.

e *Harga sudah termasuk PPN : tandai (centang) checkbox ini apabila
harga barang dikenakan PPN dan harga sudah termasuk PPN.

Khusus pembelian pada Umumnya (checkbox Pembelian Lain-lain dalam
keadaan tidak dicentang)

(Untuk varian Accpro Trada hanya Pembelian jenis ini yang tersedia)

ﬁ Purchase Invoice ]
TR 0[] pembeiian Lain-ain Tol. Terima
No.  00DOO1 44 ] Purchase .

& [V nvoice Diterima 20-15.01.0001 06/01/2015 ﬂ

L — [t e o e
GRAHA PRIMA SEJAHTERA - 003(GPS/INV/I/15 L TE

PT. GRAHA PRIMA SEJAHTERA No. Faktur Pajak Tgl.F. Pajak
11, pakis Kawat No. 53 A 010.000-15,00000100 06/01/2015 n
Rp - 1,00 Net 30 - |05/02/2015 n

Barang [C] *Harga sudah termasuk PPN
Nama Barang

1. GT-80V | GPS Tracker GT-90V 5 Box 24,000,000 120,000.000 | |

2. GN-333( GPS Navigasi GN-333X 50 Unit 1,500,000 75,000,000

InsertRow [l Delete Row SubTatal 195.000.000
Disc o % 97.500.000

{ UangMuka (1) @) )

DPP 00 % 97.500.000

[ Bukan Kredit Pajak <— PPN 1 % 9,750,000

Jumlah Biaya o

Grand Total 107.250.000

4 TunsijUsngMuka(® @) 0 0

e T I putars 10720000
Sudah Dibayar 660.000

e Tab Barang : apabila pembelian dengan PO dan anda memilih No. PO
pada saat input No. PO, maka detail transaksi pada tab Barang ini akan
terisi dengan sendirinya, tinggal anda menyesuaikan kolom Qty sesuai
kuantitas yang diterima untuk masing-masing baris transaksi dan
(apabila ada) merinci Serial No. atau Lot No./Batch No dan/atau Expire
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Datenya, tetapi apabila pembelian tanpa No. PO anda harus mengisi

detail transaksi secara manual.

ol

Kode Barang : isi Kode Barangnya, atau klik tombol drop-down
pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Kode Barangnya, anda tinggal memilih item barang yang dimaksud.
Pilih < New > apabila perlu menambah barang baru.

Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Nama Barangnya. Tetapi harus diketahui bahwa apabila kolom
Kode Barang telah terisi, maka mengedit kolom ini hanya dianggap
oleh program sebagai mengedit Nama Barang, sedangkan
barangnya tetap mengacu pada Kode Barangnya, oleh karena itu
kalau anda ingin menentukan barangnya melalui kolom ini, pastikan
kolom Kode Barang belum terisi atau dikosongkan lebih dulu.

Qty : isikan kuantitasnya. Jika barang dimaksud mempunyai Serial
No./Lot. No dan/atau Expire Date, maka pada kolom ini akan ada
tombol drop-down yang kalau diklik akan memunculkan form
“Perincian Serial No./Lot No. masing-masing Barang” dimana anda
bisa merinci kuantitas barang berikut Serial No./Lot No dan/atau
Expire Datenya. Baik apabila pembelian dengan atau tanpa PO,
Serial No./Lot No. atau Expire Date harus diisi sendiri jika item
barang bersangkutan memilikinya. Pada varian Accpro Trada dan
Accpro Strada fitur Serial No./Lot No. atau Expire Date tidak
tersedia, kalau anda membutuhkan fitur ini anda harus
menggunakan varian Accpro Spectra.

Satuan : apabila satuan untuk item barang yang anda isikan pada
kolom Kode Barang hanya satu (sesuai yang ada pada Master
Barang & Jasa), maka kolom ini akan terisi dengan sendirinya.
Namun apabila lebih dari satu, maka anda harus memilih satuannya

dengan mengklik tombol drop-down pada kolom ini
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3+  Harga Satuan : isi harga satuannya.

#t  Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.

#  Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.

e Tab Biaya: bila tidak ada biaya lain maka bagian ini bisa dilewati.
Biaya disini bisa berasal dari biaya atas jasa pihak ketiga yang telah
dibayarkan oleh penjual dan dibebankan kepada pihak pembeli, atau
biaya atas jasa pihak ketiga yang langsung ditanggung oleh pihak
pembeli. Untuk yang terakhir ini hanya perlu anda masukkan pada
transaksi pembelian apabila biaya yang dikeluarkan ingin dikonversikan
menambah nilai persediaan dengan kata lain ingin diperhitungkan
sebagai bagian dari Harga Pokok Penjualan nantinya, sedangkan Hutang
atau Pengeluaran Kas / Bank kepada pihak ketiga tetap harus anda input
sebagai transaksi tersendiri, apabila berupa Hutang maka bisa diinput
sebagai transaksi Pembelian Lain-lain, sedangkan kalau tidak timbul

Hutang adalah melalui modul Pengeluaran Kas / Bank. Biaya disini

contohnya adalah biaya pengiriman, biaya angkut (freight), biaya

handling, customs dan sebagainya.

#  **:centang kolom ini jika biaya ingin dikonverikan menambah Nilai
Persediaan.

3 ** : centang kolom ini jika biaya ini merupakan hutang atau
pembayaran kepada pihak ketiga (diluar Supplier dimaksud),
diinput disini karena biaya yang timbul ingin dikonversikan
menambah Nilai Persediaan.

#  Nama Biaya : ketikkan nama biayanya atau klik tombol drop-down
yang ada, maka daftar biaya yang telah anda input ke tabel Biaya
(menu Master Data > Tabel Lain-lain > Tabel Biaya) akan
ditampilkan sehingga anda dapat memilihnya.

7 Curr : apabila kolom *** tidak dicentang, maka currency atau valuta
adalah sesuai dengan valuta transaksi, kolom ini akan terisi dengan

sendirinya setelah anda mengisi kolom Nama Biaya dan tidak bisa
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diubah. Tetapi kalau kolom *** dicentang yang artinya biaya
merupakan pembayaran kepada pihak ketiga maka valuta bisa
berbeda dengan valuta transaksi, maka kolom ini bisa anda
sesuaikan dengan mengklik tombol drop-down yang ada. (Untuk
varian Accpro Trada dan Accpro Strada pilihan valuta tidak tersedia)

#  Kurs : kolom ini seperti halnya kolom Curr, hanya bisa berbeda
dengan kurs transaksi apabila kolom *** dicentang.

7 Jumlah : isi nominal biayanya sesuai valuta pada kolom Curr.

2t Keterangan : jika perlu ketikkan deskripsi mengenai biaya ini.

Khusus Pembelian Lain-lain (checkbox Pembelian Lain-lain dalam keadaan
dicentang)

(Untuk varian Accpro Trada Pembelian jenis ini tidak tersedia)

e . ==

Mo, 000004 R Purchase @ [Jpenbeiantanan | I

@) (V] Invaice Diterima |

A T I
DELTA COMPUTER - 000300 [y;1s [~ |
Toko DELTA COMPUTER Tol F. Pajak
Mal Mangga Maris Lt. 3 Blok 8 Na. 2 I |+
e a2 B N BT
Jakarta Utara P - 100 et v s ||

Detail Transaksi /] supplier Tunai (Non A/P) “Harga sudsh termasuk PRIV

Deskripsi No. Perk
1. Laptop LENOVO G40-30

Harga Satuan E -
_=|02-01-01-000 1 Unit 3,650,000 3.650.000 |

0 e s

Delete Row SubTotal 3.650.000
Disc T w o
4 UangMuka (1) @) )
DFP % 0
PPN % 0
Jumlah Biaya
Grand Total 3.650.000
q TunaifUengMuka () @ 3.6%0.000
Hutang 0

Sudah Dibayar 0

e Tab Detail Transaksi : apabila pembelian dengan PO dan anda memilih
No. PO pada saat input No. PO, maka detail transaksi akan terisi dengan
sendirinya, tinggal anda menyesuaikan kolom Qty sesuai kuantitas yang
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diterima untuk masing-masing baris transaksi, tetapi apabila pembelian

tanpa No. PO anda harus mengisi detail transaksi secara manual.

Tt
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Deskripsi : isi deskripsi itemnya, anda bebas mengetikkan apa saja
baik item yang sudah ada pada tabel Item Pembelian ataupun tidak.
Semua item pada transaksi jenis ini adalah item Non Inventory, oleh
karena itu tidak memerlukan Kode Barang. Apabila tabel Item
Pembelian sudah ada datanya, maka akan ada bantuan berupa
daftar item yang dimunculkan begitu anda mengetikkan sesuatu,
pun bila anda mengklik tombol drop-down yang ada pada kolom
ini.

No. Perk : guna keperluan penjurnalan, maka anda harus
menentukan akun yang akan dikenakan pendebitan terkait item
pembelian ini, biasanya adalah akun biaya tetapi bisa juga akun
aktiva, tetapi jangan sampai salah paham, yang dimaksudkan
bukanlah akun Hutang Usahanya, karena akun Hutang Usaha ada
di sisi kredit dan program telah mengetahuinya berdasarkan akun
default Hutang Usaha yang telah anda beritahukan kepada program.
Ketikkan Nomor Perkiraannya, daftar perkiraan akan dimunculkan
oleh program sebagai bantuan dalam mencari akun yang dimaksud.
Pilih < New > apabila ingin menambahkan akun baru ke Chart of
Account. Cara lain adalah dengan mengklik tombol drop-down pada
kolom ini, maka form Lookup Perkiraan akan ditampilkan sehingga
anda dapat mencari perkiraan tertentu berdasarkan Nomor
Perkiraan atau Nama Perkiraannya. Klik tombol New apabila ingin
menambah akun baru.

Qty : isikan kuantitasnya.

Satuan : ketikkan satuannya, karena item Non Inventory maka anda
bebas mengetikkan apa saja bahkan bisa tidak diisi.

Harga Satuan : isi harga satuannya.

Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.
Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.



Tips :

Untuk mengisi kolom No. Perk secara global khususnya bila Nomor
Perkiraannya sama untuk kesemua atau beberapa item pada detail
transaksi, maka gunakan cara dengan mengklik pada judul kolom No.
Perk, maka form Lookup Perkiraan akan ditampilkan. Setelah anda
memilih perkiraannya, maka akan diminta konfirmasi apakah perkiraan
ini akan diaplikasikan pada kesemua detail transaksi yang ada atau
hanya baris yang belum ditentukan Nomor Perkiraannya.

Tab Biaya : bila tidak ada biaya lain maka bagian ini bisa dilewati.

Umumnya biaya disini berasal dari biaya atas jasa pihak ketiga yang

telah dibayarkan oleh penjual dan dibebankan kepada pihak pembeli,

contohnya biaya pengiriman, biaya angkut (freight) dan sebagainya.

7  Nama Biaya : ketikkan nama biayanya atau klik tombol drop-down
yang ada, maka daftar biaya yang telah anda input ke tabel Biaya
(menu Master Data > Tabel Lain-lain > Tabel Biaya) akan
ditampilkan sehingga anda dapat memilihnya.

% Jumlah : isi jumlah biayanya.

3 Keterangan : jika perlu ketikkan deskripsinya.

Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

Tombol Delete Row : untuk menghapus baris tertentu.

Disc : apabila ada diskon terhadap total nilai transaksi, isikan
persentasenya, mendukung multi diskon, contohnya 5+2,5. Nominal
jumlah diskon akan otomatis terisi pada field disebelahnya. Jika diskon
tidak berupa persentase terhadap nilai transaksi, maka isi field ini
dengan nominal jumlah diskonnya.

Uang Muka (1) : field ini diperuntukkan apabila sebelumnya untuk
pembelian ini telah dibayarkan uang muka sejumlah tertentu berikut
PPNnya. Disini anda harus mengisinya dengan nominal uang muka
tidak termasuk PPNnya. Apabila field Uang Muka (1) diisi, anda juga
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harus menentukan akun uang mukanya, tab Uang Muka (1) akan
ditampilkan oleh program, ketikkan nomor perkiraannya pada field No.
Perkiraan tab Uang Muka (1) atau klik tombol Lookup disebelahnya
untuk menampilkan Lookup Perkiraan. Apabila sebelumnya pada
Pengeluaran Kas / Bank, anda telah mendebit akun Uang Muka
Pembelian misalnya, seyogyanya akun uang muka yang dikreditkan
disini juga Uang Muka Pembelian. Apabila anda perlu mengetahui
histori atau sisa uang muka pembelian untuk supplier bersangkutan klik
icon ? di samping field ini, akan ditampilkan form yang meminta anda
untuk mengisi data yang diperlukan agar program bisa menampilkan

histori dan saldo uang muka pembelian yang diinginkan.

Pada saat uang muka dibayarkan maka seyogyanya anda telah
menginput transaksinya sebagai Pengeluaran Kas / Bank (jenis transaksi :

bukan Hutang Usaha) dengan jurnal sebagai berikut :

Kas atau Bank XXXXXXXXX (Cr)
Uang Muka Pembelian  xxxxxxxxx (Db)
PPN Masukan XXXXXXXXX (Db)

Tetapi dengan cara ini, maka PPN Masukan atas Uang Muka Pembelian,
tidak akan muncul pada Daftar PPN Masukan sehingga untuk keperluan
eFaktur, anda harus menginputnya secara manual. Ada cara lain yang
lebih baik sehingga PPN Masukan atas Uang Muka Pembelian bisa
muncul pada Daftar PPN Masukan sehingga nantinya anda tidak perlu
input secara manual ke eFaktur tetapi cukup dengan cara
mengekspornya ke CSV melalui fasilitas Ekspor ke CSV pada modul
Daftar PPN Masukan tadi, yaitu anda harus input tagihan atau
pembayaran Uang Muka Pembelian yang ada PPNnya ini melalui modul
Purchase Invoice ini juga. Caranya adalah buat tarnsaksi Purchase
Invoice (opsi Pembelian Lain-lain) dengan memilih akunnya pada kolom
No. Perk sebagai akun Uang Muka Pembelian, sedangkan deskripsinya
bebas anda tentukan sendiri. Kemudian centang checkbox PPN, maka
jurnal yang dihasilkan dari transaksi ini adalah sebagai berikut :

Uang Muka Pembelian  xxxxxxxxx (Db)
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PPN Masukan XXXXXXXXX (Db)

Hutang Usaha XXXXXXXXX (Cr)

Selanjutnya pelunasan Hutang Usaha yang timbul dapat dilakukan
melalui modul Pengeluaran Kas/Bank.

Apabila anda ingin langsung melunasinya melalui modul Purchase
Invoice ini dengan mengisi field Tunai / Uang Muka (2) sebesar Hutang
Usaha yang timbul (karena misalnya pelunasan Uang Muka telah
dilakukan secara Tunai sehingga tidak timbul Hutang Usaha) dan
memilih Akun G/L yang akan dikreditkan terkait Pembayaran Tunai /

Uang Muka (2) dengan akun Kas/Bank maka jurnalnya akan menjadi

sebagai berikut :
Uang Muka Pembelian  xxo0o0o0cxx (Db)
PPN Masukan XXXXXXXXX (Db)
Hutang Usaha XXXXXXXXX (Cr)
Kas atau Bank XXXXXXXXX (Cr)
Hutang Usaha XXXXXXXXX (Db)

Sayangnya, opsi Pembelian Lain-lain hanya tersedia pada varian Accpro
Strada dan Accpro Spectra. Untuk anda yang menggunakan varian
Accpro Trada, maka anda harus membuatkan Kode Barang untuk item
Uang Muka Pembelian ini agar anda bisa menginputnya melalui modul
Purchase Invoice. Jangan sampai salah dalam mengkategorikan item
Uang Muka Pembelian ini pada saat input Kode Barangnya melalui
menu Master Barang & Jasa, anda harus mengkategorikannya sebagai
Non Inventory dan pilih akun Uang Muka Pembelian sebagai akun
Aktiva / Biaya-nya.

DPP : defaultnya, DPP (Dasar Pengenaan Pajak) adalah 100 % yang akan
diisikan oleh program apabila anda mencentang checkbox PPN di
bawahnya, tetapi bisa saja ada transaksi dengan DPP Nilai Lain, dalam
hal ini anda bisa mengisikan persentasenya sendiri. Jadi, DPP hanya
perlu ditentukan jika transaksi dikenakan PPN.

PPN : Tandai (centang) checkbox ini jika ada PPNnya, maka persentase
PPN akan terisi sesuai default persentase PPN yang telah ditentukan

pada Setup Preferensi, demikian juga nominal PPN akan dihitung oleh
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program. Jika checkbox *Harga sudah termasuk PPN ditandai, maka
checkbox PPN juga akan ikut tercentang dengan sendirinya.

e Bukan Kredit Pajak : ada kalanya PPN Masukan yang timbul tidak
dapat menjadi kredit Pajak, dalam hal ini maka centang checkbox ini.
Khusus perusahaan bukan PKP (apabila anda tidak mencentang
checkbox PKP melalui menu File > Setup Preferensi pada tab Fiskal),
maka otomatis checkbox ini akan tercentang dengan sendirinya.

¢ Akumulasikan ke akun pembelian : Kalau anda mencentang checkbox
“Bukan Kredit Pajak”, maka checkbox ini akan dimunculkan oleh
program dan akan otomatis tercentang dengan sendirinya apabila anda
telah menentukannya demikian melalui menu File > Setup Preferensi
pada tab Fitur dengan mencentang checkbox “Akumulasikan PPN
Masukan Bukan Kredit Pajak ke akun pembeliannya”. Jika anda tidak
mencentang checkbox ini, maka PPN Masukan yang timbul akan didebit
bukan ke akun default “PPN Masukan” tetapi ke akun default “PPN
Masukan bukan Kredit Pajak”. Untuk itu program akan meminta anda
untuk menentukan akun default “PPN Masukan bukan Kredit Pajak”
kalau anda belum menentukannya sebelumnya.

e Tunai/Uang Muka (2) : field ini diperuntukkan apabila ada pembayaran
tunai atau ada uang muka yang telah dibayarkan. Berbeda denga field
Uang Muka (1) di atas, maka uang muka yang telah dibayarkan di sini
belum termasuk PPNnya atau memang transaksi yang tidak dikenakan
PPN. Apabila ada uang muka yang telah dibayarkan sebelumnya maka
seyogyanya anda telah menginput transaksinya sebagai Pengeluaran Kas

/ Bank (jenis transaksi : bukan Hutang Usaha) dengan jurnal sebagai

berikut :
Kas atau Bank XXXXXXXXX (Cr)
Uang Muka Pembelian  xxxxxxxxx (Db)

Apabila field ini diisi, anda juga harus menentukan akunnya apakah
berupa Kas / Bank atau Uang Muka Pembelian. Pilih Kas / Bank jika
pembayarannya (apakah sebagian atau seluruhnya) bersamaan dengan
transaksi ini, sedangkan bila pengeluaran Kas / Bank telah dilakukan

sebelumnya sebagai uang muka, maka pilih Uang Muka Pembelian.
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Ketikkan nomor perkiraannya pada field No. Perkiraan tab Tunai / Uang
Muka (2) (yang akan dimunculkan oleh program) atau klik tombol
Lookup disebelahnya untuk menampilkan Lookup Perkiraan. Khusus
apabila berupa uang muka, maka apabila sebelumnya pada Pengeluaran
Kas / Bank, anda telah mendebit akun Uang Muka Pembelian misalnya,
seyogyanya akun uang muka yang dikreditkan disini juga Uang Muka
Pembelian. Apabila anda perlu mengetahui histori atau sisa uang muka
pembelian untuk supplier bersangkutan klik icon ? di samping field ini,
akan ditampilkan form yang meminta anda untuk mengisi data yang
diperlukan agar program bisa menampilkan histori dan saldo uang muka
pembelian yang diinginkan.

Field ini akan terisi dengan sendirinya sebesar total transaksinya
(nominal pada Grand Total) apabila supplier adalah Supplier Tunai.
Apakah Supplier Tunai atau bukan telah anda tentukan sebelumnya
pada saat input supplier bersangkutan pada Master Supplier. Supplier
Tunai berarti supplier yang transaksinya tidak menghasilkan Hutang
Usaha karena dilunasi secara tunai. Field ini akan dikunci oleh program
apabila supplier adalah Supplier Tunai. Anda harus menentukan akun
Kas / Bank dengan mengisikannya pada field No. Perkiraan pada tab
Tunai / Uang Muka (2) atau dengan memilih akunnya dengan bantuan
form Lookup Perkiraan yang ditampilkan apabila anda mengklik tombol
Lookup di samping field No. Perkiraan. Klik icon 4 di samping field
Tunai / Uang Muka (2) apabila diperlukan untuk memunculkan tab
Tunai / Uang Muka (2).

Sedangkan bila bukan Supplier Tunai, maka akan timbul Hutang Usaha
walaupun akan didebit kembali sebesar jumlah yang dibayarkan tunai
ataupun uang muka yang telah dibayarkan. Walaupun ada pembayaran
tunai, namun anda bisa juga tidak menginputnya disini tetapi tetap lewat
modul Pengeluaran Kas / Bank (jenis transaksi : Pelunasan Hutang
Usaha). Jadi manfaatkan field Tunai / Uang Muka (2) khususnya Supplier
Tunai hanya jika anda memerlukannya atau prosedur di perusahaan
anda memungkinkannya karena belum tentu user yang ditugaskan
untuk input pembelian berwenang untuk input pelunasannya. Anda bisa

menggunakan modul Pengeluaran Kas/Bank untuk input pelunasannya,
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atau apabila murni pelunasannya menggunakan uang muka pembelian
yang telah dibayarkan maka bisa menggunakan modul Debit Note
(menu Credit Note / Debit Note > Debit Note atas Hutang Supplier).

e Tombol New : menambah transaksi baru.

e Tombol Search : mencari transaksi berdasarkan No. PO, No. Trs atau No.
Invoice atau Faktur Pajaknya.

e Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan, artinya apabila tidak ada perubahan yang dilakukan anda
tidak perlu mengklik tombol ini untuk menghindari perubahan data
yang tidak disengaja.

e Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

e Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya berfungsi untuk menghapus baris
tertentu.

e Tombol Print : mencetak bukti transaksi pembelian. Apabila checkbox
Preview tercentang maka akan ditampilkan dulu ke layar. Pengaturan
default untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Purchase Invoice. Pilih ukuran kertas dan lakukan
pengaturan lain yang dikehendaki melalui modul tersebut. Apabila anda
ingin mencetak bukti pembelian sekaligus menyimpan transaksi, anda
bisa langsung klik tombol ini. Jadi tidak perlu mengklik tombol Save
dulu baru kemudian klik tombol Print, karena program akan menyimpan

transaksi sebelum mencetaknya. Apabila ada perubahan maka akan ada
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konfirmasi apakah akan disimpan atau ingin membatalkan perubahan,

jadi apa yang tercetak adalah sesuai dengan apa yang tersimpan.

Catatan : untuk Purchase Invoice yang ada POnya, maka pada bagian
bawah form akan ditampilkan informasi menyangkut Uang Muka pada
PO, berikut Uang Muka Terpakai dan Sisanya untuk masing-masing jenis
Uang Muka (Uang Muka (1) atau Uang Muka (2)) seperti yang
dikemukakan di atas. Hanya perlu diketahui bahwa, informasi yang
ditampilkan ini semata-mata berdasarkan Uang Muka yang diinput pada
PO dikaitkan dengan pemakaiannya yang diinput melalui modul
Purchase Invoice (untuk 1 PO bisa lebih dari satu kali penerimaan
barangnya melalui modul Purchase Invoice). Apakah realisasinya uang
muka telah dibayarkan (melalui modul Pengeluaran Kas / Bank) atau sisa
uang muka mencukupi harus dilihat lagi dengan mengklik icon ? di

samping field Uang Muka (1) atau Uang Muka (2).

53 Purchase Return

Adakalanya barang yang sudah dibeli ingin dikembalikan kepada pihak
Supplier, tentunya biasanya telah ada kesepakatan mengenai hal ini. Modul
ini berguna untuk melakukan input transaksi terkait retur pembelian dan

dibuka melalui menu Transaksi > Purchase Return.

e No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher) akan menjadi referensi untuk transaksi ini. Default Kode Jurnal
yang diberikan Accpro untuk modul ini adalah PR.

e Tgl. Retur : sesuaikan tanggal retur apabila diperlukan, bisa dengan
mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn) masing-
masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

e No. Referensi : ketikkan nomor bukti atau referensinya.
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e o S =

SR Tgl. Retur MNo. Referensi
No. 000001
LRI 31f01/2015 ﬂ PR-15.000001
No. Pembelian
EIEI purchase Return =
GRAHA PRIMA SEJAHTERA - 000001 - || ooz/ePsmwajs  ~
dRew
Data Pembeliax =
PT. GRAHA PRIMA SEJAHTERA mhelan
1. Pakis Kawat No. 53 A Tgl Terima 06/01/2015 Total A/P 107.250.000
fremm Tl Invoice  D5/01/2015 Sudah Dibayar 0
valuta Rp  Kurs 1,00 (Tidak termasuk Retur ini)
Barang *Harga sudah termasuk PPN
Mo| Kode Barang Nama Barang Harga Satuan A =
1L GT-80V  =|GPS Tracker GT-90V 1 Unit 1,200,000 1.200.000 [ |
2
3
4
5.
5.
7.
3 -
-
Disc E A 600,000
PP 00 % 600,000
PPN 0% 60.000
Grand Total 660,000
Memo [ Catatan  {Max. 3 baris)
Ada retek pada casing .

e  Supplier : pilih Suppliernya. Caranya klik pada field ini atau tombol
drop-down disampingnya, kemudian ketikkan initial atau potongan
awal Nama Pengenal supplier bersangkutan atau gunakan bantuan
scroll-bar untuk mencarinya. Setelah anda memilih supplier, Nama
Resmi dan alamat supplier akan ditampilkan pada textbox di bawahnya.

e No. Pembelian : centang checkbox pada field ini jika anda ingin
melakukan retur untuk pembelian (penerimaan barang) yang belum
diterima Invoicenya, kemudian klik tombol drop-down yang ada untuk
memilih nomor transaksi pembelian yang ingin diretur.

e No. Invoice : checkbox pada field ini secara default akan otomatis
tercentang setiap kali anda membuat transaksi retur baru, artinya kalau
tidak ditentukan lain maka program akan menganggap anda akan
melakukan retur atas pembelian yang sudah ada Invoicenya. Klik tombol
drop-down yang ada untuk memilih Invoice yang akan diretur.

e *Harga sudah termasuk PPN : checkbox ini akan disesuaikan dengan

transaksi pembeliannya.
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Tab Barang :

ol

Kode Barang : klik tombol drop-down pada kolom ini, maka daftar
Barang akan ditampilkan dalam urutan Kode Barangnya, anda
tinggal memilih item barang yang dimaksud. Daftar barang yang
ditampilkan adalah hanya yang ada pada transaksi pembelian yang
ingin diretur dan ditampilkan berikut kuantitas pembeliannya.
Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, klik tombol
drop-down pada kolom ini, maka daftar Barang akan ditampilkan
dalam urutan Nama Barangnya sesuai yang ada pada transaksi
pembeliannnya.

Qty : isikan kuantitasnya. Jika barang dimaksud mempunyai Serial
No./Lot. No dan/atau Expire Date, maka pada kolom ini akan ada
tombol drop-down yang kalau diklik akan memunculkan form
“Perincian Serial No./Lot No. masing-masing Barang” dimana anda
bisa merinci kuantitas barang berikut Serial No./Lot No dan/atau
Expire Datenya. Pada varian Accpro Trada dan Accpro Strada fitur
Serial No./Lot No. atau Expire Date tidak tersedia, kalau anda
membutuhkan fitur ini anda harus menggunakan varian Accpro
Spectra.

Satuan : kolom ini akan terisi sesuai satuan pada saat pembelian
setelah anda mengisi Kode Barangnya. Apabila satuan pada Master
Barang & Jasa untuk barang bersangkutan lebih dari satu, anda bisa
memilih satuan lainnya dengan mengklik tombol drop-down yang
ada.

Harga Satuan : kolom ini akan terisi sesuai harga satuan dan satuan
pada transaksi pembeliannya dan akan menyesuaikan apabila
satuan pada kolom Satuan anda ubah.

Disc % : kolom ini akan terisi persentase diskon sesuai transaksi

pembeliannya, namun apabila perlu anda bisa mengeditnya.
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#  Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.

e Disc : field ini akan terisi sesuai persentase diskon pada transaksi
pembeliannya. Dimungkinkan untuk diedit, mendukung diskon
bertingkat (multi diskon), contohnya 5+2,5. Nominal jumlah diskon akan
otomatis terisi pada field disebelahnya. Jika diskon tidak berupa
persentase terhadap nilai transaksi, maka field ini akan terisi sesuai
proporsional nilai transaksi (Sub Total) yang diretur terhadap nilai
transaksi pembeliannya.

e DPP : field ini persentasenya akan terisi sesuai dengan persentase DPP
pada transaksi pembeliannya.

e PPN : field ini akan disesuaikan dengan transaksi pembeliannya, tetapi
tetap dimungkinkan untuk diedit.

e  Memo / Catatan : bisa untuk memberikan catatan untuk diketahui pihak
Supplier.

e Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

e Tombol Delete Row : untuk menghapus baris tertentu.

¢  Tombol New : menambah transaksi baru.

e Tombol Search : mencari transaksi berdasarkan No. Trs, No. Trs
Pembelian, No. Invoice Pembelian dan No. Referensi Retur.

e Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

¢ Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.

Sedangkan kalau anda sebelumnya bermaksud mengedit tramsaksi
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tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

e Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya berfungsi untuk menghapus baris
tertentu.

e Tombol Print : mencetak printout transaksi. Apabila checkbox Preview
tercentang maka akan ditampilkan dulu ke layar. Pengaturan default
untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Purchase Return. Pilih ukuran kertas dan lakukan
pengaturan lain yang dikehendaki.

54 Sales Order

PO (Purchase Order) yang kita terima dari customer biasanya diinput sebagai
Sales Order oleh pihak Marketing. Tergantung kebutuhannya dan skalabilitas
perusahaan atau alasan penyederhanaan, mungkin saja ini modul ini tidak
dibutuhkan artinya PO langsung diinput sebagai DO (Delivery Order) tanpa
melalui SO (Sales Order).

Mengakomodasi penjualan khususnya yang terkait jasa atau item penjualan
lain yang bersifat non inventory atau insidentil, disediakan opsi Penjualan
Lain-lain untuk keperluan ini, dimana item penjualan untuk transaksi yang
demikian ini tidak perlu memiliki Kode Barang dan tidak perlu disiapkan
lebih dulu datanya pada Master Barang & Jasa. Dengan demikian Penjualan
Lain-lain adalah untuk item penjualan yang tidak diperlukan pengukuran
atau pengontrolan terhadap saldonya. (Untuk varian Accpro Trada opsi ini tidak
tersedia)

Modul ini dibuka melalui menu Transaksi > Sales Order.
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No.  DO000T LR AR AL ]

Customer
IMPERIAL TAXI

Sales Order

I E—

PT. IMPERIAL RODA PERKASA
Jl. Kedamaian Raya No. 123
Jakarta Selatan

PT. IMPERIAL RODA PERKASA
3. Kedamaian Raya No. 123

50-15.000001

oo S ==

@)[_|Penjualzn Lainain
‘@[ ship to Customer's Outiet

Jakarta Selatan

@[] dose this SO

00S/IRP/PO/I/15

B ]

Insert Row Delete Row subTotal 110.000.000
Disc )

Catatan @) Uang Muka (1) T
DPP 00 % 110,000,000

[] PP o % 11.000.000

Pajak Lain 0

Jumlah Biaya Y

Grand Total 121,000,000

@) Uang Muka (2) 0

e e I T TN

1,00
|| *Harga sudah termasuk PPN

Dikirim
50 Unit
50 Pcs [
50 Unit [
50 Unit o
50 Unit 0

Nama Barang
| GPs Tracker GT-90x
Kartu Perdana
Pulsa 250 ribu {utk 6 bulan)
Free langganan web tracking 1 (satu) t
Free Jasa Pemasangan

Kode Barang
GT-50%
KkP-01
VCH-250
I5-01F
15-0F

No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya.

Penjualan Lain-lain : checkbox ini defaultnya adalah dalam keadaan
tidak tercentang. Apabila berupa Penjualan Lain-lain sesuai pengertian
yang telah dikemukakan di atas maka centang checkbox ini. (Untuk
varian Accpro Trada checkbox ini tidak tersedia)

Ship to Customer’s Outlet : hanya kalau Customer mempunyai outlet
atau cabang dan pengiriman adalah ke outletnya, anda perlu mencentang
checkbox

menentukan customer-customer yang merupakan outlet dari suatu

ini. Untuk keperluan ini, maka seyogyanya anda telah
customer pada saat input data customer tersebut melalui Master
Customer (lihat 4.3.6 Customer)

Customer : pilih Customernya. Caranya klik pada field ini atau tombol
drop-down yang ada, kemudian ketikkan initial atau potongan awal
Nama Pengenal customer bersangkutan atau gunakan bantuan scroll-bar
untuk mencarinya. Setelah anda memilih customer, Nama Resmi dan
alamat customer akan ditampilkan pada textbox di bawahnya. Apabila
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customer belum ada dalam daftar customer, pilih < New > untuk
menambahkannya, maka form Customer akan ditampilkan. Customer
yang diinput di sini harus merupakan nama dan alamat kepada mana
tagihan atau Invoice nantinya akan ditujukan. Sedangkan apabila
pengiriman kepada outlet atau cabang customer tersebut, maka checkbox
Ship to Customer’s Outlet bisa dicentang, selanjutnya nama dan alamat
pengirimannya ditentukan pada field Ship To.

No. SO :isi No. SOnya.

Tanggal : sesuaikan tanggal SO apabila diperlukan, bisa dengan
mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn) masing-
masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

No. PO : isi No. PO dari customer.

Tgl. PO : apabila No. PO diisi maka tanggal PO juga harus diisi, bisa
dengan mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn)
masing-masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

Valuta : otomatis terisi sesuai valuta customer bersangkutan pada Master
Customer. Apabila anda memilih “Breakdown Account Hutang
Usaha/Piutang Usaha menurut Supplier/Customer” (pada saat Setup
Preferensi pada tab Sistem) dan anda menentukan akun Piutang Usaha
untuk customer dimaksud pada Master Customer adalah akun dengan
valuta asing (bukan Rp), maka valuta untuk transaksi juga disesuaikan
dengan itu dan tidak bisa diubah, tetapi apabila dalam Rp maka valuta
transaksi bisa Rp atau valuta lainnya. Klik tombol drop-down apabila
ingin memilih valutanya. (Untuk varian Accpro Trada dan Accpro Strada
pilihan valuta tidak tersedia)

Kurs : jika valuta dalam Rp, maka Kurs otomatis terisi dengan 1 dan
tidak bisa diedit, sedangkan untuk valuta lainnya, anda harus
mengisinya. Apabila histori kurs untuk valuta bersangkutan pernah
diupdate melalui modul Tabel Valuta, maka akan otomatis terisi kurs
sesuai tgl terakhir yang pernah anda update dibandingkan dengan
tanggal SO.
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e Terms : apabila customer bersangkutan telah ditentukan terms of
paymentnya pada Master Customer, maka akan otomatis terisi. Apabila
Terms of Payment pada Master Customer tidak ditentukan tetapi pada
tabel Terms of Payment ada yang dijadikan default, maka juga akan
otomatis terisi dengan sendirinya. Sekalipun demikian masih bisa diubah
kalau diperlukan, klik tombol drop-down untuk memilih termsnya.

e ETD : Estimation Time of Delivery, sesuaikan tanggal perkiraan
pengiriman barang, bisa dengan mengetikkan langsung dengan format
dd/mm/yy (tgl/bln/thn) masing-masing 2 digit atau klik tombol drop-
down untuk memunculkan kalender.

e Salesman : tentukan Salesmannya dengan klik pada field ini atau tombol
drop-down yang ada. Apabila perlu menambah Salesman baru pilih <
New Salesman >.

e Ship To : apabila checkbox “Ship to Customer’s outlet” dicentang, maka
field ini akan aktif dan bisa ditentukan outletnya dengan mengkliknya
atau tombol drop-down yang ada. Daftar customer yang merupakan
outlet dari customer pada field Customer akan ditampilkan apabila
sudah ada customer yang ditentukan sebagai outletnya pada Master
Customer.

e Close this SO : checkbox ini hanya aktif pada modus Edit, gunanya
adalah untuk menutup SO yang belum lengkap dikirim tetapi SOnya
ingin ditutup.

e *Harga sudah termasuk PPN : tandai (centang) checkbox ini apabila
harga barang dikenakan PPN dan harga sudah termasuk PPN.

Khusus SO pada umumnya (checkbox Penjualan Lain-lain tidak dicentang)
(Untuk varian Accpro Trada hanya SO jenis ini yang tersedia, oleh karena itu
checkbox Penjualan Lain-lain tidak ditampilkan)

e Tab Barang:

2 Kode Barang : isi Kode Barangnya, atau klik tombol drop-down

pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
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Kode Barangnya, anda tinggal memilih item barang yang dimaksud.
Pilih < New > apabila perlu menambah barang baru.

Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Nama Barangnya. Tetapi harus diketahui bahwa apabila kolom
Kode Barang telah terisi, maka mengedit kolom ini hanya dianggap
oleh program sebagai mengedit Nama Barang, sedangkan
barangnya tetap mengacu pada Kode Barangnya, oleh karena itu
kalau anda ingin menentukan barangnya melalui kolom ini, pastikan
kolom Kode Barang belum terisi atau dikosongkan lebih dulu.
Sedangkan apabila kolom Kode Barang telah terisi, maka mengklik
tombol drop-down pada kolom ini akan menampilkan daftar nama
lain untuk barang ini (sesuai Kode Barangnya) yang telah anda input
melalui Master Barang & Jasa.

Qty : isikan kuantitasnya.

Dikirim : kolom ini hanya tampil pada modus Edit, menampilkan
kuantitas yang telah dikiirim berdasarkan data pengiriman barang
yang diinput melalui modul Delivery Order atau Sales Invoice, oleh
karena itu kolom ini tidak bisa diedit.

Satuan : apabila satuan untuk item barang yang anda isikan pada
kolom Kode Barang hanya satu (sesuai yang ada pada Master
Barang & Jasa), maka kolom ini akan terisi dengan sendirinya.
Namun apabila lebih dari satu, maka anda harus memilih satuannya
dengan mengklik tombol drop-down pada kolom ini

Harga Satuan : isi harga satuannya.

Disc % : kalau ada item discount untuk barang pada baris tertentu,
maka isikan persentasenya, bisa dalam bentuk bertingkat misalnya
5+2,5.

5-33



#  Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom
lainnya.

3z Cls : kolom ini hanya muncul pada modus Edit. Gunanya untuk
menandai baris transaksi tertentu yang belum dikirim lengkap tetapi
ingin ditutup (mungkin pesanan tidak ada atau telah dibuatkan SO

baru).

Khusus SO untuk Penjualan Lain-lain (checkbox Penjualan Lain-lain
dicentang)

(Untuk varian Accpro Trada karena SO untuk Penjualan Lain-lain tidak tersedia,
maka checkbox Penjualan Lain-lain juga tidak tersedia dan tidak ditampilkan)

e Tab Detail Transaksi :

zr  Deskripsi : isi deskripsi itemnya, anda bebas mengetikkan apa saja
baik item yang sudah ada pada tabel Item Penjualan ataupun tidak.
Semua item pada transaksi jenis ini adalah item Non Inventory atau
Jasa, oleh karena itu tidak memerlukan Kode Barang. Apabila tabel
Item Penjualan sudah ada datanya, maka akan ada bantuan berupa
daftar item yang dimunculkan begitu anda mengetikkan sesuatu,
pun bila anda mengklik tombol drop-down yang ada pada kolom
ini.

2 No. Perk : guna keperluan penjurnalan pada saat input transaksi
penjualannya melalui modul Sales Invoice, maka anda bisa
menentukan akun penjualan terkait masing-masing item penjualan.
Apabila default akun Penjualan Lain-lain telah ditentukan pada
modul Account Default, maka kolom ini otomatis terisi sesuai akun
default tersebut. Namun bila tidak, atau ingin merubah akunnya,
ketikkan Nomor Perkiraannya, daftar perkiraan akan dimunculkan
oleh program sebagai bantuan dalam mencari akun yang dimaksud.
Pilih < New > apabila ingin menambahkan akun baru ke Chart of
Account. Cara lain adalah dengan mengklik tombol drop-down pada

kolom ini, maka form Lookup Perkiraan akan ditampilkan sehingga
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anda dapat mencari perkiraan tertentu berdasarkan Nomor
Perkiraan atau Nama Perkiraannya. Klik tombol New apabila ingin
menambah akun baru. Apabila anda tidak menentukan akunnya
pada saat ini, maka anda bisa menentukannya pada saat input
transaksi penjualannya melalui modul Sales Invoice.

% Qty : isikan kuantitasnya.

3 Dikirim : kolom ini hanya tampil pada modus Edit. Kolom ini
menampilkan kuantitas yang telah dikirim berdasarkan data
penjualan yang diinput melalui modul Delivery Order atau Sales
Invoice, oleh karena itu kolom ini tidak bisa diedit.

%  Satuan : ketikkan satuannya, karena item non inventory maka anda
bebas mengetikkan apa saja bahkan bisa tidak diisi.

¥ Harga Satuan : isi harga satuannya.

#  Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.

%  Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.

Tips :

Untuk mengisi kolom No. Perk secara global khususnya bila Nomor
Perkiraannya sama untuk kesemua atau beberapa item pada detail
transaksi, maka gunakan cara dengan mengklik pada judul kolom No.
Perk, maka form Lookup Perkiraan akan ditampilkan. Setelah anda
memilih perkiraannya, maka akan diminta konfirmasi apakah perkiraan
ini akan diaplikasikan pada kesemua detail transaksi yang ada atau
hanya baris yang belum ditentukan Nomor Perkiraannya.

Disc : apabila ada diskon terhadap total nilai transaksi, isikan
persentasenya, mendukung multi diskon, contohnya 5+2,5. Nominal
jumlah diskon akan otomatis terisi pada field disebelahnya. Jika diskon
tidak berupa persentase terhadap nilai transaksi, maka isi field ini

dengan nominal jumlah diskonnya.
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e Uang Muka (1) : apabila ada Uang Muka terkait pesanan ini yang
dimintakan kepada Customer, dimana Customer juga diminta PPN atas
Uang Muka tersebut, anda bisa mengisinya di sini. Isi field ini hanya
sebesar nominal tanpa PPNnya. Jangan lupa untuk menginput transaksi
pelunasan atau tagihan Uang Muka ini (lihat penjelasan mengenai hal ini
pada 5.6 Sales Invoice).

e DPP : defaultnya DPP (Dasar Pengenaan Pajak) adalah 100 % (kecuali
jika telah diubah melalui Setup Preferensi) yang akan diisikan oleh
program apabila anda mencentang checkbox PPN di bawahnya, tetapi
bisa saja ada transaksi dengan DPP Nilai Lain, dalam hal ini anda bisa
mengisikan persentasenya sendiri. Jadi, DPP hanya perlu ditentukan jika
transaksi dikenakan PPN. Kalau dominan atau bahkan semua transaksi
penjualan yang dilakukan perusahaan adalah dengan DPP Nilai Lain
yang bukan 100%, maka sebaiknya anda menentukan defaultnya melalui
menu File > Setup Preferensi pada tab Profil, dimana pada tab ini anda
bisa menentukan persentase default DPP Penjualannya jika bukan 100%.

e PPN : Tandai (centang) checkbox ini jika ada PPNnya, maka persentase
PPN akan terisi sesuai default persentase PPN yang telah ditentukan
pada Setup Preferensi, demikian juga nominal PPN akan dihitung oleh
program. Jika checkbox *Harga sudah termasuk PPN dicentang, maka
checkbox PPN juga akan ikut tercentang dengan sendirinya. Apabila
pada saat input informasi perusahaan melalui menu File > Setup
Informasi Perusahaan anda telah mencentang checkbox “Pengusaha
Kena Pajak (PKP)” yang artinya anda memberitahukan kepada program
bahwa perusahaan anda adalah PKP, maka bahkan anda tidak perlu
mencentang checkbox PPN, karena program akan otomatis
melakukannya untuk anda setiap kali anda membuat transaksi SO yang
baru.

e Jumlah Biaya : apabila ada biaya lain, isi jumlah biayanya.

e Uang Muka (2) : anda bisa mengisi field ini jika diperlukan yaitu apabila
ada uang muka yang telah diterima dari customer yang akan
dikompensasi atas piutang yang timbul untuk penjualan atas SO ini.

Berbeda dengan uang muka yang diinput melalui field Uang Muka (1)
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maka uang muka yang diinput di sini jika uang muka yang diterima
belum diberikan (dilunasi) PPNnya.

Catatan : bila anda perlu memberikan catatan atas SO ini maka field ini
bisa diisi. Catatan ini nantinya akan muncul juga dan bisa dilihat oleh
user yang input Surat Jalan (DO)-nya pada field Notes on SO pada saat
input DOnya melalui modul Delivery Order.

Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

Tombol Delete Row : untuk menghapus baris tertentu.

Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Trs, No. SO atau No.
PO.

Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit tramsaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

Tombol Delete : menghapus transaksi tertentu.

Tombol Print : mencetak printout transaksi. Apabila checkbox Preview
tercentang maka akan ditampilkan dulu ke layar. Pengaturan default
untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Sales Order. Pilih ukuran kertas dan lakukan

pengaturan lain yang dikehendaki.
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5.5 Delivery Order

Transaksi penjualan barang biasanya didahului dengan menerbitkan Delivery
Order atau Surat Jalan. Namun apabila berupa penjualan langsung dimana
tanpa didahului dengan penerbitan DO, umumnya ini adalah perusahaan
yang menjual langsung produknya kepada customer tanpa diperlukan
pengantaran (delivery) atau bisa jadi barangnya berupa jasa, maka modul ini

bisa dilewati.

Modul ini dibuka dengan memilih menu Transaksi > Delivery Order atau
Klik icon = pada toolbar.

ﬁ Delivery Order (Surat Jalan)

o L T
No. 000001
144 E'E Surat Jalan 08/01/2015 0-15.000001 50-15.000001 07/01/2015 H
eeRIAL T
@) [[] ship to Customer's Outlet
PT. IMPERIAL RODA PERKASA PT. IMPERTAL RODA PERKASA Tidak Dinveicekan
3. Kedamaian Raya No. 123 11, Kedamaian Raya No. 123
Jakarta Selatan Jakarta Selatan
== e ==
005/IRP/PO/I/15 07/01/2015 = Budiono -
roroils | pmiws ||
Kode Barang Nama Barang
1. GT-50X x| GPS Tracker GT-50X 50 Unit ol
2. kP01 Kartu Perdana 50 Pes

3. VCH-250 Pulsa 250 ribu {utk 6 bulan) 50 Unit
4. J501F Free langganan web tracking 1 (satu) thn 50 Unit
5. J5-02F Free Jasa Pemasangan 50 Unit
[

7.
3.

InsertRaw Deletz Raw

Catatan | Noteson SO | Stock OnHand

Use
Default
4 b

e No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher atau Kode Transaksi) akan menjadi referensi untuk transaksi ini.
Default Kode Jurnal yang diberikan Accpro untuk modul ini adalah DO.

e Ship to Customer’s Outlet : hanya kalau Customer mempunyai outlet
atau cabang dan pengiriman adalah ke outletnya, anda perlu mencentang
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checkbox ini. Untuk keperluan ini, maka seyogyanya anda telah
menentukan customer-customer yang merupakan outlet dari suatu
customer pada saat input data customer tersebut melalui Master
Customer (lihat 4.3.6 Customer)

Tidak diinvoicekan : cetak checkbox ini jika ada DO yang tidak akan
pernah dibuatkan Invoicenya supaya Donya tidak muncul terus dalam
daftar DO yang belum dibuatkan Invoicenya.

Customer : pilih Customernya. Caranya klik pada field ini atau tombol
drop-down yang ada, kemudian ketikkan initial atau potongan awal
Nama Pengenal customer bersangkutan atau gunakan bantuan scroll-bar
untuk mencarinya. Setelah anda memilih customer, Nama Resmi dan
alamat customer akan ditampilkan pada textbox di bawahnya. Apabila
customer belum ada dalam daftar customer, pilih < New > untuk
menambahkannya, maka form Customer akan ditampilkan. Customer
yang diinput di sini harus merupakan nama dan alamat kepada mana
tagihan atau Invoice nantinya akan ditujukan. Sedangkan apabila
pengiriman kepada outlet atau cabang customer tersebut, maka checkbox
Ship to Customer’s Outlet bisa dicentang sehingga nama dan alamat
pengirimannya ditentukan pada field Ship To.

No. DO : isi Nomor DOnya.

Tgl. DO : sesuaikan tanggal DO apabila perlu, bisa dengan mengetikkan
langsung dengan format dd/mm/yy (tgl/bln/thn) masing-masing 2 digit
atau klik tombol drop-down untuk memunculkan kalender.

No. SO : apabila penjualan didahului dengan adanya Sales Order (SO),
maka anda tinggal memanggil SO yang bersangkutan dengan klik icon
¥ pada field ini. Form Lookup SO akan ditampilkan sehingga anda
tinggal memilih SO dimaksud. Apabila SO ditentukan maka field-field
yang lain pada form ini akan terisi dengan sendirinya sesuai data pada
SO, anda tinggal menyesuaikan kolom Qty sesuai jumlah yang dikirim.
Selebihnya hanya field Ship To yang harus ditentukan apabila Ship to
Customer’s Outlet.

Tgl. SO : tanggal SO akan terisi dengan sendirinya setelah anda memilih
No. SO.
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e No. PO : PO Customer bersifat optional. Apabila DO didahului SO maka
akan terisi dengan sendirinya setelah SO ditentukan

e Tgl. PO : tanggal PO harus diisi apabila No. PO diisi. Akan terisi sesuai
data pada SO apabila SO ditentukan.

e  Ship Via: field ini bersifat optional.

e Salesman : apabila SO ditentukan akan terisi sesuai data pada SO.
Sedangkan untuk DO tanpa SO akan terisi sesuai data Salesman pada
Master Customernya. Field ini bersifat optional.

e Ship To : apabila checkbox “Ship to Customer’s outlet” dicentang, maka
field ini akan aktif dan bisa ditentukan outletnya dengan mengkliknya
langsung atau tombol drop-down yang ada. Daftar customer yang
merupakan outlet dari customer pada field Customer akan ditampilkan
apabila sudah ada customer yang ditentukan sebagai outletnya pada

Master Customer.

e Tab Barang : apabila SO ditentukan maka detail transaksi pada tab
Barang ini akan terisi dengan sendirinya, tinggal anda menyesuaikan
kolom Qty sesuai kuantitas yang dikirim untuk masing-masing baris
transaksi, tetapi apabila DO tanpa SO, anda harus mengisi detail
transaksi secara manual.
7t Kode Barang : isi Kode Barangnya, atau klik tombol drop-down

pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Kode Barangnya, anda tinggal memilih item barang yang dimaksud.
2 Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Nama Barangnya. Tetapi harus diketahui bahwa apabila kolom
Kode Barang telah terisi, maka mengedit kolom ini hanya dianggap
oleh program sebagai mengedit Nama Barang, sedangkan
barangnya tetap mengacu pada Kode Barangnya, oleh karena itu

kalau anda ingin menentukan barangnya melalui kolom ini, pastikan
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kolom Kode Barang belum terisi atau dikosongkan lebih dulu.
Sedangkan apabila kolom Kode Barang telah terisi, maka mengklik
tombol drop-down pada kolom ini akan menampilkan daftar nama
lain untuk barang ini (sesuai Kode Barangnya) yang telah anda input
melalui Master Barang & Jasa.

Qty : isikan kuantitasnya. Jika barang dimaksud mempunyai Serial
No./Lot. No dan/atau Expire Date, maka pada kolom ini akan ada
tombol drop-down yang kalau diklik akan memunculkan form
“Perincian Serial No./Lot No. masing-masing Barang” dimana anda
bisa merinci kuantitas barang berikut Serial No./Lot No dan/atau
Expire Datenya. Baik DO dengan SO atau tanpa SO, anda tetap
harus merincinya. Pada varian Accpro Trada dan Accpro Strada fitur
Serial No./Lot No. atau Expire Date tidak tersedia, kalau anda
membutuhkan fitur ini anda harus menggunakan varian Accpro Spectra.
Satuan : apabila satuan untuk item barang yang anda isikan pada
kolom Kode Barang hanya satu (sesuai yang ada pada Master
Barang & Jasa), maka kolom ini akan terisi dengan sendirinya.
Namun apabila lebih dari satu, maka anda harus memilih satuannya
dengan mengklik tombol drop-down pada kolom ini

Konversi : apabila satuan pada kolom Satuan bukan merupakan
Satuan Dasar (Satuan Inventory), maka kolom ini akan terisi dengan
konversinya ke Satuan Inventory, jadi kolom ini hanya informasi

yang ditampilkan oleh program saja, tidak dapat diedit.

Tab Catatan : apabila ada catatan yang ingin disampaikan kepada

customer, maka field Catatan bisa diisi. Untuk memasukkan catatan

default yang telah anda tentukan pada tab Catatan pada modul Setup

Preferensi, klik tombol Use Default. Apabila anda ingin field Catatan

otomatis terisi catatan default setiap kali membuat transaksi DO yang

baru, maka isikan catatan default ini pada field Catatan pada tab Footer

ketika anda memodifikasi layout printout DO sesuai varian yang anda

pilih melalui Setup Printout Transaksi untuk modul Delivery Order
(Surat Jalan). (lihat 4.2.3 Setup Printout Transaksi).
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e Tab Notes On SO : khusus DO dengan SO, klik tab ini untuk melihat
apakah ada Catatan menyangkut SO yang bersangkutan, mungkin SO
diinput oleh wuser yang berbeda atau departemen lain misalnya
departemen Marketing dan ada pesan khusus yang ingin disampaikan ke
user yang melalukan input DO.

e Tab Stock On Hand : klik tab ini apabila anda ingin mengetahui saldo
barang menurut catatan komputer per tanggal transaksi dan saldo

keseluruhan untuk item barang dimana kursor saat itu berada.

Cakatan | Motes on SO | Stock On Hand |
Kode Brg : CFO01.12 | Box Oty Trs Ini Tersedia

Sampai dgn tgl. 14/01,/2008 50 50 100
5Saldo keseluruhan : 51 + 50 = 101

Penjelasan : Kuantitas yang tersedia untuk dilakukan pengiriman
(dibuatkan DO) untuk Kode Barang : CF001.12 pada tanggal 14 Januari
2008 adalah sebayak 100 Box. Tampilan diatas dilihat setelah transaksi
telah disimpan (modus Edit) dan tanggal komputer sudah lewat dari
tanggal 14 Januari 2008, maka kolom Saldo akan terisi sebesar 50 Box
yang adalah Saldo Tersedia pada tanggal 14 Januari (100 Box) dipotong
Qty Trs Ini (50 Box). Saldo Keseluruhan (51 + 50 = 101) lebih besar dari
Saldo Tersedia per 14/01/2008 karena setelah tanggal 14 Januari ada
transaksi masuk untuk Kode Barang bersangkutan sebesar 1 Box.
Apabila anda membuat transaksi baru (modus Add) per tanggal 14
Januari 2008 dan tanggal hari itu adalah sama dengan tanggal transaksi
maka kolom Saldo akan terisi 100, Qty Trs Ini adalah 0, Tersedia adalah
100, demikian juga Saldo Keseluruhan = 100.

e Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

e Tombol Delete Row : untuk menghapus baris tertentu.

¢ Tombol New : menambah transaksi baru.

e  Tombol Search : mencari transaksi berdasarkan No. Trs atau No. DO.
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Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan, artinya apabila tidak ada perubahan yang dilakukan anda
tidak perlu mengklik tombol ini untuk menghindari perubahan data
yang tidak disengaja. Tombol ini akan dinonaktifkan oleh program
apabila DO bersangkutan sudah dibuatkan Invoicenya melalui modul
Sales Invoice.

Tombol Save & New : fungsinya sama dengan tombol Save, hanya kalau
pada tombol Save, setelah menyimpan transaksi anda tetap akan berada
pada transaksi bersangkutan (anda akan berada pada modus Edit),
mungkin anda ingin mencetaknya lebih dulu sebelum anda membuat
transaksi baru dengan mengklik tombol New. Sedangkan menggunakan
tombol Save & New, setelah transaksi disimpan, maka form akan
dikosongkan dan siap untuk diinput sebagai transaksi baru (anda berada
pada modus Add). Tombol ini akan dinonaktifkan oleh program apabila
DO bersangkutan sudah dibuatkan Invoicenya melalui modul Sales
Invoice.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya bermaksud untuk menghapus
baris tertentu.

Tombol Print : mencetak printout DO (Surat Jalan). Apabila checkbox
Preview tercentang maka akan ditampilkan dulu ke layar. Pengaturan
default untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Delivery Order (Surat Jalan). Pilih ukuran kertas
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dan lakukan pengaturan lain yang dikehendaki melalui modul tersebut.
Apabila anda ingin mencetak DO sekaligus menyimpan transaksi, anda
bisa langsung klik tombol ini. Jadi tidak perlu mengklik tombol Save
dulu baru kemudian klik tombol Print, karena program akan menyimpan
transaksi sebelum mencetaknya. Apabila ada perubahan maka akan ada
konfirmasi apakah akan disimpan atau ingin membatalkan perubahan,

jadi apa yang tercetak adalah sesuai dengan apa yang tersimpan.

56 Sales Invoice

Setelah DO dibuat maka selanjutnya diterbitkan Sales Invoicenya. Namun jika
berupa penjualan langsung, maka Sales Invoice langsung dibuat tanpa harus
membuat DO lebih dulu. Apabila semua penjualan pada perusahaan adalah
berupa penjualan langsung, maka sebaiknya aktifkan opsi ini yaitu “Default
Penjualan adalah Penjualan Langsung (Tanpa Surat Jalan / DO)” melalui
modul Setup Preferensi sehingga setiap kali anda membuat Sales Invoice
tidak perlu harus selalu mencentang checkbox Penjualan Langsung. Untuk
Penjualan Langsung sendiri masih ada opsi Penjualan Lain-lain, yaitu untuk
penjualan yang tidak memerlukan Kode Barang sehingga tidak perlu
disiapkan lebih dulu data masternya. Penjualan Lain-lain ini biasanya untuk
penjualan yang bersifat insidentil dan untuk barang berupa Non Inventory
atau Jasa, dimana pengukuran atau pengontrolan terhadap saldo barang
tidak bisa atau tidak perlu dilakukan. (Untuk varian Accpro Trada opsi

Penjualan Lain-lain tidak tersedia)

Modul ini dibuka dengan memilih menu Transaksi > Sales Invoice atau

mengklik icon j pada toolbar.

¢ No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher atau Kode Transaksi) akan menjadi referensi untuk transaksi ini.
Default Kode Jurnal yang diberikan Accpro untuk modul ini adalah SI.

e Penjualan Langsung : hanya kalau berupa penjualan langsung (tanpa

DO), checkbox ini perlu dicentang.
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ﬁi Faktur Penjualan (Sales Invaice)

LD}
No. 000001 14 » M| Sales Invoice @ reiciniantin
L)

Penjualan Lain-lain : hanya kalau berupa Penjualan Lain-lain
sebagaimana yang telah dikemukakan dan dijelaskan pengertiannya di
atas, checkbox ini perlu dicentang. (Untuk varian Accpro Trada checkbox ini
tidak tersedia)

Penjualan Langsung

Uang Muka Penjualan
IMPERIAL TAX] - [NV-15.000001 08/01/2015 El
PT. IMPERIAL RODA PERKASA Ho. DO Tgl. PO
3. Kedamaian Raya No. 123 DO-15,000001 005/RP/POSI/15 07/01/2015 [ |
Jakarta Selatan

Ho. Faktur Pajak Tol.F. Pajak

Kode Barang Nama Barang Satua Harga Satuan

010.000-15.00000201 08/01/2015 E

s

00 Net 14 ~ [22/01/2015 Budiono -

[ *Harga sudah termasuk PPN

GPS Tracker GT-80X 50 Unit 2,200,000 110.000.000 ||

2. kP01 Kartu Perdana 50 Pes o
3, VCH-250 Pulsa 250 ribu {utk & bulan) 50 Unit 0
4. 1501F Free langganan web tracking 1 (satu) thn 50 Unit [ =4 F. Paisk
5. 15-02F Free Jasa Pemasangan 50 Unit 0
&
7.
. =
SubTotal 110.000.000
. saldo Barang
pee * :
{ UangMuka @) 0
DFP W % 110.000.000
PPN 10 % 11.000.000
Biaya & Pajak Lain 0
Catatan Grand Total 121.000.000
Pembayaran dengan Cheque/Giro, kami anagap lunas setelzh q Tuai /M
Cheque/Giro tersebut dapat kami Langkan 0
e Piutang 121.000.000
°

Uang Muka Penjualan : opsi ini berguna untuk input Sales Invoice
terutama untuk Uang Muka Penjualan dimana uang muka yang telah
diterima ada PPNnya sehingga harus diterbitkan Faktur Pajaknya atau
uang muka yang baru akan ditagihkan sehingga perlu diterbitkan
Invoicenya dan Faktur Pajaknya (bila ada PPNnya). Apabila uang muka
telah diterima sebelumnya (tidak timbul Piutang Dagang, karena uang
muka telah diterima bisa jadi hanya menggunakan kwitansi), maka
checkbox Jurnal jangan dicentang sehingga program tidak akan
melakukan penjurnalan lagi. Jadi hanya sekedar untuk keperluan
mencetak Faktur Pajak. Untuk perusahaan yang telah menggunakan
eFaktur dengan diinput melalui modul Sales Invoice, maka PPN
Keluarannya tinggal diekspor melalui fasilitas Ekspor ke CSV melalui
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menu Daftar > Daftar PPN Keluaran sehingga anda tidak perlu input
PPN Keluarannya ke dalam program eFaktur secara manual. Dengan
tidak mencentang checkbox Jurnal, maka penjurnalan mestinya telah
anda lakukan sendiri melalui modul Penerimaan Kas / Bank (bukan

Piutang Usaha) dimana jurnalnya kurang lebih sebagai berikut :

Kas atau Bank XXXXXXXXX (Db)
Uang Muka Penjualan XXXXXXXXX (Cr)
PPN Keluaran XXXXXXXXX (Cr)

Tetapi kalau uang muka belum diterima tetapi masih akan ditagihkan
(timbul Piutang Dagang), maka biarkan checkbox Jurnal dalam keadaan

tercentang sehingga program akan melakukan penjurnalan kurang lebih

sebagai berikut :
Piutang Dagang XOOOXXXX (Db)
Uang Muka Penjualan XXXXXXXXX (Cr)
PPN Keluaran XXXXXXXXX (Cr)

Selanjutnya anda bisa mencetak Invoice dan Faktur Pajak (untuk yang
belum menggunakan eFaktur) untuk tagihan Uang Muka ini, sedangkan
pelunasannya adalah melalui Penerimaan Kas/Bank dengan jenis
transaksinya adalah RV - Pelunasan Piutang Usaha.

e Customer : pilih Customernya. Caranya klik pada field ini atau tombol
drop-down disampingnya, kemudian ketikkan initial atau potongan
awal Nama Pengenal customer bersangkutan atau gunakan bantuan
scroll-bar untuk mencarinya. Setelah anda memilih customer, Nama
Resmi dan alamat customer akan ditampilkan pada textbox di bawahnya.
Apabila customer belum ada dalam daftar customer, pilih < New > untuk
menambahkannya, maka form Customer akan ditampilkan.

e No. Invoice : isi Nomor Invoicenya.

e Tgl. Invoice : sesuaikan tanggal Invoice apabila perlu, bisa dengan
mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn) masing-
masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

e No. DO : untuk penjualan dengan DO maka pilih DOnya dengan klik
pada tombol () yang ada pada field ini maka akan ditampilkan daftar
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DO untuk customer bersangkutan yang belum ada Invoicenya. Anda bisa
memilih lebih dari satu DO dengan mencentang checkbox yang
bersangkutan. Sedangkan untuk bukan penjualan langsung maka field
ini tidak ditampilkan tetapi sebagai gantinya field No. SO yang
ditampilkan. Setelah DO ditentukan maka detail transaksi akan terisi
sesuai data pada DOnya, anda tinggal menentukan Harga Satuan dan
mengisi kolom Disc% (kalau perlu). Bahkan apabila DO didahului
dengan SO, anda tidak perlu mengisi kedua kolom ini karena akan terisi
sesuai data pada SOnya, demikian juga field-field yang lain pada form
ini, hanya Faktur Pajak dan Tgl. F. Pajak yang perlu diisi jika dibutuhkan.
No. SO : hanya kalau Penjualan Langsung maka field ini ditampilkan,
itupun optional artinya hanya kalau ada SOnya maka anda tinggal
memanggil SO yang bersangkutan dengan klik icon ¥ pada field ini.
Form Lookup SO akan ditampilkan sehingga anda tinggal memilih SO
dimaksud. Apabila SO ditentukan maka field-field yang lain pada form
ini akan terisi dengan sendirinya sesuai data pada SO, anda tinggal
menyesuaikan kolom Qty sesuai jumlah yang dikirim. Selebihnya anda
tinggal mengisi No. Faktur Pajak dan Tgl. F. Pajak jika diperlukan.

No. PO : field ini akan terisi dengan sendirinya sesuai data pada DO atau
SOnya. Bisa juga diisi secara manual dan sifatnya adalah optional.

Tgl. PO : demikian juga Tgl. PO akan terisi sesuai data pada DO atau
SOnya. Apabila No. PO diisi, maka field ini juga harus diisi, caranya
sebagaimana Tgl. Invoice.

No. Faktur Pajak : isi No. Faktur Pajak jika ada (optional).

Tgl. Faktur Pajak : apabila No. Faktur Pajak diisi, maka field ini juga
harus diisi. Setelah No. Faktur Pajak diisi, Tgl. Faktur Pajak akan terisi
sesuai Tgl. Invoice, anda bisa mengeditnya apabila perlu.

Valuta : untuk penjualan dengan SO akan otomatis terisi sesuai data
pada SOnya, selain itu maka akan terisi sesuai valuta customer
bersangkutan pada Master Customer. Apabila anda memilih
“Breakdown Account Hutang Usaha/Piutang Usaha menurut
Supplier/Customer” (pada saat Setup Preferensi pada tab Sistem) dan
anda menentukan akun Piutang Usaha untuk customer dimaksud pada

Master Customer adalah akun dengan valuta asing (bukan Rp), maka
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valuta untuk transaksi juga disesuaikan dengan itu dan tidak bisa
diubah, tetapi apabila dalam Rp maka valuta transaksi bisa Rp atau
valuta lainnya. Klik tombol drop-down apabila ingin memilih valutanya.
(Untuk varian Accpro Trada dan Accpro Strada pilihan valuta tidak tersedia)
Kurs : untuk penjualan dengan SO akan terisi sesuai data pada SOnya,
selain daripada itu, apabila histori kurs untuk valuta bersangkutan
pernah diupdate melalui modul Tabel Valuta, maka akan otomatis terisi
kurs sesuai tgl terakhir yang pernah anda update dibandingkan dengan
tanggal Invoice. Jika valuta dalam Rp, maka Kurs otomatis terisi dengan
1 dan tidak bisa diedit. Sedangkan untuk valuta lainnya, bisa dientry
ataupun diedit.

Terms : untuk penjualan dengan SO akan terisi sesuai data pada SOnya,
selain daripada itu, apabila customer bersangkutan telah ditentukan
Terms of Paymentnya pada Master Customer, maka akan otomatis terisi.
Apabila Terms of Payment pada Master Customer tidak ditentukan
tetapi pada tabel Terms of Payment ada yang dijadikan default, maka
juga akan otomatis terisi dengan sendirinya. Sekalipun demikian masih
bisa diubah kalau diperlukan, klik tombol drop-down untuk memilih
termsnya.

Jatuh Tempo : otomatis terisi sesuai dengan Tanggal Invoice ditambah
jumlah hari jatuh tempo sesuai termsnya.

Salesman : untuk penjualan dengan SO atau DO akan terisi sesuai yang
sudah ditentukan disitu. Selain daripada itu, maka akan terisi sesuai
Salesman pada Master Customer. Namun jikapun tidak, anda bisa
memilih Salesmannya dengan mengklik tombol drop-down pada field
ini. Pilih < New > apabila ingin menambahkan Salesman baru. Apabila
tidak ada Salesmannya field ini boleh tidak diisi.

Customer Tunai (Non A/R) : checkbox ini hanya tampil apabila customer
merupakan Customer Tunai yaitu customer yang pembayarannya tunai
sehingga tidak mempunyai kartu piutang. Penentuan mengenai hal ini
adalah melalui Master Customer.

*Harga sudah termasuk PPN : tandai (centang) checkbox ini apabila
harga barang dikenakan PPN dan harga sudah termasuk PPN.

5-48



¢ Account Uang Muka Penjualan : apabila transaksi merupakan Uang
Muka Penjualan yang ada jurnalnya (checkbox Uang Muka dan Jurnal
dicentang), maka field ini akan ditampilkan oleh program dan anda
harus mengisinya dengan No. Perkiraan yang berupa Uang Muka
Penjualan atau gunakan tombol LookUp di sebelah field ini untuk

mencari perkiraan yang dimaksud.

Khusus Penjualan pada umumnya (checkbox Penjualan Lain-lain tidak
dicentang)
(Untuk varian Accpro Trada, hanya opsi Penjualan jenis ini yang tersedia, sehingga

checkbox Penjualan Lain-lain juga tidak ditampilkan)

e Tab Barang : apabila penjualan dengan DO maka detail transaksi pada
tab Barang akan terisi dengan sendirinya sesuai data pada DOnya, hanya
kolom Harga Satuan dan Disc% (kalau ada) yang harus anda tentukan
dan hanya kedua kolom ini yang bisa diakses, kolom-kolom lainnya
adalah sesuai dengan data pada DOnya, oleh karena itu tidak bisa
diubah. Jadi baik Qty dan perincian Serial No./Lot No, atau Expire Date
(kalau ada) adalah sesuai yang telah ditentukan pada DOnya. Sedangkan
untuk penjualan langsung (penjualan tanpa DO, dengan mencentang
checkbox Penjualan Langsung) dan tidak ada SOnya, maka kolom-kolom
ini harus diisi sendiri.

#+ Kode Barang : isi Kode Barangnya, atau klik tombol drop-down
pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Kode Barangnya, anda tinggal memilih item barang yang dimaksud.
Pilih < New > apabila perlu menambah barang baru.

# Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan

Nama Barangnya. Tetapi harus diketahui bahwa apabila kolom
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Kode Barang telah terisi, maka mengedit kolom ini hanya dianggap
oleh program sebagai mengedit Nama Barang, sedangkan
barangnya tetap mengacu pada Kode Barangnya, oleh karena itu
kalau anda ingin menentukan barangnya melalui kolom ini, pastikan
kolom Kode Barang belum terisi atau dikosongkan lebih dulu.
Sedangkan apabila kolom Kode Barang telah terisi, maka mengklik
tombol drop-down pada kolom ini akan menampilkan daftar nama
lain untuk barang ini (sesuai Kode Barangnya) yang telah anda input
melalui Master Barang & Jasa.

Qty : isikan kuantitasnya. Jika barang dimaksud mempunyai Serial
No./Lot. No dan/atau Expire Date, maka pada kolom ini akan ada
tombol drop-down yang kalau diklik akan memunculkan form
“Perincian Serial No./Lot No. masing-masing Barang” dimana anda
bisa merinci kuantitas barang berikut Serial No./Lot No dan/atau
Expire Datenya. Pada varian Accpro Trada dan Accpro Strada fitur Serial
No./Lot No. atau Expire Date tidak tersedia, kalau anda membutuhkan fitur
ini anda harus menggunakan varian Accpro Spectra.

Satuan : apabila satuan untuk item barang yang anda isikan pada
kolom Kode Barang hanya satu (sesuai yang ada pada Master
Barang & Jasa), maka kolom ini akan terisi dengan sendirinya.
Namun apabila lebih dari satu, maka anda harus memilih satuannya
dengan mengklik tombol drop-down pada kolom ini

Harga Satuan : isi harga satuannya. Apabila harga jual (sesuai
satuannya) untuk item barang bersangkutan telah ditentukan (bisa
lewat Set Harga Jual atau Master Barang & Jasa) dan customer
terkait telah dikaitkan kepada skema harga jual tertentu (melalui
Master Customer), maka apabila kolom ini masih kosong dengan
mengklik pada kolom ini harga satuan akan terisi dengan
sendirinya.

Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.
Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.



Khusus Penjualan Lain-lain (checkbox Penjualan Lain-lain dicentang)

Sebagaimana telah dikemukakan di awal, Penjualan Lain-lain adalah

penjualan yang menyangkut barang-barang yang tidak perlu dikontrol

stoknya atau bisa jadi berupa jasa, daripada harus membuatkan Kode Barang

untuk barang-barang semacam ini sementara tidak ada urgensinya (karena

tidak perlu atau bahkan tidak bisa dikontrol stoknya), terutama lagi kalau

penjualannya hanya insidentil (sesekali) maka lebih baik memanfaatkan opsi

Penjualan Lain-lain ini yang tidak memerlukan Kode Barang.

(Untuk varian Accpro Trada, karena opsi Penjualan Lain-lain tidak tersedia maka

checkbox ini juga tidak tersedia dan tidak ditampilkan)

e Tab Detail Transaksi : apabila penjualan dengan SO, maka detail

transaksi akan terisi dengan sendirinya sesuai dengan data pada SOnya,

selain itu anda harus mengisinya sendiri.

£t

Deskripsi : isi deskripsi itemnya, anda bebas mengetikkan apa saja
baik item yang sudah ada pada tabel Item Penjualan ataupun tidak.
Semua item pada transaksi ini adalah item Non Inventory, oleh
karena itu tidak memerlukan Kode Barang. Apabila tabel Item
Penjualan sudah ada datanya, maka akan ada bantuan berupa daftar
item yang dimunculkan begitu anda mengetikkan sesuatu, pun bila
anda mengklik tombol drop-down yang ada pada kolom ini.

No. Perk : guna keperluan penjurnalan, maka anda harus
menentukan akun penjualannya. Apabila anda sudah menentukan
default akun Penjualan Lain-lain melalui menu Master Data >
Account Default, maka akan otomatis terisi akun dimaksud. Namun
jika anda ingin merubahnya, ketikkan Nomor Perkiraannya, daftar
perkiraan akan dimunculkan oleh program sebagai bantuan dalam
mencari akun yang dimaksud. Pilih < New > apabila ingin
menambahkan akun baru ke Chart of Account. Cara lain adalah
dengan mengklik tombol drop-down pada kolom ini, maka form
Lookup Perkiraan akan ditampilkan sehingga dapat dapat mencari
perkiraan tertentu berdasarkan Nomor Perkiraan atau Nama

Perkiraannya. Klik tombol New apabila ingin menambah akun baru.
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Ingat ! Yang diinput di sini adalah akun penjualan atau
pendapatannya bukan akun Piutang Usahanya.

#  Qty :isikan kuantitasnya.

#  Satuan : ketikkan satuannya, karena item Non Inventory maka anda
bebas mengetikkan apa saja bahkan bisa tidak diisi.

zr  Harga Satuan : isi harga satuannya.

#t Disc % : kalau ada item discount untuk barang pada baris ini, maka
isikan persentasenya, bisa dalam bentuk bertingkat misalnya 5+2,5.

#+  Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya.

Tips :

Untuk mengisi kolom No. Perk secara global khususnya bila Nomor
Perkiraannya sama untuk kesemua atau beberapa item pada detail
transaksi, maka gunakan cara dengan mengklik pada judul kolom No.
Perk, maka form Lookup Perkiraan akan ditampilkan. Setelah anda
memilih perkiraannya, maka akan diminta konfirmasi apakah perkiraan
ini akan diaplikasikan pada kesemua detail transaksi yang ada atau
hanya baris yang belum ditentukan Nomor Perkiraannya.

e Tab Biaya (Beban Customer) : bila tidak ada biaya lain maka bagian ini
bisa dilewati.

Umumnya biaya disini berasal dari biaya atas jasa pihak ketiga yang

telah dibayarkan oleh anda sebagai pihak penjual dan akan dibebankan

kepada pihak pembeli, contohnya biaya pengiriman, biaya angkut

(freight) dan sebagainya.

7  Nama Biaya : ketikkan nama biayanya atau klik tombol drop-down
yang ada, maka daftar biaya yang telah anda input ke tabel Biaya
(menu Master Data > Tabel Lain-lain > Tabel Biaya) akan
ditampilkan sehingga anda dapat memilihnya.

z  Jumlah: isi jumlah biayanya.

2 Keterangan : jika perlu ketikkan deskripsinya.
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Catatan :

Apabila biaya merupakan pengeluaran yang telah dilakukan atas jasa
pihak ketiga, maka seyogyanya anda perlu membuat jurnal pengeluaran
Kas / Bank (jenis transaksi : bukan Piutang Usaha) yang mengkredit
akun Kas / Bank dan mengdebit akun biaya. Kalau disini anda
membebankan pada departemen tertentu, maka anda harus konsisten
pada saat mengkreditkannya kembali pada saat membebankannya
kepada customer.

Disc : apabila ada diskon terhadap total nilai transaksi, isikan
persentasenya, mendukung multi diskon, contohnya 5+2,5. Nominal
jumlah diskon akan otomatis terisi pada field disebelahnya, jika diskon
tidak berupa persentase terhadap nilai transaksi, maka isi field
disebelahnya ini dengan nominal jumlah diskonnya.

Uang Muka : field ini diperuntukkan apabila sebelumnya untuk
penjualan ini telah diterima uang muka sejumlah tertentu berikut
PPNnya. Disini anda harus mengisinya dengan nominal uang muka
tidak termasuk PPNnya. Apabila field Uang Muka diisi, anda juga harus
menentukan akun uang mukanya, ketikkan nomor perkiraannya pada
field No. Perkiraan tab Uang Muka (yang akan dimuculkan oleh
program) atau klik tombol Lookup disebelahnya untuk menampilkan
Lookup Perkiraan. Apabila sebelumnya pada transaksi penerimaan atau
tagihan Uang Muka, anda telah mengkredit akun Uang Muka Penjualan
misalnya, seyogyanya akun uang muka yang didebit disini juga Uang
Muka Penjualan. Uang Muka Penjualan default bisa anda tentukan
melalui modul Account Default sehingga akun Uang Muka akan terisi
dengan sendirinya, walaupun masih bisa diubah lagi pada saat transaksi.
Sebelumnya, pada saat uang muka diterima atau ditagihkan, semestinya
anda telah menginput transaksi terkait tagihan atau penerimaan Uang
Muka ini. Anda bisa menginput transaksinya melalui modul Penerimaan
Kas / Bank (jenis transaksi : bukan Piutang Usaha) dengan jurnal sebagai
berikut :

Kas atau Bank XXXXXXXXX (Db)
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Uang Muka Penjualan XXXXXXXXX (Cr)

PPN Keluaran XXXXXXXXX (Cr)

Tetapi dengan cara ini maka PPN Keluaran yang timbul tidak akan
muncul pada Daftar PPN Keluaran sehingga anda tidak bisa
mengekspornya ke file CSV melalui fasilitas yang disediakan Accpro
pada modul Daftar PPN Keluaran sehingga anda harus input secara
manual pada program eFaktur. Ada cara yang lebih baik, yaitu dengan
input tagihan atau penerimaan Uang Muka yang disertai PPNnya
melalui modul Sales Invoice ini juga dengan mencentang checkbox Uang
Muka Penjualan. Biarkan checkbox Jurnal tetap tercentang, maka jurnal

yang timbul atas transaksi ini adalah sebagai berikut :

Uang Muka Penjualan XXXXXXXXX (Cr)
PPN Keluaran XOOOKXXXX (Cr)
Piutang Usaha XXXXXXXXX (Db)

Tagihan Uang Muka ini nantinya tinggal anda terima pelunasannya
melalui modul Penerimaan Kas/Bank. Bisa juga anda langsung
melakukan pelunasannya langsung melalui modul Sales Invoice ini juga
dengan mengisi field Tunai sebesar Piutang Usaha yang timbul dengan
menentukan Akun G/L yang akan didebit terkait pelunasan ini sebagai

akun Kas/Bank, maka jurnal yang timbul akan menjadi sebagai berikut :

Uang Muka Penjualan XXXXXXXXX (Cr)
PPN Keluaran XXXXXXXXX (Cr)
Piutang Usaha XXXXXXXXX (Db)
Kas atau Bank XXXXXXXXX (Db)
Piutang Usaha XXXXXXXXX (Cr)

Pertanyaannya adalah apa bedanya checkbox Jurnal dicentang atau
tidak. Apabila checkbox Jurnal tidak dicentang, maka program tidak
akan membuatkan jurnalnya, demikian juga tidak timbul Piutang Usaha
atas tagihan Uang Muka ini. Ini dilakukan apabila penerimaan Uang
Muka ini telah anda lakukan melalui modul Penerimaan Kas/Bank
seperti dikemukakan di atas (apabila anda mencentang checkbox Jurnal

maka berarti terjadi dua kali penjurnalan dan pengkreditan terhadap
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akun Uang Muka Penjualan), anda perlu input tagihan Uang Mukanya
melalui modul Sales Invoice ini terutama untuk keperluan mencetak
Faktur Pajak atas tagihan Uang Muka ini (untuk user yang belum
menggunakan eFaktur), sedangkan untuk user yang telah menggunakan
eFaktur adalah agar PPN Keluaran atas tagihan Uang Muka Penjualan ini
dapat diekspor menggunakan fasilitas Ekspor ke CSV pada modul Daftar
PPN Keluaran.

DPP : defaultnya DPP (Dasar Pengenaan Pajak) adalah 100 % (kecuali
jika telah diubah melalui Setup Preferensi) yang akan diisikan oleh
program apabila anda mencentang checkbox PPN di bawahnya, tetapi
bisa saja ada transaksi dengan DPP Nilai Lain, dalam hal ini anda bisa
mengisikan persentasenya sendiri. Jadi, DPP hanya perlu ditentukan jika
transaksi dikenakan PPN. Kalau dominan atau bahkan semua transaksi
penjualan yang dilakukan perusahaan adalah dengan DPP Nilai Lain
yang bukan 100%, maka sebaiknya anda menentukan defaultnya melalui
menu File > Setup Preferensi pada tab Profil. Pada tab ini anda bisa
menentukan persentase default DPP Penjualannya jika bukan 100%.

PPN : Tandai (centang) checkbox ini jika ada PPNnya, maka persentase
PPN akan terisi sesuai default persentase PPN yang telah ditentukan
pada Setup Preferensi, demikian juga nominal PPN akan dihitung oleh
program. Jika checkbox *Harga sudah termasuk PPN ditandai, maka
checkbox PPN juga akan ikut tercentang dengan sendirinya. Apabila
pada saat input informasi perusahaan melalui menu File > Setup
Informasi Perusahaan anda telah mencentang checkbox “Pengusaha
Kena Pajak (PKP)” yang artinya anda memberitahukan kepada program
bahwa perusahaan anda adalah PKP, maka bahkan anda tidak perlu
mencentang checkbox PPN, karena program akan otomatis
melakukannya untuk anda setiap kali anda membuat transaksi Sales
Invoice yang baru tetapi untuk Sales Invoice yang ada SOnya maka field
ini akan menyesuaikan data pada SOnya.

Tunai / UM : field ini diperuntukkan apabila ada pembayaran tunai atau
ada uang muka yang telah dibayarkan oleh customer yang akan didebit
sehingga mengurangi Piutang Customer atas Invoice ini. Berbeda dengan

field Uang Muka di atas, maka uang muka yang telah diterima di sini
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belum termasuk PPNnya atau memang transaksi yang tidak dikenakan
PPN. Apabila ada uang muka yang telah diterima sebelumnya maka
seyogyanya anda telah menginput transaksinya sebagai Penerimaan Kas

/ Bank (jenis transaksi : bukan Piutang Usaha) dengan jurnal sebagai

berikut :
Kas atau Bank XXXXXXXXX (Db)
Uang Muka Penjualan XXXXXXXXX (Cr)

Apabila field ini diisi, anda juga harus menentukan akunnya apakah
berupa Kas / Bank atau Uang Muka Penjualan. Pilih Kas / Bank jika
pernerimaan pembayarannya (apakah sebagian atau seluruhnya)
bersamaan dengan transaksi ini, sedangkan bila penerimaan Kas / Bank
telah dilakukan sebelumnya sebagai uang muka, maka pilih Uang Muka
Penjualan. Ketikkan nomor perkiraannya pada field No. Perkiraan pada
tab Tunai / UM (yang akan dimunculkan oleh program) atau klik tombol
Lookup disebelahnya untuk menampilkan Lookup Perkiraan. Khusus
apabila berupa uang muka, maka apabila sebelumnya pada Penerimaan
Kas / Bank, anda telah mengkredit akun Uang Muka Penjualan misalnya,
seyogyanya akun uang muka yang didebit disini juga Uang Muka
Penjualan.

Field ini akan terisi dengan sendirinya sebesar total transaksinya
(nominal pada Grand Total) apabila customer adalah Customer Tunai,
indikasinya checkbox Customer Tunai (Non A/R) akan ditampilkan pada
form ini. Apakah Customer Tunai atau bukan telah anda tentukan
sebelumnya pada saat input customer bersangkutan pada Master
Customer. Customer Tunai berarti customer yang transaksinya tidak
menghasilkan Piutang Usaha karena dilunasi secara tunai. Field ini akan
dikunci oleh program apabila customer adalah Customer tunai. Anda
harus menentukan akun Kas / Bank dengan mengisikannya pada field
No. Perkiraan pada tab Tunai / UM atau dengan memilih perkiraannya
menggunakan bantuan form Lookup Perkiraan yang akan ditampilkan
apabila anda mengklik tombol Lookup di sebelah field No Perkiraan.
Khusus Customer Tunai, anda bisa menentukan akun default untuk

Kas/Bank Penjualan Tunai melalui modul Account Default sehingga akan
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terisi dengan sendirinya, walaupun masih bisa diubah pada saat
transaksi.

Sedangkan bila bukan Customer Tunai, maka akan timbul Piutang Usaha
walaupun akan dikreditkan kembali sebesar jumlah yang dibayarkan
tunai ataupun uang muka yang telah dibayarkan oleh customer.
Walaupun ada pembayaran tunai, namun anda bisa juga tidak
menginputnya disini tetapi tetap lewat modul Penerimaan Kas / Bank
(jenis transaksi : Pelunasan Piutang Usaha). Jadi manfaatkan field Tunai /
UM khususnya Customer Tunai hanya jika anda memerlukannya atau
prosedur di perusahaan anda memungkinkannya karena belum tentu
user yang ditugaskan untuk input penjualan berwenang untuk input
pelunasannya. Anda bisa menggunakan modul Penerimaan Kas/Bank
untuk input pelunasannya, atau apabila murni pelunasannya
menggunakan uang muka penjualan yang telah diterima sebelumnya
maka bisa menggunakan modul Credit Note (menu Credit Note / Debit
Note > Credit Note atas Piutang Customer).

Catatan : bisa diisi catatan untuk ditampilkan pada printoutnya yang
berupa Sales Invoice. Apabila pada Setup Preferensi telah ditentukan
catatan defaultnya dan diatur agar diaplikasikan otomatis setiap kali
buat Invoice baru, maka field ini akan otomatis terisi dengan catatan
default tadi. Namun bila pada varian layout printout Sales Invoice yang
anda pilih melalui Setup Printout Transaksi telah anda tentukan catatan
defaultnya pada tab Footer ketika memodifikasinya (lihat 4.2.3 Setup
Printout Transaksi), maka catatan default inilah yang akan otomatis terisi
ke dalam field Catatan.

Use Default : untuk mengisi catatan dengan catatan default, apabila
catatan default telah ditentukan tetapi tidak diatur untuk diaplikasikan
otomatis tiap kali buat Invoice baru.

Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

Tombol Delete Row : untuk menghapus baris tertentu.

Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Trs, No. Invoice atau
Faktur Pajaknya.
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e Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan, artinya apabila tidak ada perubahan yang dilakukan anda
tidak perlu mengklik tombol ini untuk menghindari perubahan data
yang tidak disengaja. Tombol ini akan dinonaktifkan oleh program
apabila Sales Invoice bersangkutan sudah pelunasannya.

e Tombol Save & New : fungsinya sama dengan tombol Save, hanya kalau
pada tombol Save, setelah menyimpan transaksi anda tetap akan berada
pada transaksi bersangkutan (anda berada pada modus Edit), mungkin
anda ingin mencetaknya lebih dulu sebelum anda membuat transaksi
baru dengan mengklik tombol New. Sedangkan menggunakan tombol
Save & New, setelah transaksi disimpan, maka form akan dikosongkan
dan siap untuk diinput sebagai transaksi baru (anda berada pada modus
Add).

¢ Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

e Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya bermaksud untuk menghapus
baris tertentu.

¢  Tombol Invoice : mencetak invoice penjualan. Apabila checkbox Preview
tercentang maka akan ditampilkan dulu ke layar. Pengaturan default
untuk ini adalah melalui menu File > Setup Printout Transaksi,
kemudian pilih modul Sales Invoice. Pilih ukuran kertas dan lakukan
pengaturan lain yang dikehendaki. Pada saat anda mencetak invoice
maka program akan sekaligus menyimpan transaksi lebih dulu, oleh

karena itu anda cukup langsung klik tombol ini pada saat selesai input
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transaksi dan ingin mencetaknya tanpa harus mengklik tombol Save

lebih dulu. Ini berarti apa yang anda cetak adalah apa yang sudah
tersimpan.

¢ Tombol F. Pajak : mencetak Faktur Pajak apabila transaksi bersangkutan
ada PPNnya.
57 Sales Return

Apabila ada retur penjualan maka bisa diinput melalui modul ini dengan
memilih menu Transaksi > Sales Return

S T
M, aooamt
) m—
Customer
e sales Return
SEMESTA GPS - - | | mwv-15.000002 -
PT. SEMESTA GPS L=
31, Tamansari No. 53 Tgl. DO Total A/R 27.063.437
Telukbetung Tal. Invoice  12/01/2015 Sudah Dibayar 0
Bandar Lampung valuta Rp  Kurs 1,00 {Tidzk termasuk Retur ini)

=

Kode Barang Nama Barang
1 GN-333X =] GPS Navigasi GN-333X
2,

Keterangan  Barang rusak, Customer Ref. No. 002/SG/PR/15

[] *Harga sudah termasuk PPN

Harga Satuan | Disc (%)

1.500.000 27,5+2,5

Insert Row Delete Row Sub Total 1.060.313

Disc % 0

DPP 100 % 1.060.313

PPN 10 % 106.031

Grand Total 1.166.344

No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher) akan menjadi referensi untuk transaksi ini. Default Kode Jurnal
yang diberikan Accpro untuk modul ini adalah SR.
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e Tgl. Retur : sesuaikan tanggal retur apabila diperlukan, bisa dengan
mengetikkan langsung dengan format dd/mm/yy (tgl/bln/thn) masing-
masing 2 digit atau klik tombol drop-down untuk memunculkan
kalender.

e No. Referensi : ketikkan nomor bukti atau referensinya.

e  Customer : pilih Customernya. Caranya klik pada field ini atau tombol
drop-down disampingnya, kemudian ketikkan initial atau potongan
awal Nama Pengenal customer bersangkutan atau gunakan bantuan
scroll-bar untuk mencarinya. Setelah anda memilih supplier, Nama
Resmi dan alamat customer akan ditampilkan pada textbox di bawahnya.

e No. DO : centang checkbox pada field ini jika anda ingin melakukan
retur atas DO yang belum ada Invoicenya, kemudian klik tombol drop-
down yang ada untuk memilih DO yang ingin diretur.

¢ No. Invoice : checkbox pada field secara default akan otomatis tercentang
setiap kali anda membuat transaksi retur baru, artinya kalau tidak
ditentukan lain maka program akan menganggap anda akan melakukan
retur atas penjualan yang sudah ada Invoicenya. Klik tombol drop-
downnya untuk memilih Invoice yang akan diretur.

e Keterangan : bisa untuk mengisi keterangan menyangkut alasan diretur
dan sebagainya.

e *Harga sudah termasuk PPN : checkbox ini akan disesuaikan dengan

(mengikuti) transaksi penjualannya.

e Tab Barang:

3t Kode Barang : klik tombol drop-down pada kolom ini, maka daftar
Barang akan ditampilkan dalam urutan Kode Barangnya, anda
tinggal memilih item barang yang dimaksud. Daftar barang yang
ditampilkan adalah hanya yang ada pada transaksi penjualan yang
ingin diretur dan ditampilkan berikut kuantitas penjualannya serta
kuantitas tersedia untuk diretur.

7z Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,

apabila lebih mudah mengingat Nama Barangnya, anda bisa
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menggunakan kolom ini untuk memilih barang tertentu, klik tombol
drop-down pada kolom ini, maka daftar Barang akan ditampilkan
dalam urutan Nama Barangnya sesuai yang ada pada transaksi
penjualannya.

Qty : isikan kuantitasnya. Jika barang dimaksud mempunyai Serial
No./Lot. No dan/atau Expire Date, maka pada kolom ini akan ada
tombol drop-down yang kalau diklik akan memunculkan form
“Perincian Serial No./Lot No. masing-masing Barang” dimana anda
bisa merinci kuantitas barang berikut Serial No./Lot No dan/atau
Expire Datenya. Pada varian Accpro Trada dan Accpro Strada fitur Serial
No./Lot No. atau Expire Date tidak tersedia, kalau anda membutuhkan fitur
ini anda harus menggunakan varian Accpro Spectra.

Satuan : setelah anda mengisi Kode Barangnya, kolom ini akan terisi
sesuai satuan pada saat penjualan. Apabila satuan pada Master
Barang & Jasa untuk barang bersangkutan lebih dari satu, anda bisa
memilih satuan lainnya dengan mengklik tombol drop-down yang
ada.

Harga Satuan : kolom ini akan terisi sesuai harga satuan dan satuan
pada transaksi penjualannya dan akan menyesuaikan apabila satuan
pada kolom Satuan anda ubah. Apabila retur atas DO maka kolom
ini tidak ditampilkan

Disc % : kolom ini akan terisi persentase diskon sesuai transaksi
penjualannya, namun apabila perlu anda bisa mengeditnya. Untuk
retur atas DO, kolom ini tidak ditampilkan.

Nilai : kolom ini akan terisi dengan sendirinya, maka kolom ini tidak
bisa diakses, indikasinya warna kolom berbeda dengan kolom

lainnya. Untuk retur atas DO, kolom ini tidak ditampilkan.

Disc : field ini akan terisi sesuai persentase diskon pada transaksi

penjualannya. Dimungkinkan untuk diedit, mendukung diskon

bertingkat (multi diskon), contohnya 5+2,5. Nominal jumlah diskon akan

otomatis terisi pada field disebelahnya. Jika diskon tidak berupa

persentase terhadap nilai transaksi, maka field akan terisi sesuai
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proporsional nilai transaksi (Sub Total) yang diretur terhadap nilai
transaksi penjualannya. Untuk retur atas DO, field ini tidak ditampilkan.

e DPP : field ini persentasenya akan terisi sesuai persentase DPP pada
transaksi penjualannya, oleh karena itu tidak bisa diedit. Untuk retur atas
DO, field ini tidak ditampilkan.

e PPN : field ini akan disesuaikan dengan transaksi penjualannya, tetapi
tetap dimungkinkan untuk diedit. Untuk retur atas DO, field ini tidak
ditampilkan.

e  Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang
ada.

¢  Tombol Delete Row : untuk menghapus baris tertentu.

¢ Tombol New : menambah transaksi baru.

e Tombol Search : mencari transaksi berdasarkan No. Trs, No. DO, No.
Invoice dan No. Referensi Retur.

¢ Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

¢ Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit tramsaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

e Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya berfungsi untuk menghapus baris
tertentu.

e  Tombol Print : mencetak printout transaksi. Apabila checkbox Preview
tercentang maka akan ditampilkan dulu ke layar. Pengaturan default
untuk ini adalah melalui menu File > Setup Printout Transaksi,
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kemudian pilih modul Sales Return. Pilih ukuran kertas dan lakukan

pengaturan lain yang dikehendaki.

5.8 Jurnal Transaksi

Pada umumnya, untuk setiap transaksi akan otomatis dilakukan penjurnalan
oleh program, dan jurnal transaksinya dapat dilihat pada modul ini. Namun
demikian, tetap ada jurnal-jurnal yang harus dibuat sendiri secara manual
khususnya adalah jurnal penyesuaian pada akhir periode. Jurnal yang
merupakan posting dari modul lain yaitu jurnal yang otomatis dibuatkan
oleh program, pada modul ini hanya sebatas bisa dilihat saja, tidak bisa diedit
atau dihapus, kalau ingin mengedit atau menghapusnya adalah melalui

modul yang bersangkutan.

Untuk membuka modul Jurnal Transaksi periode bulan tertentu, pilih menu
Transaksi > Jurnal Transaksi kemudian pilih periodenya. Hanya periode
yang belum tutup buku yang bisa diakses, sedangkan bila sudah tutup buku,
maka harus diaktifkan kembali lebih dulu untuk bisa mengaksesnya melalui
menu Utilitas > Tutup Buku. Khusus periode bulan berjalan maka bisa

diakses juga dengan mengklik icon E pada toolbar.

¢ No.: No. Transaksi otomatis digenerate oleh program sehingga tidak bisa
diubah.

e Tanggal : sesuaikan tanggal transaksi dengan mengetikkannya langsung
dengan format dd/mm/yy (tgl/bln/thn) masing-masing 2 digit atau klik
tombol drop-down untuk memunculkan kalender. Khusus modul ini,
tanggal transaksi harus dalam range periode transaksi yang anda pilih.

e No. Voucher : No. Voucher terdiri dari Kode Jurnal (kode transaksi) dan
Nomor Jurnal. Untuk jurnal yang merupakan posting dari modul lain,
maka No. Voucher adalah sesuai dengan Kode Jurnal (kode transaksi)
dan Nomor transaksi dari mana transaksi berasal. Sedangkan untuk
transaksi yang diinput melalui modul ini telah disediakan satu Kode
Jurnal default yaitu GJ (General Journal), dengan catatan default Kode

Jurnal ini belum anda ubah melalui Set Kode Jurnal pada Setup
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Preferensi. Anda dimungkinkan membuat Kode Jurnal lain untuk modul
ini dengan memilih < New > pada pilihan No. Voucher setelah anda
mengklik langsung pada field ini atau tombol drop-downnya. No.
Jurnalnya sendiri akan otomatis digenerate oleh program setelah anda
memilih Kode Jurnalnya. Jadi No. Jurnal tidak bisa diubah secara

manual.

AEEE Jarnat Tramalkar /L~ Jartar 20T s S

Modul ini digunakan untuk memasukkan jurnal transaksi yang bersifat umum, sedangkan untuk transaksi khusus yang sudah ada

medulnya tersendiri harus dimasukkan melalui medul yang bersangkutan, Untuk jurnal yang merupakan posting dari medul lain, pada
moedul ini hanya sebatas dapat dilihat saja.

Mo. o000z (1 4 »|p] Tanggal 31012015 [«
Mo. Voucher  GJ - 000001 Mo, Ref GJ 000001

() Customer () Supplier @ Others
Kontak. <NjA> -

I

1. 07-01-15-000 ;I Biaya Sewa 5.000.000
2, 01-05-01-005 Sewa Dibayar Dimuka 5,000,000
3

| Keterangan  Biaya sewa bangunan bin, Januari 2015
|

| Total: | 5.000.000] | 5.000.000)
Selisih :
I

o Kategori Kontak (Customer | Supplier | Others) : untuk jurnal umum,
yaitu jurnal yang diinput secara manual melalui modul ini maka default
kategori Kontaknya otomatis adalah Others, namun anda bisa memilih
kategori kontak lain yaitu Customer atau Supplier. Namun harus
dipahami bahwa sekalipun kontaknya adalah Customer atau Supplier,
anda tidak diperkenankan menggunakan Nomor Perkiraan yang
merupakan default Piutang Usaha atau Hutang Usaha untuk Customer
atau Supplier bersangkutan. Ini dimaksudkan untuk memelihara
kesesuaian antara saldo akun bersangkutan pada buku besar dengan
saldo Piutang atau Hutang pada buku pembantunya karena jurnal yang
diinput melalui modul ini hanya mengupdate buku besar dan tidak

mengupdate buku pembantunya. Ini berbeda dengan apabila anda
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menggunakan program yang semata-mata hanya terdiri dari modul
General Ledger, maka tentunya anda bebas menggunakan akun mana
saja karena tidak ada modul lain misalnya Hutang atau Piutang selain
dirinya sendiri. Untuk program yang terintegrasi antara modul satu
dengan lainnya, maka General Ledger adalah merupakan muara dari
modul lain, artinya modul lain akan mengupdate General Ledger tetapi
tidak sebaliknya. Apakah sama sekali tidak boleh menggunakan akun
dengan kategori Hutang atau Piutang ? Sepanjang akun itu tidak
merupakan akun default (terkait Hutang atau Piutang) yang telah anda
beritahukan kepada program, maka akun itu bisa dipakai, misalnya
selain akun Hutang Usaha yang merupakan akun default untuk Hutang
Usaha, anda mempunyai akun Hutang Usaha Lain-lain atau Hutang
Lain-lain yang tidak merupakan akun default, dimana anda gunakan
untuk jurnal manual tanpa melalui modul pembelian (dengan demikian
tidak ada buku pembantu hutangnya) dan anda konsisten dengan itu,

maka hal ini bisa dilakukan.

Mempertimbangkan adanya kebutuhan untuk justru menyesuaikan
saldo akun yang merupakan akun default Piutang Usaha dan akun
default Hutang Usaha dengan saldo menurut buku pembantunya, maka
developer Accpro menambahkan satu fasilitas khusus yang hanya
diberikan kepada user dengan level Administrator dengan sebelumnya
memberikan akses untuk ini dengan mencentang checkbox “User ini
diberikan akses untuk menggunakan akun Default Hutang, Piutang,
Persediaan sebagai baris jurnal manual pada modul Jurnal Transaksi”
melalui menu File > Setup User. Jadi ini gunanya adalah terutama pada
saat awal pemakaian Accpro dimana saldo akun Piutang Usaha atau
Hutang Usaha yang anda dapat dari Laporan Neraca sebelum pemakaian
Accpro ternyata tidak bisa tepat atau ada perbedaan dengan saldo
Piutang atau Hutang menurut perincian Invoicenya melalui modul Saldo
Awal Hutang/Piutang/Sub Ledger. Jadi tetap harus dicamkan bahwa
sekalipun fasilitas ini diadakan tetapi gunanya adalah untuk
meyesuaikan saldo akun bersangkutan pada Buku Besar dengan saldo

menurut buku pembantunya. Artinya jurnal menyangkut akun Piutang
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atau Hutang yang anda input melalui modul Jurnal Transaksi ini tidak
akan mengupdate buku pembantunya termasuk saldonya.

¢ Kontak : pilih kontaknya dengan mengklik pada field ini atau tombol
drop-down disampingnya. Daftar kontak yang ditampilkan adalah
sesuai dengan kategori kontak yang telah anda pilih. Pilih < New Contact
> atau < New Customer > atau < New Supplier > apabila ingin menambah
kontak baru. Apabila kategori Kontaknya adalah Others, maka default
kontaknya adalah <N/A>, artinya kontak tidak dibutuhkan atau tidak
ingin disebutkan, boleh saja anda memilih kontak yang lain apabila ada
urgensinya.

¢ Keterangan : isikan keterangan mengenai transaksi ini, karena
keterbatasan panjang field ini yaitu 70 karakter, maka anda harus pintar-
pintar dalam menyiasatinya.

e No. Perk : ketik Nomor Perkiraannya atau klik tombol drop-down pada
kolom ini, maka daftar perkiraan akan ditampilkan dalam urutan Nomor
Perkiraannya. Pilih < New > jika ingin menambahkan akun baru.

Ingin dikemukakan bahwa sama halnya dengan akun default Piutang
Usaha dan akun default Hutang Usaha, maka akun yang dijadikan akun
default Persediaan yang telah anda beritahukan kepada program pada
saat input data barang Inventory melalui menu Master Data > Barang &
Jasa pada tab Akun-akun tidak bisa digunakan untuk baris jurnal
manual. Alasannya sama seperti yang telah dikemukakan di atas yaitu
untuk memelihara kesesuaian antara saldo akun Persediaan pada Buku
Besar dengan nilai persediaan menurut buku pembantunya yaitu
Laporan Saldo Barang. Tetapi dengan pertimbangan bahwa kadangkala
justru user perlu menyesuaikan saldo akun Persediaan pada Buku Besar
dengan buku pembantunya terutama pada saat awal pemakaian Accpro
dimana saldo akun Persediaan yang anda dapat dari Laporan Neraca
sebelum pemakaian Accpro ternyata tidak bisa sama persis atau terdapat
perbedaan dengan nilai persediaan berdasarkan perincian saldo awal
barangnya melalui modul Saldo Awal Inventory, maka anda bisa
menggunakan akun default Persediaan sebagai baris jurnal manual
untuk keperluan ini. Tetapi hanya user dengan level Administrator yang

bisa melakukannya dengan sebelumnya diberikan akses untuk ini
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dengan mencentang checkbox “User ini diberikan akses untuk
menggunakan akun Default Hutang, Piutang, Persediaan sebagai baris
jurnal manual pada modul Jurnal Transaksi” melalui menu File > Setup
User.

Nama Perkiraan : kolom ini akan otomatis terisi setelah anda memilih
nomor perkiraannya. Namun demikian, sebagai alternatif, anda bisa saja
menggunakan kolom ini untuk menentukan perkiraannya apabila lebih
mudah buat anda untuk mengingat nama perkiraannya ketimbang
nomor perkiraannya. Cukup ketik initial atau potongan awal nama
perkiraan atau klik tombol drop-down yang ada maka daftar perkiraan
akan ditampilkan dalam urutan Nama Perkiraannya. Pilih < Perkiraan
Baru > apabila ingin menambahkan akun baru. Setelah anda memilih
Nama Perkiraannya, maka kolom No. Perk akan terisi dengan
sendirinya.

Debit : isi kolom Debit jika baris jurnal ini bernilai Debit, diisi sebesar
nominal dalam Rp.

Kredit : isi kolom Kredit jika baris jurnal ini bernilai Kredit, diisi sebesar
nominal dalam Rp.

Keterangan (kolom) : kolom ini hanya ada apabila fitur yang berkaitan
dengan hal ini, yaitu “Bisa mengisi keterangan tambahan untuk setiap
baris (ayat) jurnal transaksi” diaktifkan melalui Setup Preferensi. Isi
keterangannya jika diperlukan.

Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Voucher, No.
Perkiraan, Nilai transaksi atau Kontaknya.

Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.

Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
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tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

¢ Tombol Delete : menghapus transaksi tertentu.

e Tombol Print : mencetak bukti jurnal transaksi. Apabila checkbox
Preview disamping tombol ini dalam keadaan tercentang (defaultnya
tergantung pengaturan pada Set Printout Transaksi untuk modul Jurnal
Transaksi), maka akan dipreview (ditampilkan ke layar) lebih dulu untuk

kemudian bisa dicetak ke printer.

Tips :

Untuk mengisi kolom Debit atau Kredit pada baris transaksi yang terakhir,
anda dapat menggunakan tombol Ctrl+Enter (menekan tombol Ctrl
disertai tombol Enter) untuk mempaste angka yang merupakan selisih
antara jumlah debit dengan jumlah kredit sehingga transaksi menjadi
balance tanpa harus mengetikkannya secara langsung. Untuk melakukan
hal ini maka posisikan kursor lebih dulu pada kolom Debit atau Kredit
(tergatung selisihnya apakah Debit atau Kredit).

59 Penerimaan Kas / Bank

Accpro membedakan Penerimaan Kas / Bank atas 2 jenis transaksi. Yang
pertama adalah yang berkaitan dengan pelunasan Piutang Usaha, artinya
penerimaan Kas / Bank sebagai pelunasan piutang usaha yang timbul atas
Invoice yang diterbitkan melalui modul Sales Invoice, atau Invoice yang
merupakan saldo awal Piutang Usaha pada awal pemakaian Accpro, bisa jadi
juga berupa Debit Note (walaupun kemungkinan besar modul ini akan jarang
atau tidak pernah digunakan untuk mendebit piutang customer). Yang kedua
adalah yang tidak berkaitan dengan Piutang Usaha, yaitu segala bentuk
penerimaan Kas / Bank lainnya. Sedangkan menyangkut jenis akun kemana
dana yang diterima disetorkan, apakah Kas atau Bank, Accpro tidak
membedakannya atas modul yang berbeda. Jadi baik penerimaannya berupa
Kas atau Bank tetap penginputannya adalah melalui modul yang sama, yang
membedakan semata-mata adalah Akun Kas / Banknya. Kode Transaksi

untuk Penerimaan Kas / Bank sebagai Pelunasan Piutang Usaha, defaultnya
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adalah RV, sedangkan untuk Penerimaan Kas / Bank lainnya defaultnya
adalah BI. Default disini artinya apabila tidak dirubah melalui Set Kode

Jurnal pada Setup Preferensi.

Modul ini dibuka melalui menu Transaksi > Penerimaan Kas / Bank atau

dengan mengklik iconnya pada toolbar.

Penerimaan Kas / Banl

£ ' Tunai @ Cek/Giro . Transfer
3l

Mo. 000002 EED ]
No. Voucher Valuta Rp = Kus 1,00 Jumish 88,660,000

Tanggal h4/o1/15 Ma. Ref RV 000002 No. CekfGro A 630123 Bank  Bank Mitra -
© Customer  Supplier Others JatuhTempo |14/04/2015 [+ |  Sudak Cair

Terima dari ERA BARU SOLUSINDO - Push e EEmE

AccountBank  Bank BCD - Abu Rupiahs#

Keterangan  Pelunasan INV-14.000302, 000304

No. Invoice/Dokumen Tg. Inv Piutang Piutang Dibayar
T SA 000004 INV-14,000302 09/12/2014  08/01/2015 27.063.437 1,00 Rp 27.063.437 [ |
FSA 000005 INV-14.000304 15/12(2014  14/01/2015 61,600,000 1,00 Rp 61,600,000

Total : Rp. 88.663.437

an nilai Piutang yang dianggap dbayar oleh
ima lebin kecil atau lebih besar

ayar b
laupun i uang yan

Jurnal Transaksi
Ho. Perk Hama Perkiraan Debit Kredit =
1. 01-03-02:001 v |Putang Gro 88.660.000
2. 01-03-01-001 Piutang Dagang 88.663.437
3. 09-20-00-000 Biaya Laindain 3.437
4
5. -
Total : 88.663.437) | 88.663.437
Selisih :

e Jenis Transaksi : pada saat membuat transaksi baru, maka anda harus
menentukan jenis transaksi lebih dulu apakah RV - Pelunasan Piutang

Usaha atau BI - Penerimaan Kas / Bank bukan Piutang Usaha.

Jenis Transaksi

Jenis Transaksi

RV - Pelunasan Piutang Usaha @)

(= BI - Penerimaan Kas { Bank bukan @
~ Piutang Usaha

e No. : Nomor Transaksi otomatis digenerate oleh program sehingga tidak

bisa diedit.
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e No. Voucher : terdiri dari Kode Transaksi (kode jurnal) dan No. Jurnal.
Kode Transaksi otomatis sesuai dengan jenis transaksinya, sedangkan
No. Jurnal otomatis digenerate oleh program, jadi kedua field ini juga
tidak bisa diedit.

e Tanggal : sesuaikan tanggal transaksi jika diperlukan, caranya ketikkan
langsung dengan format dd/mm/yy artinya ketikkan masing-masing 2
digit tanggal, bulan dan tahun atau klik tombol drop-down untuk
memunculkan kalender.

e No. Ref: kalau anda merasa perlu mengisikan nomor referensi dari bukti
transaksi manual, maka disinilah anda bisa mengisikannya. Apabila
tidak diisii, maka program nantinya pada saat disimpan akan
mengisikannya sesuai dengan No. Voucher diatas (kombinasi dari Kode
Voucher dan No. Vouchernya).

e Kategori Kontak (Customer | Supplier | Others) : untuk Penerimaan
Kas / Bank sebagai pelunasan piutang usaha, maka otomatis Kategori
Kontaknya adalah Customer, sedangkan unuk Penerimaan Kas / Bank
lainnya, walaupun defaultnya adalah Others namun anda bisa memilih
kategori kontak yang lain yaitu Customer atau Supplier. Yang harus
dipahami adalah bahwa sekalipun kontaknya adalah Customer atau
Supplier, untuk baris jurnal transaksi yang anda buat secara manual
(bukan baris jurnal otomatis yang dibuatkan program), anda tidak
diperkenankan menggunakan Nomor Perkiraan yang merupakan default
Piutang Usaha atau Hutang Usaha. Mengapa demikian ? Accpro hanya
akan mengupdate Kartu Piutang untuk Penerimaan Kas / Bank dengan
jenis transaksi Pelunasan Piutang Usaha (Kode Transaksi : RV) atas baris
jurnal transaksi otomatis yang dibuatkannya yang berkaitan dengan
akun default Piutang Usaha dan tidak baris jurnal lainnya apalagi
Penerimaan Kas / Bank bukan Piutang Usaha (Kode Transaksi : BI),
demikian juga Kartu Hutang hanya akan diupdate melalui Pengeluran
Kas / Bank yang berupa pelunasaan Hutang Usaha (Kode Transaksi : PV)
untuk baris jurnal transaksi otomatis yang berkaitan dengan akun default
Hutang Usaha. Akibatnya akan timbul ketidaksesuaian antara Kartu
Piutang atau Kartu Hutang dengan buku besar apabila anda

menggunakan akun-akun yang dikemukakan di atas pada jurnal
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transaksi yang anda lakukan secara manual. Jadi apakah sama sekali
tidak boleh menggunakan akun dengan kategori Hutang atau Piutang
untuk baris jurnal manual ? Sepanjang akun itu tidak merupakan akun
default (terkait Hutang atau Piutang) yang telah anda beritahukan
kepada program, maka akun itu bisa dipakai, misalnya selain akun
Piutang Usaha yang merupakan akun default untuk Piutang Usaha, anda
mempunyai akun Piutang Usaha Lain-lain atau Piutang Lain-lain yang
tidak merupakan akun default, dimana pada saat timbulnya Piutang
hanya dijurnal secara manual melalui modul Jurnal Transaksi tanpa
melalui modul penjualan (dengan demikian tidak ada buku pembantu
Piutangnya baik Kartu Piutang maupun Laporan Umur Piutang) dan
anda konsisten dengan itu, maka hal ini bisa dilakukan. Namun
pertimbangkanlah urgensinya melakukan hal yang demikian, karena
kerugiannya adalah piutang sebagian ada di kartu piutang, sebagian
tidak.

Terima dari : pilih kontaknya dari mana penerimaan berasal dengan
mengklik pada field ini atau tombol drop-down disampingnya. Daftar
kontak yang ditampilkan adalah sesuai dengan kategori kontak yang
telah anda pilih. Pilih < New Contact > atau < New Customer > atau <
New Supplier > apabila ingin menambah kontak baru. Apabila kategori
Kontaknya adalah Others, maka default kontaknya adalah <N/A>,
artinya kontak tidak dibutuhkan atau tidak ingin disebutkan, boleh saja
anda memilih kontak yang lain apabila ada urgensinya.

Account Bank : klik pada field ini atau tombol drop-downnya untuk
memilih akun Kas atau Banknya. Jadi seperti telah dikemukakan diatas,
apakah penerimaan kas atau bank yang membedakan adalah field ini.
Baik modul ataupun kode transaksinya tidak dibedakan menjadi
Penerimaan Kas sendiri dan Penerimaan Bank sendiri.

Keterangan : isikan keterangan mengenai transaksi ini, karena
keterbatasan panjang field ini yaitu 70 karakter, maka anda harus pintar-
pintar dalam menyiasatinya.

Tab Uang : tab ini hanya akan aktif dan bisa diakses setelah field
Account Bank telah ditentukan.
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#t  Pilih Tunai atau Cek/Giro atau Transfer. Apabila berupa Tunai atau
Transfer maka jurnal yang timbul akan langsung mendebit akun Kas
/ Bank yang telah anda tentukan pada field Account Bank. Namun
apabila berupa cek/giro, baik berupa giro mundur ataupun tidak,
maka jurnal yang timbul akan mendebit akun Piutang Giro. Oleh
karena itu Accpro mensyaratkan anda untuk mempunyai akun
Piutang Giro (bisa saja dengan nama lain, yang jelas kategorinya
seyogyanya adalah Asset) pada Chart of Account dan
menetapkannya sebagai akun default untuk Piutang Giro melalui
modul Account Default. Setelah anda melakukan proses Mencairkan
Giro Masuk Jatuh Tempo, baru program akan mendebit akun Kas /
Bank dengan mengkredit akun Piutang Giro.

#t  Valuta : akan disesuaikan dengan valuta akun Kas/Banknya, apabila
dalam valuta asing, maka valuta pada tab Uang ini akan
mengikutinya dan tidak bisa dirubah, tetapi kalau valuta akun
Kas/Banknya adalah Rp, maka valuta uangnya dimungkinkan dalam
Rp atau valuta lainnya. (Karena untuk varian Accpro Trada dan Accpro
Strada, fitur multi currency tidak disediakan, maka satu-satunya valuta
yang tersedia adalah Rp.)

#  Kurs : apabila valutanya dalam valuta asing maka kurs harus
ditentukan.

z  Jumlah : isi jumlah uang dalam nominal valuta transaksinya.

el

No. Cek/Giro : kalau berupa Cek/Giro maka isi nomornya

#t  Bank : kalau berupa Cek/Giro, tentukan Bank yang menerbitkannya
dengan mengklik pada filed ini atau tombol drop-down
disampingnya. Pilih < New Bank > apabila perlu menambah data
Nama Bank.

7 Jatuh Tempo : kalau berupa Cek/Giro, tentukan tanggal Jatuh
Tempo dengan mengetikkannya langsung yaitu masing-masing 2
digit tanggal, bulan, tahun atau klik tombol drop-down untuk
mendapatkan bantuan berupa kalender.

e Tab Invoice : tab ini hanya muncul untuk Penerimaan Kas / Bank sebagai

Pelunasan Piutang Usaha (Kode Transaksi : RV)
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No Trs : field ini tidak bisa diisi tetapi hanya untuk memunculkan
No. Transaksi yang berkaitan dengan isian (entry) pada kolom No.
Invoice/Dokumen.

No. Invoice/Dokumen : pilih dokumen-dokumen yang akan
diterima pembayarannya bisa berupa Invoice, bisa juga berupa Debit
Note. Cukup klik tombol drop-down pada kolom ini untuk
memilihnya.

Tgl. Inv : menampilkan tanggal Invoice dari isian (entry) pada
kolom No. Invoice/Dokumen.

Tgl. JT : menampilkan tanggal jatuh tempo.

Piutang : menampilkan total piutang dari isian (entry) pada kolom
No. Invoice/Dokumen.

Kurs : menampilkan kurs sesuai kurs pada Invoice/dokumennya.
Curr : menampilkan valuta sesuai valuta pada Invoice/dokumennya.
Piutang Dibayar : ketik jumlah piutang yang dibayar dalam nominal
valuta sesuai Invoice/dokumennya. Apabila jumlah piutang yang
dibayar sama dengan sisa piutang untuk Invoice/dokumen tersebut
(sebagaimana sisa piutang yang diinformasikan oleh program), anda
bisa menggunakan tombol Ctrl+Enter untuk mempaste nilai tersebut
pada kolom ini. Penting untuk dipahami bahwa anda harus mengisi
kolom ini bukan sejumlah uang yang diterima pada field Jumlah
pada tab Uang di atas tetapi bisa jadi lebih atau kurang, yang paling
penting adalah jangan sampai meninggalkan sisa piutang yang
sebenarnya telah dianggap dilunasi oleh customer, contoh : piutang
sebesar 1.001.000 tetapi uang yang diterima hanya sebesar 1.000.000
maka piutang dibayar harus diisikan 1.001.000, kalau tidak sisa
piutang customer tersebut akan menggantung, dan harus dibuatkan
credit note di kemudian hari. Kelebihan atau kekurangan dari
penerimaan terhadap jumlah piutang yang dianggap telah dibayar
atau dilunasi oleh customer bisa jadi merupakan pembulatan,
pendapatan lain-lain atau biaya administrasi Bank, biaya meterai
atau biaya lain-lain dan dapat ditambahkan sebagai baris jurnal

manual pada tab Jurnal Transaksi.
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Catatan :

Apabila valuta transaksi dalam valuta asing dan demikian juga
Invoice/dokumennya dalam valuta yang sama dan terdapat perbedaan
kurs antara kurs transaksi dengan kurs pada Invoice/dokumennya, maka
akan timbul Selisih Kurs. Dalam hal ini, maka seyogyanya anda telah
mempunyai akun untuk keperluan ini bisa berupa akun biaya atau
pendapatan sebagai Laba (Rugi) Selisih Kurs, karena program akan
membuatkan baris jurnal secara otomatis terkait selisih kurs ini. Namun
ini tidak berlaku apabila valutanya berlainan, dalam keadaan ini apabila
ada selisih kurs anda harus menentukannva sendiri.

e Tab Jurnal Transaksi : apabila jenis transaksi adalah RV — Pelunasan
Piutang Usaha, maka baris pertama dan baris kedua dari jurnal transaksi
akan ditentukan oleh program, oleh karena itu kedua baris ini tidak bisa
anda edit kecuali kolom Keterangan (apabila ada). Apabila perlu
menambahkan baris jurnal ketiga dan seterusnya bisa anda lakukan
secara manual. Sedangkan apabila BI — Penerimaan Kas / Bank bukan
Piutang Usaha, maka baris pertama akan ditentukan oleh program dan
tidak bisa diedit kecuali kolom Keterangan (apabila ada), baris jurnal
kedua dan seterusnya dapat anda tentukan sendiri secara manual.

#  No. Perk : ketik Nomor Perkiraannya atau klik tombol drop-down
pada kolom ini, maka daftar perkiraan akan ditampilkan dalam
urutan Nomor Perkiraannya. Pilih < New > jika ingin menambahkan
akun baru. Sekali lagi perlu ditegaskan bahwa hanya baris jurnal
otomatis oleh program, yaitu baris kedua untuk transaksi dengan
Kode Transaksi : RV yang boleh menggunakan akun default untuk
Piutang Usaha, sedangkan selain itu tidak diperkenankan untuk
menggunakan akun default Piutang Usaha, apalagi akun default
Hutang Usaha, kecuali kalau akun tersebut biarpun merupakan
akun Piutang atau Hutang tetapi bukan merupakan akun default
Piutang Usaha atau Hutang Usaha.

#+ Nama Perkiraan : kolom ini akan otomatis terisi setelah anda
memilih nomor perkiraannya. Namun demikian, sebagai alternatif,

anda bisa saja menggunakan kolom ini untuk menentukan
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perkiraannya apabila lebih mudah buat anda untuk mengingat nama
perkiraannya ketimbang nomor perkiraannya. Cukup ketik initial
atau potongan awal nama perkiraan atau klik tombol drop-down
yang ada maka daftar perkiraan akan ditampilkan dalam urutan
Nama Perkiraannya. Pilih < Perkiraan Baru > apabila ingin
menambahkan akun baru. Setelah anda memilih Nama
Perkiraannya, maka isi kolom No. Perk akan menyesuaikan.

#  Debit : isi kolom Debit jika baris jurnal ini bernilai Debit, diisi
sebesar nominal dalam Rp.

#  Kredit : isi kolom Kredit jika baris jurnal ini bernilai Kredit, diisi
sebesar nominal dalam Rp.

#+  Keterangan : kolom ini hanya ada apabila fitur yang berkaitan
dengan hal ini, yaitu “Bisa mengisi keterangan tambahan untuk
setiap baris (ayat) jurnal transaksi” diaktifkan melalui Setup

Preferensi. Isi keterangannya jika diperlukan.

Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Voucher, No. Cek,
Nilai Uang atau Kontaknya.

Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

Tombol Delete : menghapus transaksi tertentu.

Tombol Print : mencetak bukti Jurnal Penerimaan Kas / Bank, demikian
juga ada pilihan dalam bentuk bukti Pelunasan Invoice untuk jenis

transaksi RV — Pelunasan Piutang Usaha. Apabila checkbox Preview

5-75



disamping tombol ini dalam keadaan tercentang (defaultnya tergantung
pengaturan pada Set Printout Transaksi untuk modul Penerimaan Kas /
Bank), maka akan dipreview (ditampilkan ke layar) lebih dulu untuk
kemudian bisa dicetak ke printer.

5.10 Pengeluaran Kas /7 Bank

Seperti halnya Penerimaan Kas / Bank, Accpro membedakan Pengeluaran Kas
/ Bank atas 2 jenis transaksi. Yang pertama adalah yang berkaitan dengan
pelunasan Hutang Usaha, artinya pengeluaran Kas / Bank sebagai pelunasan
hutang usaha yang timbul atas Invoice yang berasal dari modul Purchase
Invoice, juga Invoice yang merupakan saldo awal Hutang Usaha pada awal
pemakaian Accpro, bisa jadi juga berupa Credit Note (walaupun
kemungkinan besar modul ini akan jarang atau tidak pernah digunakan
untuk mengkredit hutang supplier). Yang kedua adalah yang tidak berkaitan
dengan Hutang Usaha, yaitu segala bentuk pengeluaran Kas / Bank lainnya.
Sedangkan menyangkut jenis akun dari mana dana yang dikeluarkan, apakah
Kas atau Bank, Accpro tidak membedakannya atas modul yang berbeda. Jadi
baik pengeluarannya berupa Kas atau Bank tetap penginputannya adalah
melalui modul yang sama, yang membedakan semata-mata adalah Akun Kas
/ Banknya. Kode Transaksi untuk Pengeluaran Kas / Bank sebagai Pelunasan
Hutang Usaha, defaultnya adalah PV, sedangkan untuk Pengeluaran Kas /
Bank lainnya defaultnya adalah BO. Default disini artinya apabila tidak

dirubah melalui Set Kode Jurnal pada Setup Preferensi.

Modul ini dibuka melalui menu Transaksi > Pengeluaran Kas / Bank atau

dengan mengklik iconnya pada toolbar.

e Jenis Transaksi : pada saat membuat transaksi baru, maka anda harus
menentukan jenis transaksi lebih dulu apakah PV — Pelunasan Hutang

Usaha atau BO - Pengeluaran Kas / Bank bukan Hutang Usaha.
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Jenis Transaksi

Jenis Transaksi
PV - Pelunasan Hutang Usaha @)

~ 8O- Pengeluaran Kas [ Bank bukan L2)
" Hutang Usaha

No. : Nomor Transaksi otomatis digenerate oleh program sehingga tidak

bisa diedit.

No. Voucher : terdiri dari Kode Transaksi (kode jurnal) dan No. Jurnal.

Kode Transaksi otomatis sesuai dengan jenis transaksinya, sedangkan

No. Jurnal otomatis digenerate oleh program, jadi kedua field ini juga

tidak bisa diedit.

Tanggal : sesuaikan tanggal transaksi jika diperlukan, caranya ketikkan

langsung dengan format dd/mm/yy artinya ketikkan masing-masing 2

digit tanggal, bulan dan tahun atau klik tombol drop-down untuk

memunculkan kalender.

Pengeluaran Kas / Banl

L

No. ooooos (14| 4| »[m] ;é: ) Tunai @ Cek/Giro ) Transfer

No.Voucher PV v Valuta Rp v Kurs 1,00 Jumish 120,000,000

Tanggal No.Ref PY0OOOOZ No. CekfGro  AA 456390 Bank  Bank 5CD -
Customer (@ Supplier Others Jatuh Tempa H Sudah Cair

Bayarkepada  GRAHA PRIMA SEJAHTERA - T

AccountBark  Bank BCD -

Keterangan  Bayar Inv. D15/GPS/INV/12/14 (partal)

No Trs o, Invoice/Dokumen o Tgl. IT Hutang Hutang Dibayar |98
SA 000001 D1/GPS/INV/12/14 =] 15/12/2014  14/01/2015 220,000,000 1,00 Rp 120.000.000
Total : Rp. 120.000.000

Hutang Dibayar harus disi dengan rilai Hutang ya
ppiier, walaupun nilai uang yang dibayarkan lebih ked ata

Jurnal Transaksi

hih besar

Ho Ho. Perkc Hama Perkiraan Debit Kredit =
1. 03-05-01-000 | Hutang Gira 120,000,000
2. 03-01-01-000 Hutang Dagang 120.000.000
3
4.
5 -
Total : lzmmmml] [ ummuum]
Selisih -
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e No. Ref : kalau anda merasa perlu mengisikan nomor referensi dari bukti
transaksi manual, maka disinilah anda bisa mengisikannya. Apabila
tidak diisi, maka program nantinya pada saat disave akan
mengisikannya sesuai dengan No. Voucher diatas (kombinasi dari Kode
dan No. Vouchernya).

e Kategori Kontak (Customer | Supplier | Others) : untuk Pengeluaran
Kas / Bank sebagai pelunasan hutang usaha, maka otomatis Kategori
Kontaknya adalah Supplier, sedangkan unuk Pengeluaran Kas / Bank
lainnya, walaupun defaultnya adalah Others namun anda bisa memilih
kategori kontak yang lain yaitu Customer atau Supplier. Yang harus
dipahami adalah bahwa sekalipun kontaknya adalah Customer atau
Supplier, untuk baris jurnal transaksi yang anda buat secara manual
(bukan baris jurnal otomatis yang dibuatkan program), anda tidak
diperkenankan menggunakan Nomor Perkiraan yang merupakan akun
default Hutang Usaha atau Piutang Usaha. Mengapa demikian ? Accpro
hanya akan mengupdate Kartu Hutang untuk Pengeluaran Kas / Bank
dengan jenis transaksi Pelunasan Hutang Usaha (Kode Transaksi : PV)
atas baris jurnal transaksi otomatis yang dibuatkannya yang berkaitan
dengan akun default Hutang Usaha dan tidak baris jurnal lainnya
apalagi Pengeluaran Kas / Bank bukan Hutang Usaha (Kode Transaksi :
BO), demikian juga Kartu Piutang hanya akan diupdate melalui
Penerimaan Kas / Bank yang berupa pelunasaan Piutang Usaha (Kode
Transaksi : RV) untuk baris jurnal transaksi otomatis yang berkaitan
dengan akun default Piutang Usaha. Akibatnya akan timbul
ketidaksesuaian antara Kartu Hutang atau Kartu Piutang dengan buku
besar apabila anda menggunakan akun-akun yang dikemukakan di atas
pada jurnal transaksi yang anda lakukan secara manual. Jadi apakah
sama sekali tidak boleh menggunakan akun dengan kategori Hutang
atau Piutang untuk baris jurnal manual ? Sepanjang akun itu tidak
merupakan akun default (terkait Hutang atau Piutang) yang telah anda
beritahukan kepada program, maka akun itu bisa dipakai, misalnya
selain akun Hutang Usaha yang merupakan akun default untuk Hutang
Usaha, anda mempunyai akun Hutang Usaha Lain-lain atau Hutang

Lain-lain yang tidak merupakan akun default, dimana pada saat
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timbulnya Hutang hanya dijurnal secara manual melalui modul Jurnal
Transaksi tanpa melalui modul pembelian (dengan demikian tidak ada
buku pembantu Hutangnya baik Kartu Hutang maupun Laporan Umur
Hutang) dan anda konsisten dengan itu, maka hal ini bisa dilakukan.
Bayar kepada : pilih kontaknya kepada siapa pengeluaran ditujukan
dengan mengklik pada field ini atau tombol drop-downnya. Daftar
kontak yang ditampilkan adalah sesuai dengan kategori kontak yang
telah anda pilih. Pilih < New Contact > atau < New Customer > atau <
New Supplier > apabila ingin menambah kontak baru. Apabila kategori
Kontaknya adalah Others, maka default kontaknya adalah <N/A>,
artinya kontak tidak dibutuhkan atau tidak ingin disebutkan, boleh saja
anda memilih kontak yang lain apabila ada urgensinya.

Account Bank : klik pada field ini atau tombol drop-downnya untuk
memilih akun Kas atau Banknya. Jadi seperti telah dikemukakan diatas,
apakah pengeluaran kas atau bank yang membedakan adalah field ini.
Baik modul ataupun kode transaksinya tidak dibedakan menjadi
Pengeluaran Kas sendiri dan Pengeluaran Bank sendiri.

Keterangan : isikan keterangan mengenai transaksi ini, karena
keterbatasan panjang field ini yaitu 70 karakter, maka anda harus pintar-

pintar dalam menyiasatinya.

Tab Uang : tab ini hanya akan aktif dan bisa diakses setelah field

Account Bank telah ditentukan.

#  Pilih Tunai atau Cek/Giro atau Transfer. Apabila berupa Tunai atau
Transfer maka jurnal yang timbul akan langsung mengkredit akun
Kas / Bank yang telah anda tentukan pada field Account Bank.
Namun apabila berupa cek/giro, baik berupa giro mundur ataupun
tidak, maka jurnal yang timbul akan mengkredit akun Hutang Giro.
Oleh karena itu Accpro mensyaratkan anda untuk mempunyai akun
Hutang Giro (bisa saja dengan nama lain, yang jelas kategorinya
seyogyanya adalah Liabilities atau Asset) pada Chart of Account dan
menetapkannya sebagai akun default untuk Hutang Giro melalui

modul Account Default. Setelah anda melakukan proses Mencairkan
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Giro Keluar Jatuh Tempo, baru program akan mengkredit akun Kas /
Bank dengan mendebit akun Hutang Giro.

Valuta : akan disesuaikan dengan valuta akun Kas/Banknya, apabila
dalam valuta asing, maka valuta pada tab Uang ini akan
mengikutinya dan tidak bisa dirubah, tetapi kalau valuta akun
Kas/Banknya adalah Rp, maka valuta uangnya dimungkinkan dalam
Rp atau valuta lainnya. (Karena untuk varian Accpro Trada dan Accpro
Strada, fitur multi currency tidak disediakan, maka satu-satunya valuta
yang tersedia adalah Rp.)

Kurs : apabila valutanya dalam valuta asing maka kurs harus
ditentukan.

Jumlah : isi jumlah uang dalam nominal valuta transaksinya.

No. Cek/Giro : kalau berupa Cek/Giro maka isi nomornya

Bank : kalau berupa Cek/Giro, tentukan Bank yang menerbitkannya
dengan mengklik pada filed ini atau tombol drop-down
disampingnya. Pilih < New Bank > apabila perlu menambah data
Nama Bank.

Jatuh Tempo : kalau berupa Cek/Giro, tentukan tanggal Jatuh
Tempo dengan mengetikkannya langsung yaitu masing-masing 2
digit tanggal, bulan, tahun atau klik tombol drop-down untuk

mendapatkan bantuan berupa kalender.

Tab Invoice : tab ini hanya muncul untuk Pengeluaran Kas / Bank

sebagai Pelunasan Hutang Usaha (Kode Transaksi : PV)

Eel
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No Trs : field ini tidak bisa diisi tetapi hanya untuk memunculkan
No. Transaksi yang berkaitan dengan isian (entry) pada kolom No.
Invoice/Dokumen.

No. Invoice/Dokumen : pilih dokumen-dokumen yang akan
dilakukan pembayarannya bisa berupa Invoice, bisa juga berupa
Credit Note. Cukup klik tombol drop-down pada kolom ini untuk
memilihnya.

Tgl. Inv : menampilkan tanggal Invoice dari isian (entry) pada
kolom No. Invoice/Dokumen.

Tgl. JT : menampilkan tanggal jatuh tempo.



¥  Hutang : menampilkan total hutang dari isian (entry) pada kolom
No. Invoice/Dokumen.

2 Kurs: menampilkan kurs sesuai kurs pada Invoice/dokumennya.

It

Curr : menampilkan valuta sesuai valuta pada Invoice/dokumennya.
#+  Hutang Dibayar : ketik jumlah hutang yang dibayar dalam nominal
valuta sesuai Invoice/dokumennya. Apabila jumlah hutang yang
dibayar sama dengan sisa hutang untuk Invoice/dokumen tersebut
(sebagaimana sisa hutang yang diinformasikan oleh program), anda
bisa menggunakan tombol Ctrl+Enter untuk mempaste nilai tersebut
pada kolom ini. Penting untuk dipahami bahwa anda harus mengisi
kolom ini bukan sejumlah uang yang dibayarkan pada field Jumlah
pada tab Uang di atas tetapi bisa jadi lebih atau kurang, yang paling
penting adalah jangan sampai meninggalkan sisa hutang yang
sebenarnya telah dianggap dilunasi, contoh : hutang sebesar
1.001.000 tetapi uang yang dibayarkan hanya sebesar 1.000.000
maka hutang dibayar harus diisikan 1.001.000, kalau tidak sisa
hutang kepada supplier tersebut akan menggantung, dan harus
dibuatkan debit note di kemudian hari. Kelebihan atau kekurangan
dari pembayaran terhadap jumlah hutang yang dianggap telah
dibayar atau dilunasi bisa jadi merupakan biaya administrasi Bank,
biaya meterai, biaya lain-lain, pembulatan, atau pendapatan lain-
lain dan dapat ditambahkan sebagai baris jurnal manual pada tab

Jurnal Transaksi.

Catatan :

Apabila valuta transaksi dalam valuta asing dan demikian juga
Invoice/dokumennya dalam valuta yang sama dan terdapat perbedaan
kurs antara kurs transaksi dengan kurs pada Invoice/dokumennya, maka
akan timbul Selisih Kurs. Dalam hal ini, maka seyogyanya anda telah
mempunyai akun untuk keperluan ini bisa berupa akun biaya atau
pendapatan sebagai Laba (Rugi) Selisih Kurs, karena program akan
membuatkan baris jurnal secara otomatis terkait selisih kurs ini. Namun
ini tidak berlaku apabila valutanya berlainan, dalam keadaan ini apabila
ada selisih kurs anda harus menentukannya sendiri.
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Tab Jurnal Transaksi : apabila jenis transaksi adalah PV — Pelunasan
Hutang Usaha, maka baris pertama dan baris kedua dari jurnal transaksi
akan ditentukan oleh program, oleh karena itu kedua baris ini tidak bisa
anda edit kecuali kolom Keterangan (apabila ada). Apabila perlu
menambahkan baris jurnal ketiga dan seterusnya bisa anda lakukan
secara manual. Sedangkan apabila BO — Pengeluraan Kas / Bank bukan
Hutang Usaha, maka baris pertama akan ditentukan oleh program dan
tidak bisa diedit kecuali kolom Keterangan (apabila ada), baris kedua dan

seterusnya bisa anda tentukan sendiri secara manual.

ﬁ( Pengeluaran Kas / Banl )
No. 000010 EE A E\ () Tunai ) Cek/Giro (@ Transfer
No.Voucher B0 - [ 000007 Valuta Rp v Kurs 1,00 Jumiah 2,750,000
Tanggal 15/01/2015 No. Ref BO 000007
Se:
() Customer () Supplier @ Others
s < M #Du3 Juta Tuuh Ratus Lima Pulih Rbu Rupshz
AccountBank  Bank ABC - _
[M)save
Keterangan  Bayar Listrik, Telpon bin. Januari 2015
e,
Jurnal Transaksi
[ No. Perk Nama Perkiraan Debit Kredit -
. 01-02-01-000 Bank ABC 2,750,000
. 07-01-20-000 Biaya Listrik 2.000.000 _
. 07-01-21-000 Fizya Telepon} 750.000

07-01-21-000

Biaya Tol |07-01-11-000

Biaya Transportasi |07-01-08-000 [ umm] [ us«m]
Borus |07-01-03-000

Harga Pokok Penjuzlan |08-01-00-000

Honorarium (Jasa Profesional) |07-01-04-000

Hutang Angsuran Kendaraan |03-05-04-000 -

#t No. Perk : ketik Nomor Perkiraannya atau klik tombol drop-down
pada kolom ini, maka daftar perkiraan akan ditampilkan dalam
urutan Nomor Perkiraannya. Pilih < New > jika ingin menambahkan
akun baru. Sekali lagi perlu ditegaskan bahwa hanya baris jurnal
otomatis oleh program, yaitu baris kedua untuk transaksi dengan
Kode Transaksi : PV yang boleh menggunakan akun default untuk
Hutang Usaha, sedangkan selain itu tidak diperkenankan untuk
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menggunakan akun default Hutang Usaha, apalagi akun default
Piutang Usaha, kecuali kalau akun ersebut biarpun merupakan akun
Hutang atau Piutang tetapi bukan merupakan akun default Hutang
Usaha atau Piutang Usaha.

3+ Nama Perkiraan : kolom ini akan otomatis terisi setelah anda
memilih nomor perkiraannya. Namun demikian, sebagai alternatif,
anda bisa saja menggunakan kolom ini untuk menentukan
perkiraannya apabila lebih mudah buat anda untuk mengingat nama
perkiraannya ketimbang nomor perkiraannya. Cukup ketik initial
atau potongan awal nama perkiraan atau klik tombol drop-down
yang ada maka daftar perkiraan akan ditampilkan dalam urutan
Nama Perkiraannya. Pilih < Perkiraan Baru > apabila ingin
menambahkan akun baru. Setelah anda memilih Nama
Perkiraannya, maka kolom No. Perk akan terisi dengan sendirinya.

#  Debit : isi kolom Debit jika baris jurnal ini bernilai Debit, diisi
sebesar nominal dalam Rp.

#  Kredit : isi kolom Kredit jika baris jurnal ini bernilai Kredit, diisi
sebesar nominal dalam Rp.

7 Keterangan : kolom ini hanya ada apabila fitur yang berkaitan
dengan hal ini, yaitu “Bisa mengisi keterangan tambahan untuk
setiap baris (ayat) jurnal transaksi” diaktifkan melalui Setup

Preferensi. Isi keterangannya jika diperlukan.

Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Voucher, No. Cek,
Nilai Uang atau Kontaknya.

Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan

dikosongkan kembali dan anda tetap berada pada modus Add.
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Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

¢ Tombol Delete : menghapus transaksi tertentu.

e  Tombol Print : mencetak bukti Jurnal Pengeluaran Kas / Bank, demikian
juga ada pilihan dalam bentuk bukti Pelunasan Invoice untuk jenis
transaksi PV - Pelunasan Hutang Usaha. Apabila checkbox Preview
disamping tombol ini dalam keadaan tercentang (defaultnya tergantung
pengaturan pada Set Printout Transaksi untuk modul Pengeluaran Kas /
Bank), maka akan dipreview (ditampilkan ke layar) lebih dulu untuk
kemudian bisa dicetak ke printer.

5.11 Mencairkan Giro Masuk Jatuh Tempo

Penerimaan Kas / Bank berupa cek/giro perlu dilakukan proses pencairan
apabila sudah waktunya jatuh tempo dan telah dapat dicairkan. Proses
pencairan ini dilakukan melalui menu Transaksi > Mencairkan Giro Masuk

Jatuh Tempo.

Pada form ini akan ditampilkan semua giro masuk yang belum dicairkan,
defaultnya adalah dalam urutan tanggal transaksinya. Anda bisa
mengurutkannya menurut kolom tertentu dengan mengklik pada judul
kolom bersangkutan. Demikian juga anda bisa menyeleksi data yang
ditampilkan dengan mengklik tombol Filter, namun lakukanlah hal ini

sebelum anda memilih cek/giro yang akan dicairkan.

e Tanggal : menampilkan tanggal transaksi Penerimaan Kas / Bank.

e Dari: menampilkan kontak dari mana penerimaan Kas / Bank berasal.
¢ Nama Bank : menampilkan Nama Bank yang menerbitkan cek/giro.

e  No. Giro : menampilkan nomor cek/giro.

e Jatuh Tempo : menampilkan tanggal jatuh tempo cek/giro.

e  Kurs : menampilkan kurs transaksi.

¢ Nilai : menampilkan nilai cek/giro berikut valutanya.
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Data Giro Masuk Belum Cair Y Filter

09/01/2015 RAJAWALT PERKASA Bank ABC XY 123567 16{01/2015 1,00 Rp 45,700,000 |v] | 16/01/2015 1,00
14/01/2015 ERA BARU SOLUSINDO Bank Mitra AABSD123  14/01/2015 1,00 Rp 88.660.000 " [las

Nama Bank No.Giro Jatuh Tempo

Unfiltered Jumiah Data ; 2 TotalS860.000

i Mencairkan Giro Masuk
TIPS anda hanya bisa mencairkan cek yang tanggal Jatuh Temponya
tidak melebini Periode Bulan Berjalan. Kalau ingin mela

"y fiter, lakukanlsh sebelum ada data yang dipilih / dichedk | Bivem | | W sdectan | | Bproses | | Ak |

Cair : centang kolom ini bila cek/giro pada baris ini ingin dilakukan
proses pencairan. Hanya cek yang tanggal Jatuh Temponya tidak
melebihi periode bulan berjalan yang bisa dicairkan.

Tgl. Cair : otomatis terisi sesuai tanggal jatuh tempo. Bisa disesuaikan
apabila dibutuhkan dengan mengetikkannya langsung masing-masing 2
digit tgl, bulan, tahun atau klik tombol drop-down untuk memunculkan
bantuan kalender.

Kurs Cair : otomatis terisi sesuai dengan kurs transaksi. Apabila perlu
menyesuaikannya anda bisa melakukannya. Namun dalam prakteknya
penyesuaian nilai dalam nominal Rp untuk akun Kas / Bank yang berupa
valuta asing cukup dilakukan pada akhir periode pada saat anda
melakukan revaluasi valuta asing.

Tombol Filter : menyeleksi data yang ditampilkan menurut range
tanggal transaksi, tanggal (jatuh tempo) cek/giro, Nama Bank, kontak
dan/atau batasan nilai cek/giro. Seperti telah dikemukakan di atas, kalau
ingin melakukan filter, maka lakukanlah sebelum ada data yang

dicentang atau dipilih.
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e Tombol Detail : menampilkan form transaksi Penerimaan Kas / Bank
sesuai baris dimana kursor berada.

e Tombol Select All / Deselect All : memilih (menandai) semua detail
transaksi yang sedang ditampilkan. Mengkliknya kembali berarti
melakukan uncheck atas semua baris yang sudah dipilih (ditandai).

e Tombol Proses : melakukan proses pencairan semua baris yang telah
ditandai.

¢  Tombol Keluar : menutup form ini.

5.12 Mencairkan Giro Keluar Jatuh Tempo

Pengeluran Kas / Bank berupa cek/giro perlu dilakukan proses pencairan
apabila sudah waktunya jatuh tempo dan telah dicairkan oleh pihak
penerimanya. Proses pencairan ini dilakukan melalui menu Transaksi >

Mencairkan Giro Keluar Jatuh Tempo.

Pada form ini akan ditampilkan semua giro keluar yang belum dicairkan,
defaultnya adalah dalam urutan tanggal transaksinya. Anda bisa
mengurutkannya menurut kolom tertentu dengan mengklik pada judul
kolom bersangkutan. Demikian juga anda bisa menyeleksi data yang
ditampilkan dengan mengklik tombol Filter, namun lakukanlah hal ini

sebelum anda memilih cek/giro yang akan dicairkan.

e Tanggal : menampilkan tanggal transaksi Pengeluaran Kas / Bank.

e Untuk : menampilkan kontak kepada siapa pengeluaran Kas / Bank
ditujukan.

¢ Nama Bank : menampilkan Nama Bank yang menerbitkan cek/giro.

¢ No. Giro : menampilkan nomor cek/giro.

¢ Jatuh Tempo : menampilkan tanggal jatuh tempo cek/giro.

¢  Kurs : menampilkan kurs transaksi.

e Nilai : menampilkan nilai cek/giro berikut valutanya.
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anggal Untuk
12/01/2015  GRAHA PRIMA SEJAHTERA Bark
26/01/2015  PANCA MITRA Bark BCD AB 345678 25/01/2015 1,00 Rp 42.968.000 | [¥] | 26/01/2015 1,00
26/01/2015 KAS NEGARA Bark BCD AAX 567830 28/01/2015 1,00 Rp 3360312 [}

Unfiltered Jumlzh Data : 3

i Mencairkan Giro Keluar
TIPS nda hanya bisa mencairkan cek yang tanggal Jatuh Temponya

ticak melebibi Periode Bulan Berjalan. Kalau ingin melai

fiter, lakukaniah sebelum ada data yang dipilh / dicheck | Bivetal ‘ ‘ + Select All | ‘ By proses ‘ | i keluar |

e Cair : centang kolom ini bila cek/giro pada baris ini ingin dilakukan
proses pencairan. Hanya cek yang tanggal Jatuh Temponya tidak
melebihi periode bulan berjalan yang bisa dicairkan.

e Tgl. Cair : otomatis terisi sesuai tanggal jatuh tempo. Bisa disesuaikan
apabila dibutuhkan dengan mengetikkannya langsung masing-masing 2
digit tgl, bulan, tahun atau klik tombol drop-down untuk memunculkan
bantuan kalender.

e Kurs Cair : otomatis terisi sesuai dengan kurs transaksi. Apabila perlu
menyesuaikannya anda bisa melakukannya. Namun dalam prakteknya
penyesuaian nilai dalam nominal Rp untuk akun Kas / Bank yang berupa
valuta asing cukup dilakukan pada akhir periode pada saat anda
melakukan revaluasi valuta asing.

e Tombol Filter : menyeleksi data yang ditampilkan menurut range
tanggal transaksi, tanggal (jatuh tempo) cek/giro, Nama Bank, kontak
dan/atau batasan nilai cek/giro. Seperti telah dikemukakan di atas, kalau
ingin melakukan filter, maka lakukanlah sebelum ada data yang

dicentang atau dipilih.
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e Tombol Detail : menampilkan form transaksi Pengeluaran Kas / Bank
sesuai baris dimana kursor berada.

e Tombol Select All / Deselect All : memilih (menandai) semua detail
transaksi yang sedang ditampilkan. Mengkliknya kembali berarti
melakukan uncheck atas semua baris yang sudah dipilih (ditandai).

e Tombol Proses : melakukan proses pencairan semua baris yang telah
ditandai.

¢  Tombol Keluar : menutup form ini.

5.13 Membatalkan Giro Masuk sudah Cair

Data giro masuk yang sudah dilakukan proses pencairan dapat dilihat
melalui modul ini dengan memilih menu Transaksi > Membatalkan Giro
Masuk Sudah Cair. Pada saat anda membukanya maka akan ditampilkan
data giro masuk sudah cair untuk periode bulan berjalan dalam urutan
tanggal transaksi. Apabila perlu memilih periode lain atau rentang waktu
tertentu maka klik tombol Filter. Sedangkan apabila ingin mengurutkan
menurut kolom tertentu maka klik judul kolom yang bersangkutan. Tidak
seperti pada saat melakukan proses pencairan, membatalkan pencairan

cek/giro harus dilakukan satu demi satu.

e Tanggal : menampilkan tanggal transaksi Penerimaan Kas / Bank.

e Dari: menampilkan kontak dari mana penerimaan Kas / Bank berasal.
¢ Nama Bank : menampilkan Nama Bank yang menerbitkan cek/giro.

¢ No. Giro : menampilkan nomor cek/giro.

e Jatuh Tempo : menampilkan tanggal jatuh tempo cek/giro.

¢  Kurs : menampilkan kurs transaksi.

¢ Nilai : menampilkan nilai cek/giro berikut valutanya.

e Tgl. Cair: menampilkan tanggal cair cek/giro.

e  Kurs Cair : menampilkan nilai kurs yang diisikan pada saat pencairan.
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(Periode Januari 2015) Fiter  Refr =
[T STRIBEN RAJAWALT PERKASA Bank ABC XY 123567 16/01/2015 1,00 Rp 49.700.000 16/01/2015 1,00 GM 000002
14/01/2015 ERA BARU SOLUSINDO Bark Mitra AA 890123 14/01/2015 1,00 Rp 88.660.000 15/01/2015 1,00 GM 000001
- 3
4 Membatalkan Giro Masuk Sudah Cair ==
Tuiskan alasan pembatalan, bisa memiih dari Daftar atau menuisian
slzsan lain.
Dari RAJAWALT PERKASA
Bank Bank ABC

No. Cek (Gro XY 123567
Hilai Rp 42.700.000

Alasan | -

Tanggal posting (16012015 [+]
pembatalan

Unfiltered ImiData : 2

Ti Membatalkan Giro Masuk
#PS posisikan aursor pada baris data Cek/Gio vang akan dbatakan,

. selanjutnya kik roses. Tidak seperti paca proses pencairan,
&' andahanya bisa membatalkan Cek/Giro sat persatu | Bicewm | P proses N | e |

e Tombol Filter : menyeleksi data yang ditampilkan menurut range
tanggal transaksi, tanggal (jatuh tempo) cek/giro, Nama Bank, kontak
dan/atau batasan nilai cek/giro.

e Tombol Refresh : apabila ada kemungkinan penambahan atau
pengurangan data atas aktifitas pencairan atau pembatalan yang
dilakukan oleh user lain, sementara anda sudah dalam keadaan
membuka form ini sebelumnya, maka perlu dilakukan proses refresh
untuk menampilkan data dalam kondisi terkini.

e Tombol Search : apabila data yang ditampilkan cukup banyak, anda
dapat menggunakan bantuan tombol ini untuk mencari data tertentu
berdasarkan nama pengenal kontaknya atau nomor cek/gironya. Setelah
mengklik tombol ini, masukkan teks yang dicari pada field Cari,
kemudian pilih apakah mencari di kolom Diterima dari atau kolom No.
Giro, kemudian klik tombol Go. Tombol Clear berfungsi mengosongkan
field Cari agar mudah mengetikkan teks baru.

e Tombol Detail : menampilkan form transaksi Penerimaan Kas / Bank

sesuai baris dimana kursor berada.

5-89



e Tombol Proses : melakukan proses pembatalan pencairan atas cek/giro
dimana kursor berada. Program akan meminta anda untuk mengisi
alasan pembatalan cek/giro.

¢  Tombol Keluar : menutup form ini.

5.14 Membatalkan Giro Keluar sudah Cair

Data giro keluar yang sudah dilakukan proses pencairan dapat dilihat melalui
modul ini dengan memilih menu Transaksi > Membatalkan Giro Keluar
Sudah Cair. Pada saat anda membukanya maka akan ditampilkan data giro
keluar sudah cair untuk periode bulan berjalan dalam urutan tanggal
transaksi. Apabila perlu memilih periode lain atau rentang waktu tertentu
maka klik tombol Filter. Sedangkan apabila ingin mengurutkan menurut

kolom tertentu maka klik judul kolom yang bersangkutan. Tidak seperti pada

saat melakukan proses pencairan, membatalkan pencairan cek/giro harus
dilakukan satu demi satu.

Nama Bank No.Giro Jatuh Tempo Kurs. . Tgl. Cair No. Jurnal
12/01/2015 GRAHA PRIMA SEJAHTERA Bank BCD AA 456890 14/01/2015 1,00 Rp 120.000.000 15/01/2015 1,00 GK 000002
FIIGETEARE PANCA MITRA Bank BCD AB 345678 25/01/2015 1,00 Rp 42,968,000 26/01/2015 1,00 GK 000001
28/01/2015 KAS NEGARA Bank BCD AAX 567830  28/01/2015 1,00 Rp 3.360.312 28/01/2015 1,00 GK 000003
p N
§4 Membatalkan Giro Keluar Sudah Cair )

Tuliskan alasan pembatalan, bisa memiih dari Daftar atau menuliskan
alasan lain.

Untuk PANCA MITRA

Bank Bank BCD

Mo. Cek / Giro AB 345678

Milai Rp 42.968.000

Alasan | -

Tanggal postng  [26/01/2015 [+
pembatalan

Unfiltered JmlData : 3

Ti Membatalkan Giro Keluar
PS5 Posiskan cursor pada baris data Cek/Giro yang akan dibatalkan,
selanjutnya Kk Proses. Tidak sepert pada proses pencairan,
"4 anda hanya bisa membataken Cek/Gio satu persat | Bioew |

‘.’_g.p@sas% ‘ el keluar ‘
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Tanggal : menampilkan tanggal transaksi Pengeluaran Kas / Bank.

Untuk : menampilkan kontak kepada siapa pengeluaran Kas / Bank
ditujukan.

Nama Bank : menampilkan Nama Bank yang menerbitkan cek/giro.

No. Giro : menampilkan nomor cek/giro.

Jatuh Tempo : menampilkan tanggal jatuh tempo cek/giro.

Kurs : menampilkan kurs transaksi.

Nilai : menampilkan nilai cek/giro berikut valutanya.

Tgl. Cair : menampilkan tanggal cair cek/giro.

Kurs Cair : menampilkan nilai kurs yang diisikan pada saat pencairan.
No. Jurnal : menampilkan referensi Kode dan No. Jurnal atas jurnal yang
timbul pada saat pencairan.

Tombol Filter : menyeleksi data yang ditampilkan menurut range
tanggal transaksi, tanggal (jatuh tempo) cek/giro, Nama Bank, kontak
dan/atau batasan nilai cek/giro.

Tombol Refresh : apabila ada kemungkinan penambahan atau
pengurangan data atas aktifitas pencairan atau pembatalan yang
dilakukan oleh user lain, sementara anda sudah dalam keadaan
membuka form ini sebelumnya, maka perlu dilakukan proses refresh
untuk menampilkan data dalam kondisi terkini.

Tombol Search : apabila data yang ditampilkan cukup banyak, anda
dapat menggunakan bantuan tombol ini untuk mencari data tertentu
berdasarkan nama pengenal kontaknya atau nomor cek/gironya. Setelah
mengklik tombol ini, masukkan teks yang dicari pada field Cari,
kemudian pilih apakah mencari di kolom Untuk atau kolom No. Giro,
kemudian klik tombol Go. Tombol Clear berfungsi mengosongkan field
Cari agar mudah mengetikkan teks baru.

Tombol Detail : menampilkan form transaksi Pengeluaran Kas / Bank
sesuai baris dimana kursor berada.

Tombol Proses : melakukan proses pembatalan pencairan atas cek/giro
dimana kursor berada. Program akan meminta anda untuk mengisi
alasan pembatalan cek/giro.

Tombol Keluar : menutup form ini.
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5.15 Rekonsiliasi Bank

Modul ini digunakan sebagai alat bantu dalam melakukan rekonsiliasi
khususnya untuk akun Bank setelah memperoleh rekening koran yang
diterbitkan pihak Bank.

Untuk membuka modul ini pilih menu Transaksi > Rekonsiliasi Bank.

e Account Bank : pilih akun Bank yang ingin direkonsiliasi dengan
mengklik pada field ini atau tombol drop-down disampingnya.

e Saldo Rekening Koran : ketik saldo menurut rekening koran.

e Per Tanggal : sesuaikan dengan tanggal rekening koran atau tanggal
dilakukannya rekonsiliasi. Bisa dengan mengetikkannya langsung
dengan format dd/mm/yy : masing-masing 2 digit tanggal, bulan dan
tahun atau klik tombol drop-down untuk memunculkan kalender.

AccountBank  Bank 5CD +  SaldoRekening Koran 44.05.069 PerTonggd  PUOUD1S -] | htoadmefiesh | [
Tol. Rekonsiiasi Terakhir : ~ 31/01/2015 << Rekonsiliasi Bank >> Valuta: IDR
Tanggal  Kd MNo.Vch Mo, Referensi Kontak Keterangan Debit Kredit 7
[<]15/01/2015 |GM 000001 |GM 000001 ERA BARL SOLUSINDO Pelunasan INV-14,000302, 000304 88,560,000 3
o 15012015 GM 000001 GM 000001 ERA BARL SOLUSINDO Pembatalan Gira No. AA 890123, Salah Input il 88.660.000 G
0 15/01/2015 GM 000001 GM 000001 ERA BARL SOLUSINDO Pelunasan INV-14,000302, 000304 88,560,000 3
o 15/01/2015 GK 000002 GK0O0DOZ GRAHA PRIMA SEJAHTERA  Bayar Inv. 015/GPS/INV/12/14 (partial) 120.000.000 G
0 15/01/2015 GM 000002 GM 000002 RAJAWALI PERKASA Pelunasan INV-14,000300, INV-14,000303 (part 49,700,000 3
0 26/01/2015 GK 000001 GKO0ODDO1 PANCA MITRA Bayar Inv. 15.000012 42.968.000 G
0 25/01/2015 BO 000003 BO 000003 ABC FINANCE Bayar angsuran kendaraan bin, Januari 2015 2729222 T
o 2501/2015 G 000002 GJ 000002 <N/a> Biaya administrasi Bank bin. Januari 2015 30.000
0 28/01/2015 GK 000003 GK 000003 KAS NEGARA Bayar PPN DN Masa Desember 2014 3.360.312 G
0 30/01/2015 BO 000004 BO 000004 MITRA FINANCE Bayar angsuran kendarazn bin, Januari 2015 5.938.000 T
0 31/01/2015 G] 000003 GJ000003 <NjA> Jasa giro bin, Januari 2015 433,047
0 31f01/2015 G 000004 GJ 00004 <N/a> Pajak jasa giro bin. Januari 2015 86.649
ml Data: 12 Checked : 12 | Not Checked : 0 227.453.247 263.772.183 K
Tgl. Rekongiiasi Sebelumnya :  31/12/2014 | Saldo : 500.375.000 C:Cash | G: Gro | T: Transfer Saldo Buku Besar : 464,056,064

e R |

Setoran dalam Perjalanan 0 Masuk 227.453.247 Seldo Rekening Koran 464.056.064
Cek Beredar 0 Keluar 263.772.183 Saldo Terekansiiasi 464.056.064
Jumiah 0 Jumiah (36.315.936) Selish 0
‘ Mencairkan Giro Masuk ‘ ‘ Mencairkan Giro Keluar ‘ ‘ Jurnal Penyesuaian ‘ ‘ New Receipt | ‘ New Payment | | Flsave ‘ ‘ = Preview ‘

e Tombol Load/Refresh : setelah anda menentukan Account Bank dan
fokus (kursor) anda pindahkan pada field lain, maka data transaksi
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dalam rentang sejak tanggal rekonsiliasi sebelumnya dengan tanggal
akan dilakukannya rekonsiliasi, otomatis akan ditampilkan oleh
program. Demikian juga jika anda merubah tanggal pada field Per
Tanggal. Namun anda juga bisa melakukan loading data secara langsung
dengan mengklik tombol ini. Kegunaan lain dari tombol ini adalah
merefresh tampilan data apabila ada kemungkinan penambahan atau
perubahan data oleh user lain sementara anda sudah dalam keadaan
membuka form ini.

Tgl. Rekonsiliasi Terakhir : menampilkan tanggal terakhir pernah
dilakukannya rekonsiliasi untuk akun Bank dimaksud.

Valuta : menampilkan valuta akun Bank dimaksud.

Tanggal : kolom ini menampilkan tanggal transaksi.

Kd : menampilkan Kode Voucher (kode transaksi atau kode jurnal).

No. Vch : menampilkan Nomor Voucher (nomor jurnal).

No. Cheque/Giro : menampilkan nomor cek/giro jika transaksinya
berupa cek/giro.

Kontak : menampilkan Nama Pengenal kontak terkait transaksi
dimaksud.

Keterangan : menampilkan keterangan terkait transaksi.

Kurs : menampilkan kurs transaksi.

Debit : apabila transaksi bernilai debit, kolom ini menampilkan nilai
debit dalam nominal valuta akun Banknya.

Kredit : apabila transaksi bernilai kredit, kolom ini menampilkan nilai
kredit dalam nominal valuta akun Banknya.

|/ : centang kolom ini bila transaksi pada baris ini telah sesuai rekening
koran. Untuk mencentang semua baris transaksi sekaligus maka klik
pada footer kolom ini, sedangkan setelah tercentang semua, untuk
melakukan uncheck sekaligus maka klik kembali footer kolom ini.

Tgl. Rekonsiliasi Sebelumnya : menampilkan tanggal rekonsiliasi
sebelumnya terhadap tanggal pada field Per Tanggal berikut saldonya
Saldo Buku Besar : menampilkan saldo pada buku besar untuk akun
Bank dimaksud sesuai tanggal pada field Per Tanggal.
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e Belum Dicairkan : mengindikasikan apakah masih ada cek/giro baik
masuk maupun keluar dalam rentang waktu dimaksud yang sudah
diinput tapi belum dilakukan proses pencairan.

#  Setoran dalam Perjalanan : menampilkan nilai transaksi dalam
bentuk cek/giro masuk dalam rentang waktu dimaksud yang sudah
diinput tapi belum dilakukan proses pencairan.

3t Cek beredar : menampilkan nilai transaksi dalam bentuk cek/giro
keluar dalam rentang waktu dimaksud yang sudah diinput tapi
belum dilakukan proses pencairan.

#  Jumlah : jumlah dari Setoran dalam Perjalanan dikurangi Cek
Beredar.

e Direkonsiliasi :
3t Masuk : menampilkan nilai transaksi berupa penerimaan bank yang

telah anda rekonsiliasi (dicentang)

3t Keluar : menampilkan nilai transaksi berupa pengeluaran bank
yang telah anda rekonsilias (dicentang)

#t  Jumlah : jumlah dari Masuk dikurangi Keluar.

e Saldo:
3t Saldo Rekening Koran : menampilkan saldo rekening koran sesuai

yang anda input.

# Saldo Terekonsiliasi : menampilkan saldo yang sudah
direkonsiliasi. Nilai ini berasal dari saldo rekonsiliasi sebelumnya
ditambah nilai rekonsiliasi Masuk dikurangi Keluar.

#t  Selisih : mengindikasikan apakah masih ada selisih antara Saldo
Rekening Koran dan Saldo Terekonsiliasi.

¢ Tombol Mencairkan Giro Masuk : apabila masih ada giro masuk yang
belum dilakukan proses pencairan, indikasinya Setoran dalam Perjalanan
masih ada nilainya, maka anda bisa menggunakan tombol ini untuk
mencairkannya.

¢ Tombol Mencairkan Giro Keluar : apabila masih ada giro keluar yang
belum dilakukan proses pencairan, indikasinya Cek Beredar masih ada
nilainya, maka anda bisa menggunakan tombol ini untuk

mencairkannya.
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e Tombol Jurnal Penyesuaian : tombol ini bisa digunakan untuk
menambahkan jurnal penyesuaian atas akun Bank dimaksud yang belum
diinput misalnya atas bunga bank, biaya administrasi bank atau jasa giro
dan sebagainya.

¢ Tombol New Receipt : apabila ada penerimaan Kas / Bank yang belum
diinput maka gunakan tombol ini untuk menambah transaksi
Penerimaan Kas / Bank baru.

e Tombol New Payment : apabila ada pengeluaran Kas / Bank yang belum
diinput maka gunakan tombol ini untuk menambah transaksi
Pengeluaran Kas / Bank baru.

e Tombol Save : menyimpan data rekonsiliasi yang sudah anda lakukan.

e Tombol Preview : menampilkan laporan rekonsiliasi ke layar untuk
kemudian bisa dicetak ke printer.

e Tombol Close : menutup form ini.

Tips :

e Apabila anda memerlukan untuk mengurutkan data menurut kolom
tertentu, maka klik pada judul kolom bersangkutan.

e Apabila ingin mengedit atau menghapus baris transaksi tertentu,
maka double klik pada baris bersangkutan atau tombol drop-down
pada kolom paling Kkiri untuk masuk pada form transaksi yang
bersangkutan.

5.16 Menerima SSP dari Bendaharawan

Modul ini hanya diperlukan jika perusahaan melakukan penjualan kepada
Customer yang merupakan Bendaharawan atau BUMN, apabila tidak maka

modul ini tidak anda perlukan.

Untuk membuka modul ini pilih menu Transaksi > Menerima SSP dari
Bendaharawan. Transaksi penjualan kepada Bendaharawan yang belum
diterima SSPnya akan ditampilkan dalam urutan Tanggal Invoicenya.
Apabila perlu melakukan penyeleksian terhadap data yang ditampilkan

maka klik tombol Filter, sedangkan apabila perlu mengurutkan data menurut

5-95



kolom tertentu, maka klik pada judul kolom bersangkutan. Penentuan suatu
Customer adalah Bendaharawan atau bukan adalah pada saat input data
Customer bersangkutan melalui menu Master Data > Customer (lihat 4.3.6

Customer)

e Tgl. Invoice : menampilkan Tanggal Invoice transaksi penjualan
bersangkutan.

e  Customer : menampilkan nama pengenal Bendaharawan bersangkutan.

¢  No. Invoice : menampilkan nomor Invoice.

¢ No. Faktur : menampilkan nomor Faktur Pajak.

e Gross Sales : menampilkan nilai transaksi penjualan bruto.

e Discount : menampilkan nominal discount total untuk penjualan
bersangkutan.

¢ PPN :menampilkan nilai PPN untuk transaksi bersangkutan.

e Terima : centang kolom ini bila transaksi penjualan pada baris ini telah
diterima SSPnya dari Bendaharawan bersangkutan dan ingin dilakukan
penjurnalan yang akan mengkredit Piutang customer dimaksud sebesar
PPN ditambah PPh 22. Artinya jurnal yang terbentuk akan mendebit
PPN Keluaran dan PPh Pasal 22. Penentuan besarnya persentase
potongan PPh Pasal 22 adalah melalui modul Setup Preferensi pada tab
Profil. (lihat 4.2.2 Setup Preferensi)

e Tgl. Terima : setelah mencentang kolom Terima, maka anda harus
menentukan tanggal penerimaan SSP yang akan merupakan tanggal
dilakukannya penjurnalan sebagaimana yang dukemukakan di atas.
Ketik masing-masing 2 digit tanggal, bulan dan tahun atau klik tombol
drop-down yang ada pada kolom ini untuk memunculkan bantuan
kalender.

e Tombol Filter : menyeleksi data yang ditampilkan menurut Periode atau
range tanggal Invoicenya dan/atau Customer tertentu. Seperti telah
dikemukakan di atas, kalau ingin melakukan filter, maka lakukanlah
sebelum ada data yang dicentang atau dipilih.

e Tombol Detail : menampilkan form transaksi penjualan (Sales Invoice)

sesuai baris dimana kursor berada.
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e Tombol Select All / Deselect All : memilih (menandai) semua detail
transaksi yang sedang ditampilkan. Mengkliknya kembali berarti
melakukan uncheck atas semua baris yang sudah dipilih (ditandai).

¢ Tombol Proses : melakukan proses pencairan semua baris yang telah
ditandai.

¢ Tombol Keluar : menutup form ini.

5.17 Stock Opname

Apabila anda bermaksud melakukan penyesuaian stok atau saldo barang
yang relatif menyeluruh atas barang inventory yang ada, biasanya atas dasar
stock opname atau stock taking yang telah dilakukan, maka gunakan modul
Stock Opname untuk melakukan input hasil stock opname yang telah
dilakukan. Namun apabila hanya bermaksud melakukan penyesuaian stok
atas satu atau beberapa item barang, maka lebih tepat menggunakan modul
Stock Adjustment. Apa yang anda input melalui modul Stock Opname pada
akhirnya akan bermuara pada modul Stock Adjustment.

Untuk membuka modul Stock Opname pilih menu Transaksi > Stock

Opname.
Ei Lookup Data Stock Opname ﬂ 5& Lookup Data Stock Opname ﬂ
Cari Data Cari Data
MNo.Refrens = | | No. Refrensi
No. Refrensi Tanggal Posted

Lengkapi data berikut untuk membuat data Stock|
/- = Opname yang baru, selanjutnya kik tombol OK

Klik Mew untuk
input data Stock
Opharne haru

001/5T-ADJ/01/15 |31/01/2015 M

[ ok || P cancel | | &8 cancel New | ng%| B} cancel |
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Apabila ingin membuat atau melakukan input data Stock Opname baru, klik
tombol New kemudian isi field Referensi, tentukan tanggal penyesuaian pda
field Tanggal dengan mengetikkannya dengan format dd/mm/yy (masing-
masing 2 digit tanggal, bulan, tahun) atau klik tombol drop-down yang ada
untuk memunculkan kalender. Selanjutnya klik tombol OK untuk
melanjutkan ke tahap berikutnya atau Cancel New apabila ingin
membatalkan (tidak jadi) membuat data baru. Tombol Cancel berfungsi
menutup form dan membatalkan proses selanjutnya.

Sedangkan apabila ingin membuka data Stock Opname yang pernah
dilakukan, maka pilih data yang bersangkutan kemudian klik tombol OK.
Apabila data Stock Opname sudah cukup banyak, anda bisa mencarinya
berdasarkan No. Referensi atau Tanggal. Caranya klik tombol drop-down
pada field Cari Data kemudian pilih apakah ingin mencari berdasarkan No.
Referensi atau Tanggal kemudian ketikkan teks atau tanggal yang dicari pada
field di sebelahnya.

Setelah anda mengklik tombol OK, maka proses selanjutnya akan
ditampilkan form sebagaimana gambar di bawah yang menampilkan daftar
barang inventory yang ada berikut saldo menurut catatan komputer (Stock
On Hand) per tanggal dilakukannya penyesuaian. Untuk melakukan
penyesuaian, ketikkan saldo menurut penghitungan fisik pada kolom Stock
Fisik.

Apabila anda membuat data Stock Opname baru, maka kolom Stock Fisik
akan terisi nol, untuk memudahkan dalam menginput penyesuaian karena
biasanya lebih banyak data yang sesuai antara stock on hand dan stock fisik,
maka centang checkbox Set Stock Fisik = Stock On Hand, maka kolom Stock
Fisik akan terisi sesuai kolom Stock On Hand, selanjutnya anda tinggal
menyesuaikan kolom Stock Fisik apabila tidak sesuai dengan data hasil
penghitungan fisik.
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: v B 2 [
oL Fiter  Prevew Search Close
Kode Barang Nama Barang Satuan Stock on Hand Stock Fisik Selisih
GN-333 GPS Navigasi GN-333 Unit 50 49 -1
GN-333% GPS Navigasi GN-333X Unit 51 51 0
GT-90v GPS Tracker GT-90V Unit 149 148 -1
GT-80% (GPS Tracker GT-80X Unit 451 451 0
KP-O1 Rartu Perdana Pes [} 3 3]

VCH-250 Pulsa 250 ribu Unit 0 [ 0 ‘ ¥ cancel |
VN-50E GPS Navigasi YN-50E Unit 0 0 0
‘ (R |
‘ 12 Posting |
‘ ¢ Delete |
Unfiltered Jumlzh Data : 7 Sort : Ascending (cick here to change order)
[ | Set Stock Fisik = Stock On Hand ["|Set Stock Fisik = 0

. Padamodul in, kik tombol Save hanya berarti menyimpan posisi Stock on Hand dan/atau hasil Stock Opname. Untuk mengupdate Stock dan
“4' JumalLedger, anda harus mengkik tombal Posting. Lakukan hal ini hanya bila input telsh dianggap fix, karena seteleh diposting maka Hasi Stock
Opname tidak bisa diedit lagi. Apabila masih ada koreksi, anda harus membuat data Stock Opniame baru atau melalui modul Stock Adjusment

Untuk barang-barang yang tidak ada pada data Stock Opname (berarti belum
ada pada Master Barang & Jasa) tetapi di lapangan ditemukan barang
tersebut, apabila anda sudah terlanjur membuat data Stock Opname (sudah
menyimpannya), maka bisa anda input barang tersebut nantinya melalui
modul Stock Adjustment setelah diposting dengan sebelumnya diinput dulu
ke Master Barang & Jasa. Tetapi kalau anda belum membuat data Stock
Opname, maka input dulu data barang bersangkutan ke Master Barang & Jasa
sehingga setelahnya maka pada saat anda membuat data Stock Opname,

barang tersebut akan ikut muncul pada data Stock Opname.

Khusus untuk barang yang ada Serial No, Lot. No/Batch No atau Expire
Datenya, maka perincian menyangkut hal ini untuk masing-masing barang
dapat ditentukan melalui modul Stock Adjustment setelah data Stock
Opanme ini diposting.

(Catatan : Untuk Varian Accpro Trada dan Accpro Strada, fasilitas Serial No, Lot
No/Batch No atau Expire Date tidak tersedia)
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e Tombol Filter : digunakan apabila anda ingin menyeleksi data yang
ditampilkan apakah Grup tertentu atau Satuan tertentu atau ada kriteria
menyangkut Stock on Hand dan Stock Fisik tertentu saja yang ingin
ditampilkan. Pada saat anda mengklik tombol ini, maka kalau
sebelumnya anda telah melakukan perubahan, program akan meminta
konfirmasi apakah anda ingin menyimpan lebih dulu perubahan yang
telah dilakukan.

¢  Tombol Preview : untuk menampilkan form Stock Opname atau laporan
Hasil Stock Opname ke layar untuk selanjutnya bisa dicetak ke printer.
Sebelum anda melakukan Stock Opname di lapangan, anda bisa
membuat data Stock Opname dan menyimpan posisi Stock On Hand per
tanggal tertentu sesuai dilakukannya Stock Opname dan selanjutnya
mencetak form Stock Opname untuk diisi secara manual hasil Stock
Taking, kemudian hasil ini dapat anda input kembali sebagai data Stock
Fisik dengan memanggil data Stock Opname yang telah anda buat
sebelumnya.

e Tombol Search : apabila item barang cukup banyak, anda bisa
memanfaatkan tombol ini untuk mencari barang tertentu yang saat itu
sedang ditampilkan menurut Kode Barang atau Nama Barangnya.

e Tombol Cancel : membatalkan perubahan yang dilakukan dan
mengembalikan tampilan seperti sebelum ada perubahan.

¢ Tombol Save : menyimpan posisi stock on hand sesuai tanggal saat anda
membuat data stock opname ini pertama kali. Apabila ada perubahan
terhadap stock on hand setelah itu, posisi stock on hand untuk data Stock
Opname ini tidak berubah lagi. Mengklik tombol Save hanya berarti
menyimpan posisi stock on hand dan hasil stock opname (stock fisik)
yang anda input dan belum mengupdate stock.

e Tombol Posting : untuk mengupdate stok dan buku besar (G/L), anda
harus mengklik tombol ini. Lakukan hal ini apabila input telah dianggap
fix, karena setelah diposting maka form ini tidak bisa diedit lagi. Apabila
masih ada koreksi, harus melalui modul Stock Adjustment atau membuat
data Stock Opname baru.

Setelah anda mengklik tombol Posting maka akan ditampilkan form

yang meminta anda untuk menentukan default account lawan
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Persediaan baik apabila persediaan bertambah ataupun berkurang. Selain
itu untuk persediaan bertambah anda harus memilih apakah unit cost

adalah sesuai harga beli terakhir atau dibiarkan nol.

4 Input Akun Lawan Persediaan (]

Tentukan Default Account Lawan Persediaan

Persediaan bertambah : HPF / COGS

Persediaan berkurang : [V]HPP / COGS

Unit Cost untuk Persediaan bertambah :[7]H, Beli Terakhir
[iarkan = Mol

| afcancel | | o OK N

Default Account lawan persediaan baik persediaan bertambah atau
berkurang ditentukan oleh program sebagai akun HPP/COGS untuk
masing-masing barang bersangkutan, apabila anda menginginkan lain
maka klik checkbox HPP/COGS hingga tidak tercentang kemudian
tentukan akun defaultnya dengan mengisikan pada field disebelahnya
atau klik tombol Lookup untuk memunculkan form Lookup Perkiraan
sehingga anda bisa mencari perkiraan dimaksud.

Dengan mengklik tombol OK, maka form Stock Adjustment akan
ditampilkan dimana sudah terisi data barang-barang yang ada
penyesuaiannya (kolom Selisih <> 0).

Sedangkan apabila ingin membatalkan posting klik tombol Cancel.

5-101



s S =
T TR Adjustment
Tanggal No. Referensi  [15.01.0002

Keterangan  Stock Opname tgl. 33/01/2015 , No. Ref. 001/ST-ADJ/01/15

Default Account G/L sebagai lawan Persediaan

Persedoanbertanbeh: @) [7]kpPjcoGs | --- |8,
Persedzanberkrang : @) [P jcocs | - - - B

Sebelum mengisi detall transaksi adjustment, pastikan Tanggal sudah sesual dengan tanggal dilakukannys
adjustment karena tanggal tidak bisa diubah kalau sudah ada detail transaksinya !

Kode Barang Nama Barang
| GPS Navigasi GN-333
2. GT90V GPS Tracker GT-50V 149 148 -1 Unit
3. KP-01 Kartu Perdana 0 2 2P 5.000

e [

Setelah masuk pada modul atau form Stock Adjustment anda tinggal
melengkapi field Keterangan. Selain itu apabila ada barang tertentu yang
ada Serial No., Lot No./Batch No, dan/atau Expire Datenya, klik tombol
drop-down yang ada pada kolom Qty Adj. sehingga form “Perincian
Serial No./Lot No. masing-masing Barang” akan ditampilkan dimana
anda bisa merinci kuantitas barang berikut Serial No, Lot No./Batch No.
dan/ atau Expire Datenya.

e Tombol Delete : menghapus data Stock Opname.

e Tombol Close : menutup form ini.

Tips :

Apabila anda memerlukan untuk mengurutkan data pada form Stock
Opname menurut kolom tertentu, maka klik pada judul kolom
bersangkutan.
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5.18 Stock Adjustment

Untuk melakukan penyesuaian atas satu atau beberpa item barang inventory
apalagi kalau bukan berdasarkan hasil Stock Opname, anda tidak perlu
menggunakan modul Stock Opname tetapi cukup melalui modul Stock

Adjustment.

Modul ini dibuka melalui menu Transaksi > Stock Adjustment.

Barenpann e . ==
T TR Adjustment
Tanggal Mo. Referensi  [15.01.0001

Keterangan Retur penjualan, Customer Ref. No. 00S/RP/SR/I/15

Default Account G/L sebagai lawan Persediaan
Persediaan bertambah : &) [Z] HPP / COGS
Persediaan berkurang : @) [¥] HPP / COGS

PP

Qty Adj. harus bernilai negatif untuk b ) dan positif untuk sebaliknya

| GPS Tracker GT-30X

I

Semummawm

et [

e No : No. Transaksi otomatis digenerate oleh program. Anda tidak bisa
merubahnya. Nomor ini dengan kombinasi awalan Kode Jurnal (Kode
Voucher atau Kode Transaksi) akan menjadi referensi untuk transaksi ini.
Default Kode Jurnal yang diberikan Accpro untuk modul ini adalah AD]J.

¢ No. Referensi : isi nomor bukti atau referensinya.

e Tanggal : tentukan tanggal transaksi dengan mengetikkannya langsung
dengan format dd/mm/yy yaitu masing-masing 2 digit tanggal, bulan,
tahun atau klik tombol drop-down yang ada untuk memunculkan

kalender. Pastikan anda menentukan lebih dulu tanggal transaksi
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sebelum menginput detail transaksi, karena setelah itu tanggal transaksi
tidak bisa diubah lagi.

e  Keterangan : isi keterangan mengenai transaksi ini.

e Default Account G/L sebagai lawan Persediaan : jurnal transaksi yang
terjadi atas transaksi ini adalah mendebit atau mengkredit akun
Persediaan (tergantung apakah persediaan bertambah atau berkurang),
sebagai lawannya program menentukan default akunnya sebagai akun
HPP/COGS. Apabila anda ingin menetapkan akun lain (biasanya adalah
akun biaya atau pendapatan), maka uncheck checkbox HPP/COGS
kemudian isikan nomor perkiraannya pada field disebelahnya atau klik
tombol Lookup yang ada sehingga akan dimunculkan form Lookup
Perkiraan dimana anda bisa mencari perkiraan dimaksud. Apabila
nantinya pada baris transaksi tertentu, anda ingin menentukan akunnya
secara lebih spesifik, maka anda bisa mengklik tombol drop-down pada
kolom @. Kekeliruan yang pernah ditemui adalah menentukan akun ini
sebagai akun Persediaan, hal ini tidak tepat karena akun Persediaan telah
digunakan oleh program, sehingga akan saling meniadakan, jadi yang
dimaksud disini adalah akun sebagai lawan dari akun Persediaan yang
telah secara otomatis digunakan oleh program untuk baris jurnal

pertamanya.
e Tab Barang:

3 Kode Barang : isi Kode Barangnya, atau klik tombol drop-down
pada kolom ini, maka daftar Barang akan ditampilkan dalam urutan
Kode Barangnya, anda tinggal memilih item barang yang dimaksud.

7z Nama Barang : setelah anda mengisi kolom Kode Barang, maka
kolom ini akan terisi dengan sendirinya. Namun sebagai alternatif,
apabila lebih mudah mengingat Nama Barangnya, anda bisa
menggunakan kolom ini untuk memilih barang tertentu, ketik initial
atau potongan awal Nama Barang atau klik tombol drop-down pada
kolom ini, maka daftar Barang akan ditampilkan dalam urutan

Nama Barangnya.
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Qty OnHand : setelah anda menentukan Kode Barangnya, maka
program akan menampilkan kuantitas atau saldo barang per tanggal
transaksi pada kolom ini, jadi kolom ini tidak bisa diedit. Kolom ini
hanya muncul pada modus Add.

Qty Fisik : isikan kuantitas sesuai penghitungan fisik di lapangan.
Kolom ini hanya muncul pada modus Add.

Qty Adj. : apabila anda mengisi kolom Qty Fisik, maka kolom ini
akan terisi dengan sendirinya sebagai selisih Qty Fisik dengan Qty
On Hand, namun anda bisa mengedit kolom ini atau menggunakan
kolom ini sebagai alternatif untuk mengisikan kuantitas yang
diadjust (disesuaikan) secara langsung, apabila negatif berarti
persediaan akan berkurang, demikian sebaliknya, kolom Qty Fisik
akan menyesuaikan dengan perubahan ini. Untuk barang-barang
yang ada Serial No, Lot No/Batch No atau Expire Datenya, maka
akan ada tombol drop-down pada kolom ini. Dengan mengklik tombol
ini akan akan ditampilkan form yang dapat anda gunakan untuk merinci
kuantitas adjustment dan Serial No, Lot No/Batch No atau Expire Datenya.
Akan tetapi fasilitas ini hanya tersedia pada varian Accpro Spectra.

Satuan : kolom ini akan terisi sesuai Satuan Inventory untuk item
barang bersangkutan dan tidak bisa diedit.

Unit Cost : apabila adjustment positif (persediaan bertambah) maka
anda harus menentukan cost per unit untuk item bersangkutan.
Program akan otomatis mengisikannya sesuai harga beli terakhir,
apabila dianggap unit cost tidak ada maka anda harus mengisinya
dengan 0 (nol).

@ : kolom ini berguna apabila anda ingin menentukan akun lawan
Persediaan secara spesifik untuk item barang tertentu yang berbeda
dengan yang telah anda tentukan secara default pada Default
Account G/L sebagai lawan Persediaan diatas. Untuk itu klik tombol

drop-down yang ada sehingga akan ditampilkan daftar perkiraan.

Tombol Insert Row : untuk menyisipkan baris baru diantara baris yang

Tombol Delete Row : untuk menghapus baris tertentu.
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e  Tombol New : menambah transaksi baru.

e Tombol Search : mencari transaksi berdasarkan No. Trs atau No.
Referensi.

e Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan, artinya apabila tidak ada perubahan yang dilakukan anda
tidak perlu mengklik tombol ini untuk menghindari perubahan data
yang tidak disengaja.

¢ Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

e Tombol Delete : menghapus transaksi tertentu. Berhati-hatilah
menggunakan tombol ini karena transaksi yang dihapus tidak bisa
ditimbulkan (direcall) kembali. Juga jangan rancu dengan tombol Delete
Row, karena tombol Delete Row hanya bermaksud untuk menghapus
baris tertentu.

e Tombol Print : mencetak printout transaksi (bukti Adjustment Stock).
Apabila checkbox Preview tercentang maka akan ditampilkan dulu ke
layar. Pengaturan default untuk ini adalah melalui menu File > Setup
Printout Transaksi, kemudian pilih modul Stock Adjustment. Pilih
ukuran kertas dan lakukan pengaturan lain yang dikehendaki melalui
modul tersebut. Apabila anda ingin mencetak printout sekaligus
menyimpan transaksi, anda bisa langsung klik tombol ini. Jadi tidak
perlu mengklik tombol Save dulu baru kemudian klik tombol Print,
karena program akan menyimpan transaksi sebelum mencetaknya.
Apabila ada perubahan maka akan ada konfirmasi apakah akan
disimpan atau ingin membatalkan perubahan, jadi apa yang tercetak

adalah sesuai dengan apa yang tersimpan.
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5.19 Assembling
(Untuk varian Accpro Trada dan Accpro Strada, modul ini tidak tersedia)

Kegunaan dari modul ini adalah apabila ingin mengkonversikan barang satu
ke barang lain, atau untuk perakitan atau pengolahan barang atau bahan
yang menghasilkan barang tertentu dari beberapa barang lain. Transaksi ini
tidak menghasilkan jurnal transaksi kecuali bila ada perbedaan antara akun
persediaan antara barang yang dihasilkan dan barang penyusunnya atau

apabila ada biaya tambahannya.

5.20 Stock Tranfer
(Untuk varian Accpro Trada dan Accpro Strada, modul ini tidak tersedia)

Modul ini hanya ada dan dapat diakses melalui menu Transaksi > Stock
Transfer apabila fitur Multi Gudang telah diaktifkan melalui modul Setup
Preferensi. Dimaksudkan untuk keperluan pemindahan barang dari gudang

satu ke gudang lain.

5.21 Credit Note / Debit Note

Pendebitan atas Piutang Usaha umumnya terjadi pada transaksi penjualan
sedangkan pengkreditan atas Piutang Usaha terjadi pada saat pelunasannya
melalui modul Penerimaan Kas / Bank. Demikian juga pengkreditan atas
Hutang Usaha umumnya terjadi melalui transaksi pembelian sedangkan
pendebitannya terjadi pada saat pembayarannya melalui modul Pengeluaran
Kas / Bank. Namun adakalanya diperlukan pendebitan atau pengkreditan
atas Piutang Usaha atau Hutang Usaha yang tidak berkaitan dengan
transaksi-transaksi yang disebutkan di atas. Fasilitas untuk ini adalah melalui
modul Credit Note / Debit Note.
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Modul ini dibuka dengan memilih menu Transaksi > Credit Note / Debit
Note. Selanjutnya pilih item menu dari Sub menu yang muncul sbb :

0 Credit Note atas Piutang Customer

0 Mendebit Piutang Customer

0  Debit Note atas Hutang Supplier

0 Mengkredit Hutang Supplier

Bt e st oo o =
No. 000001 141 s 3 )
Tanggal No.Ref CNR-000001
Customer RAJAWALL PERKASA -

Keterangan  Retur penjualan, Customer Ref. No. 005/RP/SR/1/15

Atas Invoice  INV-14.000303 -

Sebesar 616.000,00  Kurs 1,00

[@]ppy  10,00% Rp 56.000,00 DPP 100,00 % Rp 560.000,00

Nama Perkiraan

o
1. 010301001 | Piutang Dagang 616.000 [ |
2 030302000 PPN Keluzran 56.000
3. 050103000 Retur Penjualan 560.000
4,

5.
6
7
3
ES
10 o
Total : ﬁla.mm] [ 616.000
Selisih :

e  No. : Nomor transaksi otomatis digenerate oleh program, oleh karena itu
tidak bisa diedit.

e Tanggal : sesuaikan tanggal transaksi jika diperlukan, caranya ketikkan
langsung dengan format dd/mm/yy artinya ketikkan masing-masing 2
digit tanggal, bulan dan tahun atau klik tombol drop-down untuk
memunculkan kalender.

e No. Ref : isi nomor referensinya maksimal 20 karakter.

e  Customer (atau Supplier) tergantung pilihan anda pada sub menu di
atas, maka bisa jadi Customer atau Supplier) : pilih customer atau
suppliernya dengan mengklik pada field ini atau tombol drop-down
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disampingnya. Daftar customer atau supplier akan ditampilkan. Pilih <
New Supplier > atau < New Customer > apabila ingin menambah
supplier atau customer baru.

Keterangan : isi keterangan mengenai transaksi ini maksimal 70 karakter.
Atas Invoice : bila anda memilih sub menu Credit Note atas Piutang
Customer maka sebelumnya semestinya ada penerbitan Invoice atas
penjualan kepada customer bersangkutan. Demikian juga jika anda
memilih sub menu Debit Note atas Hutang Supplier, maka sebelumnya
semestinya ada Invoice atas pembelian dari supplier bersangkutan. Jadi
intinya adalah untuk kedua jenis transaksi ini harus dikaitkan kepada
Invoice tertentu.

Jatuh Tempo : Sebaliknya dari kedua jenis transaksi diatas, apabila anda
memilih sub menu Mendebit Piutang Cuatomer berarti timbul Piutang
Usaha baru, maka tanggal jatuh tempo harus ditentukan. Demikian juga
bila anda memilih sub menu Mengkredit Hutang Supplier berarti timbul
Hutang Usaha baru. Ketik tanggalnya dengan mengisikan 2 digit
tanggal, bulan dan tahun atau klik tombol drop-down untuk
memunculkan bantuan kalender. Kedua jenis transaksi mungkin akan
sangat jarang terjadi karena umumnya pendebitan Piutang Customer
adalah melalui transaksi penjualan (Sales Invoice), demikian juga
pengkreditan Hutang Supplier adalah melalui transaksi pembelian
(Purchase Invoice) tetapi Accpro tetap menyediakan fasilitas ini
manakala user memang memerlukannya.

Sebesar : isi nilai transaksinya yaitu besarnya pendebitan atau
pengkreditan atas Hutang Usaha atau Piutang Usaha. Untuk kedua jenis
transaksi yang pertama yang telah dikemukakan di atas, maka valuta
adalah sesuai valuta pada Invoicenya, sedangkan untuk kedua jenis
transaksi lainnya maka tentukan valutanya. (Untuk varian Accpro Trada
dan Accpro Strada, pilihan valuta asing tidak tersedia)

Kurs : kurs adalah sesuai kurs pada Invoicenya untuk kedua jenis
transaksi yang pertama (yang telah dikemukakan di atas), sedangkan
untuk kedua transaksi lainnya, tentukan kursnya jika valutanya bukan
Rp.

PPN : centang checkbox ini apabila ada PPNnya.
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e Jurnal Transaksi : baris pertama dari jurnal transaksi otomatis

ditentukan oleh program sesuai dengan apa yang telah input pada field-

field di atas, oleh karena itu tidak bisa diedit kecuali kolom Keterangan

(kalau ada). Demikian juga baris kedua apabila checkbox PPN dicentang.

Sedangkan untuk baris selanjutnya harus anda tambahkan secara

manual.

Tt
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No. Perk : ketik Nomor Perkiraannya atau klik tombol drop-down
pada kolom ini, maka daftar perkiraan akan ditampilkan dalam
urutan Nomor Perkiraannya. Pilih < New > jika ingin menambahkan
akun baru. Perlu ditegaskan bahwa hanya baris jurnal otomatis oleh
program, yaitu baris pertama yang boleh menggunakan akun
default untuk Hutang Usaha atau Piutang Usaha, sedangkan selain
itu tidak diperkenankan untuk menggunakan akun default Hutang
Usaha atau Piutang Usaha karena pengupdate-an terhadap Kartu
Hutang atau Kartu Piutang hanya dilakukan untuk baris jurnal
pertama.

Nama Perkiraan : kolom ini akan otomatis terisi setelah anda
memilih nomor perkiraannya. Namun demikian, sebagai alternatif,
anda bisa saja menggunakan kolom ini untuk menentukan
perkiraannya apabila lebih mudah buat anda untuk mengingat nama
perkiraannya ketimbang nomor perkiraannya. Cukup ketik initial
atau potongan awal nama perkiraan atau klik tombol drop-down
yang ada maka daftar perkiraan akan ditampilkan dalam urutan
Nama Perkiraannya. Pilih < Perkiraan Baru > apabila ingin
menambahkan akun baru. Setelah anda memilih Nama
Perkiraannya, maka isi kolom No. Perk akan menyesuaikan.

Debit : isi kolom Debit jika baris jurnal ini bernilai Debit, diisi
sebesar nominal dalam Rp.

Kredit : isi kolom Kredit jika baris jurnal ini bernilai Kredit, diisi
sebesar nominal dalam Rp.

Keterangan : kolom ini hanya ada apabila fitur yang berkaitan
dengan hal ini, yaitu “Bisa mengisi keterangan tambahan untuk
setiap baris (ayat) jurnal transaksi” diaktifkan melalui Setup

Preferensi. Isi keterangannya jika diperlukan.



Tombol New : menambah transaksi baru.

Tombol Search : mencari transaksi berdasarkan No. Voucher, Invoice,
No. Referensi, Nilai transaksi atau Kontaknya.

Tombol Save : menyimpan penambahan atau perubahan yang telah
dilakukan.

Tombol Cancel : membatalkan penambahan atau perubahan yang telah
dilakukan. Apabila sebelumnya anda bermaksud menambah transaksi
baru, maka dengan mengklik tombol Cancel, apabila sudah ada transaksi
lain maka akan ditampilkan transaksi yang terakhir (anda berada pada
modus Edit), tetapi kalau belum ada transaksi lain maka form akan
dikosongkan kembali dan anda tetap berada pada modus Add.
Sedangkan kalau anda sebelumnya bermaksud mengedit transaksi
tertentu, maka tampilan data akan dikembalikan seperti sebelum diedit
(anda tetap berada pada modus Edit).

Tombol Delete : menghapus transaksi tertentu.

Tombol Print : mencetak bukti transaksi berupa jurnal, demikian juga
ada pilihan dalam bentuk statement apabila diperlukan untuk
menerbitkan statement kepada pihak luar terutama Customer. Apabila
checkbox Preview disamping tombol ini dalam keadaan tercentang
(defaultnya tergantung pengaturan pada Set Printout Transaksi untuk
modul Credit Note / Debit Note), maka akan dipreview (ditampilkan ke
layar) lebih dulu untuk kemudian bisa dicetak ke printer.
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BAB 6
Menu Daftar

Menu Daftar bisa berupa master data atau transaksi yang disajikan dalam
bentuk daftar. Melalui menu ini, anda bisa mengakses master data atau
transaksi sebagai alternatif selain melalui modul yang bersangkutan secara

langsung.
6.1 Daftar Kontak, Saldo & Kartu Hutang / Piutang

Setiap kali anda membuka modul ini, maka akan ditampilkan daftar semua
kontak yang ada mencakup Customer, Supplier, Other Contact dalam urutan
Nama Pengenalnya. Apabila perlu menyeleksi data yang ditampilkan
menurut kategori kontaknya anda bisa menggunakan tombol Filter,
sedangkan untuk mengurutkan menurut kolom tertentu, maka klik pada
judul kolom tersebut. Sebenarnya form ini sudah dibahas pada 4.3.6

Customer.

e 0:kolom paling kiri dari daftar kontak akan menampilkan tombol drop-
down. Dengan mengklik tombol ini maka anda bisa mengedit data
bersangkutan.

¢ Nama Pengenal : menampilkan Nama Pengenal kontak bersangkutan.

¢ Nama Resmi : menampilkan Nama Resmi atau Nama Lengkap.

¢ Kota : menampilkan Kota.

e Telepon : menampilkan Telepon.

¢ Keterangan : menampilkan kategori Kontak.

e Tombol Saldo A/R : klik tombol ini untuk menampilkan kolom
Salesman, TOP (Terms of Payment), Credit Limit dan Saldo A/R. Data
kontak akan terseleksi dengan sendirinya, yaitu hanya data Customer
yang ditampilkan. Mengklik kembali tombol ini berarti mengembalikan

tampilan data menjadi Data Contact seperti semula.
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Close

o Nama Pengenal Nama Resmi Keterangan

o ABC FINANCE PT. ABC FINANCE Jakarta Barat s New

0 DELTA COMPUTER Toko DELTA COMPUTER Jakarta Utara

FT. ELANG SAKTL Pekanbaru | I p— ‘

o ERABARU SOLUSINDO PT. ERA BARU SOLUSINDO Palembang Customer

o GRAHA CELLULAR GRAHA CELLULAR Jakarta Pusat Supplier E

0 GRAHA PRIMA SEJAHTERA PT. GRAHA PRIMA SEJAHTERA Surabaya Supplier | & supplier ‘

o IMPERIAL TAXI PT. IMPERIAL RODA PERKASA Jakarta Selatan Customer -

o JAYA ABADL CV. JAYA ABADI Jakarta Barat Supplier | B2 Others ‘

0 KASNEGARA KAS NEGARA Jakarta Barat Others

o MITRAFINANCE PT. MITRA FINANCE Jakarta Selatan Others

0 PANCAMITRA PT. PANCA MITRA Jakarta Barat Supplier —

0 PRIMATRAVEL CV. RODA FRIMA SAKTT Jakarta Timur Customer ‘ ¥ Edt |

0 RAJAWALI PERKASA PT. RAJAVALL PERKASA Makassar Customer

o SEMESTAGPS PT. SEMESTA GPS Bandar Lampung Customer ‘ € Delet= |
‘ =] Preview |
‘ Kartu AR |
‘ Saldo AR |
‘ Saldo AP |

Unfitered Jml Data : 14
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Tombol Saldo A/P: klik tombol ini untuk menampilkan kolom Saldo
A/P. Data kontak akan terseleksi dengan sendirinya, yaitu hanya data
Supplier yang ditampilkan. Mengklik kembali tombol ini berarti
mengembalikan tampilan data menjadi Data Contact seperti semula.
Tombol Kartu A/R atau Kartu A/P : tombol ini berfungsi menampilkan
Kartu A/R (Kartu Piutang) apabila kursor berada pada baris dengan
kategori Customer, sedangkan pada baris berupa Supplier maka akan
berfungsi menampilkan Kartu A/P (Kartu Hutang). Setelah Kartu A/R
ditampilkan, maka data kontak akan terseleksi hanya berupa Customer,
anda tinggal memindahkan kursor pada baris berikut atau sebelumnya
atau baris tertentu untuk melihat Kartu A/R untuk baris bersangkutan.
Demikian juga halnya untuk Kartu A/P. Untuk menutup tampilan Kartu
A/R atau Kartu A/P, maka klik kembali tombol ini.

(New) Customer : menambah customer baru.

(New) Supplier : menambah supplier baru.

(New) Others : menambah data kontak lainnya.

Tombol Edit : merubah data kontak (customer, supplier atau kontak lain)

pada baris dimana kursor berada.



Tombol Delete : menghapus data kontak pada baris dimana kursor
berada.

Tombol Preview : menampilkan laporan Data Contact (sesuai yang saat
itu sedang ditampilkan) ke layar untuk selanjutnya bisa dicetak apabila
diinginkan.

Tombol Filter : menyaring atau menyeleksi data kontak yang
ditampilkan menurut batasan tertentu yaitu kategori (customer, supplier,
others atau kesemuanya), sembarang potongan nama pengenal, kota
tertentu. Khusus apabila difilter menurut customer, maka bisa difilter
lagi menurut grup customernya.

Tombol Search : mencari data kontak tertentu berdasarkan Nama
Pengenal, Nama Resmi, Kota atau Telepon dengan cukup memasukkan
sebagian teks berupa potongan awal atau sembarang potongan teks yang
dicari. Ini berguna apabila data kontak relatif cukup banyak, maka
ketimbang melakukan scrolling dengan mengklik pada scroll-bar, bisa
juga menggunakan cara ini sebagai alternatif.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka Data Contact ini sudah beberapa saat yang
lalu, sementara itu ada user lain yang mengupdate transaksi penjualan
yang mempengaruhi piutang customer tertentu, atau menambah
customer baru, maka dengan melakukan refresh, data akan ditampilkan
sesuai dengan kondisi terkini.

Tombol Close : menutup form ini. Form Data Contact adalah form yang
bersifat non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3
Istilah dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

Daftar Barang, Saldo dan Kartu Stock

Modul ini menampilkan daftar barang & jasa sesuai dengan yang anda input

melalui modul Barang & Jasa. Saldo Terakhir (terkini) barang berikut nilainya

juga bisa diketahui melalui modul ini, demikian juga kartu stock untuk

masing-masing barang. Pada saat dibuka pertama kali, maka akan
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ditampilkan daftar barang menurut urutan Kode Barangnya, anda bisa

mengurutkan menurut kolom tertentu dengan mengklik pada judul kolom

bersangkutan.

Uizl el

Nama Barang Kategori
GPS Navigasi GN-333 Inventory
0 GN-333 GPS Navigasi GN-333X Inventory GPS NAVIGAST

o GT-50V GPS Tracker GT-90V Inventory GPS TRACKER

o GT-80X GPS Tracker GT-30% Inventory GPS TRACKER Unit
o 15-01F Free langganan web tracking Jasa 1ASA unit
o 150 Free Jasa Pemasangan Jasa JASA Unit
o KP-01 Kartu Perdana Inventory OTHERS Pcs
o VCH-250 Pulsa 250 ribu Inventory OTHERS Unit.

o VN-50E GPS Navigasi VN-50E Inventory GPS NAVIGASI Unit

Unfitered Jml Data : 9

e o0 : kolom paling kiri dari daftar ini akan menampilkan tombol drop-
down. Dengan mengklik tombol ini maka anda bisa mengedit data
bersangkutan.

¢ Kode Barang : menampilkan Kode Barang.

¢ Nama Barang : menampilkan Nama Barang.

o Kategori : menampilkan Kategori barang apakah Inventory, Non
Inventory atau Jasa.

e  Grup : menampilkan kelompok barang bersangkutan.

e  Satuan : menampilkan Satuan Inventory barang bersangkutan.

e Saldo : menampilkan saldo terkini barang bersangkutan dalam Satuan

Inventorynya.
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o CEO0L.11 Cover Buffalo ‘aC' Kuning Muda 21,533 Inwventar Katton Buffalo
Urfilkered Iml Data : 52

o MK001.06 IMika Film Queen 21,5x33-0,10 Oranye Inwentory Mika Film Pak. 10

o KPOO1.11 Kertas Photo Mitsui A% Inwentory Kertas Inkjet/Phota Pak. 20
o MKOo1.04 Mika Film Queen 21,5x33-0, 10 Hijau Inventary Mika Film Pak 45
o MKOO01.05 IMika Filn Queen 21,5x33-0,10 Kuning Inventary Mika Film Pak 45

MK001.07 - Mika Film Queen 21,5x33-0,70 Bening  Perinde : 1 Januati 2008 sfd 31 Januari 2008
Tanggal o, Bukti SUK, 1a
. 01/01j2008 S0
. 08/01j2008 DO 000002 Delivery Order Ma. 00002/1/08 5 45
. 11/01j2008 51 000004 Inwoice Mo, 08,00000004 H 43
. 31/01j2008 ADJ 000001 Adjustment Mo, 001/4DJ/1j08 1 42

PV N PN N WP W P VS ieepe S P Y Sy

Tombol Kartu Stock : klik tombol ini untuk menampilkan kartu stock
untuk barang dimana kursor saat itu berada. Apabila Multi Gudang,
maka anda harus menentukan gudang tertentu lebih dulu. Setelah kartu
stock ditampilkan anda tinggal menggerakkan kursor pada tabel daftar
barang untuk melihat kartu stock untuk barang lainnya. Pada saat
ditampilkan pertama kalinya saat anda mengklik tombol Kartu Stock,
periode yang ditampilkan adalah sesuai periode berjalan. Bila perlu
merubah periode atau rentang waktu kartu stock maka klik tombol
Periode panel Kartu Stock, kemudian tentukan rentang waktunya. Untuk
menutup tabel Kartu Stock klik kembali tombol Kartu Stock.

Tombol Saldo Awal : jika ingin memasukkan Saldo Awal untuk barang
tertentu, klik tombol Saldo Awal setelah kursor ditempatkan pada baris
dimana barang dimaksud berada. Jika Multi Gudang, anda harus
menentukan gudang tertentu lebih dulu. Penjelasan lengkap
menyangkut saldo awal lihat penjelasan mengenai Saldo Awal Inventory.
Untuk menutup tabel atau form Saldo Awal klik kembali tombol Saldo
Awal.

Tombol Nilai : klik tombol ini untuk menampilkan kolom Nilai. Selain
kolom Nilai akan ditampilkan juga kolom Stock Min. dan Qty Sales Last
3 Months. Setelah anda mengklik tombol Nilai sehingga kolom Nilai
ditampilkan maka akan tampil pula tombol Highlight. Mengklik tombol
Nilai akan menyembunyikan kolom Nilai dan mengembalikan tampilan
kolom seperti semula.

Tombol Highlight : jika tombol ini diklik akan muncul popup menu
dimana anda bisa memilih apakah akan menghighlight barang-barang
dengan kondisi Saldo < Stock Minimum atau Saldo < Qty Sales Last 3
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6-6

Months atau Clear Highlight untuk membersihkan highlight yang telah
anda lakukan sebelumnya. Baris yang memenuhi kondisi yang telah
dipilih akan ditampilkan dengan warna mencolok dibandingkan baris
lainnya.

Tombol New : menambah barang baru. Dengan mengklik tombol ini
form Barang & Jasa akan ditampilkan dalam modus Add, anda tinggal
menambahkan barang baru tanpa harus mengklik tombol New lagi pada
form tersebut

Tombol Edit : merubah data barang pada baris dimana kursor berada,
form Barang & Jasa akan ditampilkan pada record yang bersesuaian,
anda tinggal mengeditnya jika dikehendaki.

Tombol Delete : menghapus data barang pada baris dimana kursor
berada.

Tombol Preview : tombol Preview sebelah atas untuk menampilkan
laporan Daftar Barang (sesuai kondisi yang saat itu sedang ditampilkan :
kolom apa saja yang saat itu tampil, kondisi penyeleksian dsbnya) ke
layar untuk selanjutnya bisa dicetak apabila diinginkan, sedangkan
tombol Preview sebelah bawah untuk menampilkan laporan Kartu Stock
atau Saldo Awal atau Lokasi Stock untuk barang tertentu tergantung apa
yang saat itu sedang ditampilkan

Tombol Filter : menyaring atau menyeleksi data barang yang
ditampilkan menurut batasan tertentu yaitu kategori, sembarang
potongan nama barang, grup tertentu, satuan tertentu, batasan saldo.
Tombol Search : mencari data barang tertentu berdasarkan Kode Barang,
Nama Barang, atau Grupnya dengan cukup memasukkan sebagian teks
berupa potongan awal atau sembarang potongan teks yang dicari. Ini
berguna apabila data barang relatif cukup banyak, maka ketimbang
melakukan scrolling dengan mengklik pada scroll-bar, bisa juga
menggunakan cara ini sebagai alternatif.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada wuser lain yang mengupdate transaksi yang

mempengaruhi saldo barang tertentu, atau menambah barang baru,



maka dengan melakukan refresh, data akan ditampilkan sesuai dengan
kondisi terkini.

e Tombol Close : menutup form ini. Form Daftar Barang adalah form yang
bersifat non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3
Istilah dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.3 Dafar Kelompok Barang & Saldo

Modul ini menampilkan daftar kelompok atau grup barang berikut Saldonya.
Nilai dan juga grafik dapat ditampilkan apabila diinginkan. Apabila perlu
mengurutkan data menurut kolom tertentu, klik pada judul kolom
bersangkutan. Pada saat suatu kolom sedang ditampilkan dalam urutan
menaik  (ascending), mengklik judul kolom bersangkutan akan

mengurutkannya secara menurun (desending).

Data Kelompok Barang

o Nama Grup Deskripsi Saldo (Unit) Hilai (Rp)
GPS NAVIGAST 151 102312500  Tampilkan

o OTHERS ]

=

| Preview

372.112.500
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o : kolom paling kiri dari daftar ini akan menampilkan tombol drop-

down. Dengan mengklik tombol ini maka form Kelompok (Grup) Barang

akan ditampilkan sehingga anda bisa mengedit data bersangkutan.

Nama Grup : menampilkan nama kelompok (grup) barang.

Deskripsi : menampilkan deskripsi kelompok (grup) barang.

Saldo (Unit) : menampilkan saldo kelompok barang yang menunjukkan

jumlah unit sebagai penjumlahan dari saldo anggotanya dalam Satuan

Inventorynya masing-masing.

Nilai (Rp) : menampilkan penjumlahan nilai dalam nominal Rupiah atas

nilai masing-masing barang dalam kelompok barang bersangkutan.

Tampilkan :

0 Non Inventory : centang checkbox ini jika kelompok barang dengan
kategori Non Inventory juga ingin ditampilkan.

0 Jasa : centang checkbox ini jika kelompok barang dengan kategori
Jasa juga ingin ditampilkan.

Tombol Chart : hanya jika yang ditampilkan adalah kelompok barang

Inventory, tombol ini dapat diklik. Gunanya untuk menampilkan grafik

perbandingan saldo atau nilai untuk masing-masing kelompok barang

Inventory. Mengklik kembali tombol ini akan menutup form tampilan

grafik.

JmlData : 3 751 372.112.500
' d

b
(@) Bar ) Pie Q []3D view In Volume/Qty & Max  f

Y A AV AT e NV VTV Y 0 s Y O T S an sV Vo L S VT e Y Y W 4
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#  In : klik tombol drop-down pada field ini jika ingin merubah
tampilan grafik dari Volume/Qty ke Value atau sebaliknya.

7 Max / Min : klik tombol ini untuk memaksimalkan ukuran form
tampilan grafik, klik kembali apabila ingin meminimalkan.

#  Bar : pilih opsi ini jika ingin menampilkan grafik dalam bentuk bar
(batang).

#  Pie : pilih opsi ini jika ingin menampilkan grafik dalam bentuk
grafik lingkaran.

% 3D View : centang checkbox ini jika grafik ingin ditampilkan dalam
bentuk 3 dimensi.



Tombol Nilai : pada saat pertama kali ditampilkan kolom Nilai tidak
ditampilkan, klik tombol ini apabila ingin menampilkan kolom Nilai.
Mengklik tombol Nilai akan menyembunyikan kolom Nilai.

Tombol New : menambah data baru. Dengan mengklik tombol ini form
Kelompok (Grup) Barang akan ditampilkan.

Tombol Edit : sama halnya dengan tombol New, dengan mengklik
tombol ini form Kelompok (Grup) Barang akan ditampilkan.

Tombol Delete : menghapus data kelompok barang pada baris dimana
kursor berada.

Tombol Preview : menampilkan laporan Daftar Kelompok Barang ke
layar untuk selanjutnya bisa dicetak apabila diinginkan.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi yang
mempengaruhi saldo kelompok barang tertentu, atau menambah
kelompok barang baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

Tombol Close : menutup form ini. Form Daftar Kelompok Barang adalah
form yang bersifat non transaksional (lihat penjelasan mengenai hal ini
pada Bab 2.3 Istilah dan Konvensi), artinya anda bisa saja membuka

modul lain tanpa menutup form ini lebih dulu.

Daftar Jurnal Transaksi

Jurnal transaksi baik yang dibuatkan secara otomatis oleh program maupun

berupa jurnal transaksi manual melalui modul Jurnal Transaksi akan

ditampilkan pada modul ini. Setiap kali modul ini dibuka maka akan

menampilkan daftar jurnal transaksi untuk periode bulan berjalan menurut

urutan tanggal transaksi. Apabila ingin menampilkan jurnal transaksi untuk

periode tertentu bisa mengklik tombol Periode atau mengklik tombol Filter,

sedangkan apabila ingin mengurutkan menurut kolom tertentu maka klik

pada judul kolom tersebut.
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1 2]

Filter Refresh
Keterangan

~|06/01/2015 000001 GRAHA PRIMA SEJAF Inv : 003/GPS/INV/I/15, Fak : 010.000-15.0000 01-04-01-000 97.500.000
o 06/01/2015 000001  DO3/GPS/INV/I/LS  GRAHA PRIMA SEJAF Inv : 0D3/GPS/INV/I/1S, Fak : 010.000-15.0000 03-03-01-000 9.750.000
o 06/01/2015 PI 000001 O0O3/GPS/INV/I/LS  GRAHA PRIMA SEIAF Inv : 003/GPS/INV/I/1S, Fak : 010.000-15.0000 03-01-01-000 107,250,000
o 07/01/2015 PI 000002 0003123 GRAHA CELLULAR  Tnv: 01-04-01-000 12,250,000
o 07/01/2015 FI 000002 0003123 GRAHA CELLULAR  Inv: 03-01-01-000 12,250,000
© 07/01/2015 PV 000001 PV O000DOL GRAHA CELLULAR  Bayar pembelizn kartu perdana & pulsa Inv, Na. 01-02-01-000 12,250,000
o 07/01/2015 PV 000001 PV OO0DOL GRAHA CELLULAR  Bayar pembelian kartu perdana & pulsa Inv. Na. 03-01-01-000 12,250,000
o 08/01/2015 DO 000001 DO-15.000001 IMPERTAL TAXI DO No : DO-15.000001 06-01-00-000 32.250.000 =
o 08/01/2015 DO 000001 DO-15.000001 IMPERIAL TAXI DO No : DO-15,000001 01-04-01-000 32,250,000
o 08/01/2015 SI 000001  INV-15.000001 IMPERIAL TAXI Inv : INV-15,000001, Fak : 010.000-15,000002 01-03-01-001 121,000,000
o 08/01/2015 SI 000001 INV-15.000001 IMPERIAL TAXI Inv : INV-15,000001, Fak ; 010,000-15.000002 05-01-01-000 110,000,000
© 08/01/2015 SI 000001  INV-15.000001 IMPERIAL TAXI Iny : TNY-15,000001, Fk : 010,000-15,000002 03-03-02-000 11.000.000
© 09/01/2015 BO 000001 BO000DOL <N/A> Mengisi Kas Kedl 01-02-01-000 2,000,000
o 09/01/2015 BO 000001 BO 0000OL AN Mengisi Kas Kedl 01-01-01-000 2.000.000
o 09/01/2015 RV 000001 RV 000001 RAJAWALI PERKASA Pelunasan INV-14.000300, INV-14.000303 {par’ 01-03-02-001 49,700.000 L
o 09/01/2015 RV 000001 RV 000001 RAJAWALI PERKASA Pelunasan INV-14.000300, INV-14.000303 {par’ 01-03-01-001 49,700,000
o 12/01/2015 DO 000002  DO-15.000002 SEMESTA GFS DO No : DO-15.000002 06-01-00-000 17.500.000
© 12/01/2015 DO 000002  DO-15.000002 SEMESTA GPS DO N : DO-15,000002 01-04-01-000 17.500.000
o 12/01/2015 SI 000002  INV-15.000002 SEMESTA GPS Inv : INV-15,000002, Fak : 010.000-15.000002 01-03-01-001 27.063.437
o 12/01/2015 SI 000002  INV-15.000002 SEMESTA GPS Tnv : INV-15.000002, Fak : 010.000-15.000002 05-01-01-000 24.603.125
o 12/01/2015 SI 000002  INV-15.000002 SEMESTA GPS Inv : INV-15,000002, Fak : 010,000-15.000002 03-03-02-000 2,460,312
o 12/01/2015 Pl 000003  15.000012 PANCA MITRA Inv : 15.000012, Fak : 010.000-15.00000151  01-04-01-000 39,062,500
o 12/01/2015 Pl 000003  15.000012 PANCA MITRA Inv : 15.000012, Fak : 010.000-15.00000151  03-03-01-000 3,906,250
o 12/01/2015 PI 000003  15.000012 PANCA MITRA Inv : 15.000012, Fak : 010,000-15.00000151  03-01-01-000 42,968,750
o 12/01/2015 PV 000002 PV 000002 GRAHA PRIMA SEJA- Bayar Inv. 015/GPS/TNV/12/14 (partial) 03-05-01-000 120,000,000
o 12/01/2015 PV 000002 PV 000002 GRAHA PRIMA SEJA+ Bayar Inv. 015/GPS/INV/12/14 (partial) 03-01-01-000 120.000.000
o 13/01/2015 BO 000002 BO 000002 <N/A> Beli ATK dari Tk, JAYA Stationery 01-01-01-000 550,000
o 13012015 BO 000002 BO 000002 <NjA> Beli ATK dari Tk, JAYA Stationery 07-01-16-000 650000
o 14/01/2015 PI 000004 000300 DELTA COMPUTER  Inv : 000300 02-01-01-000 3,650,000
© 14/01/2015 PI 000004 000300 DELTA COMPUTER  Inv : 000300 01-02-01-000 3,650,000
o 14/01/2015 PI 000005  15.01.0005 JAYA ABADI Iny : 15.01,0005 02-01-01-000 25,000,000
o 14/01/2015 PI 000005  15.01.0005 JAYA ABADI Tnv : 15.01.0005 03-01-01-000 25.000.000
o 14/01/2015 RV 000002 RV 000002 ERA BARU SOLUSINE Pelunasan INV-14,000302, 000304 01-03-02-001 88.560.000
o 14/01/2015 RV 000002 RV 000002 ERA BARU SOLUSINE Pelunasan INV-14,000302, 000304 01-03-01-001 88.663.437
o 14/01/2015 RV 000002 RV 000002 ERA BARU SOLUSINE Pelunasan INV-14,000302, 000304 09-20-00-000 3.437
o 15012015 GM 000001  GMO0OOOL ERA BARU SOLUSIN Pelunasan INV-14,000302, 000304 01-02-02-000 88,660,000
o 1501/2015 GM 000001  GMO0DOOL ERA BARU SOLUSING Pelunasan INV-14,000302, 000304 01-03-02-001 3,660,000

M.00000 QLUSINE Pembatalan Giro ¥ ol

Unfiltered &2

e Tombol New : menambah jurnal transaksi baru pada periode sesuai
periode dimana kursor berada. Apabila data masih kosong maka periode
penambahan data adalah sesuai periode yang dipilih untuk ditampilkan
saat itu, sedangkan bila rentang tanggal transaksi yang dipilih mencakup
beberapa periode maka periode penambahan data adalah sesuai periode
bulan berjalan.

e Tombol Detail : untuk membuka modul Jurnal Transaksi dan
menampilkan transaksi sesuai baris dimana kursor berada. Sebagai
alternatif, bisa dengan melakukan double klik pada baris tersebut atau
klik tombol drop-down pada kolom paling kiri (o).

¢ Tombol Preview : menampilkan laporan Jurnal Transaksi (sesuai yang
saat itu sedang ditampilkan) ke layar untuk selanjutnya bisa dicetak
apabila diinginkan.

e Tombol Periode : memilih periode jurnal transaksi yang ingin
ditampilkan.

e Tombol Filter : menyaring atau menyeleksi data yang ditampilkan
menurut batasan tertentu yaitu rentang tanggal transaksi, kode jurnal,

kontak atau perkiraan tertentu.
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e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka Daftar Jurnal Transaksi ini sudah
beberapa saat yang lalu, sementara itu ada user lain yang mengupdate
transaksi tertentu, atau menambah transaksi baru, maka dengan
melakukan refresh, data akan ditampilkan sesuai dengan kondisi terkini.

e Tombol Close : menutup form ini. Form Daftar Jurnal Transaksi adalah
form yang bersifat non transaksional (lihat penjelasan mengenai hal ini
pada Bab 2.3 Istilah dan Konvensi), artinya anda bisa saja membuka

modul lain tanpa menutup form ini lebih dulu.

6.5 Daftar Proyek

(Untuk varian Accpro Trada dan Accpro Strada karena modul Proyek tidak tersedia,
maka menu Daftar Proyek juga tidak tersedia. Fasilitas Proyek tersedia pada varian
Accpro Spectra, dikemukakan di sini untuk memberikan sekedar gambaran mengenai

fasilitas ini)

Menu ini hanya ada jika telah diakomodasi adanya Proyek melalui Setup
Preferensi. Modul atau form ini menampilkan daftar proyek, untuk masing-
masing proyek bisa diketahui revenue, cost, expense dan laba (rugi)nya.
Setiap kali form ini dibuka, maka akan ditampilkan daftar Proyek dalam
urutan Kode Proyek. Apabila perlu mengurutkan data menurut kolom
tertentu, maka klik judul kolom bersangkutan. Sedangkan apabila ingin
menyeleksi data yang ditampilkan maka klik tombol Filter.
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6.6 Daftar Fixed Asset

(Untuk varian Accpro Trada dan Accpro Strada karena modul Fixed Asset tidak
tersedia, maka menu ini juga tidak tersedia. Modul Fixed tersedia pada varian Accpro
Spectra)

6.6.1 Daftar Fixed Asset & History Transaksi

Form ini menampilkan daftar Fixed Asset yang telah anda input melalui
menu Master Data > Fixed Asset (Aktiva Tetap) > Master Fixed Asset, dimana
untuk masing-masing Fixed bisa dilihat History Transaksinya. Melalui form
ini anda juga dapat menambah data Fixed Asset, mengedit data Fixed Asset
yang ada serta melakukan transaksi terhadap Fixed Asset tertentu yaitu

meliputi Pengeluaran, Penjualan, Write Off, Revaluasi dan transaksi lainnya.
6.6.2 Depresiasi Fixed Asset

Pada saat anda melakukan Proses Awal Bulan, maka program akan
menawarkan untuk juga melakukan proses depresiasi Fixed Asset dan
membuatkan jurnalnya untuk periode sebelumnya. Tetapi kalau anda tidak
melakukannya pada saat Proses Awal Bulan, anda juga bisa melakukan
proses depresiasi Fixed Asset melalui modul ini. Demikian juga kalau anda
ingin menghapus jurnal depresiasi Fixed Asset tertentu, melalui modul inilah

anda dapat melakukannya.

6.7 Data PO & Histori Penerimaan Barang

Modul atau form ini akan menampilkan daftar Purchase Order (PO) dimana
untuk masing-masing PO dapat ditampilkan juga histori penerimaan
barangnya. Setiap kali form ini dibuka, maka akan ditampilkan daftar PO
untuk periode bulan berjalan dalam urutan tanggal PO. Apabila ingin
memilih periode lain maka klik tombol Periode, sedangkan apabila ingin
menyeleksi data yang ditampilkan maka klik tombol Filter. Mengurutkan
data menurut kolom tertentu dilakukan dengan mengklik pada judul kolom

tersebut.
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Daka Plrchase Order. (01 Jan 2015 s/d 31 Jan 2015) i Al 2]

Periode Filter Refresh

o Tanggal Suppler Required Status c Sub Total Discount

0 05/01/2015 |PO-15.01.0001 |GRAHA PRIMA SEJAHTERA 06/01/2015 |06/01/2015 |Complete Rp
o 14/01/2015 PO-15.01.0002 JAYA ABADI 14/01/2015 14/01/2015 Complete Rp 25.000.000 0 0 0

0 0.000.000 00.000 0 0.000
< m 3

| Detail Penerimaan g New &) Edit =] Preview

Tombol Detail Penerimaan : klik tombol ini untuk menampilkan detail
(histori) penerimaan barang atas PO pada baris dimana kursor berada.
Selanjutnya anda tinggal memposisikan kursor pada baris sebelum atau
berikutnya atau baris tertentu untuk menampilkan detail penerimaan
barang untuk PO pada baris tersebut. Sebagai alternatif dari tombol ini,
anda bisa mengklik tombol drop-down pada kolom paling kiri (kolom o).
Tombol New : untuk menambah PO baru. Form Purchase Order akan
ditampilkan dalam modus Add sehingga anda tinggal melakukan input
data PO baru tanpa perlu lagi mengklik tombol New pada frorm
bersangkutan.

Tombol Edit : untuk mengedit PO pada baris dimana kursor berada,
termasuk jika ingin menghapusnya. Sebagai alternatif dari tombol Edit
anda bisa melakukan double klik pada baris yang akan diedit. Form
Purchase Order akan ditampilkan dalam modus Edit pada record yang
bersesuaian sehingga anda tinggal mengeditnya.

Tombol Preview : menampilkan laporan PO ke layar untuk selanjutnya
bisa dicetak ke printer.

Tombol Periode : untuk memilih periode PO yang ingin ditampilkan.
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e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal PO, supplier, valuta dan status PO.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate PO tertentu, atau
menambah PO baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

e Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.8 Data Pembelian & Detail Pembayaran

Modul atau form ini akan menampilkan daftar transaksi pembelian dimana
untuk masing-masing transaksi dapat ditampilkan juga histori
pembayarannya. Setiap kali form ini dibuka, maka akan ditampilkan daftar
transaksi pembelian untuk periode bulan berjalan dalam urutan tanggal
Invoicenya. Apabila ingin memilih periode lain maka klik tombol Periode,
sedangkan apabila ingin menyeleksi data yang ditampilkan maka klik tombol
Filter. Mengurutkan data menurut kolom tertentu dilakukan dengan

mengklik pada judul kolom tersebut.

e Tombol Detail Pelunasan : klik tombol ini untuk menampilkan detail
(histori) pembayaran atas transaksi pembelian pada baris dimana kursor
berada. Posisikan kursor pada baris sebelum atau berikutnya atau baris
tertentu untuk menampilkan detail pelunasan untuk baris tersebut.

e Tombol New : untuk menambah transaksi baru.

e Tombol Edit : untuk mengedit transaksi pada baris dimana kursor

berada, termasuk jika ingin menghapusnya.
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Data Pembelian (013an 2015 s/d 31 Jan 2015) i Al 2] "

Periode Filter Refresh Biaya Close
o Tanggal Mo. Invoice Supplier GrossPurch | Discount Net Purch Jumlah Tagihan | Sisa Tagihan

B 06/01/2015 003/GPS/INV/1/15|GRAHA PRIMA SEJAHTERA 000, .500. 97.500.000 107.250.000 106.590.000
o 07/01/2015 000002 0003123 GRAHA CELLULAR 12.250.000 0 12.250.000 0 12.250.000 0
o 12/01/2015 000003  15.000012 PANCA MITRA 62,500,000 23.437.500 39.062.500  3.906.250 42,968,750 0
o 14/01/2015 000004 000300 DELTA COMPUTER 3.650,000 0 3,650,000 0 3.650,000 0
o 14/01/2015 000005  15.01.0005 JAYA ABADL 25.000,000 ] 25.000.000 ] 25.000,000 25,000,000

Unfiltered eriode : Januari 2015 298.400.000( 120.937.500]  177.462.500| 13.656.250|  191.118.750] 131,590,000

|23 Detsil Pelunasan

e Tombol Preview : menampilkan laporan pembelian ke layar untuk
selanjutnya bisa dicetak ke printer.

e Tombol Periode : untuk memilih periode transaksi yang ingin
ditampilkan.

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, kontak dan valuta transaksi.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

e Tombol Biaya : apabila pada transaksi pembelian kemungkinan ada
biaya lain seperti freight atau ada pajak lain diluar PPN, maka dengan
mengklik tombol ini akan ditampilkan kolom Biaya dimana pada kolom
ini ditampilkan jumlah biaya dan pajak lain sedangkan kolom Sisa
Tagihan tidak ditampilkan. Mengklik tombol ini kembali akan
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menampilkan kembali kolom Sisa Tagihan, sedangkan kolom Biaya tidak
ditampilkan.

e Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

Catatan :

Apabila transaksi sudah termasuk PPN (include PPN), maka nilai yang
ditampilkan pada kolom Gross Purch, Discount dan Net Purch adalah
dalam nominal tanpa PPN.

6.9 Data PPN Masukan — Ekspor ke CSV

Modul atau form ini akan menampilkan daftar PPN Masukan pada rentang
waktu tertentu. Setiap kali form ini dibuka, maka akan ditampilkan daftar
PPN Masukan yang tanggal transaksinya dalam rentang periode bulan
berjalan dalam urutan tanggal Faktur Pajaknya. Apabila ingin memilih
periode lain maka klik tombol Periode, sedangkan apabila ingin menyeleksi
data yang ditampilkan maka klik tombol Filter. Mengurutkan data menurut

kolom tertentu dilakukan dengan mengklik pada judul kolom tersebut.

Modul ini adalah fasilitas baru yang disediakan terutama untuk melakukan
ekspor PPN Masukan ke file CSV untuk selanjutnya tinggal dilakukan proses
Impor menggunakan fasilitas yang ada pada program eFaktur dari Direktorat
Jenderal Pajak. Dengan adanya fasilitas ini pengguna Accpro tidak perlu lagi
melakukan input manual data PPN Masukan menggunakan program
eFaktur. Perlu diketahui hanya PPN Masukan yang transaksinya
menggunakan modul Purchase Invoice yang akan ditampilkan di sini. PPN
Masukan yang diinput melalui modul lain misalnya Pengeluaran Kas/Bank
atau Jurnal Transaksi tidak akan ditampilkan di sini. Jadi jika anda tidak
menggunakan modul Purchase Invoice untuk input transaksi yang ada PPN
Masukannya, maka apabila anda perlu input PPN Masukan ke program
eFaktur, maka untuk transaksi yang demikian ini harus dilakukan secara

manual.
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Data PPN Masukan (013an 2015 5/d 31 Jan 2015) o 2] =]
Filter Refresh  Periode

Discount | Uang Muka

E - 3 upplier Sub Total g sdh
06/01/2015 010.000-15.00000100 003/GPS/INV/I/15 GRAHA PRIMA SEJAHTERA 195.000.000 57.500.000 0 97.500.000  9.750.000 L]

N (L T TS e [ 2 500 000|23.437.500] 0| 59 662 500] 3 306 2]

o Ekspor | Tl FP No. FP No. Invoice Suppl

|unfiltered Periode : Januari 2015 | 257.500.000| 20.937.500| | 136.562.500]  13.656.250|

Lihat File CSV

¢ Kolom Ekspor : kolom ini digunakan oleh user untuk menyeleksi data
PPN Masukan yang akan diekspor dengan mencentangnya. Jadi user
bisa memilih sekaligus beberapa data untuk diekspor ke CSV. Apabila
tidak ada data yang dicentang, maka data pada posisi kursor yang akan
diekspor ke CSV oleh program. Apabila anda melakukan lebih dari satu
kali proses ekspor PPN Masukan ke file CSV yang berbeda dalam satu
sesi (tanpa menutup form ini lebih dulu), jangan lupa untuk melakukan
uncheck kembali untuk data yang tidak ingin anda ekspor. Hanya kolom
ini yang bisa anda akses dengan mencentangnya, kolom lain hanya
menampilkan informasi terkait PPN Masukan bersangkutan.

¢ Kolom Sdh Ekspor : kolom ini hanya menandakan data manakah yang
sudah pernah diekspor. Pelu diketahui, program tidak bisa mengetahui
apakah data yang anda ekspor sudah berhasil diimpor oleh program
eFaktur, karena tidak ada interaksi antara Accpro dan program eFaktur.
Tetapi data yang sudah pernah diekspor tetap bisa diekspor ulang.

e Tombol Select All : apabila anda ingin menyeleksi semua data yang
ditampilkan untuk diekspor ke CSV, anda bisa mengklik tombol ini.

Maka tombol ini kemudian akan berfungsi sebagai tombol Deselect All
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yang berfungsi sebaliknya yaitu untuk mengosongkan kembali kolom
Ekspor.

Tombol Ekspor ke CSV : setelah anda menyeleksi data PPN Masukan
yang akan anda ekspor baik dengan mencentangnya satu per satu atau
menggunakan tombol Select All atau hanya memposisikan kursor pada
baris tertentu yang akan diekspor, maka anda bisa mengklik tombol ini
untuk melakukan proses ekspor ke file CSV. Ingat ! Kalau ada data yang
dicentang, maka data itulah yang akan diekspor, bukan data pada posisi
kursor.

Tombol Lihat File CSV : file CSV PPN Masukan yang anda buat melalui
program Accpro dapat anda lihat isinya dengan menggunakan tombol
ini. Anda akan diminta untuk menentukan nama file CSV yang akan
anda buka.

Tombol Detail Barang : klik tombol ini untuk menampilkan detail
barang atas PPN Masukan pada baris dimana kursor berada. Posisikan
kursor pada baris sebelum atau berikutnya atau baris tertentu untuk
menampilkan detail barang untuk baris tersebut.

Tombol New : untuk menambah transaksi Purchase Invoice yang baru.
Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

Tombol Preview : menampilkan laporan data PPN Masukan ke layar
untuk selanjutnya bisa dicetak ke printer.

Tombol Periode : untuk memilih periode data PPN Masukan yang ingin
ditampilkan.

Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, kontak dan valuta transaksi.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

Tombol Close : menutup form ini. Form ini adalah form yang bersifat

non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
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dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.10 Data Retur PPN Masukan — Ekspor ke CSV

Modul atau form ini akan menampilkan daftar Retur PPN Masukan pada
rentang waktu tertentu. Setiap kali form ini dibuka, maka akan ditampilkan
daftar Retur PPN Masukan yang tanggal transaksinya dalam rentang periode
bulan berjalan dalam urutan tanggal Faktur Pajaknya. Apabila ingin memilih
periode lain maka klik tombol Periode, sedangkan apabila ingin menyeleksi
data yang ditampilkan maka klik tombol Filter. Mengurutkan data menurut

kolom tertentu dilakukan dengan mengklik pada judul kolom tersebut.

Modul ini adalah fasilitas baru yang disediakan terutama untuk melakukan
ekspor Retur PPN Masukan ke file CSV untuk selanjutnya tinggal dilakukan
proses Impor menggunakan fasilitas yang ada pada program eFaktur dari
Direktorat Jenderal Pajak. Dengan adanya fasilitas ini pengguna Accpro tidak
perlu lagi melakukan input manual data Retur PPN Masukan menggunakan
program eFaktur. Perlu diketahui hanya Retur PPN Masukan yang
transaksinya menggunakan modul Purchase Return yang akan ditampilkan
di sini. Retur PPN Masukan yang diinput melalui modul lain misalnya
Penerimaan Kas/Bank atau Jurnal Transaksi atau Debit Note tidak akan
ditampilkan di sini. Jadi jika anda tidak menggunakan modul Purchase
Return untuk input transaksi yang ada Retur PPN Masukannya, maka apabila
anda perlu input Retur PPN Masukan ke program eFaktur, maka untuk

transaksi yang demikian ini harus dilakukan secara manual.
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Retur PPN Masukan (01 3an 2015 5/d 31 Jan 2015} 3 R
Fiter  Refresh

No. Retur [ No, Irvoice S

0. FP upplier
31/01/2015 |PR-15.000001 |06/01/2015(010.000-15.00000100 |003/GPS/INV/L/15|GRAHA PRIMA SEIAHTERA

|Unfiitered Periode : Januari 2015

¢ Kolom Ekspor : kolom ini digunakan oleh user untuk menyeleksi data
Retur PPN Masukan yang akan diekspor dengan mencentangnya. Jadi
user bisa memilih sekaligus beberapa data untuk diekspor ke CSV.
Apabila tidak ada data yang dicentang, maka data pada posisi kursor
yang akan diekspor ke CSV oleh program. Apabila anda melakukan lebih
dari satu kali proses ekspor Retur PPN Masukan ke file CSV yang
berbeda dalam satu sesi (tanpa menutup form ini lebih dulu), jangan
lupa untuk melakukan uncheck kembali untuk data yang tidak ingin
anda ekspor. Hanya kolom ini yang bisa anda akses dengan
mencentangnya, kolom lain hanya menampilkan informasi terkait Retur
PPN Masukan bersangkutan.

¢ Kolom Sdh Ekspor : kolom ini hanya menandakan data manakah yang
sudah pernah diekspor. Pelu diketahui, program tidak bisa mengetahui
apakah data yang anda ekspor sudah berhasil diimpor oleh program
eFaktur, karena tidak ada interaksi antara Accpro dan program eFaktur.
Tetapi data yang sudah pernah diekspor tetap bisa diekspor ulang.

e Tombol Select All : apabila anda ingin menyeleksi semua data yang
ditampilkan untuk diekspor ke CSV, anda bisa mengklik tombol ini.
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Maka tombol ini kemudian akan berfungsi sebagai tombol Deselect All
yang berfungsi sebaliknya yaitu untuk mengosongkan kembali kolom
Ekspor.

Tombol Ekspor ke CSV : setelah anda menyeleksi data Retur PPN
Masukan yang akan anda ekspor baik dengan mencentangnya satu per
satu atau menggunakan tombol Select All atau hanya memposisikan
kursor pada baris tertentu yang akan diekspor, maka anda bisa mengklik
tombol ini untuk melakukan proses ekspor ke file CSV. Ingat ! Kalau ada
data yang dicentang, maka data itulah yang akan diekspor, bukan data
pada posisi kursor.

Tombol Lihat File CSV : file CSV Retur PPN Masukan yang anda buat
melalui program Accpro dapat anda lihat isinya dengan menggunakan
tombol ini. Anda akan diminta untuk menentukan nama file CSV yang
akan anda buka.

Tombol Detail Barang : klik tombol ini untuk menampilkan detail
barang atas Retur PPN Masukan pada baris dimana kursor berada.
Posisikan kursor pada baris sebelum atau berikutnya atau baris tertentu
untuk menampilkan detail barang untuk baris tersebut.

Tombol New : untuk menambah transaksi Purchase Return yang baru.
Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

Tombol Preview : menampilkan laporan data Retur PPN Masukan ke
layar untuk selanjutnya bisa dicetak ke printer.

Tombol Periode : untuk memilih periode data Retur PPN Masukan yang
ingin ditampilkan.

Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, kontak dan valuta transaksi.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

Tombol Close : menutup form ini. Form ini adalah form yang bersifat

non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
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dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.11 Data SO & Histori Pengiriman Barang

Modul atau form ini akan menampilkan daftar Sales Order (SO) dimana
untuk masing-masing SO dapat ditampilkan juga histori pengiriman
barangnya. Setiap kali form ini dibuka, maka akan ditampilkan daftar SO
untuk periode bulan berjalan dalam urutan tanggal SO. Apabila ingin
memilih periode lain maka klik tombol Periode, sedangkan apabila ingin
menyeleksi data yang ditampilkan maka klik tombol Filter. Mengurutkan
data menurut kolom tertentu dilakukan dengan mengklik pada judul kolom

tersebut.

Data Sales|Order. (01Jan 2015 5/d 31 Jan 2015) = o El

Filter Refresh
Customer
B4 07/01/2015 |S0-15.000001  |IMPERIAL TAXI

0 11.000.000
[

e  Tombol Detail Pengiriman : klik tombol ini untuk menampilkan detail
(histori) pengiriman barang atas SO pada baris dimana kursor berada.
Selanjutnya anda tinggal memposisikan kursor pada baris sebelum atau
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berikutnya atau baris tertentu untuk menampilkan detail pengiriman
barang untuk SO pada baris tersebut. Sebagai alternatif dari tombol ini,
anda bisa mengklik tombol drop-down pada kolom paling kiri (kolom o).
Tombol New : untuk menambah SO baru. Form Sales Order akan
ditampilkan dalam modus Add sehingga anda tinggal melakukan input
data SO baru tanpa perlu lagi mengklik tombol New pada frorm
bersangkutan.

Tombol Edit : untuk mengedit SO pada baris dimana kursor berada,
termasuk jika ingin menghapusnya. Sebagai alternatif dari tombol Edit
anda bisa melakukan double klik pada baris yang akan diedit. Form Sales
Order akan ditampilkan dalam modus Edit pada record yang
bersesuaian sehingga anda tinggal mengeditnya.

Tombol Preview : menampilkan laporan SO ke layar untuk selanjutnya
bisa dicetak ke printer.

Tombol Periode : untuk memilih periode SO yang ingin ditampilkan.
Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal SO, customer, valuta dan status SO.

Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate SO tertentu, atau
menambah SO baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.12 Data Penjualan & Detail Pelunasan

Modul atau form ini akan menampilkan daftar transaksi penjualan yang

diinput melalui modul Sales Invoice, dimana untuk masing-masing transaksi

dapat ditampilkan juga histori pelunasannya. Setiap kali form ini dibuka,

maka akan ditampilkan daftar transaksi penjualan untuk periode bulan
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berjalan dalam urutan tanggal Invoicenya. Apabila ingin memilih periode lain
maka klik tombol Periode, sedangkan apabila ingin menyeleksi data yang
ditampilkan maka klik tombol Filter. Mengurutkan data menurut kolom
tertentu dilakukan dengan mengklik pada judul kolom tersebut.

Data Penjualan (013an 2015 5/d 31 Jan 2015) m o 2]
Periode Filter Refresh  Biava

Discount. [V PPN Jumiah Tagihan
0 110.000.000 11,000.000 121.000.000

o 12/01/2015 000002 INV-15.000002  SEMESTA GPS 24,603.125 0 24.603.125 2,460,312 27.063.437 897,093
o 19/01/2015 000003  INV-15.000003  PRIMA TRAVEL 12.000.000 0 12.000.000 1.200.000 13.200.000 13.200.000

JmlData: 3 Unfiltered Periode : Januari 2015 | 146,603,125

e Tombol Detail Pelunasan : klik tombol ini untuk menampilkan detail
(histori) pelunasan atas transaksi penjualan pada baris dimana kursor
berada. Posisikan kursor pada baris sebelum atau berikutnya atau baris
tertentu untuk menampilkan detail pelunasan untuk baris tersebut.

¢ Tombol New : untuk menambah transaksi Sales Invoice baru.

e Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

e Tombol Preview : menampilkan laporan penjualan ke layar untuk
selanjutnya bisa dicetak ke printer.

e Tombol Periode : untuk memilih periode transaksi yang ingin
ditampilkan.

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan

rentang tanggal transaksi, kontak, valuta transaksi dan salesman.
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Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

Tombol Biaya : apabila pada transaksi penjualan kemungkinan ada
biaya lain seperti freight atau ada pajak lain diluar PPN, maka dengan
mengklik tombol ini akan ditampilkan kolom Biaya dimana pada kolom
ini ditampilkan jumlah biaya dan pajak lain sedangkan kolom Sisa
Tagihan tidak ditampilkan. Mengklik tombol ini kembali akan
menampilkan kembeali kolom Sisa Tagihan, sedangkan kolom Biaya tidak
ditampilkan.

Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

Catatan :

Apabila transaksi sudah termasuk PPN (include PPN), maka nilai yang
ditampilkan pada kolom Gross Sales, Discount dan Net Sales adalah
dalam nominal tanpa PPN.

6.13 Data PPN Keluaran — Ekspor ke CSV

Modul atau form ini akan menampilkan daftar PPN Keluaran pada rentang
waktu tertentu. Setiap kali form ini dibuka, maka akan ditampilkan daftar
PPN Keluaran yang tanggal transaksinya dalam rentang periode bulan
berjalan dalam urutan tanggal Faktur Pajaknya. Apabila ingin memilih
periode lain maka klik tombol Periode, sedangkan apabila ingin menyeleksi
data yang ditampilkan maka klik tombol Filter. Mengurutkan data menurut

kolom tertentu dilakukan dengan mengklik pada judul kolom tersebut..
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Data PPH Keluaran (01 Jan 2015 5/d 31 Jan 2015} o 2] =]

Filter Refresh Periode
No. Invoice Customer Sub Total | Dis munt Uang Muka
o 08/01/2015 010,000 15 00000201 INV-15.000001  IMPERIAL TAXI 110.000.000 0 110 000, uuu 11,000,000

o * 12/01/2015]010.000-15.00000202 [INV-15.000002 |SEMESTA GPS 24.603.125 n- O]
C

15/01/2015 010.000-15.00000203 INV-15.000003  PRIMA TRAVEL 12.000.000 0 12000 nnn 1.200.000 O

|unfiltered Periode : Januari 2015 | 6.603, 12! | 1se.603.125] 14.660.312|

Lihat File CSV % Detail Barang

Modul ini adalah fasilitas baru yang disediakan terutama untuk melakukan
ekspor PPN Keluaran ke file CSV untuk selanjutnya tinggal dilakukan proses
Impor menggunakan fasilitas yang ada pada program eFaktur dari Direktorat
Jenderal Pajak. Dengan adanya fasilitas ini pengguna Accpro tidak perlu lagi
melakukan input manual data PPN Keluaran menggunakan program
eFaktur. Perlu diketahui hanya PPN Keluaran yang transaksinya
menggunakan modul Sales Invoice yang akan ditampilkan di sini. PPN
Keluaran yang diinput melalui modul lain misalnya Penerimaan Kas/Bank
atau Jurnal Transaksi tidak akan ditampilkan di sini. Jadi jika anda tidak
menggunakan modul Sales Invoice untuk input transaksi yang ada PPN
Keluarannya, maka apabila anda perlu input PPN Keluaran ke program
eFaktur, maka untuk transaksi yang demikian ini harus dilakukan secara

manual.

¢ Kolom Ekspor : kolom ini digunakan oleh user untuk menyeleksi data
PPN Keluaran yang akan diekspor dengan mencentangnya. Jadi user bisa
memilih sekaligus beberapa data untuk diekspor ke CSV. Apabila tidak
ada data yang dicentang, maka data pada posisi kursor yang akan
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diekspor ke CSV oleh program. Apabila anda melakukan lebih dari satu
kali proses ekspor PPN Keluaran ke file CSV yang berbeda dalam satu
sesi (tanpa menutup form ini lebih dulu), jangan lupa untuk melakukan
uncheck kembali untuk data yang tidak ingin anda ekspor. Hanya kolom
ini yang bisa anda akses dengan mencentangnya, kolom lain hanya
menampilkan informasi terkait PPN Keluaran bersangkutan.

Kolom Sdh Ekspor : kolom ini hanya menandakan data manakah yang
sudah pernah diekspor. Pelu diketahui, program tidak bisa mengetahui
apakah data yang anda ekspor sudah berhasil diimpor oleh program
eFaktur, karena tidak ada interaksi antara Accpro dan program eFaktur.
Tetapi data yang sudah pernah diekspor tetap bisa diekspor ulang.
Tombol Select All : apabila anda ingin menyeleksi semua data yang
ditampilkan untuk diekspor ke CSV, anda bisa mengklik tombol ini.
Maka tombol ini kemudian akan berfungsi sebagai tombol Deselect All
yang berfungsi sebaliknya yaitu untuk mengosongkan kembali kolom
Ekspor.

Tombol Ekspor ke CSV : setelah anda menyeleksi data PPN Keluaran
yang akan anda ekspor baik dengan mencentangnya satu per satu atau
menggunakan tombol Select All atau hanya memposisikan kursor pada
baris tertentu yang akan diekspor, maka anda bisa mengklik tombol ini
untuk melakukan proses ekspor ke file CSV. Ingat ! Kalau ada data yang
dicentang, maka data itulah yang akan diekspor, bukan data pada posisi
kursor.

Tombol Lihat File CSV : file CSV PPN Keluaran yang anda buat melalui
program Accpro dapat anda lihat isinya dengan menggunakan tombol
ini. Anda akan diminta untuk menentukan nama file CSV yang akan
anda buka. Ini bisa digunakan untuk melakukan evaluasi datanya
sebelum dilakukan proses impor melalui fasilitas impor pada program
eFaktur.

Tombol Detail Barang : klik tombol ini untuk menampilkan detail
barang atas PPN Keluaran pada baris dimana kursor berada. Posisikan
kursor pada baris sebelum atau berikutnya atau baris tertentu untuk
menampilkan detail barang untuk baris tersebut.

Tombol New : untuk menambah transaksi Sales Invoice baru.
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e Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

e Tombol Preview : menampilkan laporan data PPN Keluaran ke layar
untuk selanjutnya bisa dicetak ke printer.

e  Tombol Periode : untuk memilih periode transaksi data PPN Keluaran
yang ingin ditampilkan.

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, kontak dan valuta transaksi.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

¢ Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

6.14 Data Retur PPN Keluaran — Ekspor ke CSV

Modul atau form ini akan menampilkan daftar Retur PPN Keluaran pada
rentang waktu tertentu. Setiap kali form ini dibuka, maka akan ditampilkan
daftar Retur PPN Keluaran yang tanggal transaksinya dalam rentang periode
bulan berjalan dalam urutan tanggal Faktur Pajaknya. Apabila ingin memilih
periode lain maka klik tombol Periode, sedangkan apabila ingin menyeleksi
data yang ditampilkan maka klik tombol Filter. Mengurutkan data menurut

kolom tertentu dilakukan dengan mengklik pada judul kolom tersebut.

Modul ini adalah fasilitas baru yang disediakan terutama untuk melakukan
ekspor Retur PPN Keluaran ke file CSV untuk selanjutnya tinggal dilakukan
proses Impor menggunakan fasilitas yang ada pada program eFaktur dari
Direktorat Jenderal Pajak. Dengan adanya fasilitas ini pengguna Accpro tidak

perlu lagi melakukan input manual data Retur PPN Keluaran menggunakan
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program eFaktur. Perlu diketahui hanya Retur PPN Keluaran yang
transaksinya menggunakan modul Sales Return yang akan ditampilkan di
sini. Retur PPN Keluaran yang diinput melalui modul lain misalnya
Pengeluran Kas/Bank atau Jurnal Transaksi atau Credit Note tidak akan
ditampilkan di sini. Jadi jika anda tidak menggunakan modul Sales Return
untuk input transaksi yang ada Retur PPN Keluarannya, maka apabila anda
perlu input Retur PPN Keluaran ke program eFaktur, maka untuk transaksi

yang demikian ini harus dilakukan secara manual.

Retur PPN Keluaran (01 Jan 2015 5/d 31 Jan 2015} 3 F 8
Fiter  Refresh  Periode

Tgl. Retur No, Retur Tgl. FP No. FP No. Invoice Customer

M| [31/01/2015 |SR-15.01.0001 |12/01/2015010.000-15.00000202 |INV-15.000002 |SEMESTA GPS

|Unfiltered Periode : Januari 2015

Lihat File CSV

¢ Kolom Ekspor : kolom ini digunakan oleh user untuk menyeleksi data
Retur PPN Keluaran yang akan diekspor dengan mencentangnya. Jadi
user bisa memilih sekaligus beberapa data untuk diekspor ke CSV.
Apabila tidak ada data yang dicentang, maka data pada posisi kursor
yang akan diekspor ke CSV oleh program. Apabila anda melakukan lebih
dari satu kali proses ekspor Retur PPN Keluaran ke file CSV yang
berbeda dalam satu sesi (tanpa menutup form ini lebih dulu), jangan
lupa untuk melakukan uncheck kembali untuk data yang tidak ingin
anda ekspor. Hanya kolom ini yang bisa anda akses dengan
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mencentangnya, kolom lain hanya menampilkan informasi terkait Retur
PPN Keluaran bersangkutan.

Kolom Sdh Ekspor : kolom ini hanya menandakan data manakah yang
sudah pernah diekspor. Pelu diketahui, program tidak bisa mengetahui
apakah data yang anda ekspor sudah berhasil diimpor oleh program
eFaktur, karena tidak ada interaksi antara Accpro dan program eFaktur.
Tetapi data yang sudah pernah diekspor tetap bisa diekspor ulang.
Tombol Select All : apabila anda ingin menyeleksi semua data yang
ditampilkan untuk diekspor ke CSV, anda bisa mengklik tombol ini.
Maka tombol ini kemudian akan berfungsi sebagai tombol Deselect All
yang berfungsi sebaliknya yaitu untuk mengosongkan kembali kolom
Ekspor.

Tombol Ekspor ke CSV : setelah anda menyeleksi data Retur PPN
Keluaran yang akan anda ekspor baik dengan mencentangnya satu per
satu atau menggunakan tombol Select All atau hanya memposisikan
kursor pada baris tertentu yang akan diekspor, maka anda bisa mengklik
tombol ini untuk melakukan proses ekspor ke file CSV. Ingat ! Kalau ada
data yang dicentang, maka data itulah yang akan diekspor, bukan data
pada posisi kursor.

Tombol Lihat File CSV : file CSV Retur PPN Keluaran yang anda buat
melalui program Accpro dapat anda lihat isinya dengan menggunakan
tombol ini. Anda akan diminta untuk menentukan nama file CSV yang
akan anda buka. Ini bisa digunakan untuk melakukan evaluasi datanya
sebelum dilakukan proses impor melalui fasilitas impor pada program
eFaktur.

Tombol Detail Barang : klik tombol ini untuk menampilkan detail
barang atas Retur PPN Keluaran pada baris dimana kursor berada.
Posisikan kursor pada baris sebelum atau berikutnya atau baris tertentu
untuk menampilkan detail barang untuk baris tersebut.

Tombol New : untuk menambah transaksi Sales Return baru.

Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

Tombol Preview : menampilkan laporan data Retur PPN Keluaran ke
layar untuk selanjutnya bisa dicetak ke printer.

6-30



e Tombol Periode : untuk memilih periode transaksi data Retur PPN
Keluaran yang ingin ditampilkan.

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, kontak dan valuta transaksi.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

e Tombol Close : menutup form ini. Form ini adalah form yang bersifat
non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3 Istilah
dan Konvensi), artinya anda bisa saja membuka modul lain tanpa

menutup form ini lebih dulu.

Cara melakukan Ekspor data PPN Masukan / PPN Keluaran atau
Retur PPN Masukan /Retur PPN Keluaran ke CSV :

Setelah anda mengklik tombol Ekspor ke CSV maka akan ditampilkan form
untuk menentukan lokasi dan nama file CSV yang akan dibuat. Ada 2 pilihan,
anda bisa mengekspor data PPN Masukan / PPN Keluaran atau Retur PPN
Masukan / Retur PPN Keluaran ke file CSV yang sudah pernah anda buat
sebelumnya, dalam hal ini program akan menambahkan data ini ke file CSV
tersebut jika data transaksi bersangkutan belum ada di file CSV yang anda
tentukan atau menggantikannya dengan data terkini jika data transaksi ini
sudah ada sebelumnya pada file CSV yang anda tentukan. Untuk cara
pertama ini pilih (klik) option-button “Ekspor ke File CSV PPN Masukan
yang sudah ada” (jika datanya adalah PPN Masukan) atau “Ekspor ke File
CSV Keluaran yang sudah ada” (jika datanya adalah PPN Keluaran) atau
“Ekspor ke File CSV Retur PPN Masukan yang sudah ada” (jika datanya
adalah Retur PPN Masukan) atau “Ekspor ke File CSV Retur PPN Keluaran
yang sudah ada” (jika datanya adalah Retur PPN Keluaran).
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{4 Buat File CSV PPN Keluaran -— —

Tentukan pilihan anda

() Ekspor ke File CSV PPN Keluaran yang sudah ada

Tentukan Nama File CSV yang akan digunakan Mama File C5V

@ Buat File CSV PPN Keluaran yang baru

1. Tentukan folder lokasi file CSV yang akan dibuat | Lokasi File CSV |

2. Tentukan Narma Filenya
uat Mama File Otomatis dengan format PPMKeluaran_yyyy-mm-dd_hh.mm.ss

[ [Buat Nama File sendiri

| Yo | | B cancel |

Cara kedua adalah dengan memilih (klik) option-button “Buat File CSV PPN
Masukan yang baru” (jika datanya adalah PPN Masukan) atau “Buat File CSV
PPN Keluaran yang baru” (jika datanya adalah PPN Keluaran) atau “Buat File
CSV Retur PPN Masukan yang baru” (jika datanya adalah Retur PPN
Masukan) atau “Buat File CSV Retur PPN Keluaran yang baru” (jika datanya
adalah Retur PPN Keluaran). Selanjutnya anda perlu menentukan lokasi
(folder) file CSV yang akan dibuat. Untuk itu klik tombol Lokasi File CSV dan
pilih foldernya. Anda juga bisa langsung mengetikkan lokasi foldernya. Kalau
anda tidak menentukan lokasi foldernya, maka program akan menempatkan
file CSV yang anda buat pada folder dimana database Accpro berada. Untuk
cara kedua ini anda masih diberikan pilihan untuk menentukan sendiri nama
file CSVnya, dalam hal ini centang checkbox “Buat Nama File sendiri”,
kemudian ketikkan nama filenya. Tetapi anda juga bisa memilih pilihan
pertama dengan mencentang checkbox “Buat Nama File Otomatis dengan
format PPNMasukan_yyyy-mm-dd_hh.mm.ss” atau “Buat Nama File
Otomatis dengan format PPNKeluaran_yyyy-mm-dd_hh.mm.ss” atau “Buat
Nama File Otomatis dengan format ReturPPNMasukan_yyyy-mm-
dd_hh.mm.ss” atau “Buat Nama File Otomatis dengan format

ReturPPNKeluaran_yyyy-mm-dd_hh.mm.ss” (tergantung jenis PPN yang
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akan diekspor : PPN Maukan, PPN Keluaran , Retur PPN Masukan atau
Retur PPN Keluaran), maka anda tidak perlu repot menentukan nama file
CSVnya, tetapi program akan otomatis membuatkan namanya sesuai dengan
format yang telah ditentukan yaitu PPNMasukan_yyyy-mm-dd_hh.mm.ss
atau PPNKeluaran_yyyy-mm-dd_hh.mm.ss atau ReturPPNMasukan_yyyy-
mm-dd_hh.mm.ss atau ReturPPNKeluaran_yyyy-mm-dd_hh.mm.ss dimana
yyyy adalah 4 digit tahun, mm adalah 2 digit bulan, dd adalah 2 digit tanggal,
sedangkan hh adalah 2 digit jam, mm adalah 2 digit menit dan ss adalah 2
digit detik. Ini cara yang paling direkomendasikan karena anda tidak perlu
bingung dan pusing dalam menentukan namanya dan selalu akan

menghasilkan nama unik yang belum pernah ada sebelumnya.

File CSV yang dihasilkan dari proses ekspor ini tinggal anda lakukan proses
impornya melalui fasilitas impor PPN Masukan atau PPN Keluaran atau
Retur PPN Masukan atau Retur PPN Keluaran pada program eFaktur
sehingga anda tidak perlu lagi melakukan input data PPN Masukan atau PPN
Keluaran atau Retur PPN Masukan atau Retur PPN Keluaran secara manual
pada program eFaktur. Kalau anda ingin melakukan evaluasi lebih dulu file
CSV yang dihasilkan melalui proses ekspor ini sebelum diimpor melalui
program eFaktur, anda bisa mengklik tombol Lihat File CSV, program akan

meminta anda untuk menentukan file CSV yang akan anda buka.

6.15 Data Penerimaan Kas /7 Bank

Modul atau form ini akan menampilkan daftar transaksi penerimaan Kas /
Bank baik berupa tunai, transfer maupun cek/giro. Status penerimaan apakah
sudah cair atau belum dapat dilihat disini, untuk transaksi berupa tunai atau
transfer otomatis statusnya adalah Cair, berbeda dengan cek/giro. Setiap kali
form ini dibuka, maka akan ditampilkan daftar transaksi penerimaan Kas /
Bank untuk periode bulan berjalan dalam urutan tanggal transaksinya.
Apabila ingin memilih periode lain maka klik tombol Periode, sedangkan
apabila ingin menyeleksi data yang ditampilkan maka klik tombol Filter.
Mengurutkan data menurut kolom tertentu dilakukan dengan mengklik pada

judul kolom tersebut.
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No. Ref  Periode Filter Refresh Swap

Data Penerimaan Kas / Bank {013an 2015 5/d 31 Jan 2015) Ey =] A 2]

o Tanggal No. Trs Acc, Bank Dari Bank Mo, Cek/Giro T T Cur i (Rp) Cair
[M05/01/2015 [Rv 000001 [BankBCD  [RAJAWALI PERKASA [Bank ABC  [x¥ 123567 afuu"ols - 49,700.000 [ |
o 14/01/2015 RV 000002  BankBCD ERA BARU SOLUSINDO Bank Mitra AA 890123 88,660.000
I Data : 2 Unfitered Periode ; Januari 2015 Rp 138,360.000
o New ) pdit | Preview

e Tombol New : untuk menambah transaksi baru.

e Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

e  Tombol Preview : menampilkan laporan penerimaan Kas / Bank ke layar
untuk selanjutnya bisa dicetak ke printer.

e Tombol No. Ref : jika lebih suka menampilkan kolom No. Ref ketimbang
kolom No. Trs maka klik tombol ini. Mengklik kembali tombol ini akan
menampilkan kembali kolom No. Trs sebagai pengganti kolom No. Ref.

e Tombol Periode : untuk memilih periode transaksi yang ingin
ditampilkan.

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, jenis transaksi apakah berupa pelunasan
Piutang Usaha atau penerimaan Kas / Bank lainnya, kontak, Account
Bank, Bank, batasan Nilai, apakah Tunai / Transfer atau Cek / Giro, Cair
atau Belum Cair dan batasan tanggal jatuh tempo.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user

lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
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sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

e Tombol Swap : untuk menampilkan kolom Keterangan transaksi
sebagai pengganti kolom Bank, No. Cek/Giro dan Tgl. JT. Mengklik
kembeali tombol ini akan menampilkan kembali ketiga kolom ini sebagai
pengganti kolom Keterangan.

e Tombol Close : menutup form ini. Form Data Penerimaan Kas / Bank
adalah form yang bersifat non transaksional (lihat penjelasan mengenai
hal ini pada Bab 2.3 Istilah dan Konvensi), artinya anda bisa saja

membuka modul lain tanpa menutup form ini lebih dulu.

6.16 Data Pengeluaran Kas / Bank

Modul atau form ini akan menampilkan daftar transaksi pengeluaran Kas /
Bank baik berupa tunai, transfer maupun cek/giro. Status transaksi apakah
sudah cair atau belum dapat dilihat disini, untuk transaksi berupa tunai atau
transfer otomatis statusnya adalah Cair, berbeda dengan cek/giro. Setiap kali
form ini dibuka, maka akan ditampilkan daftar transaksi pengeluaran Kas /
Bank untuk periode bulan berjalan dalam urutan tanggal transaksinya.
Apabila ingin memilih periode lain maka klik tombol Periode, sedangkan
apabila ingin menyeleksi data yang ditampilkan maka klik tombol Filter.
Mengurutkan data menurut kolom tertentu dilakukan dengan mengklik pada

judul kolom tersebut.

¢ Tombol New : untuk menambah transaksi baru.

e Tombol Edit : untuk mengedit transaksi pada baris dimana kursor
berada, termasuk jika ingin menghapusnya.

e Tombol Preview : menampilkan laporan pengeluaran Kas / Bank ke
layar untuk selanjutnya bisa dicetak ke printer.

¢ Tombol No. Ref : jika lebih suka menampilkan kolom No. Ref ketimbang
kolom No. Trs maka klik tombol ini. Mengklik kembali tombol ini akan

menampilkan kembali kolom No. Trs sebagai pengganti kolom No. Ref.
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e Tombol Periode : untuk memilih periode transaksi yang ingin

ditampilkan.
Data Pengeluaran Kas / Bank {01 3an 201*
Fiter

o Tanggal No. Trs Acc. Bank No. Cek/Giro Tg. T
e O Y Y S

an 000001  Bank ABC <NjA> Rp 2,000,000

PV 000002  BankBCD GRAHA PRIMA SEJAHTERA Bank BCD AA 456890 1401/2015  Rp 120,000,000

B0 000002 Kas Kecl <NjA> Rp 650,000
o 15/01/2015 BO 000007 Bank ABC <NjA> Rp 2.750.000
0 26/01/2015 PV 000003  BankBCD PANCAMITRA Bank BCD 4B 345678 26/01/2015  Rp 42.968.000
0 26/012015 BO 000003  BankBCD ABC FINANCE Rp 2.729.222
o 28/01/2015 BO 000006  BankBCD KAS NEGARA. Bank BCD AAX 567890 28/01/2015  Rp 3.360.312
0 30/01/2015 BO 000004 Bank BCD MITRA FINANCE Rp 5.938.000
o 31/01/2015 BO 000005  Bank ABC <NjA> Rp 35.000.000

Il Data : 10 Unfiltered Periode ; Januari 2015 Rp 237,645,534
o New ) Edit =] Preview

e Tombol Filter : menyeleksi data yang ditampilkan menurut batasan
rentang tanggal transaksi, jenis transaksi apakah berupa pelunasan
Hutang Usaha atau pengeluaran Kas / Bank lainnya, kontak, Account
Bank, Bank, batasan Nilai, apakah Tunai / Transfer atau Cek / Giro, Cair
atau Belum Cair dan batasan tanggal jatuh tempo.

e Tombol Refresh : untuk memperbaharui tampilan data apabila ada
penambahan atau perubahan data khususnya yang dilakukan oleh user
lain. Mungkin anda membuka form ini sudah beberapa saat yang lalu,
sementara itu ada user lain yang mengupdate transaksi tertentu, atau
menambah transaksi baru, maka dengan melakukan refresh, data akan
ditampilkan sesuai dengan kondisi terkini.

e Tombol Swap : untuk menampilkan kolom Keterangan transaksi
sebagai pengganti kolom Bank, No. Cek/Giro dan Tgl. JT. Mengklik
kembali tombol ini akan menampilkan kembali ketiga kolom ini sebagai
pengganti kolom Keterangan.
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e Tombol Close : menutup form ini. Form Data Pengeluaran Kas / Bank
adalah form yang bersifat non transaksional (lihat penjelasan mengenai
hal ini pada Bab 2.3 Istilah dan Konvensi), artinya anda bisa saja

membuka modul lain tanpa menutup form ini lebih dulu.

6.17 Daftar Penjualan Tahunan
6.17.1  Yearly Net Sales by Salesman by Customer

Form ini menampilkan laporan tahunan penjualan per Salesman, dimana
untuk masing-masing Salesman dapat ditampilkan lagi detail penjualan
tahunan per Customer. Selain itu dapat ditampilkan grafik penjualan tahunan
baik per Salesman bulan per bulan maupun per Bulan tertentu untuk masing-
masing Salesman. Pada saat form dibuka maka akan ditampilkan laporan
penjualan tahunan per Salesman untuk tahun berjalan menurut urutan Nama
Salesman. Jika ingin memilih tahun tertentu maka pilih tahunnya dengan
mengklik pada tombol drop-down pada field tersebut. Sedangkan jika ingin
mengurutkan menurut kolom tertentu maka klik pada judul kolom tersebut.
Pada saat ditampilkan maka data akan diurutkan secara menaik (ascending).
Apabila perlu mengurutkan data secara menurun (descending) maka klik
pada footer sebagaimana informasi yang ditampilkan di situ. Gunakan
horisontal scroll-bar untuk melihat kolom diluar kolom yang ditampilkan
pada saat itu.

e Tombol Detail Penjualan : untuk menampilkan detail penjualan
salesman tertentu menurut customernya. Untuk melihat detail untuk
salesman lainnya maka tinggal memindahkan kursor pada baris
Salesman dimaksud. Mengurutkan data pada detail penjualan menurut
kolom tertentu bisa dilakukan dengan mengklik pada judul kolom
dimaksud. Demikian juga jika ingin mengurutkan secara menaik
(ascending) atau menurun (descending), maka klik pada footer dimana
informasi mengenai hal ini ditampilkan. Sebagai alternatif dari tombol ini
adalah dengan melakukan double klik pada baris dimana Salesman

dimaksud berada.
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Vearly et Sales By Salesman 7] B L

Preview  Chart
Total Jan e Mar
L 110.000.000 110.000.000
2. Harry Sutandi 12.000.000 12.000.000
3. Sony Susanto 24,603,125 24,603,125

Sort : Ascending (dick here to change order) 146.603.125

e Tombol Detail by Product : anda masih bisa menampilkan lagi detail
penjualan customer tertentu menurut produknya dengan mengklik
tombol ini atau double klik pada baris customer dimaksud. Seperti
halnya detail penjualan per customer, disini anda bisa mengurutkan
menurut kolom tertentu baik secara ascending atau descending. Pertama
kali dibuka maka ditampilkan dalam Volume/Qty, jika ingin
menampilkan dalam bentuk Nilai, maka pilih Value sebagai alternatif
atas Volume/Qty.

¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer apabila perlu. Ada pilihan untuk menampilkan
laporan apakah 1st Semester, 2nd Semester atau keduanya.

e Tombol Chart : menampilkan grafik penjualan. Pertama kali diklik maka
akan menampilkan grafik penjualan untuk salesman pada baris dimana
kursor berada. Untuk memaksimalkan ukuran tampilan grafik, klik
tombol Max. Pada panel sebelah kiri, anda bisa memilih Salesman yang
ingin ditampilkan grafiknya. Memilih All akan menampilkan grafik
komparatif untuk kesemua Salesman yang ada bulan per bulan. Anda
juga bisa memilih grafik komparatif untuk bulan tertentu dengan klik
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pada bulan bersangkutan pada panel sebelah kiri. Ada juga opsi untuk
menampilkan grafik dalam bentuk bar, pie atau line (grafik garis) dan
menampilkan grafik dalam bentuk 3D (3 dimensi). Untuk meminimalkan
kembali ukuran tampilan grafif klik tombol Min, sedangkan untuk
menutup tampilan grafik, klik tombol atau klik kembali tombol Chart.
e Tombol Close : menutup form ini. Karena form ini adalah form yang
bersifat non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3
Istilah dan Konvensi), maka tidak perlu menutup form ini lebih dulu

agar bisa mmebuka modul lain.

6.17.2 Yearly Sales by Product by Customer

Form ini menampilkan laporan tahunan penjualan per Product atau Item
Penjualan, dimana untuk masing-masing Product dapat ditampilkan lagi
detail penjualan tahunan per Customer. Pada saat form dibuka maka akan
ditampilkan laporan penjualan tahunan per Product untuk tahun berjalan
dalam Volume/Qty menurut urutan Nama Product. Jika ingin memilih tahun
tertentu maka pilih tahunnya dengan mengklik pada tombol drop-down pada
field tersebut. Demikian juga jika ingin menampilkan dalam Value, maka
pilih Value sebagai alternatif atas Volume/Qty. Sedangkan jika ingin
mengurutkan menurut kolom tertentu maka klik pada judul kolom tersebut.
Pada saat ditampilkan maka data akan diurutkan secara menaik (ascending).
Apabila perlu mengurutkan data secara menurun (descending) maka klik
pada footer sebagaimana informasi yang ditampilkan di situ. Gunakan
horisontal scroll-bar untuk melihat kolom diluar kolom yang ditampilkan

pada saat itu.

e  Tombol Detail Penjualan : untuk menampilkan detail penjualan product
(item) tertentu menurut customernya. Untuk melihat detail untuk
product lainnya maka tinggal memindahkan kursor pada baris product
dimaksud. Mengurutkan data pada detail penjualan menurut kolom
tertentu bisa dilakukan dengan mengklik pada judul kolom dimaksud.
Demikian juga jika ingin mengurutkan secara menaik (ascending) atau
menurun (descending), maka klik pada footer dimana informasi

mengenai hal ini ditampilkan. Sebagai alternatif dari tombol ini adalah

6-39



dengan melakukan double klik pada baris dimana product dimaksud
berada.

veary soes by product. FTHE] v [T B

Preview  Search

Kods Brg Nama Barang Total Jan
Perpanjangan web tracking selama 1 tah 10

I}

£

1.

2 GPS Navigas GN: 0 0
3. GN-333( GPS Navigasl GN-333X 1 1
4. GT-90X GPS Tracker GT-50X 50 50
5. 1501F Free langganan web tracking 50 50
6. 1SO0F Free Jasa Pemasangan 50 50
7. KPO1 Kartu Perdana 50 50
8. vCH-250 Pulsa 250 ribu

Sort : Ascending  (dick here to change order)

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer apabila perlu. Ada pilihan untuk menampilkan
laporan apakah 1st Semester, 2nd Semester atau keduanya.

e Tombol Search : apabila product atau item penjualan cukup banyak
jenisnya, maka gunakan bantuan tombol Search untuk memudahkan
dalam mencari product tertentu. Cukup ketikkan potongan teks yang
dicari pada field Cari kemudian klik tombol Go. Apabila perlu
mengosongkan field Cari, gunakan tombol Clear.

e Tombol Close : menutup form ini. Karena form ini adalah form yang
bersifat non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3
Istilah dan Konvensi), maka tidak perlu menutup form ini lebih dulu

agar bisa mmebuka modul lain.
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6.17.3 Yearly Sales by Group of Product

Form ini menampilkan laporan tahunan penjualan per Kelompok Barang
Penjualan, dimana untuk masing-masing Kelompok Barang dapat
ditampilkan lagi detail penjualan tahunan masing-masing barang. Pada saat
form dibuka maka akan ditampilkan laporan penjualan tahunan per
Kelompok Barang untuk tahun berjalan dalam Volume/Qty menurut urutan
Nama Grup Barang. Jika ingin memilih tahun tertentu maka pilih tahunnya
dengan mengklik pada tombol drop-down pada field tersebut. Demikian juga
jika ingin menampilkan dalam Value, maka pilih Value sebagai alternatif atas
Volume/Qty. Sedangkan jika ingin mengurutkan menurut kolom tertentu
maka klik pada judul kolom tersebut. Pada saat ditampilkan maka data akan
diurutkan secara menaik (ascending). Apabila perlu mengurutkan data secara
menurun (descending) maka klik pada footer sebagaimana informasi yang
ditampilkan di situ. Gunakan horisontal scroll-bar untuk melihat kolom
diluar kolom yang ditampilkan pada saat itu.

Yearly Sales by Product Group n B

Preview
Group of Product

110.000.000 110.000.000

]
#
i
Z
3
4

OTHERS 12.000.000 12.000.000

Sort : Ascending (dick here to change order) 146.603.125

¢ Tombol Detail Product : untuk menampilkan detail penjualan Kelompok
Barang tertentu terinci atas barangnya. Selanjutnya untuk melihat detail
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untuk Kelompok Barang lainnya maka tinggal memindahkan kursor
pada baris Kelompok Barang dimaksud. Mengurutkan data pada Detail
Product menurut kolom tertentu bisa dilakukan dengan mengklik pada
judul kolom dimaksud. Demikian juga jika ingin mengurutkan secara
menaik (ascending) atau menurun (descending), maka klik pada footer
dimana informasi mengenai hal ini ditampilkan. Sebagai alternatif dari
tombol ini adalah dengan melakukan double klik pada baris dimana
Kelompok Barang dimaksud berada.

¢ Tombol Chart : menampilkan grafik penjualan Kelompok Barang.
Pertama kali diklik maka akan menampilkan grafik penjualan untuk
Kelompok Barang pada baris dimana kursor berada. Untuk
memaksimalkan ukuran tampilan grafik, klik tombol Max. Pada panel
sebelah kiri, anda bisa memilih Kelompok Barang yang ingin
ditampilkan grafiknya. Memilih All akan menampilkan grafik
komparatif untuk kesemua Kelompok Barang yang ada bulan per bulan.
Anda juga bisa memilih grafik komparatif untuk bulan tertentu dengan
klik pada bulan bersangkutan pada panel sebelah kiri. Ada juga opsi
untuk menampilkan grafik dalam bentuk bar, pie atau line (grafik garis)
dan menampilkan grafik dalam bentuk 3D (3 dimensi). Untuk
meminimalkan kembali ukuran tampilan grafif klik tombol Min,
sedangkan untuk menutup tampilan grafik, klik tombol atau klik
kembali tombol Chart.

¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer apabila perlu. Ada pilihan untuk menampilkan
laporan apakah 1st Semester, 2nd Semester atau keduanya.

e Tombol Search : apabila barang atau detail product cukup banyak
jenisnya, maka gunakan bantuan tombol Search untuk memudahkan
dalam mencari barang (product) tertentu. Cukup ketikkan potongan teks
yang dicari pada field Cari kemudian klik tombol Go. Apabila perlu
mengosongkan field Cari, gunakan tombol Clear. Sedangkan apabila
perlu menyesuaikan jenis teks yang dicari apakah Kode Barang atau
Nama Barang, klik tombol drop-down pada field “di”.

e Tombol Close : menutup form ini. Karena form ini adalah form yang

bersifat non transaksional (lihat penjelasan mengenai hal ini pada Bab 2.3
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Istilah dan Konvensi), maka tidak perlu menutup form ini lebih dulu

agar bisa mmebuka modul lain.

6.18 Saldo dan Kartu Stock Barang Konsinyasi

(Untuk varian Accpro Trada dan Accpro Strada karena fasilitas Konsinyasi tidak
tersedia, maka menu ini juga tidak tersedia, fasilitas Konsinyasi tersedia pada varian

Accpro Spectra)

Menu ini hanya ada apabila telah diakomodasi adanya Penjualan Konsinyasi
melalui Setup Preferensi dengan mencentang checkbox “Mengakomodasi
Penjualan Konsinyasi dan Inventory Control Barang Konsinyasi di
Customer”. Modul atau form ini menampilkan saldo terkini barang
konsinyasi di customer (Consignee), bisa ditampilkan juga berikut nilainya.

Untuk masing-masing barang bisa ditampilkan lagi Kartu Stocknya.
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7.1

BAB 7

Laporan-laporan

Laporan Neraca

Neraca akan terbentuk dengan sendirinya tanpa anda harus menyusunnya

lebih dulu. Tinggal ditampilkan kelayar untuk selanjutnya bisa dicetak ke

printer. Bila anda tidak puas dengan Neraca Standar yang ada, maka tersedia

pilihan Custom.

54 Laporan Neraca

S

Bentuk Laporan
@) Skontro
Jenis Laporan
@ Standard
) Custom

@ Periode Januari 2015

_| Per Tanggal 31 Januari 2015
[ Tampilkan Detail
Tampilkan yang bersaldo Nol
[T Mama Perkiraan ditampilkan Nama Aliasnya

) Lajur

Customize

_:] Freview

| Kj Cancel |

s

e Bentuk Laporan:

[0}

(0]

Skontro : pilih opsi ini jika ingin menampilkan neraca dalam bentuk

skontro (2 kolom).

Lajur : pilih opsi ini jika ingin menampilkan neraca dalam bentuk

lajur.

¢ Jenis Laporan:

[0}
o

Standard : pilih opsi ini untuk menampilkan laporan neraca standar.

Custom : pilih opsi ini apabila ingin menampilkan laporan neraca

custom. Apabila anda belum pernah melakukan kustomisaai, Anda

perlu melakukannya lebih dulu dengan mengklik tombol Customize.
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Customize : klik tombol ini setelah memilih opsi Custom untuk
melakukan kustomisasi neraca apabila anda belum pernah
melakukannya. Artinya kustomisasi hanya perlu dilakukan sekali saja
atau apabila ingin melakukan perubahan pada kustomisasi yang telah
dilakukan atau jika ada penambahan akun neraca baru. Kustomisasi
disini hanya berarti menentukan akun-akun neraca mana yang ingin
ditampilkan secara detail atau akun mana yang hanya ditampilkan Sub
Kategorinya.

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Per Tanggal : sebagai alternatif dari memilih periode anda bisa
menampilkan neraca per tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik tanggalnya pada field disebelahnya dengan format
dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik tombol drop-
down untuk memunculkan bantuan kalender.

Tampilkan Detail : centang checkbox ini jika ingin menampilkan laporan
Neraca Standar yang terinci menyangkut semua akun-akun detail neraca
yang ada.

Tampilkan yang bersaldo Nol : klik checkbox ini hingga tidak
tercentang apabila tidak ingin menampilkan yang tidak ada saldonya.
Nama Perkiraan ditampilkan Nama Aliasnya : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda

belum keluar dari Accpro. Perkecualian adalah untuk laporan yang



berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.2 Laporan Laba Rugi

Seperti halnya Neraca, Laba Rugi akan terbentuk dengan sendirinya tanpa
anda harus menyusunnya lebih dulu. Tinggal ditampilkan kelayar untuk
selanjutnya bisa dicetak ke printer. Tersedia 2 pilihan apakah ingin
menampilkan laporan Laba Rugi hanya periode tertentu atau berikut Laba

Rugi dari awal tahun buku sampai dengan periode tersebut.

4 Laporan Laba Rugi (|

Jenis Laporan
'@ This Month Balance

_) This Month and Year To Date Balance

@ Periode Januari 2015 -

' PerTanggal |31 Januari 2015

Tampilkan yang bersaldo Mol
[ Tampilkan Persentase
[7] Gunakan Mama Alias sebagai Nama Perkiraan

_:]Pregiew | Kj Cancel

e Jenis Laporan:

0 This Month Balance : pilih opsi ini apabila hanya ingin
menampilkan Laba Rugi untuk periode tertentu.

0 This Month and Year to Date Balance : pilih opsi ini apabila selain
Laba Rugi periode tertentu juga ingin ditampilkan Laba Rugi dari
awal tahun buku sampai dengan periode dimaksud.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
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Per Tanggal : sebagai alternatif dari memilih periode anda bisa
menampilkan Laba Rugi per tanggal tertentu dengan mengklik pada
opsi ini kemudian ketik tanggalnya pada field disebelahnya dengan
format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik tombol
drop-down untuk memunculkan bantuan kalender.

Tampilkan yang bersaldo Nol : klik checkbox ini hingga tidak
tercentang apabila tidak ingin menampilkan yang tidak ada saldonya.
Tampilkan persentase : centang checkbox ini apabila selain
menampilkan nilai juga ingin menampilkan persentasenya.

Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

Laporan Buku Besar

Laporan Buku Besar akan menampilkan saldo akun pada Chart of Account,

aktifitas transaksi menyangkut akun dimaksud baik Debit atau Kredit berikut

saldo berjalannya.
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Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
buku besar dalam rentang tanggal tertentu dengan mengklik pada opsi
ini kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.

4 Laporan Ledger (Buku Besar) |8
@ Periode Januari 2015 -
") Tanggal 01/01/2015 sfd |31/01/2015

No.Perkiraan 01-00-00-000 [-4] s/d  09-20-00-000 [4]

Jangan tampilkan Mo. Jurnal tetapi tampilkan Mo. Referensinya
@Fﬁmpilkﬂn Account General

Jangan tampilkan yang tidak ada saldo dan mutasi

[ Gunakan Nama Alias sebagai Nama Perkiraan

| _:]Plegiew | | I Cancel |

No. Perkiraan : tentukan rentang Nomor Perkiraan yang ingin
ditampilkan dengan mengetikkan Nomor Perkiraan pada kedua field
yang ada atau gunakan bantuan tombol Lookup untuk memunculkan
form Lookup Perkiraan sebagai bantuan dalam mencari Nomor
Perkiraan yang diinginkan.

Jangan tampilkan No. Jurnal tetapi tampilkan No. Referensinya : setiap
transaksi di dalam Accpro mempunyai Kode tersendiri dan No. Trs yang
otomatis digenerate oleh program. Selain itu user juga diberikan ruang
atau fasilitas untuk memasukkan No. Referensinya sendiri. Kalau anda
lebih suka menampilkan No. Referensi ketimbang No. Jurnal yang
berupa Kode dan No. Trs yang digenerate oleh program maka biarkan
checkbox ini dalam keadaan tercentang.

Tampilkan Account General : klik checkbox ini hingga tidak tercentang

apabila tidak ingin menampilkan akun yang bertipe General.

7-5



e Jangan tampilkan yang tidak ada saldo dan mutasi : klik checkbox ini
hingga tidak tercentang apabila akun yang tidak ada saldo dan
mutasinya juga ingin ditampilkan.

e Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.4 Laporan Jurnal Transaksi

Laporan ini menampilkan semua jurnal transaksi baik berupa jurnal umum
yang dibuat secara manual maupun jurnal yang berasal dari posting otomatis

oleh program.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
jurnal transaksi dalam rentang tanggal tertentu dengan mengklik pada
opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
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tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.
&4 Laporan Jurnal Transaksi (e
@ Periode Januari 2015 -
) Tanaggal 01/01/2015 sfd  |31/01/2015

Kode Jurnal | <Al = |Z| < Semua Jenis Transaksi >

Jangan tampilkan Mo, Jurnal tetapi tampilkan Mo, Referensinya
[ Gunakan Nama Alias sebagai Nama Perkiraan

_:]Pregiewh | Kj Cancel |

Kode Jurnal : pilih <All> untuk menampilkan semua jurnal yang ada
pada periode dimaksud atau tentukan Kode Jurnalnya dengan mengklik
tombol drop-down pada field ini jika hanya ingin menampilkan jurnal
transaksi dengan Kode Jurnal tertentu.

Jangan tampilkan No. Jurnal tetapi tampilkan No. Referensinya : setiap
transaksi di dalam Accpro mempunyai Kode tersendiri dan No. Trs yang
otomatis digenerate oleh program. Selain itu user juga diberikan ruang
atau fasilitas untuk memasukkan No. Referensinya sendiri. Kalau anda
lebih suka menampilkan No. Referensi ketimbang No. Jurnal yang
berupa Kode dan No. Trs yang digenerate oleh program maka biarkan
checkbox ini dalam keadaan tercentang.

Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan

ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
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7.5

7.5.

kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

Neraca Percobaan / Neraca Saldo

1 Neraca Percobaan

Laporan ini menampilkan saldo awal, mutasi dan saldo akhir untuk masing-

masing akun detail pada Chart of Account dalam rentang waktu atau periode

tertentu.
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Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
neraca percobaan dalam rentang tanggal tertentu dengan mengklik pada
opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan

tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.
4 Laporan Trial Balance |
@ Periode Januari 2015 -
) Tanggal 01/01/2015 s/d |31/01/2015

No.Perkiraan 01-00-00-000 [-4] s/d  09-20-00-000 [

[ 7angan tampilkan yang tidak ada mutasi dan saldonya nol
[ Gunakan Mama Alias sebagai Nama Perkiraan

_:]Prexiew | !j Cancel |
[




e No. Perkiraan : tentukan rentang Nomor Perkiraan yang ingin
ditampilkan dengan mengetikkan Nomor Perkiraan pada kedua field
yang ada atau gunakan bantuan tombol Lookup untuk memunculkan
form Lookup Perkiraan sebagai bantuan dalam mencari Nomor
Perkiraan yang diinginkan.

e Jangan tampilkan yang tidak ada mutasi dan saldonya nol : klik
checkbox ini hingga tercentang apabila tidak ingin menampilkan akun
yang tidak ada saldo dan mutasinya.

¢ Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.5.2 Neraca Saldo

Laporan ini menampilkan saldo debit atau saldo kredit untuk masing-masing

akun detail pada Chart of Account per tanggal tertentu.

e Per Tanggal : ketik tanggalnya dengan format dd/mm/yy (2 digit
tanggal, bulan dan tahun) atau klik tombol drop-down untuk
memunculkan bantuan kalender.

e No. Perkiraan : tentukan rentang Nomor Perkiraan yang ingin
ditampilkan dengan mengetikkan Nomor Perkiraan pada kedua field
yang ada atau gunakan bantuan tombol Lookup untuk memunculkan
form Lookup Perkiraan sebagai bantuan dalam mencari Nomor

Perkiraan yang diinginkan.
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4 Laporan Neraca Saldo e

Per Tanggal B1/01/2015 |Z|

Mo.Perkiraan  01-00-00-000 [ sfd  03-20-00-000 [

[ 7angan tampilkan yang tidak ada saldenya
[7] Gunakan Mama Alias sebagai Mama Perkiraan

_:]Pre!iew | Kj Cancel |
L

e Jangan tampilkan yang tidak ada saldonya : klik checkbox ini hingga
tercentang apabila tidak ingin menampilkan akun yang tidak ada
saldonya.

¢ Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.
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7.5.3 Saldo Account G/L

Laporan ini menampilkan saldo akun pada Chart of Account per tanggal
tertentu.

Per Tanggal : ketik tanggalnya dengan format dd/mm/yy (2 digit
tanggal, bulan dan tahun) atau klik tombol drop-down untuk

memunculkan bantuan kalender.

4 Laporan Saldo Account G/L ]

Per Tanggal B1/01/2015 |Z|

No.Perkiraan  01-00-00-000 [ s/ 03-20-00-000 [

[ 7angan tampilkan yang tidak ada saldenya
[] Gunakan Nama Alias sebagai Nama Perkiraan

_:]Pregiew | Kj Cancel |
[

No. Perkiraan : tentukan rentang Nomor Perkiraan yang ingin
ditampilkan dengan mengetikkan Nomor Perkiraan pada kedua field
yang ada atau gunakan bantuan tombol Lookup untuk memunculkan
form Lookup Perkiraan sebagai bantuan dalam mencari Nomor
Perkiraan yang diinginkan.

Jangan tampilkan yang tidak ada saldonya : klik checkbox ini hingga
tercentang apabila tidak ingin menampilkan akun yang tidak ada
saldonya.

Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda

menginput Chart of Account.
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e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.

7.6 Laporan Perubahan Modal

Laporan ini menampilkan laporan perubahan modal pada periode tertentu

atau dalam rentang periode tertentu.

T3 Laporan Perubahan Modal |
@ Periode Januari 2015 v [l fear To Date
) DariPeriode | Jaruari 2015 sfd | Januari 2015

_:]Pre!ievh | Kj Cancel |

e Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
tombol drop-down pada combobox disebelahnya.

e Tampilkan juga YTD : jika anda memilih menampilkan laporan
perubahan modal pada periode tertentu, anda juga dapat menampilkan
laporan perubahan modal dari awal tahun buku sampai periode
dimaksud (Year to Date) dengan mencentang checkbox ini.

e  Dari Periode : sebagai alternatif dari memilih periode tertentu, anda bisa
menampilkan laporan perubahan modal dalam rentang periode tertentu
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7.7

dengan mengklik pada opsi ini kemudian pilih periode awal dan periode
akhirnya dengan mengklik tombol drop-down yang ada.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

Buku Kas / Bank

Buku Kas / Bank menampilkan aktifitas atau mutasi yang terjadi pada akun

Kas / Bank berikut saldonya selama periode atau rentang waktu tertentu.

T4 Buku Kas / Bank X
@ Periode Januari 2015 hd
) Tanggal 01/01/2015 sfd  [31/01/2015

Akun Kas / Bank | Lvtg

Jangan tampilkan Mo. Jurnal tetapi tampilkan No. Referensinya
[T Gunakan Mama Alias sebagai Mama Perkiraan

| _:]Plexiew | | Kj Lancel |

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
Buku Kas / Bank dalam rentang tanggal tertentu dengan mengklik pada
opsi ini kemudian ketik rentang tanggalnya pada kedua field
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disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e Akun Kas / Bank : pilih akun Kas atau Bank yang ingin ditampilkan
laporannya dengan mengklik pada field ini atau tombol drop-downnya.

¢ Jangan tampilkan No. Jurnal tetapi tampilkan No. Referensinya : setiap
transaksi di dalam Accpro mempunyai Kode tersendiri dan No. Trs yang
otomatis digenerate oleh program. Selain itu user juga diberikan ruang
atau fasilitas untuk memasukkan No. Referensinya sendiri. Kalau anda
lebih suka menampilkan No. Referensi ketimbang No. Jurnal yang
berupa Kode dan No. Trs yang digenerate oleh program maka biarkan
checkbox ini dalam keadaan tercentang.

¢ Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.
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7.8

Laporan Arus Kas

Laporan ini menampilkan arus kas atau Cash Flow pada periode atau rentang

periode tertentu.

T4 Laporan Arus Kas X
@ Periode Januari 2015 =[] Tampilkan juga YTD
) DariPeriede | Januari 2015 sfd | Januari 2015

[ Gunakan Mama Alias sebagai Nama Perkiraan

_:] Preview Kj Cancel
o | |

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
tombol drop-down pada combobox disebelahnya.

Tampilkan juga YTD : jika anda memilih menampilkan arus kas pada
periode tertentu, anda juga dapat menampilkan arus kas dari awal tahun
buku sampai periode dimaksud (Year to Date) dengan mencentang
checkbox ini.

Dari Periode : sebagai alternatif dari memilih periode tertentu, anda bisa
menampilkan arus kas dalam rentang periode tertentu dengan mengklik
pada opsi ini kemudian pilih periode awal dan periode akhirnya dengan
mengklik tombol drop-down yang ada.

Gunakan Nama Alias sebagai Nama Perkiraan : checkbox ini hanya
muncul apabila fitur terkait hal ini diaktifkan melalui menu Setup
Preferensi. Klik checkbox ini jika anda ingin Nama Perkiraan ditampilkan
dalam Nama Aliasnya. Nama Alias adalah nama lain untuk Nama
Perkiraan, mungkin dalam bahasa kedua misalnya bahasa Inggris yang
anda tentukan untuk masing-masing perkiraan pada saat anda
menginput Chart of Account.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran

kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
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kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.9 Laporan Hutang
7.9.1 Laporan Umur Hutang

Analisa umur hutang apakah belum jatuh tempo (sedang berjalan) atau sudah
melebihi jatuh tempo dengan umur tertentu akan ditampilkan pada laporan
ini. Default yang diberikan Accpro (apabila tidak dirubah) adalah 0 — 30 hari,
31 - 60 hari, 91 - 120, 121 - 150 hari dan > 150 hari. Anda bisa merubah range
atau rentang umur hutang melalui menu File > Setup Preferensi pada tab
Profil.

3 Laporan Umur Hutang (]

Jenis Laporan
@ Terperind

_) Rekapitulasi per Supplier

Per Tanggal |31/01/2015 E

Supplier < Semua > -

_:]Pre!iew | Kj Cancel |

s

e Jenis Laporan:
0 Terperinci : pilih opsi ini jika ingin menampilkan laporan umur
hutang secara terperinci, yaitu akan ditampilkan invoice-invoice

mana saja yang masih outstanding (belum lunas)
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0 Rekapitulasi per Supplier : apabila anda memilih opsi ini, maka
hanya ditampilkan total hutang yang masih belum lunas untuk
masing-masing supplier menurut umurnya.

Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung

dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol

drop-down untuk memunculkan kalender.

Supplier : pilih < Semua > kalau ingin menampilkan laporan Umur

Hutang untuk semua supplier yang ada saldo Hutangnya per tanggal

dimaksud. Tetapi apabila hanya ingin menampilkan supplier tertentu

maka pilih suppliernya dengan mengklik pada tombol drop-downnya.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa

dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan

ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

Tombol Cancel : membatalkan menampilkan laporan.

7.9.2 Laporan Kartu Hutang

T Laporan Kartu A/P (X
@ Periode Januari 2015 -
“) Tanggal [01/01/2015 s/d [31/01/2015
Supplier < Semua = -

Bila tidak ada Saldo Awal dan transaksi jangan ditampilkan

=] Preview | I cancel |
5

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan kartu hutang dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
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tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e Supplier : pilih < Semua > kalau ingin menampilkan laporan Kartu
Hutang untuk semua supplier yang ada. Tetapi apabila hanya ingin
menampilkan supplier tertentu maka pilih suppliernya dengan mengklik
pada tombol drop-downnya.

e Bila tidak ada Saldo Awal dan transaksi jangan ditampilkan : klik
checkbox ini hingga tidak tercentang apabila tidak ingin menampilkan
Supplier yang tidak ada saldo awal dan transaksinya dalam periode atau
rentang tanggal dimaksud.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.9.3 Laporan Hutang per Invoice

Hutang kepada Supplier untuk masing-masing Invoice Pembelian yang
masih outstanding (belum lunas) per tanggal tertentu akan ditampilkan pada
laporan ini dengan dikelompokkan menurut Supplier, kemudian juga

dikelompokkan lagi menurut Valutanya.

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol

drop-down untuk memunculkan kalender.
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1 Hutang per Invoice X

Per Tanggal B1/01/15 El

Supplier < Semua > -

[ Tampilkan Detail Transaksi & Histori Pelunasan

_:] Preview [:} | Kj Cancel |

Supplier : pilih < Semua > kalau ingin menampilkan laporan untuk
semua supplier yang ada outstanding Invoicenya per tanggal dimaksud.
Tetapi apabila hanya ingin menampilkan supplier tertentu maka pilih
suppliernya dengan mengklik pada tombol drop-downnya.

Tampilkan Detail Transaksi & Histori Pelunasan : apabila anda ingin
mengetahui juga detail transaksi Invoice yang bersangkutan dan juga
histori pelunasan (apabila ada, tentu saja baru dilunasi sebagian karena
kalau telah dilunasi seluruhnya, Invoice ini tidak akan ditampilkan lagi
pada laporan ini), maka centang checkbox ini.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.
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7.9.4 Laporan Saldo Hutang

Laporan ini akan menampilkan Saldo Hutang untuk masing-masing Supplier

per tanggal tertentu.

{1 saldo Hutang S|

PerTanggal 10115 [+]

Janagan Tampilkan yang tidak ada Saldonya

_:] Preview Kj Cancel
. | |

= LA

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol
drop-down untuk memunculkan kalender.

¢ Jangan Tampilkan yang tidak ada Saldonya : dengan mencentang
checkbox ini maka hanya Supplier yang masih mempunyai saldo hutang
per tanggal dimaksud yang akan ditampilkan.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.
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7.10 Laporan Piutang
7.10.1 Laporan Umur Piutang

Analisa umur piutang apakah belum jatuh tempo (sedang berjalan) atau
sudah melebihi jatuh tempo dengan umur tertentu akan ditampilkan pada
laporan ini. Default yang diberikan Accpro (apabila tidak dirubah) adalah 0 —
30 hari, 31 — 60 hari, 91 — 120, 121 — 150 hari dan > 150 hari. Anda bisa
merubah range atau rentang umur piutang melalui menu File > Setup

Preferensi pada tab Profil.

4 Laporan Umur Piutang |

Jenis Laporan

'@ Per Customer _ Per Salesman

Per Tanggal  |31/01/2015 E|

Salesman < Semua >

Customer < Semua > -
Detail { Summary

@) Terperindg

_ Rekapitulasi per Customer

Rekapitulasi per Salesman

_:] Pre!iewL\) | :j Cancel |

e Jenis Laporan:

0 Per Customer : pilih opsi ini bila ingin menampilkan laporan yang
dikelompokkan menurut customernya

0 Per Salesman : pilih opsi ini bila ingin menampilkan laporan yang
dikelompokkan menurut Salesman dan kemudian dikelompokkan
lagi menurut customernya.

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol
drop-down untuk memunculkan kalender.

e Salesman : apabila anda memilih opsi Per Salesman, maka anda bisa

memilih apakah akan menampilkan ke semua Salesman yang ada atau
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hanya Salesman tertentu dengan mengklik pada field ini atau tombol

drop-downnya.

Customer : pilih < Semua > kalau ingin menampilkan laporan Umur

Piutang untuk semua customer yang ada saldo Piutangnya per tanggal

dimaksud. Tetapi apabila hanya ingin menampilkan customer tertentu

maka pilih customernya dengan mengklik pada tombol drop-downnya.

Detail / Summary :

0 Terperinci : pilih opsi ini jika ingin menampilkan laporan umur
piutang secara terperinci, yaitu akan ditampilkan invoice-invoice
mana saja yang masih outstanding (belum lunas)

0 Rekapitulasi per Customer : apabila anda memilih opsi ini, maka
hanya ditampilkan total piutang yang masih belum lunas untuk
masing-masing customer menurut umurnya.

0 Rekapitulasi per Salesman : apabila anda memilih opsi Per
Salesman pada jenis laporan di atas, anda bisa memilih opsi ini
apabila hanya ingin menampilkan total piutang yang masih belum
lunas untuk masing-masing salesman menurut umurnya.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa

dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan

ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

Tombol Cancel : membatalkan menampilkan laporan.

7.10.2 Laporan Kartu Piutang

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan kartu piutang dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.
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{'.i_ Laporan Kartu A/R &

@ Periode Januari 2015 -
) Tanggal  |01/01/2015 sid  |31/01/2015
Customer < Semua > -

Bila tidak ada Saldo Awal dan transaksi jangan ditampilkan

_:]Pregie% | Kj Cancel |

Customer : pilih < Semua > kalau ingin menampilkan laporan Kartu
Piutang untuk semua customer yang ada. Tetapi apabila hanya ingin
menampilkan customer tertentu maka pilih customernya dengan
mengklik pada tombol drop-downnya.

Bila tidak ada Saldo Awal dan transaksi jangan ditampilkan : klik
checkbox ini hingga tidak tercentang apabila tidak ingin menampilkan
Customer yang tidak ada saldo awal dan transaksinya dalam periode
atau rentang tanggal dimaksud.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

7.10.3 Laporan Piutang per Invoice

Piutang Customer untuk masing-masing Invoice Penjualan (Sales Invoice)

yang masih outstanding (belum lunas) per tanggal tertentu akan ditampilkan
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pada laporan ini dengan dikelompokkan menurut Customer, kemudian juga

dikelompokkan lagi menurut Valutanya.

L1 Piutang per Invoice ]

Per Tanggal |[31/01/15 El

Customer < Semua > -

[ Tampilkan Detail Transaksi & Histori Pelunasan

_:] Preview % | Kj Cancel |

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol
drop-down untuk memunculkan kalender.

e  Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada outstanding Invoicenya per tanggal dimaksud.
Tetapi apabila hanya ingin menampilkan customer tertentu maka pilih
customernya dengan mengklik pada tombol drop-downnya.

e Tampilkan Detail Transaksi & Histori Pelunasan : apabila anda ingin
mengetahui juga detail transaksi Invoice yang bersangkutan dan juga
histori pelunasan (apabila ada, tentu saja baru dilunasi sebagian karena
kalau telah dilunasi seluruhnya, Invoice ini tidak akan ditampilkan lagi
pada laporan ini), maka centang checkbox ini.

¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.
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¢ Tombol Cancel : membatalkan menampilkan laporan.

7.10.4 Laporan Saldo Piutang

Apabila anda ingin mengetahui saldo piutang per tanggal tertentu, maka
dapat menggunakan laporan ini sebagai alternatif yang lebih ringkas
ketimbang laporan umur piutang atau laporan kartu piutang. Berbeda
dengan saldo piutang pada Daftar Kontak, Saldo & Kartu Hutang / Piutang
dimana saldo piutang yang ditampilkan adalah posisi akhir saldo piutang,

maka pada laporan ini bisa ditampilkan saldo piutang per tanggal tertentu.

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol

drop-down untuk memunculkan kalender.

L1 Saldo Piutang [t

Per Tanggal [12/02/18 El

Grup [{ Semua > -

Jangan Tampilkan yang tidak ada Saldonya
[ kelompokkan menurut Grupnya

_:] Preview Ej Cancel
h | |

e  Grup : pilih < Semua > kalau ingin menampilkan laporan Saldo Piutang
untuk semua grup customer yang ada. Tetapi apabila hanya ingin
menampilkan grup tertentu maka pilih grupnya dengan mengklik pada
tombol drop-downnya.

e Jangan tampilkan yang tidak ada saldonya : klik checkbox ini hingga
tidak tercentang apabila anda juga ingin menampilkan customer yang
tidak ada saldo piutangnya.

¢ Kelompokkan menurut grupnya : klik checkbox ini hingga tercentang

apabila anda ingin mengelompokkan customer menurut grupnya.
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e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.

7.11 Laporan Saldo Barang & Kartu Stock
7.11.1 Laporan Saldo Barang

Laporan ini menampilkan saldo barang per tanggal tertentu, bisa ditampilkan

berikut nilainya.

Per Tanggal B1/01/15 El

[ Grup / Kelompok Barang tertentu

Jangan Tampilkan yang tidak ada Saldonya
[ 3angan Tampilkan Nilai

[T Untuk keperluan Stock Opname

[ kelompokkan menurut Grupnya

jPrEgiewh | Kj Cancel |

e Per Tanggal : tentukan tanggalnya dengan mengetikkannya langsung
dengan format dd/mm/yy (2 digit tanggal, bulan, tahun) atau klik tombol
drop-down untuk memunculkan kalender.
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Grup / Kelompok Barang tertentu : biarkan checkbox ini dalam keadaan
tidak tercentang apabila tidak ingin menampilkan hanya kelompok
barang tertentu, sebaliknya centanglah checkbox ini, kemudian pilih
grup atau kelompok barangnya. Dalam keadaan tercentang, maka anda
bisa memilih atau merubah grup / kelompok barang yang ingin
ditampilkan dengan klik pada field di sampingnya atau tombol drop-
downnya.

Jangan Tampilkan yang tidak ada Saldonya : kalau checkbox ini
tercentang, maka hanya barang yang mempunyai saldo yang
ditampilkan.

Jangan Tampilkan Nilai : jika ingin ditampilkan berikut nilainya maka
biarkan checkbox ini dalam keadaan tidak tercentang.

Untuk keperluan Stock Opname : dengan mencentang checkbox ini
maka laporan yang ditampilkan adalah dalam bentuk form untuk
keperluan stock opname dimana ada kolom Stock Taking yang dapat
diisi hasil stock taking di lapangan. Apabila multi gudang, maka dengan
mencentang checkbox ini, anda harus menentukan gudang tertentu, jadi
tidak bisa untuk semua gudang.

Kelompokkan menurut Grupnya : kalau ingin laporan ditampilkan
mengelompok berdasarkan Grup Barangnya, maka centang checkbox ini.
Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.
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7.11.2 Rekapitulasi Kartu Stock

Laporan ini menampilkan saldo awal barang, rekapitulasi kuantitas masuk

dan kuantitas keluar serta saldo akhir barang pada periode tertentu.

@ Periode  Januari 2015 -

() Tanggal |01/01/2015 sfd [31/01/2015

Product / Barang
@ Semua
() Grup [ Kelompok Tertentu
() Product Tertentu

Urutkan berdasarkan
@ Kode Barang () Nama Barang

[ Jangan tampilkan apabila tidak ada saldo dan mutasi

JPrEE‘EWI}@ | lj Cancel ‘

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

o Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan rekapitulasi kartu stock dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e Product/Barang:

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

0 Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan

dimunculkan oleh program sehingga anda bisa memilih barangnya.
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Anda juga bisa mengklik tombol Lookup yang ada apabila perlu
menampilkan form Lookup Barang secara manual.

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

e Jangan tampilkan apabila tidak ada mutasi dan saldo : apabila anda
ingin hanya barang-barang yang mempunyai saldo dan mutasi pada
periode dimaksud saja yang ditampilkan, maka centang checkbox ini.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.

7.11.3 Kartu Stock

Laporan ini menampilkan kartu stock untuk periode tertentu dimana masing-

masing barang memiliki lembar yang terpisah satu sama lain.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan rekapitulasi kartu stock dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.
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(@ Periode  Januari 2015 -

(") Tanggal 01/01/2015 sfd |31/01/2015

Product | Barang
@) Semua
() Grup [ Kelompok Tertentu
() Product Tertentu

Urutkan berdasarkan
(@ Kode Barang () Nama Barang

_']Prez\ew | fj Cancel ‘

[

e  Product/Barang:

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

0 Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan
dimunculkan oleh program sehingga anda bisa memilih barangnya.
Anda juga bisa mengklik tombol Lookup yang ada apabila perlu
menampilkan form Lookup Barang secara manual.

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk

semua laporan lain (tidak termasuk printout transaksi) selama anda
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belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.11.4 Analisa Saldo Barang

Laporan ini menampilkan analisa saldo barang per tanggal hari ini
menyangkut saldo barang ditangan dan kuantitas dalam pemesanan kepada
supplier (Qty PO) dan kuantitas barang yang sudah dipesan oleh customer
(Qty SO).

Per Tanggal 31/01/2015

[ Grup / Kelompak Barang tertentu

Jangan Tampilkan yang tidak ada Saldonya
[ kelompokkan menurut Gruprya

_']Preziew[\ | Kj Cancel |

e  Per Tanggal : khusus laporan ini tanggal otomatis ditampilkan sebagai
tanggal hari ini dan tidak bisa diubah/diedit.

e  Grup / Kelompok Barang tertentu : biarkan checkbox ini dalam keadaan
tidak tercentang apabila tidak ingin menampilkan hanya kelompok
barang tertentu, sebaliknya centanglah checkbox ini, kemudian pilih
grup atau kelompok barangnya. Dalam keadaan tercentang, maka anda
bisa memilih atau merubah grup / kelompok barang yang ingin
ditampilkan dengan klik pada field ini atau klik tombol drop-downnya.
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e Jangan Tampilkan yang tidak ada Saldonya : kalau checkbox ini
tercentang, maka hanya barang yang mempunyai saldo yang
ditampilkan.

¢ Kelompokkan menurut Grupnya : kalau ingin laporan ditampilkan
mengelompok berdasarkan Grup Barangnya, maka centang checkbox ini.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.12 Laporan Mutasi Barang
7.12.1 Rekapitulasi per Jenis Transaksi

Laporan ini menampilkan saldo awal barang, rekapitulasi kuantitas mutasi
barang menurut jenis transaksinya yaitu Pembelian, Sales Return,
Assembling/Job Order, Penjualan/Pengiriman Barang, Adjustment/Stock
Transfer dan Purchase Return serta saldo akhir disertai nilai masing-masing

dalam rentang periode tertentu.
7.12.2 Per Jenis Transaksi (FIFO)

Laporan ini hanya aktif jika Metode Harga Pokok Penjualan yang digunakan
adalah FIFO (First In First Out) yang ditentukan melalui Setup Preferensi.
Laporan ini menampilkan saldo awal barang, kuantitas mutasi barang
menurut jenis transaksinya yaitu Pembelian, Sales Return, Assembling/Job
Order, Penjualan/ Pengiriman Barang, Adjustment/Stock Transfer dan
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Purchase Return serta saldo akhir disertai nilai masing-masing dalam rentang

periode tertentu sesuai prinsip FIFO.

Periode anuari 2015} M

Product / Barang
@) Semua
() Grup / Kelompok Tertentu
() Product Tertentu

Urutkan berdasarkan

(@) Kode Barang () Nama Barang

_']Pre!iew | !jganoel |

s

e Periode : pilih Periodenya dengan mengklik pada tombol drop-

downnya.

e Product/Barang:

[0}

Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan
dimunculkan oleh program sehingga anda bisa memilih barangnya.
Anda juga bisa mengklik tombol Lookup yang ada apabila perlu

menampilkan form Lookup Barang secara manual.

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin

ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin

ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama

Barang.
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e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

e  Tombol Cancel : membatalkan menampilkan laporan.

7.12.3 Histori Barang Masuk

Laporan ini menampilkan analisa histori barang masuk untuk periode
tertentu. Barang ditampilkan menurut kelompok (grup) barangnya dan
masing-masing barang akan ditampilkan histori transaksi yang menyangkut
kuantitas penambahan barang tersebut ke dalam stock berikut satuan
transaksi aslinya dan harga satuannya dan kemudian juga ditampilkan
konversi ke dalam satuan dasarnya (Satuan Inventorynya) baik kuantitas

maupun harga pokoknya.

4 Laporan Histori Barang Masu‘ (=

@ Periode  Januari 2015 -

() Tanggal [01/01/2015 sfd [31/01/2015

Product [ Barang
@ Semua
() Grup / Kelompok Tertentu
() Product Tertentu

Urutkan berdasarkan

(@) Kode Barang (7) Nama Barang

_']Pregiewb) | Kj Cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan rekapitulasi kartu stock dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
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tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.

Product / Barang :

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

0 Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan
dimunculkan oleh program sehingga anda bisa memilih barangnya.
Anda juga bisa mengklik tombol Lookup yang ada apabila perlu
menampilkan form Lookup Barang secara manual.

Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.
Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

7.12.4 Histori Barang Keluar

Laporan ini menampilkan analisa histori barang keluar untuk periode

tertentu. Barang ditampilkan menurut kelompok (grup) barangnya dan

masing-masing barang akan ditampilkan histori transaksi yang menyangkut
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kuantitas pengurangan barang tersebut dari stock berikut satuan transaksi
aslinya dan harga satuannya dan kemudian juga ditampilkan konversi ke
dalam satuan dasarnya (Satuan Inventorynya) baik kuantitas maupun harga

pokoknya.

4 Laporan Histori Barang Keluar‘ [

@ Periode  Januari 2015 -

(©) Tanggal [01/01/2015 sfd  [31/01/2015

Product [ Barang
@ Semua
() Grup / Kelompok Tertentu
(7 Product Tertentu

Urutkan berdasarkan

(@ Kode Barang () Nama Barang

_']Pregiew[:} | 5 cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan
laporan rekapitulasi kartu stock dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e  Product/Barang:

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

0 Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan

dimunculkan oleh program sehingga anda bisa memilih barangnya.
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Anda juga bisa mengklik tombol Lookup yang ada apabila perlu
menampilkan form Lookup Barang secara manual.

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.13 Laporan Pembelian
7.13.1 Purchase Order (PO) per Transaksi

Laporan ini menampilkan Purchase Order (PO) pada periode atau rentang

waktu tertentu ditampilkan menurut urutan tanggal transaksinya.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.
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@ Periode  Januari 2015 -
) Tanggal |01/01/2015 s/d |31/01/2015
Supplier < Semua = -

Item di Master Barang & Jasa
Item Lainain

[ Group by Supplier

Tampilkan Detail Transaksi

_']Pregiew[:} | Kj Cancel |

Supplier : pilih < Semua > kalau ingin menampilkan laporan untuk
semua supplier yang ada. Tetapi apabila hanya ingin menampilkan
supplier tertentu maka pilih suppliernya dengan mengklik pada tombol
drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan menyangkut item barang yang ada di
Master Barang & Jasa. (Untuk varian Accpro Trada karena memang hanya PO
yang menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi PO Lain-lain pada
modul Purchase Order, maka dengan mencentang checkbox ini PO jenis
ini akan ikut ditampilkan pada laporan. (Untuk varian Accpro Trada karena
opsi PO Lain-lain tidak tersedia dan hanya PO yang menyangkut barang yang
ada di Master Barang & Jasa saja yang dimungkinkan, maka checkbox ini tidak
ditampilkan)

Group by Supplier : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan PO menurut Suppliernya.

Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
pembelian beserta kuantitas dan harga satuannya.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

Tombol Cancel : membatalkan menampilkan laporan.
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7.13.2  Purchase Order (PO) per Barang

Laporan ini menampilkan Purchase Order (PO) menurut barang atau item
pembeliannya, jadi fokusnya adalah pada barangnya. Untuk masing-masing
barang ditampilkan rincian Tanggal PO, No. PO, Supplier, Qty Order, Qty

Diterima dan Harga Satuan serta Nilainya.

@ Periode  Januari 2015 -
() Tanggal |01/01/2015 sfd  [31/01/2015
Supplier < Semua -

Product | Barang [ Item
@) Semua
Item di Master Barang & Jasa
Item Laindain
[ Dikelompokkan menurut Grup Barang

() Grup / Kelompok Tertentu
() Product Tertentu

() Ttem Lain-ain

Urutkan berdasarkan

@ Kode Barang () Nama Barang

_‘]Preziawll} | Kj Cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan
laporan PO per Barang dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e Supplier : pilih < Semua > kalau ingin menampilkan laporan untuk
semua supplier yang ada. Tetapi apabila hanya ingin menampilkan
supplier tertentu maka pilih suppliernya dengan mengklik pada tombol
drop-downnya.

e Product/Barang/Item:

0 Semua : pilih opsi ini jika ingin menampilkan semua item pembelian
yang ada pada rentang periode yang telah dipilih.
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* Item di Master Barang & Jasa : jika anda memilih Semua, maka
masih bisa menentukan apakah termasuk item di Master Barang
& Jasa dengan mencentang atau tidak checkbox ini. (Untuk
varian Accpro Trada karena memang hanya PO yang menyangkut
barang yang ada di Master Barang & Jasa saja yang dimungkinkan,
maka checkbox ini tidak ditampilkan)
= Item Lain-lain : dengan mencentang checkbox ini berarti anda
juga ingin menampilkan item pembelian pada PO Lain-lain.
(Untuk varian Accpro Trada karena opsi PO Lain-lain tidak tersedia
dan hanya PO yang menyangkut barang yang ada di Master Barang
& Jasa saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)
* Dikelompokkan menurut Grup Barang : centang checkbox ini
jika ingin laporan ditampilkan menurut Kelompok Barangnya.
Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.
Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian
pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.
Item Lain-lain : sedangkan jika hanya ingin menampilkan item
pembelian tertentu pada PO Lain-lain maka pilih opsi ini kemudian
pilih itemnya. (Untuk varian Accpro Trada karena opsi PO Lain-lain tidak
tersedia dan hanya PO yang menyangkut barang yang ada di Master
Barang & Jasa saja yang dimungkinkan, maka checkbox ini tidak
ditampilkan)

Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin

ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin

ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama

Barang.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa

dicetak ke printer. Secara default program akan mengasumsikan anda

menggunakan ukuran kertas A4, apabila anda ingin menggunakan
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ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.13.3 Pembelian per Transaksi

Laporan ini menampilkan transaksi pembelian yang terjadi pada periode atau
rentang waktu tertentu ditampilkan menurut urutan tanggal transaksinya.

@ Periode  Januari 2015 -

(") Tanggal |01/01/2015 sfd |31/01/2015
Supplier < Semua = -

Item di Master Barang & Jasa
Item Lain-ain

[ Group by Supplier

Tampilkan Detail Transaksi

_L] Preview I:é | !j Cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan
laporan pembelian dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.
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Supplier : pilih < Semua > kalau ingin menampilkan laporan pembelian
untuk semua supplier yang ada. Tetapi apabila hanya ingin
menampilkan supplier tertentu maka pilih suppliernya dengan mengklik
pada tombol drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan pembelian menyangkut item barang
yang ada di Master Barang & Jasa. (Untuk varian Accpro Trada karena
memang hanya pembelian yang menyangkut barang yang ada di Master Barang
& Jasa saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi Pembelian Lain-lain
pada modul Purchase Invoice, maka dengan mencentang checkbox ini
pembelian jenis ini akan ikut ditampilkan pada laporan pembelian.
(Untuk varian Accpro Trada karena opsi Pembelian Lain-lain tidak tersedia dan
hanya pembelian yang menyangkut barang yang ada di Master Barang & Jasa
saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Group by Supplier : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan pembelian menurut Suppliernya.

Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
pembelian beserta kuantitas dan harga satuannya.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

Tombol Cancel : membatalkan menampilkan laporan.

7.13.4 Pembelian per Barang

Laporan ini menampilkan pembelian menurut barang atau item

pembeliannya, jadi fokusnya adalah pada barangnya. Untuk masing-masing

barang ditampilkan rincian tanggal transaksi pembeliannya, nomor transaksi

pembelian dan invoicenya, supplier, qty dan harga satuan serta nilainya.
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.1 Laporan Pembelian per Bam_ i

@ Periode Januari 2015 -
() Tanggal 01/01/2015 sfd [31/01/2015
Supplier < Semua = -

Product [ Barang [ Item
@ Semua
Ibem di Master Barang & Jasa
Item Lain-ain
[ Dikelompokkan menurut Grup Barang

() Grup / Kelompok Tertentu

() Product Tertentu

() Item Lain-ain

Urutkan berdasarkan

@ Kode Barang (7) Nama Barang

_']Pregiew % | rj Cancel |

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan Pembelian per Barang dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.
Supplier : pilih < Semua > kalau ingin menampilkan laporan pembelian
untuk semua supplier yang ada. Tetapi apabila hanya ingin
menampilkan supplier tertentu maka pilih suppliernya dengan mengklik
pada tombol drop-downnya.
Product / Barang / Item :
0 Semua : pilih opsi ini jika ingin menampilkan semua item pembelian
yang ada pada rentang periode yang telah dipilih.
= Item di Master Barang & Jasa : jika anda memilih Semua, maka
masih bisa menentukan apakah termasuk item di Master Barang
& Jasa dengan mencentang atau tidak checkbox ini. (Untuk
varian Accpro Trada karena memang hanya pembelian yang
menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)
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* Item Lain-lain : dengan mencentang checkbox ini berarti anda
juga ingin menampilkan item pembelian pada Pembelian Lain-
lain. (Untuk varian Accpro Trada karena opsi Pembelian Lain-lain
tidak tersedia dan hanya pembelian yang menyangkut barang yang ada
di Master Barang & Jasa saja yang dimungkinkan, maka checkbox ini
tidak ditampilkan)

= Dikelompokkan menurut Grup Barang : centang checkbox ini
jika ingin laporan ditampilkan menurut Kelompok Barangnya.

0 Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian
pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.

0 Item Lain-lain : sedangkan jika hanya ingin menampilkan item
pembelian tertentu pada Pembelian Lain-lain maka pilih opsi ini
kemudian pilih itemnya. (Untuk varian Accpro Trada karena opsi
Pembelian Lain-lain tidak tersedia dan hanya pembelian yang menyangkut
barang yang ada di Master Barang & Jasa saja yang dimungkinkan, maka
checkbox ini tidak ditampilkan)

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda

belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
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berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.

7.13.5 Retur Pembelian Per Transaksi

Laporan ini menampilkan retur pembelian yang terjadi pada periode atau

rentang waktu tertentu ditampilkan menurut urutan tanggal transaksinya.

{21 Laporan Retur Pembelian Per Transale’.i_‘ Lﬂ

@ Periode  Januari 2015 -

() Tanggal [01/01/2015 sid [31/01/2015

Supplier < Semua > -

] Group by Supplier
Tampilkan Detail Transaksi

J Preview % | Kj Cancel ‘

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan retur pembelian dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

Supplier : pilih < Semua > kalau ingin menampilkan laporan untuk
semua supplier yang ada. Tetapi apabila hanya ingin menampilkan
supplier tertentu maka pilih suppliernya dengan mengklik pada tombol
drop-downnya.

Group by Supplier : klik checkbox ini hingga tercentang apabila ingin

mengelompokkan laporan menurut Suppliernya.
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e  Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian
barang beserta kuantitas dan harga satuannya.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

e Tombol Cancel : membatalkan menampilkan laporan.

7.13.6 Retur Pembelian Per Barang

Laporan ini menampilkan retur pembelian menurut barangnya, jadi fokusnya
adalah pada barangnya. Untuk masing-masing barang ditampilkan rincian
tanggal transaksi, nomor transaksi dan referensinya, supplier, qty dan harga

satuan serta nilainya.

.1 Laporan Retur Pembelian per_Bamng_‘ ﬂ

@ Periode Januari 2015 -
) Tanggal 01012015 sid  [31/01/2015
Supplier < Semua = -

Product [ Barang
@) Semua
[ Dikelompokkan menurut Grup Barang
(71 Grup / Kelompok Tertentu

(7 Product Tertentu

Urutkan berdasarkan
(@) Kode Barang (7) Nama Barang

_']Pre!iew | Kj Cancel |

s

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan Retur Pembelian Per Barang dalam rentang tanggal tertentu
dengan mengklik pada opsi ini kemudian ketik rentang tanggalnya pada
kedua field disebelahnya dengan format dd/mm/yy (2 digit tanggal,
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bulan dan tahun) atau klik tombol drop-down untuk memunculkan

bantuan kalender.

Supplier : pilih < Semua > kalau ingin menampilkan laporan untuk

semua supplier yang ada. Tetapi apabila hanya ingin menampilkan

supplier tertentu maka pilih suppliernya dengan mengklik pada tombol
drop-downnya.

Product / Barang :

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada pada rentang periode yang telah dipilih.
= Dikelompokkan menurut Grup Barang : centang checkbox ini

jika ingin laporan ditampilkan menurut Kelompok Barangnya.

0 Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang, anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian
pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.

Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.
Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.
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7.14 Laporan Penjualan
7.14.1  Sales Order (SO) per Transaksi

Laporan ini menampilkan Sales Order (SO) pada periode atau rentang waktu

tertentu ditampilkan menurut urutan tanggal SOnya.

L3 Laporan Sales Order Per Tmrm e S

@ Periode  Januari 2015 -

) Tanggal [01/01/2015 sfd |31/01/2015

Customer < Semua > -
Status

ItEm di Master Barang & Jasa []1n Process

[¥] ttem Lain4ain [¥]Partial

|| Group by Customer Complete

Tampilkan Detail Transaksi Closed

_']Pregiew h | rj Cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik
tombol drop-down untuk memunculkan bantuan kalender.

e  Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

e Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin SO menyangkut item barang yang ada di Master Barang &
Jasa (SO pada umumnya) ikut ditampilkan pada laporan. (Untuk varian
Accpro Trada karena memang hanya SO yang menyangkut barang yang ada di
Master Barang & Jasa saja yang dimungkinkan, maka checkbox ini tidak
ditampilkan)
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e Item Lain-lain : apabila anda memanfaatkan opsi Penjualan Lain-lain
pada modul Sales Order, maka dengan mencentang checkbox ini, SO
untuk penjualan jenis ini akan ditampilkan pada laporan. (Untuk varian
Accpro Trada karena opsi Penjualan Lain-lain tidak tersedia dan hanya SO yang
menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)

e  Group by Customer : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan SO menurut Customernya.

e Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
penjualan beserta kuantitas dan harga satuannya.

e  Status : biarkan checkboxnya tercentang apabila ingin mengikutkan Sales
Order dengan status tertentu dalam laporan.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.2 Sales Order (SO) per Salesman

Laporan ini menampilkan SO dalam periode atau rentang waktu tertentu

yang dikelompokkan menurut Salesmannya.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.
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.1 Laporan Sales Order Per Salem ]

@ Periode  Januari 2015 -

() Tanggal |01/01/2015 sfd |31/01/2015

Salesman < Semua > -

Customer < 5emua > M
Status

| Ttem di Master Barang & Jasa

e 3 [#]1n Process

[¥] Ttem Lain4ain [¥]Partial

[~ Group by Customer Complete

Tampilkan Detail Transaksi Closed

_']Pregiew § | [j Cancel |

Salesman : pilih < Semua > jika ingin menampilkan laporan untuk
semua Salesman yang ada transaksinya atau pilih Salesmannya jika
hanya ingin menampilkan Salesman tertentu dengan mengklik tombol
drop-downnya.

Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan SO menyangkut item barang yang ada
di Master Barang & Jasa (SO pada umumnya). (Untuk varian Accpro Trada
karena memang hanya SO yang menyangkut barang yang ada di Master Barang
& Jasa saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi Penjualan Lain-lain
pada modul Sales Order, maka dengan mencentang checkbox ini
penjualan jenis ini akan ditampilkan pada laporan. (Untuk varian Accpro
Trada karena opsi Penjualan Lain-lain tidak tersedia dan hanya SO yang
menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)

Group by Customer : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan SO menurut Customernya.

Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item

penjualan beserta kuantitas dan harga satuannya.
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e  Status : biarkan checkboxnya tercentang apabila ingin mengikutkan Sales
Order dengan status tertentu dalam laporan.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.3 Sales Order (SO) per Barang

Laporan ini menampilkan SO menurut barang atau item penjualannya, jadi
fokusnya adalah pada barangnya. Untuk masing-masing barang ditampilkan
rincian Tanggal SO, No. SO, Customer, Qty Order, Qty Dikirim dan Harga
Satuan serta Nilainya.

EQ Laporan Sales Crder per Bamng‘ &1

@ Periode Januari 2015 -

() Tanggal 01/01/2015 sfd [31/01/2015
Customer < Semua > -
Salesman < 5emua = -

Product | Barang
@ Semua
Item di Master Barang & Jasa
Item Lain-ain
[ Dikelompokkan menurut Grup Barang

() Grup / Kelompok Tertentu

() Product Tertentu

() Item Lain-ain

Urutkan berdasarkan
(@ Kode Barang () Nama Barang

_']Pregiew | !jgancel |

[

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan Sales Order per Barang dalam rentang tanggal tertentu dengan

mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
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field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan

tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.

e  Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

e Salesman : pilih < Semua > jika laporan yang ditampilkan tidak
tergantung Salesmannya atau pilih Salesman tertentu jika hanya ingin
menampilkan laporan yang terkait dengan salesman tertentu.

e Product/Barang:

0 Semua : pilih opsi ini jika ingin menampilkan semua item penjualan
yang ada pada rentang periode yang telah dipilih.
= Item di Master Barang & Jasa : jika anda memilih Semua, maka

masih bisa menentukan apakah termasuk item di Master Barang
& Jasa dengan mencentang atau tidak checkbox ini. (Untuk
varian Accpro Trada karena memang hanya SO yang menyangkut
barang yang ada di Master Barang & Jasa saja yang dimungkinkan,
maka checkbox ini tidak ditampilkan)

* Item Lain-lain : dengan mencentang checkbox ini berarti anda
juga ingin menampilkan item penjualan pada SO dengan jenis
Penjualan Lain-lain. (Untuk varian Accpro Trada karena opsi
Penjualan Lain-lain tidak tersedia dan hanya SO yang menyangkut
barang yang ada di Master Barang & Jasa saja yang dimungkinkan,
maka checkbox ini tidak ditampilkan)

* Dikelompokkan menurut Grup Barang : centang checkbox ini
jika ingin laporan ditampilkan menurut Kelompok Barangnya.

0 Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan

item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian
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pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.

0 Item Lain-lain : sedangkan jika hanya ingin menampilkan item
penjualan tertentu pada SO dengan jenis Penjualan Lain-lain maka
pilih opsi ini kemudian pilih itemnya. (Untuk varian Accpro Trada
karena opsi Penjualan Lain-lain tidak tersedia dan hanya SO yang
menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.4 Penjualan per Transaksi

Laporan ini menampilkan transaksi penjualan yang terjadi pada periode atau

rentang waktu tertentu ditampilkan menurut urutan tanggal invoicenya.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan penjualan dalam rentang tanggal tertentu dengan mengklik pada

opsi ini kemudian ketik rentang tanggalnya pada kedua field
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disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.

.1 Laporan Penjualan Per Trans_ (-S|

@ Periode  Januari 2015 -
) Tanggal |01/01/2015 sfd [31/01/2015
Customer < Semua = -

Item di Master Barang & Jasa
Item Laindain

[ Group by Customer
Tampilkan Detail Transaksi
Jangan tampilkan HPP

=] Preview L\\, | S cancel |

Customer : pilih < Semua > kalau ingin menampilkan laporan penjualan
untuk semua customer yang ada. Tetapi apabila hanya ingin
menampilkan customer tertentu maka pilih customernya dengan
mengklik pada tombol drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan penjualan menyangkut item barang
yang ada di Master Barang & Jasa. (Untuk varian Accpro Trada karena
memang hanya penjualan yang menyangkut barang yang ada di Master Barang
& Jasa saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi Penjualan Lain-lain
pada modul Sales Invoice, maka dengan mencentang checkbox ini
penjualan jenis ini akan ditampilkan pada laporan penjualan. (Untuk
varian Accpro Trada karena opsi Penjualan Lain-lain tidak tersedia dan hanya
penjualan yang menyangkut barang yang ada di Master Barang & Jasa saja
yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Group by Customer : klik checkbox ini hingga tercentang apabila ingin

mengelompokkan penjualan menurut Customernya.
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e Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
penjualan beserta kuantitas dan harga satuannya.

e Jangan tampilkan HPP : kalau HPP tidak ingin muncul pada laporan
maka klik checkbox ini hingga tidak tercentang. Sebagai catatan,
checkbox ini tidak muncul untuk user yang pada saat Setup User tidak
diberikan hak untuk melihat HPP yaitu dengan mencentang checkbox
“Jangan tampilkan (sembunyikan) Harga Pokok Penjualan pada Laporan
/ Inquiry tertentu”.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.5 Penjualan per Salesman

Laporan ini menampilkan penjualan dalam periode atau rentang waktu

tertentu yang dikelompokkan menurut Salesmannya.

.1 Laporan Penjualan Per Salesm_ (eS|

@ Periode  Januari 2015 -

) Tanggal |01/01/2015 sid [3101/2015

Salesman < Semua = -

Customer < Semua > -

Item di Master Barang & Jasa
Item Lain-ain

[ Group by Customer
Tampilkan Detail Transaksi
Jangan tampilkan HPP

L Preview !j Cancel
=] N | |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
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Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan penjualan dalam rentang tanggal tertentu dengan mengklik pada
opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

Salesman : pilih < Semua > jika ingin menampilkan laporan untuk
semua Salesman yang ada transaksinya atau pilih Salesmannya jika
hanya ingin menampilkan Salesman tertentu dengan mengklik tombol
drop-downnya.

Customer : pilih < Semua > kalau ingin menampilkan laporan penjualan
untuk semua customer yang ada. Tetapi apabila hanya ingin
menampilkan customer tertentu maka pilih customernya dengan
mengklik pada tombol drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan penjualan menyangkut item barang
yang ada di Master Barang & Jasa. (Untuk varian Accpro Trada karena
memang hanya penjualan yang menyangkut barang yang ada di Master Barang
& Jasa saja yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi Penjualan Lain-lain
pada modul Sales Invoice, maka dengan mencentang checkbox ini
penjualan jenis ini akan ditampilkan pada laporan penjualan. (Untuk
varian Accpro Trada karena opsi Penjualan Lain-lain tidak tersedia dan hanya
penjualan yang menyangkut barang yang ada di Master Barang & Jasa saja
yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Group by Customer : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan penjualan menurut Customernya.

Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
penjualan beserta kuantitas dan harga satuannya.

Jangan tampilkan HPP : kalau HPP tidak ingin muncul pada laporan
maka klik checkbox ini hingga tidak tercentang. Checkbox ini tidak
muncul untuk user yang tidak diberikan hak untuk itu.
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¢ Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.6 Penjualan per Barang

Laporan ini menampilkan penjualan menurut barang atau item penjualannya,
jadi fokusnya adalah pada barangnya. Untuk masing-masing barang
ditampilkan rincian tanggal transaksi penjualannya, nomor transaksi dan

invoicenya, customer, qty dan harga satuan serta nilainya.

Eli Laporan Penjualan per Bamn_ ﬂ

@ Periode Januari 2015 -

() Tanggal 01/01/2015 sfd [3101/2015
Customer < Semua > -
Salesman < Semua > A

Product [ Barang
@ Semua
[@]1tem di Master Barang & Jasa
Item Laindain
[ Dikelompokkan menurut Grup Barang

() Grup / Kelompok Tertentu
() Product Tertentu

() Item Lain-ain

Urutkan Berdasarkan
(@ Kode Barang () Nama Barang

_']Pregiew % | !j Cancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan Penjualan per Barang dalam rentang tanggal tertentu dengan
mengklik pada opsi ini kemudian ketik rentang tanggalnya pada kedua
field disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
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tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.

e Customer : pilih < Semua > kalau ingin menampilkan laporan penjualan
untuk semua customer yang ada. Tetapi apabila hanya ingin
menampilkan customer tertentu maka pilih customernya dengan
mengklik pada tombol drop-downnya.

e Salesman : pilih < Semua > jika laporan yang ditampilkan tidak
tergantung Salesmannya atau pilih Salesman tertentu jika hanya ingin
menampilkan laporan penjualan per Barang yang terkait dengan
salesman tertentu.

e Product/Barang:

0 Semua : pilih opsi ini jika ingin menampilkan semua item penjualan
yang ada pada rentang periode yang telah dipilih.
= Item di Master Barang & Jasa : jika anda memilih Semua, maka

masih bisa menentukan apakah termasuk item di Master Barang
& Jasa dengan mencentang atau tidak checkbox ini. . (Untuk
varian Accpro Trada karena memang hanya penjualan yang
menyangkut barang yang ada di Master Barang & Jasa saja yang
dimungkinkan, maka checkbox ini tidak ditampilkan)

* Item Lain-lain : dengan mencentang checkbox ini berarti anda
juga ingin menampilkan item penjulana pada Penjualan Lain-
lain. (Untuk varian Accpro Trada karena opsi Penjualan Lain-lain
tidak tersedia dan hanya penjualan yang menyangkut barang yang ada
di Master Barang & Jasa saja yang dimungkinkan, maka checkbox ini
tidak ditampilkan)

* Dikelompokkan menurut Grup Barang : centang checkbox ini
jika ingin laporan ditampilkan menurut Kelompok Barangnya.

0 Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan

item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian

7-58



pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.

0 Item Lain-lain : sedangkan jika hanya ingin menampilkan item
penjualan tertentu pada Penjualan Lain-lain maka pilih opsi ini
kemudian pilih itemnya. (Untuk varian Accpro Trada karena opsi
Penjualan Lain-lain tidak tersedia dan hanya penjualan yang menyangkut
barang yang ada di Master Barang & Jasa saja yang dimungkinkan, maka
checkbox ini tidak ditampilkan)

e Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin
ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin
ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama
Barang.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.7 Retur Penjualan Per Transaksi

Laporan ini menampilkan retur penjualan yang terjadi pada periode atau

rentang waktu tertentu ditampilkan menurut urutan tanggal transaksinya.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan
laporan retur penjualan dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
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disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan

kalender.

.1 Laporan Retur Penjualan PEW (S|

@ Periode  Januari 2015 -
) Tanggal |01/01/2015 sfd [31/01/2015
Customer < Semua > -

[ Group by Customer
Tampilkan Detail Transaksi

=] Preview % | I cancel |

e  Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

e  Group by Customer : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan laporan menurut Customernya.

¢ Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian
barang beserta kuantitas dan harga satuannya.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.
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7.14.8 Retur Penjualan Per Salesman

Laporan ini menampilkan retur penjualan yang terjadi pada periode atau

rentang waktu tertentu dikelompokkan menurut salesmannya.

ﬁ‘i Laporan Retur Penjualan Per Salesmal_‘l o]

@ Periode  Januari 2015 -

) Tanggal [01/01/2015 sfd  [31/01/2015

Salesman < Semua > -

Customer < Semua > -

[~ Group by Customer
Tampilkan Detail Transaksi

L Preview Kj Cancel
Spreewyy | |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan
laporan retur penjualan dalam rentang tanggal tertentu dengan mengklik
pada opsi ini kemudian ketik rentang tanggalnya pada kedua field
disebelahnya dengan format dd/mm/yy (2 digit tanggal, bulan dan
tahun) atau klik tombol drop-down untuk memunculkan bantuan
kalender.

e Salesman : pilih < Semua > jika ingin menampilkan laporan untuk
semua Salesman yang ada transaksinya atau pilih Salesmannya jika
hanya ingin menampilkan Salesman tertentu dengan mengklik tombol
drop-downnya.

e  Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

e  Group by Customer : klik checkbox ini hingga tercentang apabila ingin

mengelompokkan laporan menurut Customernya.
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e  Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian
barang beserta kuantitas dan harga satuannya.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.9 Retur Penjualan Per Barang

Laporan ini menampilkan retur penjualan menurut barangnya, jadi fokusnya
adalah pada barangnya. Untuk masing-masing barang ditampilkan rincian
tanggal transaksi, nomor transaksi dan referensinya, customer, qty dan harga

satuan serta nilainya.

.1 Laporan Retur Penjualan per Bamng‘“ [

@ Periode Januari 2015 -
() Tanggal 01/01/2015 s/d [31/01/2015
Customer = Semua = -

Product [ Barang

@) Semua

[ Dikelompokkan menurut Grup Barang

() Grup / Kelompok Tertentu
() Product Tertentu

Urutkan berdasarkan
(@) Kode Barang () Nama Barang

_']Pregiewh | Kj Cancel ‘

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan

laporan Retur Penjualan Per Barang dalam rentang tanggal tertentu
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dengan mengklik pada opsi ini kemudian ketik rentang tanggalnya pada

kedua field disebelahnya dengan format dd/mm/yy (2 digit tanggal,

bulan dan tahun) atau klik tombol drop-down untuk memunculkan
bantuan kalender.

Customer : pilih < Semua > kalau ingin menampilkan laporan untuk

semua customer yang ada. Tetapi apabila hanya ingin menampilkan

customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

Product / Barang :

0 Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada pada rentang periode yang telah dipilih.
= Dikelompokkan menurut Grup Barang : centang checkbox ini

jika ingin laporan ditampilkan menurut Kelompok Barangnya.

0 Grup / Kelompok Tertentu : sebagai alternatif dari menampilkan
semua barang, anda bisa memilih opsi ini jika hanya ingin
menampilkan item di Master Barang & Jasa yang masuk dalam
kelompok barang tertentu. Selanjutnya pilih grup (kelompok)
barangnya.

0 Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
item tertentu di Master Barang & Jasa, maka pilih opsi ini, kemudian
pilih item barang yang bersangkutan dari form Lookup Barang yang
ditampilkan.

Urutkan berdasarkan : pilih opsi Kode Barang jika laporan ingin

ditampilkan menurut urutan Kode Barangnya, sedangkan jika ingin

ditampilkan menurut urutan Nama Barangnya maka pilih opsi Nama

Barang.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa

dicetak ke printer. Secara default program akan mengasumsikan anda

menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda

belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
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berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.14.10 Penjualan & Retur per Salesman

Laporan ini sama seperti Laporan Penjualan per Salesman tetapi di samping
menampilkan penjualan dalam periode atau rentang waktu tertentu yang
dikelompokkan menurut Salesmannya juga ditampilkan retur penjualannya

dalam rentang waktu tersebut.

7.1 Laporan Penjualan & Retur Per Salesmal (eS|

@ Periode  Januari 2015 -

(©) Tanggal |01/01/2015 sfd [31/01/2015

Salesman < Semua = -

Customer < Semua > -

Item di Master Barang & Jasa
Item Lainain

7] Group by Customer
Tampilkan Detail Transaksi

_']Pregiew | Kj Cancel |

N

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik
tombol drop-down untuk memunculkan bantuan kalender.

e Salesman : pilih < Semua > jika ingin menampilkan laporan untuk
semua Salesman yang ada transaksinya atau pilih Salesmannya jika
hanya ingin menampilkan Salesman tertentu dengan mengklik tombol

drop-downnya.
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Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

Item di Master Barang & Jasa : apabila checkbox ini dicentang berarti
anda ingin menampilkan laporan menyangkut item barang yang ada di
Master Barang & Jasa. (Untuk varian Accpro Trada karena memang hanya
penjualan yang menyangkut barang yang ada di Master Barang & Jasa saja
yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Item Lain-lain : apabila anda memanfaatkan opsi Penjualan Lain-lain
pada modul Sales Invoice, maka dengan mencentang checkbox ini
penjualan jenis ini akan ditampilkan pada laporan ini. (Untuk varian
Accpro Trada karena opsi Penjualan Lain-lain tidak tersedia dan hanya
penjualan yang menyangkut barang yang ada di Master Barang & Jasa saja
yang dimungkinkan, maka checkbox ini tidak ditampilkan)

Group by Customer : klik checkbox ini hingga tercentang apabila ingin
mengelompokkan penjualan dan retur (kalau ada) menurut
Customernya.

Tampilkan Detail Transaksi : klik checkbox ini hingga tidak tercentang
apabila tidak ingin menampilkan detail transaksinya yaitu perincian item
penjualan dan retur (kalau ada) beserta kuantitas dan harga satuannya.
Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Untuk laporan ini, anda hanya bisa menggunakan
ukuran kertas A4 karena laporan ditampilkan dalam bentuk landscape.

Tombol Cancel : membatalkan menampilkan laporan.

7.15 Laporan Adjustment Stock

7.15.1 Laporan Adjustment Stock Per Transaksi

Laporan ini menampilkan transaksi penyesuaian barang (adjustment stock)

yang terjadi dalam rentang waktu tertentu.

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
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e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik
tombol drop-down untuk memunculkan bantuan kalender.

.1 Laporan Adjustment Stoc_ X

@ Periode  Januari 2015 -
) Tanggal |01/01/2015 sfd [31/01/2015
Sort berdasarkan
@ Tgl. Trs I NoTrs
;
1= Preziewlk | Vj Cancel |

e  Sort berdasarkan :
0 Tgl. Trs : bila anda memilih opsi ini maka laporan akan diurutkan
menurut tanggal transaksinya.
0 No. Trs : bila anda memilih opsi ini maka laporan akan diurutkan
menurut nomor transaksinya.
¢  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.
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7.15.2

Laporan Adjustment Stock Per Barang

Laporan ini menampilkan transaksi penyesuaian barang (adjustment stock)

yang terjadi dalam rentang waktu tertentu menyangkut barang tertentu.

Ei Laporan Adjustment Stock per Bardng‘ L&J

@ Periode  Januari 2015 -

") Tanggal |01/01/2015 sid  [31/01/2015

Product [ Barang

@ Semua
_) Grup { Kelompok Tertentu

_) Product Tertentu

Sort berdasarkan

@ Kode Barang ~) Nama Barang

| Preview 5 cancel
—

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik

pada tombol drop-down pada combobox disebelahnya.

e Tanggal: sebagai alternatif dari memilih periode anda bisa menampilkan

laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini

kemudian ketik rentang tanggalnya pada kedua field disebelahnya

dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.

e Product/Barang :

[0}

Semua : pilih opsi ini jika ingin menampilkan semua barang yang
ada.

Grup / Kelompok Tertentu : jika hanya ingin menampilkan barang
dalam kelompok tertentu pilih opsi ini kemudian pilih Grup
Barangnya pada combobox di sebelahnya.

Product Tertentu : lebih spesifik lagi, jika hanya ingin menampilkan
barang tertentu pilih opsi ini. Form Lookup Barang akan
dimunculkan oleh program sehingga anda bisa memilih barangnya.
Anda juga bisa mengklik tombol Lookup yang ada apabila perlu

menampilkan form Lookup Barang secara manual.
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e  Sort berdasarkan :

0 Kode Barang : bila anda memilih opsi ini maka laporan akan
diurutkan menurut Kode Barangnya.

0 Nama Barang : bila anda memilih opsi ini maka laporan akan
diurutkan menurut Nama Barangnya.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e Tombol Cancel : membatalkan menampilkan laporan.

7.16 Laporan Sales Profitability

Laporan ini menampilkan profit dan margin atas penjualan dalam periode

atau rentang waktu tertentu.

e Jenis Laporan:

0 By Product : pilih opsi ini jika ingin mengetahui profit untuk
masing-masing barang dalam periode atau rentang periode yang
ditentukan.

0 By Transaction : pilih opsi ini jika ingin mengetahui profit untuk
masing-masing transaksi penjualan dalam periode atau rentang
periode yang ditentukan.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini

kemudian ketik rentang tanggalnya pada kedua field disebelahnya

7-68



dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.

G taporan saes romat i SN

Jenis Laporan
(@ By Product

(7 By Transaction
@ Periode  Januari 2015 -
() Tanggal |01/01/2015 sfd  |31/01/2015
Customer < Semua > M
By Salesman
Salesman < Semua >

Urutkan berdasarkan

(@ Mama Barang (7 Kode Barang

_'] Preview Kj Cancel
N

Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

By Salesman : checkbox ini beserta field Salesman di bawahnya hanya
aktif bila anda memilih opsi By Transaction pada pilihan jenis laporan di
atas. Dengan mencentang checkbox ini maka laporan akan
dikelompokkan lebih dulu menurut Salesmannya baru kemudian
Customernya.

Salesman : pilih < Semua > jika ingin menampilkan laporan untuk semua
Salesman yang ada atau pilih Salesmannya jika hanya ingin
menampilkan laporan untuk salesman tertentu.

Urutkan berdasarkan : opsi ini hanya bisa dipilih apabila anda memilih
opsi By Product pada pilihan jenis laporan di atas, pilih opsi Kode
Barang jika ingin mengurutkan berdasarkan Kode Barang, sedangkan
bila ingin mengurutkan berdasarkan Nama Barang pilih opsi Nama
Barang

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda

menggunakan ukuran kertas A4, apabila anda ingin menggunakan
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ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.17 Laporan Pengiriman Barang (DO)
7.17.1 Per Transaksi, DO vs Invoice, Invoice vs DO

Laporan ini menampilkan pengiriman barang dalam periode atau rentang
waktu tertentu.

oo S ==

Jenis Laporan
(@ Per Transaksi
(7) DO vs Invoice %
() Invoice vs DO
() HPP Pengiriman (DO}

|| Tampilkan hanya DO yang belum ada Invoicenya
[] Tampilkan hanya DO yang sudah ada Inveicenya
[] Tampilkan hanya DO yang tidak dinvoicekan

@ Periode Januari 2015 -
) Tanggal |01/01/2015 sid  [31/01/2015
Customer < Semua > -

Kunci Utama Pengurutan Data

@ Tgl. DO ) No. Trs ) No. DO

[ 3angan Tampikan DO yang tidak dinvoicekan

| jPre[iew | ‘ KS Cancel |
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Jenis Laporan :

0 Per Transaksi : pilih opsi ini jika ingin menampilkan laporan
pengiriman barang menurut transaksinya yaitu ditampilkan tanggal
DO, No. Trs, Customer, No. DO, No. PO, Tanggal PO disertai juga
detail transaksinya yang mencakup Kode Barang, Nama Barang,
Kuantitas dan Satuan.

0 DO vs Invoice : pilih opsi ini jika ingin menampilkan DO pada
periode tertentu dikaitkan dengan Invoicenya. Untuk setiap DO
akan ditampilkan Invoice yang terkait dengannya. Apabila anda
memilih opsi ini, anda masih diberikan opsi berupa checkbox
apakah hanya ingin menampilkan DO yang belum ada Invoicenya
saja, DO yang sudah ada Invoicenya saja atau kedua-duanya. Kalau
anda hanya ingin menampilkan salah satu saja maka centang
checkbox bersangkutan tetapi kalau ingin menampilkan kedua-
duanya biarkan checkbox dalam keadaan tidak dicentang.

0 Invoice vs DO : pilih opsi ini jika ingin menampilkan Sales Invoice
pada periode tertentu dikaitkan dengan DOnya. Untuk setiap
Invoice akan ditampilkan DO (bisa lebih dari satu) yang terkait
dengannya.

0 HPP Pengiriman (DO) : pilih opsi ini jika ingin menampilkan
laporan HPP untuk masing-masing DO.

Kecuali untuk laporan Invoice vs DO, untuk ketiga jenis laporan lainnya
anda bisa memilih apakah ingin menampilkan hanya DO yang belum
ada invoicenya atau hanya DO yang sudah ada Invoicenya atau hanya

DO yang tidak diinvoicekan.

Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik
tombol drop-down untuk memunculkan bantuan kalender.

Customer : pilih < Semua > kalau ingin menampilkan laporan untuk

semua customer yang ada. Tetapi apabila hanya ingin menampilkan
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customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

¢ Kunci utama pengurutan data : pilih salah satu opsi yang ada apakah
ingin diurutkan menurut Tgl. DO, No. Trs atau No DOnya.

e  Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.17.2 Per Barang (Product)

Laporan ini menampilkan pengiriman barang dalam periode atau rentang
waktu tertentu dengan fokus pada barangnya, yaitu menampilkan transaksi

mana sajakah yang terkait dengan barang tertentu.

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.

e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan
laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini
kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik

tombol drop-down untuk memunculkan bantuan kalender.
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[ Laporan Pengiriman per Earanﬁ'—'roduct) - L&’

@ Periode Januari 2015 -
“) Tanggal |01/01/2015 sfd [31/01/2015
Customer < 5emua > -

[T Product Tertentu w

[ 3angan Tampilkan Detail Transaksi

_:]Pre!iewlk | Kj Cancel |

Customer : pilih < Semua > kalau ingin menampilkan laporan untuk
semua customer yang ada. Tetapi apabila hanya ingin menampilkan
customer tertentu maka pilih customernya dengan mengklik pada
tombol drop-downnya.

Product Tertentu : jika hanya ingin menampilkan barang atau product
tertentu saja maka centang checkbox ini kemudian pilih barangnya dari
form Lookup Barang yang ditampilkan oleh program atau klik tombol
Lookup yang ada apabila perlu menampilkan form Lookup Barang
secara manual.

Jangan Tampilkan Detail Transaksi : jika tidak ingin menampilkan
transaksi mana sajakah untuk masing-masing barang maka centang
checkbox ini, jadi hanya ditampilkan kuantitas yang dikirim untuk
barang tertentu pada periode yang dipilih.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.
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7.18 Laporan Lain-lain
7.18.1  Customer List

Laporan ini untuk menampilkan daftar customer yang dimiliki perusahaan
beserta alamat, telpon, fax dan contact personnya.

Salesman < Semua > -
Group < Semua = -
Kota < 5emua = -

[T Group by Salesman
DGroup by Customer Group

j Freview | Kj Cancel |

s

e Salesman : pilih < Semua > jika tidak ingin menampilkan hanya customer
yang terkait Salesman tertentu, sebaliknya pilih Salesmannya dengan
mengklik tombol drop-downnya.

¢  Group : pilih < Semua > jika tidak ingin menampilkan hanya customer
dalam grup (kelompok) customer tertentu, sebaliknya pilih Grup
(Kelompok) Customernya dengan mengklik tombol drop-downnya.
Apabila memang anda tidak pernah mengelompokkan customer
menurut grup tertentu melalui menu Master Data > Kelompok (Grup)
Customer, maka memang tidak ada pilihan grup customer selain <
Semua >.

¢ Kota : pilih < Semua > jika tidak ingin menampilkan hanya customer
dengan kota tertentu saja, sebaliknya pilih kotanya dengan mengklik
pada tombol drop-downnya.

¢ Group by Salesman : klik checkbox ini hingga tercentang jika ingin
mengelompokkan customer menurut Salesmannya.

¢  Group by Customer Grup : sebagai alternatif dari Group by Salesman,
klik checkbox ini hingga tercentang jika ingin mengelompokkan

customer menurut grupnya. Hanya saja checkbox ini hanya aktif jika
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anda sebelumnya memang memiliki minimal 2 (dua) kelompok
customer.

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer.

¢ Tombol Cancel : membatalkan menampilkan laporan.

7.18.2  Supplier List

Laporan ini untuk menampilkan daftar supplier yang dimiliki perusahaan

beserta alamat, telpon, fax dan contact personnya.

e Salesman, Group : biarkan kedua field ini karena untuk Supplier
memang kedua field ini tidak digunakan.

e Kota : pilih < Semua > jika tidak ingin menampilkan hanya customer
dengan kota tertentu saja, sebaliknya pilih kotanya dengan mengklik
pada tombol drop-downnya.

Salesman

Group

Kota < Semua | -

Group by Salesman
Group by Customer Group

j Preview Kj Cancel
y [Bem

e Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk

semua laporan lain (tidak termasuk printout transaksi) selama anda
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belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

e  Tombol Cancel : membatalkan menampilkan laporan.

7.18.3 Laporan Sub Ledger

Laporan ini dimaksudkan untuk memfasilitasi kemungkinan diperlukannya
laporan sub ledger yang menyangkut customer, supplier atau kontak lain
tertentu untuk akun tertentu. Tentunya pergunakan laporan ini apabila ada
relevansinya. Misalnya apabila ingin mengetahui transaksi menyangkut akun
Uang Muka Penjualan untuk customer tertentu atau akun Uang Muka
Pembelian untuk supplier tertentu dalam rentang waktu tertentu. Dalam
kerangka hal ini jangan lupa, apabila kontak dimaksud pada awal pemakaian
aplikasi mempunyai saldo untuk akun (perkiraan) yang anda maksudkan di
atas, anda harus menginput saldo awalnya melalui menu Master Data > Saldo
Awal Hutang / Piutang / Sub Ledger pada tab Sub Ledger.

.4 Laporan Sub Ledger per Konta
Laporan Sub Led Kontak (|

@ Periode Januari 2015 -
© Tanggal 01/01/2015 sfd  [3101/2015

@ Customer (") Supplier (! Others
Contact Lﬂ
Ho. Perkiraan --- N

Pastikan bahwa MNo. Perkiraan yang anda tentukan ada urgensinya ditampilkan Sub
Ledgernya terkait dengan Contact yang telah anda tentukan. Pastikan juga Salde
Awal Mo, Perkiraan yang anda tentukan telah dinput melalui menu Master Data >
Saldo Awal Hutang [ Piutang  Sub Leger pada tab Sub Ledger apabila memang ada
Saldo Awalnya pada periode sebelum pemakaian Aplikasi Accpro.

| _'] Preview | ‘ !j LCancel |

e  Periode : klik pada opsi ini kemudian pilih Periodenya dengan mengklik
pada tombol drop-down pada combobox disebelahnya.
e Tanggal : sebagai alternatif dari memilih periode anda bisa menampilkan

laporan dalam rentang tanggal tertentu dengan mengklik pada opsi ini

7-76



kemudian ketik rentang tanggalnya pada kedua field disebelahnya
dengan format dd/mm/yy (2 digit tanggal, bulan dan tahun) atau klik
tombol drop-down untuk memunculkan bantuan kalender.

Contact : klik option-button Customer atau Supplier atau Others,
kemudian pilih kontaknya dari pilihan kontak yang ada sesuai option-
button yang anda pilih dengan mengklik pada tombol drop-down yang
ada.

No. Perkiraan : pilih akunnya dengan mengisikannya langsung atau
lebih mudah dengan mengklik tombol Lookup di sebelahnya yang akan
menampilkan Form Lookup Perkiraan sehingga anda tinggal mencari
dan memilih perkiraan dimaksud.

Tombol Preview : menampilkan laporan ke layar untuk selanjutnya bisa
dicetak ke printer. Secara default program akan mengasumsikan anda
menggunakan ukuran kertas A4, apabila anda ingin menggunakan
ukuran kertas Letter (Kwarto/Q4), klik kanan untuk memilih ukuran
kertasnya. Tetapi harus diingat bahwa bila anda pernah merubah ukuran
kertas ke Letter, maka program akan mengingat ukuran kertas ini untuk
semua laporan lain (tidak termasuk printout transaksi) selama anda
belum keluar dari Accpro. Perkecualian adalah untuk laporan yang
berbentuk landscape maka program akan otomatis mengembalikannya
ke ukuran A4.

Tombol Cancel : membatalkan menampilkan laporan.
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BAB 8
Menu Utilitas

8.1 Proses Awal Bulan

Setiap kali ingin mulai melakukan input transaksi untuk periode yang baru,
maka anda harus melakukan Proses Awal Bulan lebih dulu. Setelah Proses
Awal Bulan, anda tetap dapat melakukan input transaksi untuk periode
sebelumnya. Jadi proses awal bulan hanya akan membuka periode baru
sebagai periode bulan berjalan dan tidak melakukan proses tutup buku.
Form konfirmasi akan ditampilkan, pilih OK untuk melanjutkan, Cancel

untuk membatalkan.

Proses Awal Bulan

ﬂ Proses Awal Bulan Februari 2015

Proses Awal Bulan akan membuka periode transaksi
yang baru dan membuat Saldo Awal Akun untuk
periode yang baru.

o OK h | [j Cancel |

8.2 Tutup Buku

Proses Tutup Buku dilakukan apabila sudah tidak ada input transaksi untuk
periode bersangkutan untuk memproteksi agar transaksi yang terkait periode
tersebut tidak bisa diedit lagi. Apabila kemudian perlu mengeditnya lagi
maka periode bersangkutan harus diaktifkan lebih dulu. Prosesnya adalah
melalui modul Tutup Buku ini juga. Jadi tidak ada keharusan anda
melakukan proses tutup buku pada setiap akhir periode, karena untuk
membuka periode baru adalah melalui Proses Awal Bulan, tidak melalui

modul ini.
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Tahun : tentukan tahun dimana periode yang ingin dilakukan proses
tutup buku atau ingin diaktifkan kembali.
Pilih Semua periode : centang checkbox ini jika semua periode yang ada
dalam tahun yang telah ditentukan ingin dilakukan proses tutup buku
atau ingin diaktifkan kembali. Jika hanya periode tertentu saja, maka
centang kolom periode mana saja yang ingin diset statusnya. Kolom
status menampilkan status periode pada saat ini.
Set Status Tutup Buku :
0  Aktif : untuk mengaktifkan periode/periode-periode yang telah
dipilih klik pada opsi ini.
0 Tutup Buku : untuk melakukan proses Tutup Buku atas
periode/periode-periode yang telah dipilih klik pada opsi ini.
Process : untuk memproses pengaturan yang telah dilakukan, klik
tombol ini.
Cancel : klik tombol ini jika tidak jadi memproses pengaturan yang telah
dilakukan.

e v S

Tahun 2015 -

[ pilih Semua periode

Periode Status
[W|Desember 2015 Aktif
] Mopember 2015 Aktif
[] Oktober 2015 Aktif
[1september 2015 Aktif
[ Agustus 2015 Aktif
[ Juli 2015 Aktif
[ Juni 2015 Aktif
[IMei 2015 Aktif
[ April 2015 Aktif
[IMaret 2015 Aktif
Februari 2015 Akt
Januari 2015 Aktif
Set Status Tutup Buku
() Aktif (@ Tutup Buku

Untuk melakukan Tutup Buku Periode tertentu, pastikan
periodenya dicentang, kemudian pilih Tutup Buku,
sedangkan untuk mengaktifkan kembali periode tertentu,
centang periodenya dan pilih Akt

i.‘:sProoegs | m ganoel_ |

s




8.3 Hitung Ulang Saldo G/L

Pada dasarnya proses Hitung Ulang Saldo G/L tidak perlu dilakukan karena
Saldo akun G/L (buku besar) akan diupdate secara otomatis oleh program
setiap kali ada transaksi terkait akun bersangkutan. Namun apabila
diperlukan, walaupun sangat jarang terjadi misalnya apabila neraca tidak
balance atau ada ketidaksesuaian antara saldo akun pada buku besar dengan
saldo pada neraca, maka lakukan proses ini mulai dari periode dimana

ketidaksesuaian terjadi.

e  Proses : posisikan kursor pada baris yang menampilkan periode dimana
proses hitung ulang ingin dimulai, kemudian klik tombol ini. Tunggu
hingga proses hitung ulang saldo selesai.

e  Tutup : untuk menutup form ini.

Catatan :

Agar proses Hitung Ulang Saldo dapat berjalan dengan lancar, sebaiknya
pastikan pada saat Hitung Ulang Saldo G/L tidak ada user lain yang
sedang mengupdate data, setidaknya pastikan tidak ada user yang
melakukan proses penyimpanan transaksi (dengan mengklik tombol
Save), khususnya jika transaksi bersangkutan menghasilkan jurnal.

8.4 Cari Jurnal / Transaksi

Ada utilitas khusus yang dapat anda gunakan untuk mencari transaksi
apapun yang telah anda input dengan mudah (sepanjang transaksi tersebut
ada jurnalnya). Klik menu Utilitas > Cari Jurnal / Transaksi. Lengkapi field
yang ada sesuai apa yang ingin anda cari dan rentang waktu transaksi.
Kemudian klik tombol Cari. Daftar transaksi yang memenubhi kriteria yang
telah anda tentukan akan ditampilkan pada tab Daftar Transaksi. Untuk
membuka transaksi tertentu, double klik baris transaksi bersangkutan atau
klik pada kolom paling kiri (o). Pada tab Jurnal Transaksi akan ditampilkan
jurnal transaksi untuk baris transaksi sesuai kursor berada pada tab Daftar

Transaksi. Dengan memindahkan kursor ke atas atau ke bawah pada tab
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Daftar Transaksi, anda dapat melihat Jurnal Transaksi baris transaksi tertentu.

Apabila anda ingin masuk ke Jurnal Transaksinya, klik tombol Buka Jurnal.

e Periode : pilih periodenya jika ingin mencari transaksi atau jurnal pada
periode tertentu atau pilih [All] jika ingin mencarinya pada semua
periode yang ada.

L]

Tanggal : sebagai alternatif dari memilih periodenya, anda bisa klik pada
option button ini dan menentukan rentang tanggal transaksi yang ingin
anda cari. Kalau anda memilih [All] berarti rentangnya adalah pada
semua periode yang anda. Tetapi kalau anda ingin menentukan rentang
waktunya, maka pilih Range, kemudian tentukan tanggal awal dan
tanggal akhirnya. Pilihan lainnya adalah =, >, <, >= atau <= tanggal
tertentu.

Jurnal / Transaksi

(& Periode

| 1. Tenkukan persyaratan
= q T penyeleksian data yang
O Tanggal L | | | ingin dicari dengan
S menentukan/mengisi
Jenis Transaksi |[Al] | Field-field yang ada
No. Youther [t v | s | | 2. Kl tombol Carl, maka
data akan ditampilkan
No.Referensi | [Al] || | s | | parla tab Daftar Transaksi
@ all O Customer () Supplier () Others 3.Piih data pada tab
Kantak I v Daftar Transaksi, maka
L Jurrial akan diampikan
Nilai Transaksi [ [A1] v | | s ] ] pada tab Jumal Transaksi
1 |
Account G/L (Al v sfd ABlaingn mombai
! ‘ I Qs | (e Form/modul fransakei yang
s — bersangkutan, double ciik
Daftar Transaksi | | bans bersangkuran arau
= P || | clicktombol drop-down
o| Tanggal No. Referensi No. Trs G/L [ Sta Lhlor sk o (o
o [ TE] 000001 P 000001 SOLLST SECURINDO: 000004
o 03012013 RY 000001 RY 000001 WMITRA ABADT 000005 T 5 Bila ingin membuka form
o 040172013 EO 000001 B0 000001 <NfAs 000008 Jurml Transaksi yang
o 07f01/2013 P 000001 INV 13,00012 SOLUST SECLRINDC 000001 bersanglo.tan, click tombol
[0 o7jo1fz013 BO oonooz BO 000002 <N 000007 Buka Jurnal

| Jurnal Transaksi |

No. Perk Nama Perkiraan Kredit

Keterangan

1, 03-05-01-000
2, 03-01-01-000

Hutang Giro
Hutang Dagang

22,440,000
22,440,000

a Jurnal

Jenis Transaksi : pilih [All]] kalau anda tidak menentukan jenis
transaksinya, tetapi kalau ingin menentukan jenis transaksinya, pilih dari
daftar jenis transaksi yang ada dengan mengklik tombol drop-down pada

field ini.
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No. Voucher : anda bisa menentukan rentang No. Voucher yang ingin
anda cari dengan memilih [All} atau Range kemudian tentukan No.
Voucher awal dan No. Voucher akhirnya atau pilih =, >, <, >= atau <=
kemudian tentukan No. Vouchernya. Yang dimaksud No. Voucher di
sini adalah No. Transaksi yang digenerate secara otomatis oleh program
setiap kali anda membuat transaksi baru untuk modul tertentu. Ini
sebenarnya ada kaitannya dengan jenis transaksi yang anda tentukan
pada field Jenis Transaksi.

No. Referensi : pada setiap transaksi pasti ada No. Referensinya, apakah
itu berupa No. Invoice, No. DO atau No. Bukti transksi lainnya. Anda
bisa menentukan rentang yang anda yang ingin anda cari dengan
memilih [All] apabila tidak ingin menentukan No. Referensi yang anda
cari, atau pilih Range kemudian tentukan No. Referensi awal dan No.
Referensi akhir atu pilih = > <, >=<= kemudian tentukan No.
Referensinya.

Kontak : anda bisa menentukan secara spesifik kontank terkait transaksi
yang ingin cari dengan memilih nama kontaknya dengan klik pada field
ini atau tombol drop-down yang anda. Bila perlu klik dulu option-button
yang ada apakah All, Customer, Supplier atau Others. Apabila anda
tidak ingin menentukan kontaknya, biarkan field ini terisi dengan [All].
Nilai Transaksi : rentang nilai transaksi dapat anda tentukan pada field
ini apakah [All] atau pilih Range kemudian tentukan batas nilai transaksi
bawah dan batas nilai transaksi atas, atau bisa juga pilih =, ><>=, <=
kemudian tentukan nilai transaksinya.

Account G/L : kriteria terakhir yang dapat anda tentukan adalah
menyangkut Account G/Lnya. Anda bisa tidak menspesifikasikannya
dengan membiarkannya terisi [All] atau pilih Range kemudian rentang
akunnya atau pilih =>,<,>=,<= kemudian tentukan akunnya.

Tombol Cari : setelah anda menentukan kriterianya transaksi yang ingin
anda cari, selanjutnya klik tombol ini, maka program akan menampilkan
transaksi-transaksi yang sesuai dengan kriteria yang telah anda tentukan
pada tab Daftar Transaksi. Posisikan kursor pada baris tertentu maka
jurnal terkait transaksi dimaksud akan ditampilkan pada tab Jurnal

Transaksi.
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e Tombol Buka Jurnal : kalau anda ingin membuka modul Jurnal
Transaksi untuk Dbaris transaksi tertentu, maka setelah anda
memposisikan kursor pada baris transaksi dimaksud, klik tombol ini,
maka form Jurnal Transaksi akan ditampilkan sehingga anda dapat
mengetahui lebih detail jurnal transaksi bersangkutan.

e Tombol Close : untuk menutup form ini. Form Cari Jurnal / Transaksi
adalah form non transaksional, sehingga Anda tidak perlu menutupnya

lebih dulu agar bisa membuka form lain.

8.5 Ganti Password

Modul ini digunakan untuk merubah password apabila diperlukan.
Password yang bisa dirubah adalah menyangkut database yang saat itu
sedang dibuka dan untuk user yang sedang login pada aplikasi pada saat itu.

Jadi anda harus login dengan user id yang passwordnya ingin anda ubah.

1 Merubah Password |

Password Lama

Password Baru

Retype

| Bgave | | Kj Cancel |

e Password Lama : ketik password lama yang ingin diubah

e Password Baru : ketik password baru.

® Retype : sebagai konfirmasi, ketik sekali lagi password baru, agar
program dapat memeriksa keidentikan password dengan yang anda
ketikkan pada field Password Baru. Ini untuk mencegah anda salah ketik
dan tidak menyadarinya sehingga nantinya password baru tidak bisa

digunakan.
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e Save:menyimpan perubahan yang anda lakukan.
e Cancel : membatalkan (tidak jadi menyimpan) perubahan yang anda

lakukan.

8.6 Financial Highlight

Modul ini menampilkan pokok-pokok penting seperti ikhtisar penjualan
bersih tahunan masing-masing salesman, grafik penjualan bersih 5 salesman
teratas, grafik penjualan tahunan, grafik penjualan bersih 5 customer teratas,
grafik piutang dan hutang menurut umurnya, giro masuk dan keluar jatuh

tempo berdasarkan kondisi terkini.

e Tombol Menu : tombol ini digunakan menampilkan pilihan untuk
mengatur tampilan grafik

0 3D View : pilih menu ini jika grafik ingin ditampilkan dalam
bentuk 3 dimensi

0 Bar: apabila menu ini tercentang maka grafik akan ditampilkan
dalam bentuk grafik batang.

0 Pie : tergantung konteksnya, bisa jadi pilihan ini non aktif,
tetapi apabila bisa dipilih maka akan menampilkan grafik dalam
bentuk grafik lingkaran (pie).

0 Show Outline : apabila menu ini tercentang, maka grafik
ditampilkan dengan garis luar (outline), sebaliknya maka garis
luar tidak ditampilkan.

0 Horizontal Grid : pilih menu ini hingga tercentang apabila
ingin menampilkan garis horisontal pada grafik

e Tombol Max : membuka bagian tampilan yang sedang tertutup.

e Tombol Min : menutup bagian tampilan yang sedang terbuka.

e Tombol Refresh : karena modul ini adalah modul non transaksional,
anda bisa membuka modul ini tanpa menutupnya lebih dulu pada saat
mengakses modul lain. Sementara itu transaksi terus bertambah atau
diupdate, maka agar modul ini ditampilkan kembali dalam kondisi
terkini, klik tombol ini.

e Tombol Close : menutup form atau modul ini.
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BAB 9
Lain-lain
9.1 Backup

Selalu ada kemungkinan terjadinya kehilangan atau kerusakan data. Bisa
disebabkan terhapus, crash pada sistem operasi atau kerusakan pada
hardware, kehilangan perangkat keras dimana data disimpan dan
sebagainya. Oleh karena itu melakukan backup secara berkala tidak bisa tidak
harus dilakukan. Tidak saja pada folder lain pada komputer dimana data
berada tetapi juga pada tempat penyimpanan lain diluar harddisk komputer
tempat data berada, bisa berupa Flash Disk, External Hard Disk ataupun pada
harddisk komputer lain. Tergantung pada kebutuhan dan pertimbangan
anda, misalnya apabila volume (jumlah) transaksi cukup besar per hari maka
jangka waktu backup hendaklah lebih singkat. Untuk transaksi yang normal
artinya frekwensi transaksi sedang-sedang saja (walaupun pengertian normal
disini bisa bersifat relatif) maka minimal lakukan backup pada akhir setiap
minggu. Tentu saja lebih sering akan lebih baik dan aman.

Untuk melakukan backup maka pilih menu File > Backup Data.

2 ior 0o S =

= Backup data diperlukan agar bila sewaktu-waktu terjadi kerusakan
E pada database asli maka dapat direstore kembali dari data backup.

(-] Lakukan backup secara berkala,

Lokasi Backup D:\Data Accpro'Backup

Mama File Backup  pT, 51GMA GPS 2015-02-13

MNama File backup akan diberikan secara otomatis oleh program sesuai
dengan nama database asli dan tanaggal dilakukan backup. Apabila ingin
menggunakan nama lain, anda dapat menggantinya. Extension file
backup adalah dbk dan akan diberikan secara otomatis oleh program,
oleh karena itu gunakan nama file tanpa extension

1'agl.Pr::u:egs. I::f ﬂ Qancel_
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Lokasi Backup : tentukan lokasi backup. Defaultnya adalah folder
Backup yang merupakan sub folder dimana database Accpro berada.
Apabila database berada pada komputer yang sama dimana anda
menjalankan Accpro, maka program akan membuatkan foldernya jika
folder/sub folder backup yang ditentukan belum ada, sedangkan apabila
database berada pada komputer lain dalam jaringan (remote / server)
maka proses backup baru akan berhasil jika folder atau sub folder
backup telah tersedia, oleh karena itu jika folder atau sub foldernya
belum ada, maka anda harus membuatkan foldernya lebih dulu. Seperti
telah dikemukakan di atas dan sebagaimana ungkapan dalam bahasa
Inggris “don’t put all your eggs in one basket”, demi keamanan maka
sebaiknya anda juga melakukan backup pada komputer atau perangkat
penyimpanan lain diluar komputer tempat database berada. Lebih
mudah untuk menentukan lokasinya dengan mengklik tombol Lookup
disamping field ini yang akan menampilkan form Browse for Folder.
Pilih folder atau lokasi penyimpanannya, apabila folder berada komputer
lain dalam jaringan maka anda bisa mencarinya pada bagian My
Network Place (Windows XP) atau Network (Windows 7 ke atas), tentu
saja folder tersebut harus sudah dishare lebih dulu.

Nama File Backup : akan otomatis diberikan oleh program sesuai nama
database yang akan dibackup diakhiri dengan tanggal dilakukan backup
dengan format yyyy-mm-dd (tahun-bulan-hari). Apabila menghendaki
nama lain anda bisa menggantinya sepanjang memenuhi kaidah
penamaan nama file tanpa perlu menambahkan ekstensi file tersebut
karena ekstensi file akan diberikan secara otomatis oleh program dimana
ekstensi file backup Accpro adalah dbk. Tentunya juga jangan
menggunakan nama file backup yang sudah ada di lokasi backup kecuali
kalau anda memang ingin menimpanya.

Tombol Process : klik tombol ini untuk memulai proses backup. Tunggu
hingga proses selesai, form konfirmasi akan ditampilkan oleh program
bahwa proses telah selesai dilakukan.

Tombol Cancel : menutup form tanpa melakukan proses backup.



9.2 Restore

Proses Restore adalah proses untuk menjadikan database hasil backup yang
telah dilakukan sebelumnya untuk dijadikan database yang bisa dilakukan
proses update seperti layaknya database asli. Hal ini biasanya dilakukan
apabila terjadi kerusakan atas database asli yang tidak bisa dilakukan

recovery atau terjadi kehilangan atas database asli, bisa karena terhapus atau

sebab lainnya.

Apabila diperlukan atau terjadi kerusakan pada database asli, anda dapat
melakukan restore data dari proses badkup yang telah dilakukan. Pilihlah

data backup yang paling up to date

Nama File Backup  D:\Data Accpro'\Backup'PT. SIGMA GPS 201 &]

Lokasi Restore D:'Data Accpro €Y

Nama File Restore  pT, 51GMA GPS 2015-02-13

Demi keamanan, anda tidak diperkenankan menggunakan nama file hasil restore yang
sama dengan nama database accpro yang ada di lokasi restore. Extension hasil
restore adalah dac dan akan diberikan secara otomatis oleh program. Oleh karena itu
gunakan nama file restore tanpa extension.

Buka data hasil restore [] 1adikan hasil restore sebagai default database

‘)_‘g Procegs% 5 gancel_

e Nama File Backup : tentukan nama file backup yang ingin direstore,
untuk mudahnya gunakan tombol Lookup yang ada disamping field ini
untuk memunculkan form dimana anda bisa mencari file yang akan
direstore. File backup Accpro adalah file dengan ekstensi dbk.

e Lokasi Restore : tentukan folder tempat file backup ingin direstore,
gunakan tombol Lookup disamping field ini untuk memunculkan form
Browse for Folder yang akan memudahkan anda untuk mencari folder
yang dikehendaki. Apabila folder tempat database asli masih ada
mungkin anda ingin merestorenya ke sana supaya tidak repot menset
kembali lokasi database yang baru (karena harus melakukan lagi Set
Default Database) khususnya apabila komputer yang menggunakan
Accpro cukup banyak. Namun perlu diingat bahwa apabila di lokasi
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tempat database asli berada masih ada database asli (mungkin rusak dan
tidak bisa direpair) maka nama database hasil restore tidak bisa
menggunakan nama yang sama dengan itu. Anda bisa mengganti
namanya atau memindahkannya lebih dulu kalau tetap ingin
menggunakan nama yang sama.

Nama File Restore : secara default oleh program, nama file restore akan
otomatis dinamai sesuai nama file backup walaupun dengan ekstensi
berbeda yaitu dac, dengan catatan di lokasi tempat dilakukan restore
belum ada nama database yang sama dengan nama file hasil restore ini.
Apabila ingin menamai lain, ketik atau edit namanya, yang penting
jangan sama dengan nama database yang ada di tempat restore dan juga
jangan gunakan ekstensi karena akan diberikan otomatis oleh program.
Buka data hasil restore : biarkan checkbox ini dalam keadaan tercentang
apabila setelah proses restore berhasil, diinginkan program langsung
membuka database hasil restore, kalau tidak maka setelah proses restore
selesai program tetap pada database semula (yang dibuka sebelumnya)
atau kalau sebelumnya belum ada database yang dibuka, maka tidak ada
database yang dibuka. Akibatnya anda harus memilih menu File > Buka
Data Perusahaan apabila ingin membukanya.

Jadikan hasil restore ini sebagai default databse : klik checkbox ini
hingga tercentang apabila database hasil restore ingin dijadikan default
database tiap kali anda menjalankan Accpro. Tentunya anda harus
melakukan ini apabila database hasil restore merupakan satu-satunya
database yang ingin diakses selanjutnya. Pada komputer lain yang
menjalankan Accpro, harus diset default databasenya ke database hasil
restore ini (melalui menu File > Set Default Database) kecuali kalau
lokasi dan nama databasenya adalah sama dengan database aslinya
(sebelumnya).

Tombol Process : klik tombol ini untuk mulai melakukan proses restore.
Setelah proses restore berhasil, maka akan ditampilkan form konfirmasi
bahwa proses restore telah berhasil.

Tombol Cancel : menutup form tanpa melakukan proses restore.



9.3 Impor Data Master

Fasilitas ini berfungsi melakukan impor data master meliputi data Kontak,
Item Pembelian & Penjualan dan Chart of Account dari database Accpro
lainnya. Namun proses ini hanya bisa dilakukan apabila belum ada transaksi
terkait database tujuan yaitu database yang sedang dibuka saat itu,
sedangkan bila sudah ada transaksinya maka tombol Process akan
dinonaktifkan oleh program sehingga proses impor tidak bisa dilakukan.
Selain itu perlu diketahui, proses impor data akan menghapus lebih dulu data
pada tabel terkait digantikan dengan data yang diimpor.

¢ Nama File : tentukan nama database Accpro yang akan diimpor, dalam
hal ini ekstensinya adalah dac, untuk mudahnya gunakan tombol
Lookup untuk bantuan dalam mencari database yang dimaksud.

e  Kontak : klik checkbox ini hingga tercentang jika ingin mengimpor data
Kontak. Apabila data kontak yang akan diimpor mengandung informasi
Nomor Perkiraan yaitu bila hutang usaha / piutang usaha untuk masing-
masing supplier dan customer ditentukan secara spesifik nomor
perkiraannya (pada Chart of Account dilakukan breakdown Account
Hutang Usaha / Piutang Usaha menurut Supplier / Customer), maka

otomatis anda juga harus mengimpor Chart of Account.

Peringatan !1! Proses ini akan mengosongkan (menghapus) lebih dulu data
& pada tabel terkait untuk selanjutnya digantikan dengan data yang anda
impor. Proses impor data Master hanya bisa dilakukan apabila transaksi
Warning belum berjalan (tombol Process akan non Aktif bila sudah ada transaksi).

Sumber Data ( database Accpro yang ingin diimpor) :

Nama File : &N

Data yang akan diimpor :

[ kontak
[|Barang dan Jasa
|| chart of Account

Process | Kjgancel |
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e Barang & Jasa : klik checkbox ini hingga tercentang jika ingin
mengimpor data Master Barang & Jasa. Karena data ini mengandung
informasi Nomor Perkiraan, maka otomatis anda juga harus mengimpor
Chart of Account.

o  Chart of Account : anda bisa hanya mengimpor data ini saja dengan
mengklik secara langsung checkbox ini hingga tercentang, tetapi kalau
sebelumnya anda telah mencentang checkbox Kontak atau Barang & Jasa
bisa jadi otomatis telah dicentang oleh program.

¢ Tombol Process : klik tombol ini untuk mulai melakukan proses impor
data. Tunggu hingga proses selesai. Apabila berhasil, program akan
menampilkan informasi bahwa proses telah sukses dilakukan.

e  Tombol Cancel : klik tombol ini untuk menutup form tanpa melakukan

impor data.

9.4 Impor Data Master dari Excel

Untuk Impor Data Master dari Excel, maka untuk Accpro Servitia hanya data
customer dan supplier yang bisa anda impor. Anda harus menggunakan
template yang disediakan oleh Accpro yaitu accpro_template_excel.xls atau
accpro_template_excel.xIsx yang ada pada sub folder Template pada folder
dimana anda menginstall Accpro. Jadi kalau anda mempunyai database excel
yang berisi data customer dan supplier, anda tidak bisa begitu saja
mengimpornya ke dalam database Accpro tetapi anda harus melakukan
copy-paste datanya pada masing kolom-kolom yang sesuai format yang ada
pada template yang disediakan Accpro. Simpanlah template yang telah anda
isi datanya dengan nama lain supaya template aslinya bisa tetap digunakan
untuk kesempatan lain jika dibutuhkan. Tutup file excel tadi, baru lakukan

impor menggunakan aplikasi Accpro.
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Gunakan file accpro_template_excel.xlsx atau accpro_template_excelxls
sebagai format data excel yang akan diimpor. File ini defaultnya ada di
subfolder \Template dari folder dimana Accpro diinstall. Setelah diisi data,
simpan dengan nama lain, agar template aslinya tetap bisa digunakan lain
waktu jika diperlukan

Data yang akan diimpor :

|:| Barang & Jasa
|:| Customer
[ supplier

Sumber Data ( file excel yang ingin diimpor) :

MNama File : w

|‘{5Prooe;s | | RS Cancel |

Barang & Jasa : klik checkbox ini hingga tercentang jika ingin
mengimpor data Master Barang & Jasa. Jika anda ingin mengimpor data
ini dari file excel maka anda harus membuatkan dulu data Kelompok
(Grup) Barangnya melalui menu Master Data > Kelompok (Grup)
Barang. Jadi hanya data barang yang kelompok barangnya telah ada
datanya pada database Accpro yang akan berhasil diimpor.

Customer : klik checkbox ini hingga tercentang jika ingin mengimpor
data Customer.

Supplier : klik checkbox ini hingga tercentang jika ingin mengimpor data
Supplier.

Nama File : tentukan nama file excel yang akan diimpor, lebih mudah
dengan mengklik tombol Lookup untuk mencari file excel dimaksud.
Setelah proses impor selesai, anda bisa membuka kembeali file excel tadi,
pada kolom A worksheet terkait bisa dilihat baris mana yang berhasil
diimpor yang ditandai dengan OK. Baris yang tidak berhasil diimpor
bisa disebabkan formatnya ada yang salah (bisa jadi terlalu panjang) atau
telah ada data yang sama pada database Accpronya. Setelah diperbaiki,
anda bisa mengimpor ulang data yang belum berhasil diimpor. Untuk itu

tutup dulu file excelnya.
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e Tombol Process : klik tombol ini untuk mulai melakukan proses impor
data, sebelumnya pastikan file excel yang akan anda impor sudah
ditutup lebih dulu. Tunggu hingga proses selesai. Apabila berhasil,
program akan menampilkan informasi bahwa proses telah sukses
dilakukan.

e Tombol Cancel : klik tombol ini untuk menutup form tanpa melakukan

impor data.

9.5 Buka Data Perusahaan

Fasilitas ini berfungsi untuk membuka database Accpro lain diluar yang
sedang dibuka saat itu. Setiap kali program Accpro dijalankan, maka akan
langsung membuka database default dan ditampilkan form Login dimana
anda harus mengisi user id dan password untuk database tersebut. Setelah
anda login, bisa jadi anda ingin membuka database Accpro lain (jika ada),
untuk itu pilih menu File > Buka Data Perusahaan. Namun anda tidak harus
login dulu ke database default untuk membuka data lain, artinya anda bisa
membatalkan proses login dengan memilih Cancel pada form Login,

selanjutnya pilih menu File > Buka Data Perusahaan.

9.6 Set Default Database

Database default adalah database yang otomatis dibuka oleh program setiap
kali anda menjalankan Accpro. Database default telah ditentukan pada saat
anda menginstall Accpro, dimana program akan meminta anda menentukan
database dimaksud. Namun database default masih bisa diubah melalui
menu File > Set Default Database.
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E@ Set Default Daiabis- &

Default Database
D:\Data Accpro'PT. SIGMA GPS.dac

Pastikan lokasi database apakah di kemputer ini atau di komputer lain
(@) Lokal (") Remote | Server

uka database ini begitu form ini ditutup

| af OK | |!j Qan::ell

Lokal : program akan mendeteksi apakah database berada di komputer
lokal atau ada di komputer lain (remote/server). Anda bisa membantu
program untuk memastikan hal ini dengan memilih opsi ini apabila
database berada di komputer ini (lokal), namun program
menafsirkannya lain (Remote / Server).

Remote / Server : pilih opsi ini bila database berada di komputer lain,
sementara program menafsirkannya lain (Lokal).

Buka database ini begitu form ini ditutup : klik checkbox ini hingga
tercentang apabila anda ingin langsung membuka database default
setelah form Set Default Database ini ditutup. Kalau tidak, maka setelah
form ditutup maka anda masih berada pada database semula, baru
setelah anda menjalankan Accpro untuk kali berikutnya anda akan
langsung masuk ke database default yang baru.

Tombol OK : klik tombol ini memastikan bahwa proses akan dilakukan.

Tombol Cancel : untuk membatalkan proses dan menutup form.

Log In

Log In atau login adalah proses untuk masuk kedalam aplikasi dalam hal ini

Accpro, dengan sebelumnya mengisi User Id dan Password melalui form

Login. Proses Login akan otomatis dijalankan ketika anda menjalankan

Accpro. Setelah anda melakukan login, mungkin pada suatu saat Anda ingin

login dengan User Id lain, untuk itu anda bisa melakukan login secara
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manual dengan memilih menu File > Login, jadi anda tidak perlu menutup

aplikasi lebih dulu apabila hanya ingin berganti user.

Proses Login secara manual juga bisa anda lakukan apabila pada saat form
Login ditampilkan ketika menjalankan Accpro, anda membatalkan proses
Login dengan mengklik Cancel. Maka untuk masuk ke dalam aplikasi pada
database yang sedang dibuka saat itu (informasi mengenai database yang
sedang aktif dapat dilihat pada Caption), pilih menu File > Login atau klik
tombol Login pada panel sebelah kiri. Kecuali kalau anda ingin membuka
database lain maka tidak sekedar proses login yang harus dilakukan tetapi

harus melalui menu File > Buka Data Perusahaan.

9.8 Log Out

Log Out, logout atau log off adalah proses keluar dari aplikasi. Dalam
kaitannya dengan Accpro maka logout berarti keluar dari aplikasi tapi tidak
menutupnya. Aplikasi tetap aktif hanya sebagian besar menunya dalam
keadaan tidak aktif. Biasanya ini dilakukan supaya aplikasi tidak digunakan
oleh pihak lain sementara anda meninggalkan komputer dalam waktu yang
relatif lama. Untuk melakukan logout pilih menu File > Log Out atau klik

tombol Log Off pada panel sebelah kiri.

Kalau anda menutup aplikasi maka untuk masuk kembali ke dalam aplikasi,
anda harus menjalankannya kembali dengan melakukan double klik iconnya
pada desktop atau cara lainnya, tetapi kalau anda hanya melakukan logout,
anda cukup melakukan login kembali untuk masuk kembali ke dalam

aplikasi.
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Appendix A
Giro Mundur Accpro 3.7

Al Setup Preferensi

Mulai Version 3.7, Accpro memberikan alternatif Sistem Baru menyangkut
penginputan Giro Mundur. Pada Sistem Baru ini, ada modul khusus untuk
menginput giro mundur dimana giro mundur yang diinput melalui modul ini
belum menjurnal dan mengupdate (memotong) Hutang atau Piutang sampai
Giro Mundur tersebut dicairkan melalui modul baru Pencairan Giro Mundur.
Sedangkan giro yang diinput langsung melalui modul Penerimaan atau
Pengeluaran Kas / Bank hanya dikhususkan untuk giro yang sudah bisa
dicairkan pada saat diinput (bukan giro mundur) sehingga akan langsung
menjurnal dan memotong Hutang atau Piutang tanpa perlu lagi dilakukan
proses pencairan. Dengan demikian Sistem Baru ini tidak lagi mensyaratkan
atau menggunakan akun Hutang Giro atau Piutang Giro karena akan
langsung mengupdate akun Kas / Bank. Jadi pada Sistem Baru ini Giro
Mundur baru akan masuk ke dalam Penerimaan atau Pengeluaran Kas / Bank

pada saat dicairkan.

Jadi ada 2 alternatif terkait dengan Giro Mundur. User yang tetap
menginginkan sistem lama tetap masih diakomodasi. Dimana pada Sistem
Lama ini, penginputan giro baik Giro Mundur ataupun bukan, dilakukan
langsung melalui modul Penerimaan atau Pengeluaran Kas / Bank dan tidak
langsung cair tetapi harus dicairkan melalui modul Mencairkan Giro Jatuh
Tempo, namun demikian pada saat penginputannya otomatis telah menjurnal
dan mengupdate (memotong) Hutang atau Piutang, hanya saja belum
mengupdate akun Kas / Bank tetapi baru berupa Hutang Giro atau Piutang
Giro dan baru akan mengupdate akun Kas / Bank pada saat dicairkan. Oleh
karena itu sistem lama ini mensyaratkan adanya akun Hutang Giro dan

Piutang Giro.

Terkait dengan hal ini, user perlu menentukan sistem yang ingin digunakan

melalui menu File > Setup Preferensi.



Sistem IGiro I-|undur| Format | Fitur | Profil | Laindain ‘

(iiPenglnpulan Giro Mundur belum otomatis menjurnal dan memotong Hutang f Piutang

Mulai Version 3.7, Accpro memberikan alternatif Sistem Baru menyangkut penginputan Gira
Mundur. Pada Sistem Baru ini, ada modul khusus untuk menginput giro mundur dimana giro
mundur yang dinput melalui modul ini belum menjurnal dan mengupdate (memotong) Hutang
atau Piutang sampai Giro Mundur tersebut dicairkan melalui modul baru Pencairan Giro Mundur.
Sedangkan giro yang dinput langsung melalui modul Penerimaan atau Pengeluaran Kas | Bank
hanya dikhususkan untuk giro yang sudah bisa dicairkan pada saat diinput {(bukan giro mundur)
sehingga akan langsung menjurnal dan mematong Hutang atau Piutang tanpa perlu lagi
dilakukan proses pencairan. Dengan demikian Sistem Baru ini tidak lagi mensyaratkan atau
menggunakan akun Hutang Gira atau Piutang Giro karena akan langsung mengupdate akun Kas
[/ Bank, Jadi pada Sistem Baru ini Giro Mundur baru akan masuk ke dalam Penerimaan atau
Pengeluaran Kas { Bank pada saat dicairkan.

(@ Penginputan Giro Mundur sudah otomatis menjurnal dan memotong Hutang / Piutang

Ini merupakan Sistem yang dipakai selama ini oleh Accpro, dimana pada Sistem Lama ini,
penginputan giro baik Giro Mundur ataupun bukan, dilakukan langsung melalui modul
Penerimaan atau Pengeluaran Kas [ Bank dan tidak langsung cair tetapi harus dicairkan melalui
modul Mencairkan Giro Jatuh Tempo, namun demikian pada saat penginputannya otomatis telah
menjurnal dan mengupdate (memotong) Hutang atau Piutang, hanya saja belum mengupdate
akun Kas / Bank tetapi baru berupa Hutang Giro atau Piutang Giro dan baru akan mengupdate
akun Kas [ Bank pada saat dicairkan, Cleh karena itu sistem lama ini mensyaratkan adanya akun
Hutang Giro dan Piutang Giro.

‘ Uiava | | Bganoel |

Pada tab Giro Mundur, pastikan pilihan sistemnya sudah sesuai dengan yang
dikehendaki, jika tidak maka klik opsi yang dikehendaki kemudian klik
tombol Save. Dengan memilih opsi pertama (Sistem Baru) maka akan muncul
sub menu baru pada menu Transaksi untuk mengakomodasi pilihan ini yaitu
Pencatatan Giro Mundur Masuk (SISTEM BARU), Mencairkan Giro Mundur
Masuk (SISTEM BARU), Pencatatan Giro Mundur Keluar (SISTEM BARU)
serta Mencairkan Giro Mundur Keluar (SISTEM BARU). Di samping itu pada
toolbar akan muncul tombol Penerimaan Giro Mundur yang mewakili
(sebagai short cut) sub menu Pencatatan Giro Mundur Masuk (SISTEM
BARU) dan Pengeluaran Giro Mundur sebagai short cut untuk sub menu
Pencatatan Giro Mundur Keluar (SISTEM BARU). Selama masih ada input
giro mundur sebelumnya yang menggunakan sistem lama yang belum
dicairkan maka pada menu Transaksi masih muncul sub menu untuk
mencairkan dan membatalkan giro mundur yang diinput dengan sistem
lama. Untuk giro mundur yang diinput setelah user memilih opsi pertama
(Sistem Baru) melalui tab Giro Mundur pada menu File > Setup Preferensi,
maka akan mengikuti sistem baru dan untuk itu jangan lagi merubah

(bergonta-ganti) sistemnya, artinya jika sudah menentukan ingin
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menggunakan Sistem Baru, pastikan jangan lagi pilihan sistem pada tab Giro
Mundur ini diubah-ubah.

A.2 Input Cek/Giro Sistem Baru

Dengan memilih opsi pertama pada tab Giro Mundur Setup Preferensi,
artinya ingin menggunakan Sistem Baru terkait penginputan Cek/Giro maka
cara menginput Cek/Giro adalah sebagai berikut : Untuk cek/giro yang pada
saat diinput telah dapat dicairkan maka penginputannya adalah seperti biasa
seperti Sistem Lama yaitu melalui modul Penerimaan Kas/Bank dan
Pengeluaran Kas/Bank. Bedanya dengan Sistem Lama adalah cek/giro yang
diinput melalui kedua modul ini akan langsung cair dan tidak perlu dicairkan
melalui modul Mencairkan Giro Masuk Jatuh Tempo atau Mencairkan Giro
Keluar Jatuh Tempo. Artinya pada saat transaksi disimpan akan langsung
menjurnal dan memotong Piutang atau Hutang dan tidak lagi menggunakan
akun perantara Piutang Giro atau Hutang Giro tetapi akan langsung
menjurnal ke akun Kas/Bank. Itulah sebabnya Jatuh Temponya pun akan
menyesuaikan tanggal transaksinya.

Pengeluaran Kas / Banl ]
No. 000012 141l b i) 2 - - S 8 Recurring
5| valsta Ry~ Kurs 1,00 Jumlah 100.000.000
No. Vioucher PV ~ | 000004
Tunai Cek/Giro Transfer
Tanggal 31/01/2015 : No. Ref o O] o
Customer @ Supplier Others Mo. CekfGiro  BG 1245745 Bank  Bank ABC -
Bavarkepada  GRAHA PRIMA SEJAHTERA ~ | JatuhTempo
AccountBank  Bank ABC -

Keterangan Pelunasan Invoice 015/GPS/INV/12/14

[ #Seratus Juta Rupih# ]

No. Invoice/Dokumen Tgl. Inv gl. J r: Hutang Dibayar -
fH 54 000001  015/GPS/INV/12/14 15/12/2014  14/01/2015 220,000,000 100.000.000 |

Kolom Hutang Dibayar h
Supplier, walaupun rilai

disi dengan nilai Hutang yang dianggap dibayar kepada
ng dibayarkan lebih kecil atau lebih besar

Jurnal Transaksi

No MNo. Perk Nama Perkiraan Debit Kredit =
1. 01-02-01-000 v |Bank ABC 100,000,000
2. 03-01-01-000 Hutang Dagang 100.000.000 H
3.
=

5. -

Total : 1mmm] [ 100.000.000
Selisih =
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Sedangkan untuk cek/giro yang pada saat diinput belum cair (cek/giro
mundur) maka penginputannya adalah melalui modul Pencatatan Giro
Mundur Masuk (SISTEM BARU) atau Pencatatan Giro Mundur Keluar
(SISTEM BARU). Klik sub menunya pada menu Transaksi atau tombol short
cutnya pada toolbar. Karena baru sebatas pencatatan maka pada saat
transaksi disimpan belum akan menjurnal atau memotong Piutang atau
Hutang.

Mencatat Penerimaan GIRO et
MNa. 000001 11| ol ol ) £
2| valuta |rp Kurs. 1,00 Jumlah 1,000,000
odevescer [+ ¢
o
Tanggal p1fo1/15 =
d &
(@ Customer Supplier Others No. CekfGiro  AA 3456789 Bank  Bank ABC -
Termadai  IMPERIAL TAXI - BthTempo 4012085 |v|  Belum Cair
AccountBank  Bark ABC -
e i et
Keterangan  Pelunasan INV-15.000001 [s

No. Invoice /Dokumen d Piutang
FHSI 000001  INV-15.000001 08/01/2015  22{01/2015 121,000,000 Rp

s, -
Sisa Piutang untuk Invoice/Dokumen ini: Rp 121.000.000 ( press Ctri+Enter to paste ) Total : Rp. 1.000.000

Kolom Piutang Dibayar harus diisi dengan nilai Piutang yang dianggap dbayar oleh
Customer, walaupun niai uang yang diterima lebih kel atau lebh besar

Pencairannya adalah melalui sub menu Mencairkan Giro Mundur Masuk
(SISTEM BARU) atau Mencairkan Giro Mundur Keluar (SISTEM BARU).
Pastikan kursor pada baris cek/giro yang ingin dicairkan kemudian klik
tombol Process. Dengan mengklik tombol ini akan muncul informasi cek/giro
yang akan dicairkan berikut informasi yang harus dilengkapi yaitu Tanggal
Cair dan Kurs Cair. Dengan mengklik tombol OK, maka program akan
membawa user masuk ke modul Penerimaan Kas/Bank atau Pengeluaran
Kas/Bank, jika ingin melanjutkan pencairan cek/giro maka setelah melakukan
perubahan atau melengkapi transaksi yang dibuatkan oleh program (jika ada
perubahan atau ada yang perlu dilengkapi), maka user perlu mengklik
tombol Save, jika ingin membatalkan (tidak jadi) mencairkan cek/giro
dimaksud maka klik tombol Cancel.
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Mencairkan Giro Masuk ’

Tentukan Tgl. Pencairan dan Kurs pada saat Giro dicairkan

Dari IMPERTAL TAXI
Bank Bark ABC
No.Cek/Gro A 3456789

Niai Rp 1,000,000
Tanggal Cair
Kurs Cair

Tips

: X Mencairkan Giro Masuk
Anda hanya bisa mencairkan cek yang tanggal Jatuh Temponya
tidak melebihi Periode Bulan Berjalan. Kalau ingin mell

fiter, lskukanlah sebelum ada data yang dipiih / dicheck

4 ST 000001

| Pyproses

Na. 000003 1) oy g [H Recurring
5| valuta ~  Kurs 1,00 Jumiah 1.000.000
No. Voucher
Tanggal 14/01/2015 No. Ref Tunai 1@ Cek/Giro Transfer
Customer Supplier Others Mo. CekfGiro  AA 3456789 Bank  Bark ABC -
Terima dari IMPERIAL TAXT - Jatuh Tempo | 14/01/2015
ActountBank  Bank ABC -
#5atu Juta Rupah#
Keterangan  Pelunasan INV-15,000001

No. Invoice/Dokumen

fiv-15.00000 1}

121.000.000

MNo. Perk

Kredit

1. 01-02-01-000 v |Bank ABC 1.000.000
2. 01-03-01-001 Piutang Dagang 1.000.000
3.
4,
5 -
Total : I-MMIMI [ LMMI
Selisih :




Dari penjelasan di atas dapat disimpulkan bahwa kalau ingin melihat daftar
cek/giro mundur yang belum cair (dicairkan) pada Sistem Baru adalah juga
melalui sub menu Mencairkan Giro Mundur Masuk (SISTEM BARU) atau
Mencairkan Giro Mundur Keluar (SISTEM BARU) .
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